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Outil de gestion
1 Outil de gestion

Là où des composants individuels de réseau doivent être regroupés en un 
système intégral, Industrial HiVision 8.1 est la solution idéale pour configurer 
et surveiller des équipements #Variable:ReleaseNr# à administrer, y compris 
les commutateurs, routeurs, pare-feu EAGLE20, unités BAT sans fil ainsi 
que des produits de divers fabricants.

Spécifiquement mis au point pour la surveillance industrielle effective, 
Industrial HiVision s'intègre aisément dans des applications SCADA. Le sys-
tème propose un SNMP intégré pour le serveur OPC. 
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Outil de gestion
1.1 Intégration d'équipements 
hétérogènes

Il va de soi que le logiciel de gestion de réseau d'un fabricant déterminé de 
composants de réseau est optimisé pour le fonctionnement de ceux-ci. Par 
contre, un système de surveillance de réseau générique et non spécifique à 
un fabricant n'offrira qu'une intégration superficielle des produits.
Néanmoins, dans le monde réel, les réseaux se trouvent la plupart du temps 
dans un environnement hétérogène, avec des équipements provenant de 
différents fabricants.

Industrial HiVision  simplifie l'action du administrateur du réseau ainsi que 
l'intégration de produits tiers dans la mesure où ceux-ci peuvent être admi-
nistrés. Ceci s'applique aux composants d'infrastructure de réseau ainsi 
qu'aux équipements de terrain. Tous les produits « administrés » disposent 
d'une série de caractéristiques standard qu'il est possible de surveiller, par 
exemple le statut de l'équipement. En outre, via l'interface standard directe, 
d'autres informations spécifiques aux équipements peuvent être saisies tels 
un historique longue durée et des messages d’état. Vous décidez vous-
même le niveau de détails requis pour la surveillance de l'application.

Avantages :
 Surveillance et présentation des tendances des équipements pouvant 

être gérés, quel qu’en soit le fabricant.
 Affichage du statut de l'ensemble de votre système
 Surveillance de réseau étendue au moyen d'un système unique de ges-

tion
16
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Outil de gestion
1.2 Reconnaissance 
automatique et améliorée de 
topologie

Pour surveiller un réseau industriel de manière fiable, une connaissance pré-
cise de la topologie de réseau est indispensable. L’administrateur du réseau 
est supposé savoir, comment, où et quels sont les équipements mis en 
réseau afin de gérer de manière efficace un réseau complexe et, le cas 
échéant, de mener à bien les mesures de maintenance nécessaires.

Les clients actuels sont déjà familiarisés avec l'interface opérateur intuitive 
deIndustrial HiVision. 
La visualisation rapide de la topologie de réseau est l'une des caractéris-
tiques principales. Les composants de l'infrastructure de réseau sont saisis 
via le protocole LLDP normalisé et Industrial HiVision établit une représenta-
tion graphique du réseau. Les équipements terminaux tels la commande à 
mémoire programmable, les modules E/S et les panneaux HMI sont égale-
ment reconnus et localisés dans la topologie de manière graphique et pré-
cise.

Industrial HiVision vous offre la possibilité de reconnaître des commutateurs 
et concentrateurs non administrables et d'afficher leur position dans le 
diagramme de réseau. Le logiciel peut, en outre, établir la topologie de 
réseau des équipements situés derrière un routeur. Ceci ouvre la voie à une 
représentation topologique d'un niveau plus élevé.

Les réseaux industriels évoluent au fil du temps et la documentation devient 
rapidement obsolète. La reconnaissance automatique de la topologie de 
vous aide à savoir quels participants sont connectés et en quel point de votre 
réseau.

Numéro de clé
 Établissement automatique de graphiques de réseau sans intervention 

manuelle.
 Grande précision des topologies.
 Documentation de réseau actualisée.
User Manual Industrial HiVision
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Outil de gestion
1.3 MultiConfig™ pour 
l'installation du réseau

De nombreux équipements d'infrastructure de réseau requièrent des para-
mètres de configuration identiques. Ceux-ci varient toutefois suivant les 
réseaux.
Quel protocole de redondance est nécessaire ?
Quelle est la température limite des équipements ?
Où se trouve le serveur de temps ?
L'interface Web doit-elle être bloquée pour le mode de fonctionnement en 
cours ?
Quel poste de gestion doit recevoir les messages d'alarme ?
Les ports non utilisés doivent-ils être désactivés ?
La liste pourrait être longue.

La configuration de chaque équipement isolément est une tâche fastidieuse. 
De plus, il est très difficile de localiser des configurations erronées isolées. 
Des essais de réception fiables sur site impliquent un investissement consi-
dérable en temps sans oublier que le réseau risque de tomber en panne. 
MultiConfig™ vous aide à prévenir ces situations.
L'outil de configuration vous permet de configurer simultanément les mêmes 
paramètres sur plusieurs équipements et de repérer des incohérences de 
réglage de paramètres. Cela fonctionne également avec des équipements 
de différents types dans la mesure où les paramètres sont identiques.
En outre, avec MultiConfig™, vous pouvez sauvegarder plusieurs configura-
tions d'équipements, localement ou sur un serveur, sans devoir intervenir sur 
chaque équipement.

Numéro de clé
 Installation rapide du réseau
 Configuration homogène de l'infrastructure de réseau
18
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Outil de gestion
1.4 MultiConfig™ pour un 
fonctionnement continu

Pendant la durée de service d'un réseau, des mesures de maintenance 
essentielles s'imposent périodiquement. Le risque de cyberattaques exige 
une modification régulière des mots de passe des équipements de la part 
d'un administrateur du réseau responsable. Les innovations technologiques 
constituent un atout de taille pour votre réseau et votre entreprise. Elles 
requièrent, néanmoins, des mises à jour du firmware de vos équipements. 
Dans le pire des cas, en cas de panne de réseau, votre service de mainte-
nance doit pouvoir accéder immédiatement aux fichiers de configuration 
actuels et à l'historique des équipements de votre réseau.

Bien entendu, sur un petit réseau il est possible d'intervenir séparément sur 
chaque équipement. Peu importe la taille : la sécurité des données et la dis-
ponibilité font partie des priorités requises pour un réseau industriel. 
MultiConfig™ permet de répondre à ces exigences en quelques clics. Le 
gestionnaire de réseau peut ainsi accomplir ses tâches quotidiennes avec 
moins de contraintes et des interruptions.

Numéro de clé
 Disponibilité optimale du réseau
 Contraintes minimales pour la gestion et la maintenance du réseau
 Interruption de fonctionnement réduite

Commentaire : En cas de changement des paramètres d'accès utilisateur 
sur un équipement contenant les mêmes paramètres d'accès SNMP, WEB 
et CLI, les modifications s'appliquent simultanément sur les 3 modes 
d'accès.
User Manual Industrial HiVision
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Outil de gestion 1.5 Développement fondé sur l'expéri-
ence
1.5 Développement fondé sur 
l'expérience

Industrial HiVision 8.1 est la quatrième génération de logiciel de gestion de 
réseau de Hirschmann. Fondé sur les expériences acquises avec les ver-
sions antérieures, le produit mis au point n'a pas d'équivalent dans le secteur 
industriel. Industrial HiVision 8.1 rassemble les atouts et caractéristiques 
éprouvés des versions antérieures. Cela inclut notamment :

Numéro de clé
 Architecture client/serveur
 Client à navigateur web
 Modes édition et exécution (Edit/Run)
 Affichage de l'arborescence réseau
 Indications de statut globales et individuelles et surveillance des mes-

sages de statut
 Flexibilité de manipulation des évènements
 Enregistrement des données à configurer suivant l'utilisateur
 Identification des tendances
 Fonctions d'exportation très étendues
 Gestion des moyens de production
20
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Outil de gestion 1.6 Version d'évaluation gratuite pen-
dant 30 jours
1.6 Version d'évaluation gratuite 
pendant 30 jours

En qualité de gestionnaire de réseau, vous avez besoin d'outils de pointe 
pour atteindre vos objectifs. Hirschmann est synonyme d'innovations. Nous 
sommes résolument décidés à poursuivre le développement de Industrial 
HiVision pour adapter le système aux fonctions des nouveaux équipements 
informatiques. Nous visons la satisfaction des exigences de nos clients et 
l'anticipation des attentes du marché de l'Ethernet dans le secteur industriel.
L'adage « Voir pour croire » est largement répandu. Les mots ne justifient 
pas à eux seuls l'investissement dans un logiciel de gestion de réseau. Pour 
cette raison, nous vous proposons de télécharger Industrial HiVision et de 
tester le système au choix pendant 30 jours ou sur demande pendant une 
période plus longue.
La version actuelle 8.1 de Industrial HiVision est disponible au télécharge-
ment sur le site www.beldensolutions.com.
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Outil de gestion 1.7 Third Party Libraries
1.7 Third Party Libraries

Copyright (c) 2007-2008 Trilead AG (http://www.trilead.com)

All rights reserved.

Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:

a.) Redistributions of source code must retain the above copyright notice, this 
list of conditions and the following disclaimer.

b.) Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation and/or 
other materials provided with the distribution.

c.) Neither the name of Trilead nor the names of its contributors may be used 
to endorse or promote products derived from this software without specific 
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRAN-
TIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDEN-
TAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLU-
DING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABI-
LITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLU-
DING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGE.

Trilead SSH-2 for Java includes code that was written by Dr. Christian Plat-
tner during his PhD at ETH Zurich. The license states the following:

Copyright (c) 2005 - 2006 Swiss Federal Institute of Technology (ETH 
Zurich), Department of Computer Science (http://www.inf.ethz.ch), Christian 
Plattner.

All rights reserved.
22
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Outil de gestion 1.7 Third Party Libraries
Redistribution and use in source and binary forms, with or without modifica-
tion, are permitted provided that the following conditions are met:

a.) Redistributions of source code must retain the above copyright notice, this 
list of conditions and the following disclaimer.

b.) Redistributions in binary form must reproduce the above copyright notice, 
this list of conditions and the following disclaimer in the documentation and/or 
other materials provided with the distribution.

c.) Neither the name of ETH Zurich nor the names of its contributors may be 
used to endorse or promote products derived from this software without spe-
cific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRAN-
TIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE 
ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDEN-
TAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLU-
DING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABI-
LITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLU-
DING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGE.

The Java implementations of the AES, Blowfish and 3DES ciphers have 
been taken (and slightly modified) from the cryptography package released 
by “The Legion Of The Bouncy Castle”.

Their license states the following:

Copyright (c) 2000 - 2004 The Legion Of The Bouncy Castle 
(http://www.bouncycastle.org)

Permission is hereby granted, free of charge, to any person obtaining a copy 
of this software and associated documentation files (the “Software”), to deal 
In the Software without restriction, including without limitation the rights to 
use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies 
of the Software, and to permit persons to whom the Software is furnished to 
do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all 
copies or substantial portions of the Software.
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THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY 
KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE 
AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEA-
LINGS IN THE SOFTWARE.
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2 Vue d'ensemble du logiciel

Le présent chapitre aborde les sujets suivants :

 les conditions requises pour l'installation et le fonctionnement du logiciel,
 l'installation du logiciel,
 la mise à jour du logiciel,
 la maintenance du logiciel,
 le démarrage du logiciel et 
 la désinstallation du logiciel.

Vous trouverez les conditions requises pour le fonctionnement du logiciel 
dans l'annexe (voir page 30 “Configuration système requise”).

Commentaire : À propos de la sécurité :
Industrial HiVision contribue à protéger le mode édition de l'interface utilisa-
teur en demandant un mot de passe.
Si vous vous identifiez en tant qu'administrateur sur votre station d’adminis-
tration réseau et que vous démarrez l'interface utilisateur de Industrial 
HiVision, Industrial HiVision vous permet de basculer directement en «Edit 
Mode». Vous contournez ainsi la demande de mot de passe.

Commentaire : À propos de la sécurité :
La base de données de Industrial HiVision contient des informations relatives 
à votre projet Industrial HiVision.
Compliquez l'accès à ce fichier en attribuant des droits d'accès exclusive-
ment sélectionnés au répertoire <installation directory>\database.
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2.1 Configuration système 
requise 

L'installation et l'exécution de Industrial HiVision requièrent :

 Configuration requise de vos équipements informatiques
 Processeur :

Processeur UC compatible x86, min.1 GHz
 RAM :

à partir de 2 Go pour processeurs de 32 bits
à partir de 4 Go pour processeurs de 64 bits
Industrial HiVision requiert env. 500 MB de mémoire vive libre. De 
plus, 500 Ko de mémoire vive sont nécessaires par agent reconnu. En 
outre, la station d'administration de réseau requiert de la mémoire vive 
pour le système d'exploitation et d'éventuelles applications supplé-
mentaires.

 Emplacement mémoire :
2 Go d'espace disponible

 Résolution de moniteur :
égale ou supérieure à 1024 x 768 pixels

 Système d'exploitation
 Windows 7 (64 bits)
 Windows 8.1 Professionnel (64 bits)
 Windows 10 Version 1803 (64 bits)
 Windows Server 2008 R2 :

Ne pas utiliser en tant que Windows Server. Assurez-vous que Share 
Point Services, Exchange Server et Active Directory ont été désinstal-
lés.

 Windows Server 2012 R2 :
Ne pas utiliser en tant que Windows Server. Assurez-vous que Share 
Point Services, Exchange Server et Active Directory ont été désinstal-
lés.
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 Windows Server 2016 :
Ne pas utiliser en tant que Windows Server. Assurez-vous que Share 
Point Services, Exchange Server et Active Directory ont été désinstal-
lés.

 Windows Server 2019 :
Ne pas utiliser en tant que Windows Server. Assurez-vous que Share 
Point Services, Exchange Server et Active Directory ont été désinstal-
lés.

 PC Linux (64 bits : Kernel 3.10, libc 6) :
Debian 8
Debian 9
Debian 10
Red Hat 7
Red Hat 8

Commentaire : Installez les paquets libmono2.0-cil et libmono-win-
forms2.0-cil pour Debian.

 Licence
Les clés de licence pour Industrial HiVision dépendent de la quantité 
d'équipements à surveiller.
Vous pouvez obtenir des clés de licence pour 16, 32, 64, 128, 256, 512, 
1024, 2048 et 4096 équipements.
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2.2 Installation

Industrial HiVision est constitué de plusieurs composants. Un service exé-
cuté en arrière-plan effectue une grande partie du travail.

Ce service est en étroite connexion avec une base de données contenant les 
données importantes relatives à Industrial HiVision et aux équipements à 
surveiller. Au redémarrage, Industrial HiVision récupère dans la base de 
données les paramètres de configuration actualisés au moment de la ferme-
ture.

Figure 1 : Architecture 
1 - SNMP-Get/Set/Trap, HiDiscovery, Ethernet/IP, Modbus/TCP, Ping, 
http, https, 
2 - http, https
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Le logiciel Industrial HiVision, directement accessible sur l'écran, est 
connecté au service en arrière-plan dont il extrait les données nécessaires.

Vous pouvez installer Industrial HiVision et conserver une version antérieure 
de Industrial HiVision. Si vous démarrez simultanément plusieurs versions, 
chaque version est connectée à son propre service en arrière-plan.

Industrial HiVision vous propose d'installer les caractéristiques suivantes sur 
différents ordinateurs :
 l'interface utilisateur (client Industrial HiVision)
 le service avec base de données (serveur Industrial HiVision)

Vous pouvez ainsi accéder à différents sites dotés de plusieurs interfaces uti-
lisateurs sur une station centrale d'administration réseau. Le nombre d'inter-
faces utilisateurs ayant accès à une station centrale d'administration réseau 
dépend de la performance de la station d'administration réseau. Pour éviter 
des conflits d'accès, seule une interface utilisateur peut accéder à la station 
d'administration réseau en «Edit Mode» (voir page 389 “Avancé”).

Néanmoins, avec une interface utilisateur, vous pouvez accéder à plusieurs 
serveurs décentralisés Industrial HiVision.

Commentaire : installation d'un pare-feu externe avec NAT entre le service 
et l'interface utilisateur :
Dans le pare-feu externe, activez pour le port de connexion en direction du 
service une redirection pour lesports suivants :
 serveur proxy 11188, Industrial HiVision pour la communication entre ser-

vice et interface utilisateur.
 serveur web 11187, Industrial HiVision pour ouvrir également l'interface 

utilisateur dans le navigateur.
(voir page 391 “Accès Services”)

Commentaire : Industrial HiVision enregistre des événements (voir 
page 123 “Liste d'évènements”) avec date et heure dans la base de don-
nées. L'heure enregistrée se base sur l'heure du système sur lequel le ser-
vice est exécuté. Si vous lancez l'interface utilisateur sur un ordinateur situé 
dans un autre fuseau horaire, Industrial HiVision indique les heures d'événe-
ment du fuseau horaire de l'ordinateur sur lequel le service est exécuté.
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2.2.1 Téléchargement du logiciel Industrial 
HiVision

Pour installer Industrial HiVision sur votre ordinateur, procédez tout d'abord 
à l'enregistrement de votre téléchargement. Au terme de l'enregistrement, 
vous pouvez télécharger l'application.

Pour enregistrer le téléchargement de l'application Industrial HiVision auprès 
de Hirschmann, procédez comme suit :
 Ouvrez le site web de Hirschmann Industrial HiVision à l'adresse : 

http://www.hivision.de
 Cliquez sur le lien Téléchargement.
 Cliquez sur le lien « Télécharger logicielIndustrial HiVision ».
 Cliquez sur le lien du logiciel correspondant à vos critères.
 Ouvrez l'onglet « Téléchargements ».
 Dans la liste, sélectionner l'option « Logiciel ».
 Sélectionnez l'option de logiciel correspondant à vos critères.
 Dans la boîte de dialogue « Connexion », entrez votre adresse e-mail et 

cliquez sur le lien « Enregistrer » dans la zone inférieure de la boîte de 
dialogue.

 Entrez les informations correspondantes dans la boîte de dialogue 
« Enregistrement » et cliquez ensuite sur le lien « Enregistrer ». L'assis-
tance Belden vous adresse un e-mail contenant le lien vers votre compte 
(belden-service@salient.de).

 Pour activer votre compte, cliquez sur le lien dans votre e-mail.
 Saisissez un nouveau mot de passe dans la boîte de dialogue « Portail 

de partenaire privilégié » et cliquez en suite sur l'option « Envoyer ».

Pour installer Industrial HiVision sur votre ordinateur, procédez comme suit :

 Lorsque Industrial HiVision est exécuté sur votre ordinateur, arrêter le 
noyau actuel.

 Ouvrez le site web Hirschmann Industrial HiVision sous : http://www.hivi-
sion.de

 Cliquez sur le lien Téléchargement.
 Pour télécharger l'application Industrial HiVision, cliquez sur le lien 

« Télécharger logiciel Industrial HiVision »
 Cliquez sur le lien du logiciel correspondant à vos critères.
 Ouvrez l'onglet « Téléchargements ».
 Dans la liste, sélectionner l'option « Logiciel ».
 Sélectionnez l'option de logiciel correspondant à vos critères.
 Cliquez sur le lien « Télécharger fichiers sélectionnés ».
 Lisez l'accord de licence et cliquez ensuite sur le bouton « Accepter ».
 Poursuivez le téléchargement de fichier.
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 Au terme du téléchargement par le navigateur, l'explorateur de fichier 
affiche le fichier ZIP Industrial HiVision.

 Assurez-vous de disposer des droits d'administrateur.
 Pour les ordinateurs sous Windows, procédez à l'extraction des fichiers 

du fichier ZIP sur votre disque local. Surveillez l'emplacement de 
mémoire affiché dans le champ de texte.

 Si vous travaillez sous Linux, décompressez le fichierihivision08100_li-
nux.tar par la commande suivante :
tar -xf ihivision08100.tar -C /path/to/directory

2.2.2 Installation sous Windows

 Téléchargez les fichiers Industrial HiVision et procédez à l'extraction 
comme décrit dans “Téléchargement du logiciel Industrial HiVision” on 
page 34.

 Accédez jusqu'à l'emplacement de mémoire des fichiers extraits 
Industrial HiVision.

 Sous Windows, double-cliquez sur le fichier ihivision08100.
 Dans la boîte de dialogue Open File - Security Warning, cliquez sur 

le bouton Run
 Répondez aux questions du script d'installation et suivez les instructions 

de ce dernier. 
Si vous ne répondez pas à une des questions du script d'installation, 
celui-ci sélectionne la réponse par défaut.

Commentaire : Si vous recevez le message Error during installation 
of ikernel.exe, ceci signifie que l'utilisateur ne détient pas les droits 
d'administrateur.
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En fonction de votre sélection, l'assistant installe les caractéristiques 
suivantes :
 le service avec Hirschmann Industrial HiVision 08.1.00 Service avec base 

de données (serveur Industrial HiVision)
 Services OPC
 le logiciel client Industrial HiVision (= interface utilisateur)

Si vous souhaitez une intégration dans un système SCADA, les services 
OPC doivent être installés sur le serveur Industrial HiVision.
Les services OPC sont utilisés comme source de données pour les systèmes 
SCADA.

Pour faire une analyse HiDiscovery, le programme Industrial HiVision 
requiert WinPcap.
Pendant l'installation de Industrial HiVision, Industrial HiVision vérifie si une 
version éventuellement installée sur votre PC de WinPcap répond aux exi-
gences de Industrial HiVision. Si ce n'est pas le cas, autorisez l'installation 
de WinPcap par l'assistant d'installation.

Pendant l'installation, vous pouvez sélectionner si le logiciel « Hirschmann 
Industrial HiVision 08.1.00 Service » démarre comme suit :
 au redémarrage de l'ordinateur, le service est automatiquement lancé
 le service est automatiquement lancé au démarrage du logiciel

Commentaire : Pour visualiser l'état du service sous Windows 2008 R2, 
Windows Server 2012 R2, reportez-vous à Start:Control 
Panel:Administration Tools:Computer Management:Services and 
Applications:Services..
Ici, vous avez la possibilité de quitter le service et de redémarrer.
Si vous exécutez d'autres logiciels gourmands en ressources sur l'ordina-
teur, fermez le logiciel Industrial HiVision ainsi que le service « Hirschmann 
Industrial HiVision 08.1.00 Service ». Ce service requiert une grande capa-
cité de l'ordinateur. Le logiciel Industrial HiVision vous demande au démar-
rage si le service doit être lancé. Si vous sélectionnez File > Exit and Stop 
Service, pour quitter le logiciel Industrial HiVision, celui-ci vous demande si 
vous souhaitez fermer le service.
En cas de service désactivé, veillez à ce que le réseau ne soit pas surveillé 
pour éviter l'enregistrement d'événements.
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Commentaire : Conformément au préréglage des paramètres de service, 
sous l'onglet « Logon » aucun échange de données n'est autorisé entre le 
service et le bureau pour le compte local de système (Start:Control 
Panel:Administration Tools:Computer Management:Services and 
Applications:Services, cliquez avec le bouton droit de la souris sur Hir-
schmann Industrial HiVision 08.1.00 Service Service, puis sélectionnez 
Properties). Cela signifie que vous pouvez démarrer un programme par le 
biais de Industrial HiVision   (voir page 354 “Event Actions”), que le proces-
sus est exécuté en arrière-plan et que le programme ne s'affiche pas à 
l'écran. L'autorisation de l'échange de données entre le service et l'interface 
utilisateur graphique constitue un risque pour la sécurité étant donné que ce 
logiciel peut être démarré indépendamment de l'utilisateur enregistré. Les 
attaques des dénommés Troyens utilisent cette lacune de sécurité. Pour 
envoyer un SMS ou un e-mail en cas de survenance d'un événement, un 
échange de données n'est pas nécessaire entre le service et l'interface utili-
sateur graphique.

2.2.3 Installation sous Linux

 Connectez-vous via la commande su pour obtenir les droits d'accès 
racines.

 Arrêtez le noyau actuel.

 Démarrez le script d'installation via la commande
sh /mnt/cdrom/Software/industrialhivision/linux/install.sh

 Répondez aux questions du script d'installation et suivez les instructions 
de ce dernier. 
Si vous ne répondez pas à une des questions du script d'installation, 
celui-ci sélectionne la réponse par défaut.

Exemple d'exécution du script d'installation :

Welcome to Industrial HiVision
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This script will install Industrial HiVision on your system.
You can abort the setup process anytime by pressing ctrl-c.

Do you wish to continue? [y]es, [n]o (default=no)
y

Please specify a destination directory for the installation
(default=/opt/ihivision08100)

The directory /opt/ihivision08100 does not exist.
Do you wish to create it? [y]es, [n]o (default=no)
y

Unpacking Industrial HiVision...

Running setup script...
*** Checking database user ***
*** Initialising installation directory ***
*** Initialising log directory ***
*** Configuring Services ***
*** Configuring Executables ***
*** Preparing Init Script ***
*** Industrial HiVision successfully installed ***

Industrial HiVision is now installed and ready for use.

 Démarrez le service Industrial HiVision avec la commande suivante : 
/etc/init.d/ihivision08.1.00 start
Industrial HiVision suppose que vous vous êtes connectés via su.

 Terminez le service avec la commande suivante : 
/etc/init.d/ihivision08.1.00 stop

 Redémarrez le service avec la commande suivante : 
/etc/init.d/ihivision08.1.00 restart

 Vous pouvez vérifier avec la commande suivante si le service fonctionne : 
/etc/init.d/ihivision08.1.00 status

Pour lancer le service au démarrage du système d'exploitation, vous pouvez 
inclure le démarrage du service dans la séquence d'initialisation de votre 
système.
Pour ce faire, les différentes distributions Linux offrent de nombreuses pos-
sibilités.
Pour certaines séquences de démarrage compatibles avec Sys V, l'installa-
tion copie le script de démarrage ihivision08.1.00 dans le répertoire 
init.d du système.
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Selon les besoins, les options suivantes sont disponibles :
 intégration dans les différents niveaux de fonctionnement
 au besoin, démarrage manuel avec la commande ci-dessus
Le script d'initialisation a été développé et testé sous Red Hat, 
Ubuntu/Kubuntu et Mandriva Linux. D'autres distributions (Gentoo par ex.) 
utilisent un autre format de script pour lequel d'autres scripts sont néces-
saires.

 Configuration du serveur Syslog
Les applications Linux enregistrent des événements survenus dans des 
fichiers journaux. L'utilitaire système Rsyslogd vous permet de journaliser 
des événements dans un système Linux. Vous configurez l'utilitaire 
Rsyslogd à l'aide du fichier rsyslog.conf. Vous pouvez configurer le fichier 
rsyslog.conf pour enregistrer des événements de Industrial HiVision sur 
un serveur Syslog.

Linux Syslog contient les événements suivants :
 connexions et déconnexions dans l'application Industrial HiVision,
 actions qui impliquent l'envoi d'une demande de configuration SNMP 

à un équipement ; cela inclut la variable MIB ainsi que la nouvelle 
valeur,

 actions de HiDiscovery dans Industrial HiVision,
 démarrage d'applications externes.
 actions requérant le «Edit Mode».

Pour configurer le fichier rsyslog.conf de sorte à enregistrer des événe-
ments sur un serveur Syslog, procédez comme suit :
 Accédez au dossier /etc dans le répertoire d'installation.
 Ouvrez le fichier rsyslog.conf.
 Commentez les lignes suivantes :

– $ModLoad imudp,
– $UDPServerRun 514.
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Exemple pour fichier rsyslog.conf :
#/etc/rsyslog.conf     Configuration file for rsyslog
#                      For more information see
#                      /user/share/doc/rsyslog-doc/html
                       /rsyslog_conf.html

#################
#### MODULES ####
#################

$ModLoad imuxsock # provides support for local system logging
$ModLoad imklog   # provides kernel logging support
$ModLoad immark   # provides --MARK-- message capability
|
# provides UDP syslog reception
|$ModLoad imudp
|$UDPServerRun 514
|
|
|# provides TCP syslog reception
|$ModLoad imudp
|$UDPServerRun 514
|
|
|"/ect/rsyslog.conf" 121 lines, 2630 characters
|
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2.3 Mise à jour

2.3.1 Mise à jour sous Windows

Pour mettre à jour une version déjà installée de Industrial HiVision, installez 
la nouvelle version comme indiqué sous« Installation sous Windows » à la 
page 29.

Pendant l'installation, vous pouvez sélectionner si la routine d'installation doit 
transférer les contenus de la base de données de l'installation antérieure 
dans la nouvelle installation.

Si vous souhaitez transférer les contenus de la base de données d'une ver-
sion antérieure, l'ancienne version ne doit être désinstallée qu'à l'issue de la 
mise à jour. Industrial HiVision autorise l'installation de différentes versions 
sur un même ordinateur.

Commentaire : Afin de garantir le correct transfert des données provenant 
de la version antérieure, la routine d'installation, après votre approbation, 
ferme la version précédente du service si celui est encore activé. Toutefois, 
le processus de mise à jour se déroule hors surveillance du réseau.

Commentaire : La sauvegarde du Industrial HiVision dépend de la version. 
Après chaque mise à jour de logiciel, créez un fichier de sauvegarde (voir 
page 254 « Sauvegarde Backup »).
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2.3.2 Mise à jour sous Linux

Pour mettre à jour une version déjà installée de Industrial HiVision, installez 
la nouvelle version comme indiqué sous“Installation sous Linux” on page 37.

Pendant l'installation, vous pouvez sélectionner si la routine d'installation doit 
transférer les contenus de la base de données de l'installation antérieure 
dans la nouvelle installation.

Si vous souhaitez transférer les contenus de la base de données d'une ver-
sion antérieure, l'ancienne version ne doit être désinstallée qu'à l'issue de la 
mise à jour. Industrial HiVision autorise l'installation de différentes versions 
sur un même ordinateur.

Commentaire : Afin de garantir un transfert correct des données provenant 
de la version antérieure, fermez cette version avant l'installation si elle est 
encore activée. Toutefois, le processus de mise à jour se déroule hors sur-
veillance du réseau.
Si plusieurs versions précédentes sont installées, Industrial HiVision trans-
fère les données de la version antérieure la plus récente.

Commentaire : Lors d'une mise à jour, Industrial HiVision peut transférer les 
données provenant de la base de données de la version antérieure si la ver-
sion antérieure se trouve dans le répertoire d'installation par défaut.
Si ce n'est pas le cas, vous pouvez transférer les données à l'aide des fonc-
tions d'interface (voir page 270 “Save”) et(voir page 269 “Open...”).

Commentaire : La sauvegarde du Industrial HiVision dépend de la version. 
Après chaque mise à jour de logiciel, créez un fichier de sauvegarde (voir 
page 389 “Avancé”).
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2.4 Maintenance

Hirschmann œuvre en permanence à l'amélioration et au perfectionnement 
des logiciels. Vérifiez régulièrement si une nouvelle version du logiciel vous 
apporte des avantages supplémentaires.
Vous trouverez des informations concernant les mises à jour sur le site Inter-
net de Hirschmann Automation and Control GmbH.

www.hivision.de
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2.5 Démarrage

2.5.1 Démarrage sous Windows

La routine d'installation du logiciel installe une icône du logiciel qui ouvre un 
lien vers le logiciel Industrial HiVision aux emplacements suivants :

 sur le bureau et

 Dans Start:Programs:Hirschmann:Industrial HiVision 8.1

 Démarrez Industrial HiVision par un double clic sur l'icône du logiciel de 
votre bureau ou en sélectionnant l'icône du logiciel dans le répertoire de 
démarrage.

Lors du démarrage, Industrial HiVision recherche le serveur. Si Industrial 
HiVision ne trouve pas le serveur, il ouvre une boîte de dialogue deman-
dant la saisie de l'adresse IP du serveur ou du nom du serveur. Si le ser-
veur se trouve sur votre ordinateur local, saisissez le nom localhost. 

Commentaire : Pour que vous puissiez vous connecter avec le serveur 
d'Industrial HiVision depuis un autre ordinateur, autorisez auparavant l'accès 
distant dans les options du serveur (voir page 391 “Accès Services”).

Figure 2 : Fenêtre « Enter server address » [Entrez l'adresse du serveur]
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Si Industrial HiVision trouve le serveur avec lequel il a été connecté lors de 
la dernière session, Industrial HiVision rétablit la connexion avec celui-ci. Si 
vous souhaitez vous connecter à un autre serveur, cliquez sur « Cancel » 
[Annuler] dans la fenêtre « Connecting to server » [Connexion à un serveur]. 
Avec File > Login, vous ouvrez le dialogue de saisie de l'adresse IP du ser-
veur.

Figure 3 : Fenêtre « Connecting to server » [Connexion à un serveur]

 Connexion à plusieurs serveurs
 Pour vous connecter à plusieurs serveurs, copiez l'icône du logiciel et 

ajoutez-la comme un nouveau lien.
 Ouvrez les propriétés de la nouvelle icône de logiciel en cliquant sur 

le bouton droit de la souris et sélectionnez Properties.
 Dans la ligne Destination à la suite de « 

C:\Programs\Hirschmann\Industrial HiVision 
8.1\bin\HiVision.exe » introduisez une espace puis les para-
mètres de lignes de commande -kernelHost <server name>. Rem-
placez <server name> par l'adresse IP ou le nom de votre serveur.

Répétez la procédure pour chaque serveur avec lequel vous souhaitez 
établir une connexion. 
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2.5.2 Démarrage sous Linux

 Démarrez le service avant de lancer l'interface graphique (voir page 37 
“Installation sous Linux”).

Afin que vous puissiez démarrer Industrial HiVision à partir de l'interface gra-
phique, placez une icône sur le bureau utilisé (KDE, Gnome, etc.).
Vous trouverez une image appropriée (ihivision_op32x32.png) dans 
/opt/ihivision08100/lib.

Pour démarrer Industrial HiVision, chaque utilisateur peut double-cliquer sur 
l'icône ou utiliser la commande /opt/ihivision08100/bin/HiVision.
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2.6 Désinstallation

2.6.1 Désinstallation sous Windows

 Fermez le logiciel Industrial HiVision avant de commencer la désinstalla-
tion.

 Pour désinstaller Industrial HiVision, sélectionnez Start:Control 
Panel:Software
Start:Control Panel:Software

 Sélectionnez le logiciel Industrial HiVision.

 Cliquez sur Modifier/Supprimer et suivez les instructions pour la procé-
dure de désinstallation.

2.6.2 Désinstallation sous Linux

 Fermez le logiciel Industrial HiVision avant de commencer la désinstalla-
tion.

 Connectez-vous via la commande su pour obtenir les droits d'accès 
racines.

 Démarrez le service Industrial HiVision avec la commande suivante : 
/etc/init.d/ihivision08.1.00 stop
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 Effacez le répertoire /opt/ihivision08100 à l'aide de la commande : rm 
-rf /opt/ihivision08100

 Supprimez le script de démarrage ihivision des niveaux de fonctionne-
ment de votre séquence d'initialisation (voir page 37 “Installation sous 
Linux”).

Commentaire : Les contenus de la base de données et les licences se 
perdent lors de la désinstallation. 
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3 Préparation

Avant de commencer les opérations de saisie et de surveillance de votre 
réseau, mettez en place les conditions requises et utiles.

 Une condition à mettre en évidence est la protection de votre station 
d'administration réseau.

 L'accessibilité des équipements à surveiller et l'autorisation d'accès cor-
respondante font partie de ces conditions requises.

 Les conditions utiles incluent des options de présentation comme la cou-
leur et la taille de la police.

 Établissez un plan de sauvegarde des données. Exportez régulièrement 
les données de votre projet. Ainsi, vous pouvez à tout moment rétablir 
votre projet si des circonstances adverses venaient à endommager vos 
données.

Le logiciel « Demo Network » [Démo réseau], également fourni, vous offre la 
possibilité de simuler un réseau sur votre ordinateur afin de vous familiariser 
avec Industrial HiVision hors connexion.
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3.1 Améliorer la sécurité de 
Industrial HiVision

Les attaques toujours plus nombreuses des systèmes informatiques, le 
sabotage et l'espionnage demandent à l'exploitant des connaissances 
approfondies sur la vulnérabilité des cibles de l'attaque. La liste suivante 
vous fournit une sélection de cibles d'attaque potentielles qu'offre un environ-
nement administré par un système d'administration réseau :
 accès physique à la station d'administration réseau
 accès physique aux différents équipements administrés
 manipulation des fichiers d'installation
 accès Ethernet à la station d'administration réseau
 accès Ethernet aux différents équipements administrés
 accès aux fichiers de configuration et log

Dans ce chapitre, vous trouverez des instructions qui vous aident à compli-
quer l'accès non autorisé à Industrial HiVision et aux équipements adminis-
trés.

Dans ce manuel, le terme « sécurité » désigne tout ce qui est en rapport avec 
la sécurité et la protection de votre infrastructure de réseau de données. 

3.1.1 Protection physique

Même le meilleur système de sécurité informatique et les stratégies logi-
cielles correspondantes sont inutiles si un pirate dispose d'un accès phy-
sique à un équipement devant être protégé. Le pirate peut par exemple 
couper l'équipement de l'alimentation en tension, retirer les câbles de don-
nées, espionner les câbles de données, voire endommager mécaniquement 
l'équipement.
 Installez un équipement devant être protégé dans une armoire ou un local 

fermé(e).
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3.1.2 Mesures à prendre avant et pendant 
l'installation de Industrial HiVision

Les premières mesures pour la sécurité de votre système d'administration 
réseau se prennent dès avant et pendant l'installation.

 Vérifier l'environnement d'installation
Plus le nombre de logiciels installés sur votre système est important, plus 
les pirates disposent de points potentiellement vulnérables sur votre sys-
tème. Les routines d'installation de Industrial HiVision disposent de plu-
sieurs extensions du programme d'installation :
– service OPC DA
– service OPC UA
– installation de l'interface utilisateur graphique
 Vérifiez quels sont les programmes et compléments de programme 

dont vous avez besoin pour répondre à vos exigences.
 Supprimez de vos systèmes les programmes qui ne servent pas direc-

tement à répondre à vos exigences.
 Installez exclusivement les programmes et compléments de pro-

gramme dont vous avez besoin pour répondre à vos exigences.

Commentaire :  Même si vous n'installez pas le service OPC UA, le port 
de communication est ouvert. Cela représente un risque pour la sécurité.

Pour éliminer le risque sécuritaire du port de communication ouvert, pro-
cédez comme suit :
 Si le logiciel Industrial HiVision est ouvert, fermez le logiciel et arrêtez 

les processus.
 Cliquez sur File > Exit and Stop Service.
 Ouvrez le fichier « service.xml » dans un éditeur de texte, par ex. 

Notepad++. Le fichier « service.xml » se trouve sous C:\Program 
Files\Hirschmann\Industrial HiVision8.1\config

 Cherchez la ligne service OPC <Service Name="OpcUaServer" 
Enabled="yes" Path="..." Foreign="yes". Cette ligne est située 
dans la zone inférieure du fichier.

 Modifier « yes » en « no » pour le serveur OPC-UA, par ex. <Service 
Name="OpcUaServer" Enabled="no" Path="..." Foreign="yes".

 Enregistrez et fermez le fichier « service-xml ».
 Redémarrez le logiciel Industrial HiVision.
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 Vérifier la signature des fichiers d'installation
Une manière d'attaquer les systèmes informatiques consiste à contami-
ner les fichiers d'installation avec un logiciel malveillant. Hirschmann 
signe les fichiers *.exe, *.ocx, *.dll et *.jar dans Industrial HiVision. La 
signature vous permet de vérifier que vous disposez bien des fichiers 
d'installation d'origine de Hirschmann.
Vérification de la signature des fichiers *.exe, *.ocx et *.dll sous Windows :
Les fichiers du chemin d'installation contiennent une signature.
 Dans l'explorateur de fichiers, ouvrez la boîte de dialogue Properties 

du fichier que vous voulez vérifier.
 Dans la boîte de dialogue Properties, ouvrez l'onglet Digital 

Signatures.
 Sélectionnez la ligne avec la signature et cliquez sur le bouton 

Details.
 Dans la boîte de dialogue Details, cliquez sur l'option View 

Certificate. 
Assurez-vous que le certificat pour Hirschmann Automation and Control 
GmbH a été émis.
Assurez-vous que le certificat a été émis par un organisme fiable et établi 
avec une signature de code CA de classe 3.
Vérification de la signature des fichiers *.jar sous Windows et Linux :
L'interface utilisateur est une application Java.
Si vous démarrez l'interface utilisateur dans un navigateur Web, l'affi-
chage de la signature du fichier *.jar est organisé par le navigateur Web. 
De même, le navigateur Web vous donne la possibilité de faire confiance 
à la signature ou d'empêcher l'exécution du fichier *.jar.
Voir “Accès web à Industrial HiVision” on page 253.

 Limiter les droits d'accès aux fichiers d'installation
Tout individu qui dispose de droits d'accès en écriture aux fichiers instal-
lés d'un système peut manipuler ces fichiers.
 Rendez l'accès au répertoire d'installation Industrial HiVision plus dif-

ficile en n'accordant l'accès qu'aux personnes de confiance.

Commentaire : À propos de la sécurité :
Tout individu qui dispose de droits d'accès en écriture au registre d'un 
système peut manipuler les entrées de registre. Aidez à sécuriser le 
registre en accordant des droits d'accès en écriture exclusivement à des 
personnes de confiance.
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 Installation d'un système d'administration réseau 
redondant
Pour assurer une haute disponibilité d'administration réseau, le système 
d'administration réseau Industrial HiVision vous offre la possibilité d'ins-
taller le logiciel à deux emplacements différents. Dans ce cas, les instal-
lations utilisent une base de données commune. 
Ceci vous permet les structures redondantes suivantes :
 la station d'administration réseau elle-même
 la liaison des deux stations d'administration réseau
L'avantage offert par la disponibilité redondante est donné au prix de sur-
faces d'attaque supplémentaires.
Ces surfaces d'attaque supplémentaires sont les suivantes :
 la station d'administration réseau redondante elle-même
 la liaison redondante des deux stations d'administration réseau
 Prenez les mêmes mesures de sécurité pour les composants redon-

dants que pour les composants principaux.
Le manuel d'utilisateur « Redundant Network Management System 
Industrial HiVision » (Système d'administration réseau redondant) 
contient des informations détaillées sur l'installation de ce système redon-
dant.

 Certificat du serveur Web
Industrial HiVision vous offre la possibilité de communiquer via un navi-
gateur Web de manière cryptée avec le serveur Web Industrial HiVision. 
Pour la communication cryptée, sélectionnez le protocole de transmission 
https. Industrial HiVision utilise un certificat « auto-signé » pour le proto-
cole https. Faites exclusivement confiance à ce certificat si vous avez 
réellement envoyé votre demande de connexion au serveur Web 
Industrial HiVision. 
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3.1.3 Mesures à prendre lors de la configuration 
de Industrial HiVision

Après l'installation de Industrial HiVision, tout individu peut exécuter le pro-
gramme dans toute son étendue. Du point de vue de la sécurité, la configu-
ration commence par la restriction des droits d'accès.

 Modifier l'identifiant et le mot de passe pour le Edit Mode
Juste après l'installation, vous pouvez accéder librement à Industrial 
HiVision. 
Industrial HiVision vous permet d'exiger une connexion avant le démar-
rage de l'interface du logiciel.
Une fois l'interface du logiciel démarrée, Industrial HiVision dispose d'un 
«Edit Mode» et d'un mode Run. Voir “Edit Mode” on page 94.
 Configurez la requête de connexion.
 Configurez un mot de passe pour l'accès au «Edit Mode». Voir “User 

Management” on page 347.

 Déterminer les droits d'accès
Une partie importante de la protection des systèmes informatiques est la 
limitation de l'accès par des droits d'accès associés à des mots de passe.
À cet effet, vous devez définir les rôles d'autorisation correspondants et 
un utilisateur avec les rôles d'autorisation appropriés. 
 Pour limiter l'accès à Industrial HiVision, configurez un utilisateur sous 

«Local Users» et/ou activez une «Policy» d'autorisation. Voir “User 
Management” on page 347.

 Configurer le protocole LDAP
Le protocole LDAP (Lightweight Directory Access Protocol) permet entre 
autres l'authentification (vérification du mot de passe) et l'autorisation 
(vérification des droits) dans un réseau de données. Microsoft utilise par 
exemple le protocole LDAP pour la gestion des utilisateurs dans le ser-
vice Active Directory. 
Un serveur central ou plusieurs serveurs distribués gèrent entre autres 
les noms et les rôles des utilisateurs.
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Si LDAP est activé, Industrial HiVision envoie une requête au serveur 
LDAP dès qu'un utilisateur se connecte.
Industrial HiVision reprend le nom d'utilisateur et les rôles d'autorisation 
du serveur LDAP et les transfère dans le répertoire local de l'utilisateur. 
 Demandez à l'administrateur de votre serveur LDAP quelles données 

de configuration il convient d'entrer dans la boîte de dialogue LDAP de 
Industrial HiVision.

 Indiquez à l'administrateur de votre serveur LDAP les données utilisa-
teur suivantes à entrer dans le serveur LDAP :
– «User Name»
– «Password»
– «Access Roles»

Voir “User Management” on page 347.

 Radius Authentication
Le service RADIUS (Remote Authentification Dial-In User Service) per-
met l'authentification (vérification du mot de passe) et l'autorisation (véri-
fication des droits) dans un réseau de données. 
RADIUS se base sur un protocole client-serveur.
Si RADIUS est activé, Industrial HiVision envoie une requête au serveur 
RADIUS dès qu'un utilisateur se connecte.
Industrial HiVision reprend le nom d'utilisateur et les rôles d'autorisation 
du serveur RADIUS et les transfère dans le répertoire local de l'utilisateur. 
 Demandez à l'administrateur de votre serveur RADIUS quelles don-

nées de configuration il convient d'entrer dans la boîte de dialogue 
RADIUS de Industrial HiVision.

 Indiquez à l'administrateur de votre serveur RADIUS les données uti-
lisateur suivantes à entrer dans le serveur RADIUS :
– «User Name»
– «Password»
– «Access Roles»

Voir “User Management” on page 347.

 Surveiller les réglages de configuration des équipements
La configuration d'un équipement représente une cible d'attaque. Un 
pirate accédant à l'administration peut modifier la configuration d'un équi-
pement, par ex. désactiver un port.
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Industrial HiVision vous offre la possibilité de sauvegarder la configura-
tion d'équipements en tant que configuration de référence et de la com-
parer régulièrement avec la configuration active de l'équipement.
 Dans l'affichage détaillé, cliquez sur l'onglet «Properties».
 Dans la liste déroulante de «Property:», sélectionnez la propriété 

«Configuration File».
Industrial HiVision dresse la liste des équipements de votre réseau qui 
représentent la propriété «Configuration File».
 Sélectionnez les équipements dont vous souhaitez surveiller la confi-

guration.
 Cliquez avec le bouton droit de la souris sur l'équipement sélectionné 

et sélectionnez MultiConfig™.
Industrial HiVision ouvre la boîte de dialogue MultiConfig™.
 Dans l'arborescence de la boîte de dialogue MultiConfig™, cliquez sur 

«Status Config».
 Pour télécharger les configurations de référence des équipements, 

sélectionnez «Set current to reference» dans le cadre fonctionnel de 
la boîte de dialogue «Status Config».

 Sélectionnez l'état pour «Value is Reference Value», par ex «OK».
 Sélectionnez l'état pour «Other Value», par ex «Warning».
 Cliquez sur «Write».
 Pour régler la scrutation et la transmission de l'état, sélectionnez dans 

l'arborescence de la boîte de dialogue de MultiConfig™ «Property 
Properties». Pour l'intervalle de polling, tenez compte de la charge du 
réseau du fait de cette fonction.
Malgré de grands intervalles de scrutation, il existe la possibilité de 
réagir à des événements actuels par l'envoi d'alarmes à travers les 
équipements du réseau. À cet effet, entrez la station d'administration 
réseau en tant que destination des traps SNMP dans les équipements.

Si la configuration de l'équipement surveillé venait à changer, Industrial 
HiVision vous offre la possibilité de comparer la configuration sauvegar-
dée dans Industrial HiVision et la configuration actuelle sur l'équipement.
 Pour accéder à la propriété «Configuration File» de l'équipement, 

double-cliquez sur l'équipement concerné dans l'affichage de listes.
 Pour afficher les différences, cliquez avec le bouton droit de la souris 

sur la propriété «Configuration File» de l'équipement «Display diffe-
rences».

Les tags de la vue de comparaison revêtent les significations suivantes :
 Texte vert sur fond gris clair : modification
 Texte rouge sur fond gris clair : suppression
 Texte bleu sur fond gris clair : insertion
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 Suivre les modifications des réglages du programme et des 
configurations de l'équipement
Le terme « Audit Trail » (Suivi d'audit) ou « Audit Log » (Enregistrement 
d'audit) désigne un enregistrement chronologique de modifications dans 
un système et son environnement. 
Ces enregistrements permettent notamment de vérifier qui a changé une 
configuration et à quel moment.
L'Audit Trail utilise l'affichage des événements de Windows et la fonction 
Syslog sous Linux.
La fonction Audit Trail s'exécute automatiquement sans influence de l'uti-
lisateur.
Industrial HiVision enregistre des informations concernant les événe-
ments suivants :
 MultiConfig™

– Les opérations d'écriture réussies ou échouées avec 
MultiConfig™.

 Boîte de dialogue Properties (Propriétés)
– Opération d'écriture dans la boîte de dialogue d'une propriété

 Domaines 
– Octroyer des licences
– Retirer des licences octroyées
– Ajouter des sous-domaines
– Supprimer des sous-domaines

 Actions liées à des échéances
– Exécuter une tâche
– Ajouter des tâches

 Administration des équipements
– Définir l'équipement sur « Managed » (administré)
– Définir l'équipement sur « unmanaged » (non administré)
– Supprimer l'équipement
– Attribuer l'adresse cible du trap SNMP

 Modifier la configuration IP 
 Exécuter des actions qui nécessitent le « mode edit »

– La fonction « Audit Trail » (Suivi d'audit) enregistre les actions dont 
Industrial HiVision exige la saisie du mot de passe du « mode edit » 
avant l'exécution.

 Programmes externes
– Ouvrir ou fermer l'interface Web des équipements administrés
– Ouvrir ou fermer la configuration des équipements administrés
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– Ouvrir ou fermer l'interface de ligne de commande des équipe-
ments administrés

– Ouvrir ou fermer le navigateur SNMP pour l'interrogation des équi-
pements administrés par des variables SNMP-MIB

L'enregistrement des actions exécutées par les programmes externes 
incombe aux programmes externes. Industrial HiVision enregistre le 
démarrage et la fin de ces programmes externes.

 Actions définies par l'utilisateur
– Ajouter une action définie par l'utilisateur
– Exécuter une action définie par l'utilisateur

 Restreindre les droits d'accès à l'interface utilisateur 
graphique à distance
Industrial HiVision vous offre la possibilité de vous connecter à distance 
depuis un autre ordinateur au serveur Industrial HiVision. 
 Désactivez l'accès à distance si vous souhaitez interdire l'accès à dis-

tance au serveur Industrial HiVision.
Voir “Accès Services” on page 391.

 Restreindre les droits d'accès au serveur Web
Industrial HiVision vous offre la possibilité d'accéder au serveur Web de 
Industrial HiVision à l'aide d'un navigateur via le protocole http ou https. 
Vous disposez ainsi d'une vue d'ensemble de votre réseau depuis le 
monde entier. 
 Pour améliorer la protection pour l'accès au serveur Web, vous 

octroyez des droits d'accès. 
Voir “User Management” on page 347.

 Désactivez le serveur Web si vous souhaitez interdire l'accès au ser-
veur Industrial HiVision via un navigateur.
Voir “Accès Services” on page 391.
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 Restreindre l'utilisation du serveur OPC
Industrial HiVision vous offre la possibilité d'activer/de désactiver le ser-
veur OPC ou d'activer/de désactiver l'écriture des valeurs d'objet dans 
Industrial HiVision par une commande d'écriture OPC. Dans l'état de 
livraison, les deux options sont désactivées. 
 Activez uniquement l'option dont vous avez réellement besoin.

Voir “Accès Services” on page 391.
 Désactivez la fonction dans le fichier « service.xml ».

Voir “Accès Services” on page 391.

3.1.4 Limitation de l'accès au fichier

Vous pouvez protéger votre système de gestion en limitant le nombre d'utili-
sateurs de Industrial HiVision ainsi que les autorisations d'utilisateurs. Pour 
refuser un accès utilisateur non autorisé, limitez l'accès au dossier Industrial 
HiVision « config », « var\script » et « var\report_files ».

Le dossier Industrial HiVision de config contient les fichiers relatifs à la 
sécurité usermanagement.xml et service.xml.

Industrial HiVision enregistre les fichiers script dans le dossier 
« var\script ». Si vous utilisez des scripts avec des mots de passe non 
cryptés, un utilisateur peut ouvrir le fichier script et voir les mots de passe. Le 
dossier « var\report_files » contient les résultats du script. Les résultats 
du script peuvent contenir également des mots de passe non cryptés.

Le chemin par défaut vers le dossier est « C:\Program 
Files\Hirschmann\Industrial HiVision <version number> ».

Commentaire : Le dossier Industrial HiVision de config ne contient le fichier 
usermanagement.xml qu'après ajout d'utilisateurs dans la boîte de dialogue 
Configuration > Preferences > User Management.
User Manual Industrial HiVision
Release 8.1 12/19 61



Préparation 3.2 Le logiciel et son environnement
3.2 Le logiciel et son 
environnement

Industrial HiVision nécessite l'accès aux équipements à surveiller. Pour cette 
raison, respectez les indications suivantes :

 Votre station d'administration de réseau possède les droits d'accès à 
chaque équipement à surveiller. C'est le cas lorsque l'adresse IP de votre 
station d'administration réseau figure dans l'équipement à surveiller en 
tant qu'adresse IP disposant d'un droit d'accès.
Les équipements avec une adresse IP ont accès aux équipements 
Hirschmann dont la configuration est identique à celle de l'état de livrai-
son.

 votre station d'administration de réseau est physiquement reliée à chaque 
équipement à surveiller soit directement soit indirectement via des 
concentrateurs, commutateurs ou routeurs.
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3.3 Structure de réseau

Les grands réseaux de données disposent de structures de réseaux hiérar-
chiques. Industrial HiVision est modulable et s'adapte à la structure de 
réseau hiérarchique. 
L'adaptation à la structure de réseau hiérarchique signifie que vous pouvez 
créer une station d'administration réseau pour chaque sous-domaine de 
votre réseau de données (voir la figure 65 “Domaines”).

3.3.1 Avantages de la structure de réseau 
hiérarchique

Cet ajustage automatique a pour vous les avantages suivants :
 Répartition de charge

Dans les réseaux de données très étendus très surveillés, vous atteindrez 
vite les limites des ressources de votre système (voir page “Impact sur les 
ressources du système” on page 236). En utilisant plusieurs stations 
d'administration de réseau, vous pouvez limiter la sollicitation du réseau 
de données et de la station d'administration du réseau aux limites des 
domaines. Ceci augmente sensiblement les capacités.

 Petits projets
Les petits projets facilitent la vision d'ensemble.

 Structure organisationnelle
L'ajustage de vos projets d'administration de réseau à votre structure 
organisationnelle vous permet de créer et de copier individuellement des 
projets adaptés.

 Administration centralisée des licences de Industrial HiVision
 Affichage concentré des états des sous-domaines
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3.3.2 Exemple d'application

L'illustration suivante présente un exemple d'application pour une structure 
de réseau hiérarchique.
Le réseau se compose du domaine IT, avec les sous-domaines A1, A11 et 
B1.
La station d'administration réseau informatique se trouve dans le réseau 
informatique.
La station d'administration réseau A1 se trouve dans le réseau de production 
1.
La station d'administration réseau A11 se trouve dans le sous-réseau de pro-
duction 11. Dans ce cas, la station d'administration réseau A1 est le super-
domaine du domaine A11.
La station d'administration réseau B1 se trouve dans le réseau de distribution 
1.
Les domaines A1 et B1 sont les sous-domaines du domaine IT.
Industrial HiVision autorise une profondeur d'imbrication de 4 niveaux et 
5 sous-domaines par domaine.
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Figure 5 : Domaines

IT

A1

B1

A11
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3.3.3 Configuration de l'exemple d'application

La configuration des stations d'administration de réseau positionnées hiérar-
chiquement comprend les étapes suivantes :
 Autorisation de sous-domaines
 Liaison de sous-domaines à des super-domaines
 Octroi de licences de haut en bas

 Autorisation de sous-domaines
Procédez tout d'abord du bas vers le haut dans les niveaux de hiérarchie. 
Dans Industrial HiVision, validez l'interface de sous-domaine et l'accès
pour les super-domaines au niveau supérieur suivant.
Les instructions suivantes décrivent le processus à suivre pour le sous-
domaine A11.
 Dans l'arborescence «Preferences», cliquez sur la boîte de dialogue 

Advanced > Services Access.
 Pour autoriser l'accès à distance, cochez la case Project Data 

Server > Remote Access.
 Pour autoriser l'interface des sous-domaines, cochez la case Project 

Data Server > Subdomain interface.
 Sous Project Data Server > Password saisissez un mot de passe 

qui permet au super-domaine d'accéder à ce sous-domaine.
Exigences relatives au mot de passe : 8 à 16 caractères.

 Répétez la procédure pour les sous-domaines A1 et B1.

 Liaison de sous-domaines à des super-domaines
 Pour relier le sous-domaine A11 au super-domaine A1, ouvrez le 

super-domaine A1 avec File > New > Subdomain la boîte de dialogue 
«Add New Subdomain».

 Saisissez l'adresse IP du sous-domaine.
 Saisissez un nom de sous-domaine qui sera repris par Industrial 

HiVision dans le cadre de dossiers.
 Entrez le mot de passe de sous-domaine qui permet au superdomaine
 d'accéder au sous-domaine et répétez le mot de passe.

Industrial HiVision affiche le sous-domaine dans la partie supérieure
du cadre de dossiers.

 Procédez de la même manière pour le super-domaine IT avec les
 super-domaines A1 et B1.
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Vous pouvez effacer les sous-domaines du cadre de dossiers en sélec-
tionnant le sous-domaine et en appuyant sur la touche « Del. ».

 Octroi de licences de haut en bas
Allouez maintenant les noeuds sous licence Industrial HiVision dans les 
niveaux de hiérarchie de haut en bas.

Commentaire : Un super-domaine requiert une licence propre séparée. 
Vous ne pouvez pas utiliser la licence 16 nœuds gratuite pour le super-
domaine.

 Entrez votre clé de licence dans le super-domaine IT (voir 
page “License” on page 367).

 Afin d'allouer des licences au sous-domaine A1, cliquez avec le bou-
ton droit de la souris sur le sous-domaine A1 dans le cadre de dossiers 
du superdomaine IT.
Dans la boîte de dialogue «Lease license nodes» , saisissez le 
nombre de noeuds sous licence que vous allouez au sous-domaine 
A1.
Le nombre de noeuds sous licence pour le sous-domaine A1 contient 
le nombre de noeuds sous licence que vous allouerez, lors de la pro-
chaine étape, du super-domaine A1 au sous-domaine A11.

 Afin d'allouer des licences au sous-domaine A11, cliquez avec le bou-
ton droit de la souris sur le sous-domaine A11 dans le cadre de dos-
siers du superdomaine A1.
Dans la boîte de dialogue «Lease license nodes» , le nombre de 
noeuds sous licence que vous allouez au sous-domaine A11.
Le superdomaine A1 requiert une licence propre pour octroyer des 
licences aux sous-domaines.

Sinon, Industrial HiVision vous offre la possibilité de saisir des clés de 
licence directement dans le sous-domaire.

Commentaire : Un sous-domaine maintient la validité de ses licences 
octroyées par le biais d'une communication cyclique avec le superdo-
maine. Si cette communication s'interrompt pendant plus d'une heure, la 
validité des licences octroyées au sous-domaine expire. Les licences 
expirées sont à nouveau disponibles dans le superdomaine.
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Vous trouverez un aperçu des licences allouées aux sous-domaines dans 
la boîte de dialogue Basics > License dans les options de configuration 
(voir page “License” on page 367).

3.3.4 Indication d'état des sous-domaines

Vos super-domaines détermine l'état de vos sous-domaines et représente 
cet état par des couleurs.

Couleur Signification
Gris foncé Sous-domaine inaccessible
Gris Échec de détermination de l'état
Vert configurable dans les préréglages OK
Jaune configurable dans les préréglages Avertissement
Rouge configurable dans les préréglages Erreur

Tableau 1 : Signification des couleurs des états des sous-domaines
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3.4 Préréglage du logiciel

Afin de prendre en compte l'individualité de chaque utilisateur, Industrial 
HiVision offre la possibilité de définir les options de présentation, fonctions et 
détection d'équipements.

 Paramètres IP
Entrez les paramètres IP de votre station d'administration de réseau sous 
Configuration > Preferences > Advanced > Management Station (voir 
page “Management Station” on page 398).

 Accès aux équipements
Industrial HiVision reconnaît automatiquement les options standard des 
équipements Hirschmann pour l'accès SNMP. 
Si pour des raisons de sécurité, vous avez déjà modifié les paramètres 
SNMP des équipements à surveiller, entrez le nom d'utilisateur et les 
mots de passe sous Configuration > Preferences > Advanced > 
Device Credentials (voir page “Accès Services” on page 391).
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 Reconnaissance des équipements
Industrial HiVision offre trois possibilités de détecter les équipements rac-
cordés au réseau
 traps SNMP: reconnaissance des équipements grâce aux messages 

d'alarmes (traps) envoyés par eux. Vérifiez que votre station d'admi-
nistration de réseau a bien été saisie comme adresse de destination 
d'alarme dans chaque équipement à surveiller (voir page “Adresse de 
destination d'alarme” on page 222). 

 HiDiscovery: Reconnaissance des équipements par interrogation à 
l'aide du protocole HiDiscovery. Sélectionnez la carte interface de 
réseau correspondante de la station d'administration réseau (voir 
page “Management Station” on page 398).
À l'état de livraison, le protocole HiDiscovery est activé sur un nouvel 
équipement de Hirschmann.

 Reconnaissance des équipements par interrogation IP d'une plage 
d'adresses IP (voir page “Reconnaissance des équipements” on 
page 134).

Sélectionnez la méthode privilégiée pour la reconnaissance des équipe-
ments sous Configuration > Preferences > Basics > Discover 
Devices (voir page “Basics” on page 341).

 Licence
Afin de pouvoir utiliser l'éventail complet des fonctions d'Industrial 
HiVision, entrez votre clé de licence sous Configuration > 
Preferences > Basics > License (voir page “License” on page 367).
Après une réinstallation ou une mise à jour, Industrial HiVision démarre 
avec la pleine disponibilité des fonctions pendant les 30 jours de la 
période d'évaluation gratuite.
Après écoulement des 30 jours de la période d'évaluation, Industrial 
HiVision fonctionne en version gratuite (voir page “Passage à la version 
gratuite” on page 276). 
Dès que vous avez entré une clé de licence, Industrial HiVision fonctionne 
en version sous licence.
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 Taille de la police
En fonction du réglage de votre résolution d'écran, les textes peuvent 
s'afficher en trop petit caractère ou seulement en partie. Vous pouvez 
adapter la taille de la police sous Configuration > Preferences > 
Display > Device, Configuration > Preferences > Display > Device 
Appearance (voir “Appearance” on page 382 et “Device” on page 379).

 Couleurs
L'effet de signal optimal de la représentation dépend de la perception 
chromatique de votre équipement. Sélectionnez votre apparence de cou-
leurs sous Configuration > Preferences > Display > Status Colors 
(voir page “Status Colors” on page 384). 

 Noms d'équipements et de ports
Industrial HiVision vous offre la possibilité d'attribuer à un équipe-
ment/port le nom sous lequel il apparaît dans l'interface. Sélectionnez les 
noms d'équipements et de ports sous Configuration > Preferences > 
Advanced > Device/Port Names (voir page “Device/Port Names” on 
page 408). 

 Icônes standard d'équipements
Industrial HiVision vous offre la possibilité d'assigner des icônes standard 
aux différents types d'équipement. Sélectionnez des icônes d'équipe-
ments sous Configuration > Preferences > Display > Device Icon 
(voir page “Device Icon” on page 385).
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3.5 Utilisation Industrial HiVision 
avec pare-feu

Industrial HiVision est un système de gestion qui vous permet d'établir une 
connexion entre plusieurs clients et les services Industrial HiVision. Vous 
pouvez installer la station d'administration qui met à disposition les services 
de Industrial HiVision dans le même réseau que celui des clients ou dans un 
réseau à distance. Vous pouvez séparer les réseaux par un pare-feu. Si un 
pare-feu sépare les services de Industrial HiVision des clients, ajoutez des 
règles au pare-feu pour transmettre les données requises du service de 
Industrial HiVision.

Commentaire : Limitez l'accès au «Project Data Server» à des utilisateurs 
locaux. Pour limiter l'accès au «Project Data Server», désactivez la fonction 
«Remote Access».

La liste suivante répertorie les différents types de clients :
 Interface utilisateur graphique (GUI) de l'application

Le client Interface utilisateur graphique de l'application établit une 
connexion avec les services de Industrial HiVision via le fichier exécu-
table Industrial HiVision.

 Client des superdomaines deIndustrial HiVision
Ce client est le service de Industrial HiVision permettant d'ajouter un 
sous-domaine de Industrial HiVision.
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Commentaire : Activez le «Subdomain interface» et déterminez le mot 
de passe dans le sous-domaine de Industrial HiVision.

 Interface utilisateur graphique web
Le client Interface utilisateur graphique web est disponible via n'importe 
quel navigateur web.
Pour accéder aux services de Industrial HiVision via un navigateur web, 
entrez l'adresse IP de la station d'administration et le numéro de «Port». 
Exemple : 
https://[IP address of the network management station]:11165

Commentaire : À propos de la sécurité :
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Un pirate peut leurrer l'interface utilisateur graphique web, également 
connue comme client navigateur, de Industrial HiVision, et obtenir ainsi un 
accès non autorisé au serveur noyau/web de Industrial HiVision. Pour contri-
buer à protéger votre réseau de toute attaque, assurez-vous que chaque uti-
lisateur devant accéder dispose des données correctes d'identification. 
Limitez le nombre d'administrateurs et d'utilisateurs (voir page 347 “User 
Management”).

 Interface utilisateur graphique HTML
Le client Interface utilisateur graphique HTML est disponible via n'importe 
quel navigateur web.
Pour accéder à l'index deIndustrial HiVision via un navigateur web, entrez 
l'adresse IP de la station d'administration, le numéro de «Port» et idx. 
Exemple :
https://[IP address of the network management 
station]:11187/idx
Pour accéder aux événements de Industrial HiVision via un navigateur 
web, entrez l'adresse IP de la station d'administration, le numéro de 
«Port» et « events ». Exemple :
https://[IP address of the network management 
station]:11187/events

 Interface utilisateur graphique (GUI) HiMobile
L'interface utilisateur Industrial HiVision de HiMobile met à disposition des 
services pour des équipements mobiles.

 OPC UA HTTP/HTTPS
Vous pouvez configurer n'importe quel client OPC-UA approprié pour 
accéder via le port correspondant au serveur OPC UA de Industrial 
HiVision.

Activez le service dans Industrial HiVision pour les entrées marquées d'un 
« X ». Pour transmettre les données de port, ajoutez une règle au pare-feu. 
Pour activer le service, cochez la case pour le service correspondant dans la 
boîte de dialogue Preferences > Advanced > Services Access.

Commentaire : Pour les entrées du «Project Data Server», vérifiez si le ser-
vice de Industrial HiVision est exécuté et s'il est possible d'y accéder (voir 
page 391 “Accès Services”).
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Type de 
service/clientIndustrial 
HiVision

Serveur Web Serveur don-
nées de projet 

Serveur OPC-
UA (HTTP)

Serveur OPC-
UA (HTTPS)

Ports utilisés pour établis-
sement de connexion avec 
les services

11187
(Configurable)

11188 11189 11190

Interface utilisateur gra-
phique (GUI) de l'applica-
tion

– X – –

Client des superdomaines 
deIndustrial HiVision

– X – –

Interface utilisateur gra-
phique web

X X – –

Interface utilisateur gra-
phique HTML

X – – –

Interface utilisateur gra-
phique (GUI) HiMobile

X – – –

OPC UA HTTP – – X –
OPC UA HTTPS – – – X

Tableau 2 : Réglages client/service
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3.6 Empreinte digitale vérifiée

Sécurisez l'accès physique à l'hôte de noyau contre tout accès non autorisé 
comme décrit en “Protection physique” on page 52. Le client distant de 
l'interface utilisateur graphique doit être protégé contre une connexion avec 
un hôte de noyau frauduleux. Utilisez la fonction de vérification de 
l'empreinte digitale pour garantir que le client distant de l'interface utilisateur 
graphique se connecte avec le serveur correct de l'hôte de noyau.

Lors de l'installation initiale, Industrial HiVision établit un certificat et l'enre-
gistre dans la mémoire des clés. À partir du certificat, Industrial HiVision 
génère une empreinte digitale SHA-256. L'empreinte digitale utilisée pour la 
vérification est unique pour chaque application de Industrial HiVision. 

Vous trouvez l'empreinte digitale dans le champ de texte Help > About > 
Fingerprint > SHA-256 Fingerprint. La boîte de dialogue «Fingerprint» 
montre en outre des informations relatives au certificat. Notamment qui a 
établi le certificat, les dates de création et d'expiration.

Commentaire : Les stations d'administration dans les sous-domaines 
acceptent l'empreinte digitale de l'hôte de noyau sans notification.

Pour garantir que le client distant de l'interface utilisateur graphique se 
connecte au serveur correct d'hôte de noyau, procédez comme suit :
 L'utilisateur distant requiert de l'administrateur l'empreinte digitale du ser-

veur d'hôte de noyau. Pour trouver et envoyer l'empreinte digitale, l'admi-
nistrateur procède comme suit :
– Ouvrez l'onglet Help > About > Fingerprint.
– Copiez l'empreinte digitale du champ «SHA-256 Fingerprint».
– Insérez l'empreinte digitale dans un fichier texte.
– Envoyez le fichier texte à l'utilisateur distant par le biais d'un canal de 

communication sécurisé.
76
User Manual Industrial HiVision

Release 8.1 12/19



Préparation 3.6 Empreinte digitale vérifiée
Figure 6 : Onglet Help > About > Fingerprint

 Pour garantir que le client distant de l'interface utilisateur graphique se 
connecte au serveur correct de l'hôte de noyau, procédez comme suit :
– Cliquez sur l'option «File» dans la barre d'outils.
– Dans la liste déroulante de, sélectionnez la propriété «Login».
– Dans la boîte de dialogue «Enter Server», entrez l'adresse IP du ser-

veur contenant l'hôte de noyau.
– Cliquez sur le bouton «OK».
Industrial HiVision ouvre la boîte de dialogue «Confirm Server Certificate 
for Industrial HiVision Server».
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Commentaire : Si l'hôte de noyau et le client distant de l'interface utilisateur 
graphique se trouvent dans le même réseau privé, laissez le champ de texte 
vide. Au choix, cliquez sur le bouton «Accept» ou «Accept Permanently».

 Dans le champ de texte «Fingerprint to verify», entrez l'empreinte digitale 
reçue de l'administrateur.
– Si les empreintes digitales ne coïncident pas, le champ de texte 

affiche des lettres en rouge. La boîte de dialogue affiche en outre le 
message «The fingerprints do not match». Cliquez sur le bouton 
«Cancel» et contactez votre administrateur.

– Si les empreintes digitales coïncident, les boutons «Accept» et 
«Accept Permanently» sont activés. La boîte de dialogue affiche en 
outre le message «The fingerprint matches this server's fingerprint».

– Si vous cliquez sur le bouton «Accept», le client distant de l'interface 
utilisateur graphique se connecte à l'hôte de noyau. Si la connexion 
avec le serveur est interrompue, Industrial HiVision requiert une nou-
velle identification de l'empreinte digitale pour rétablir la connexion.

– Si vous cliquez sur le bouton «Accept Permanently», Industrial 
HiVision enregistre l'empreinte digitale avec l'adresse IP correspon-
dante. Si la connexion est interrompue, Industrial HiVision rétablit la 
connexion sans vérification d'empreinte digitale.

Commentaire : Si l'empreinte digitale est acceptée, Industrial HiVision écrit 
une entrée dans le fichier journal.
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Figure 7 : Boîte de dialogue «Confirm Server Certificate for Industrial HiVision Ser-
ver»

Industrial HiVision vous donne la possibilité de connecter le client distant de 
l'interface utilisateur graphique avec différents serveurs hôtes de noyau. Si 
l'empreinte digitale a changé pour un serveur fiable jusqu'à présent ou que 
le serveur n'est désormais plus fiable, « censurez » le certificat.

Industrial HiVision vous permet de censurer un certificat sur l'hôte de noyau 
ou le client distant de l'interface utilisateur graphique. 
 Si vous supprimez le fichier « corbas.jks » sur le serveur hôte de noyau 

et réinitialisez, Industrial HiVision crée un nouveau fichier « corbas.jks » 
contenant un nouveau certificat. Chaque client distant de l'interface utili-
sateur graphique doit accepter l'empreinte digitale du nouveau certificat.

 Si vous supprimez le fichier « corbas.jks » sur le client distant de l'inter-
face utilisateur graphique, supprimez les empreintes digitales de chaque 
serveur fiable. Après avoir redémarré Industrial HiVision, Industrial 
HiVision crée un nouveau fichier « corbas.jks ». Pour recréer le fichier 
« corbas.jks », acceptez de nouveau les empreintes digitales des ser-
veurs fiables.
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Pour censurer un serveur soit sur l'hôte de noyau soit sur le client distant de 
l'interface utilisateur graphique, procédez comme suit :
 Assurez-vous de disposer des droits d'administrateur.
 Accédez au dossier « config » dans le répertoire d'installation.
 Supprimez le fichier « corbas.jks » dans la mémoire des clés.
 Redémarrez le logiciel Industrial HiVision.

Pour rétablir le fichier « corbas.jks » sur le client distant de l'interface utilisa-
teur graphique, réalisez les étapes suivantes pour chaque serveur hôte de 
noyau :
 Reconnectez-vous à un serveur hôte de noyau.
 Assurez-vous que l'empreinte digitale affichée dans la boîte de dialogue 

correspond à l'empreinte digitale que vous avez reçue de l'administrateur.
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4 Interface du logiciel

Ce chapitre décrit la structure de l'interface du logiciel. Vous obtenez ici un 
aperçu qui vous familiarise avec l'interface graphique. Vous trouverez une 
description détaillée dans le chapitre “Références” on page 265.

Vous n'avez pas besoin d'être un expert en réseaux pour utiliser Industrial 
HiVision. L'interface très intuitive vous permet d'exécuter le programme aisé-
ment. Elle comprend les éléments d'interface utilisateur standard de sorte 
qu'il est possible de démarrer après une brève initiation.
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4.1 Fenêtre principale de 
Industrial HiVision

Après le démarrage de Industrial HiVision, la fenêtre principale s'affiche à 
l'écran. Elle se compose des éléments suivants :

 Barre de menus
 Barre d'outils
 Ligne d'évènements
 Cadre Folders [Répertoires]
 Champ de navigation
 Affichage détaillé
 Liste d'évènements

Si vous maintenez le pointeur de souris sur une position d'affichage dans 
Industrial HiVision, une fenêtre d'information s'ouvre avec un court texte 
d'aide.

La liste des événements de Industrial HiVision affiche l'heure synchronisée 
à l'heure réelle de l'ordinateur. Industrial HiVision actualise cette heure 
toutes les secondes.
Si l'heure affichée coïncide avec l'heure système de l'ordinateur, vous pou-
vez partir du principe que le contenu affiché de Industrial HiVision est à jour.
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Figure 8 : Fenêtre principale
1 - Menu bar [Barre de menus]
2 - Tool bar [Barre d'outils]
3 - Event line [Barre d'évènements]
4 - Folder frame [Cadre Dossiers]
5 - Navigation field [Champ de navigation]
6 - Detail display [Affichage détaillé]
7 - Event list [Liste d'évènements]
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4.2 Barre de menus

La barre de menus se trouve dans la partie supérieure de la fenêtre princi-
pale du programme. Elle vous guide lorsque vous exécutez des importations, 
des exportations et des créations de nouveaux projets, des copies, des 
insertions et des suppressions de données ainsi que des modifications de 
l'affichage et de la configuration. En outre, vous disposez d'un menu d'aide. 
Voir “Fenêtre principale de Industrial HiVision” on page 82.

La barre de menus contient les éléments suivants de sélection :
 «File»
 «Edit»
 «View»
 «Configuration»
 «Tools»
 «Help»
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4.2.1 File

L'option de menu «File» dans la barre de menus contient les champs sui-
vants de sélection :

 «New Project»
 «Run Setup Wizard»
 «New»
 «Login»
 «Logout»
 «Open...» (Ctrl+O)
 «Save» (Ctrl+S)
 «Save as...»
 «Save Backup»
 «Load Backup»
 «Export...»
 «Export Events...»
 «Print» (Ctrl+P)
 «Print Events»
 «Exit and Stop Service»
 «Exit» (Ctrl+Q)

Les combinaisons de touches indiquées entre parenthèses vous offrent la 
possibilité de démarrer les éléments de sélection sans utiliser la souris.

Figure 9 : Barre de menus – Fichier
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4.2.2 Edit

L'option de menu «Edit» dans la barre de menus contient les champs sui-
vants de sélection :

 «Undo» (Ctrl+Z)
 «Redo» (Ctrl+Y)
 «Edit Mode»
 Passage à la version gratuite (disponible pendant la période d'essai de 

30 jours)
 «Cut» (Ctrl+X)
 «Copy» (Ctrl+C)
 «Paste» (Ctrl+V)
 «Paste As Link»
 «Delete» (Del)
 «Rename» (F2)
 «Select All» (Ctrl+A)
 «Acknowledge Status Change»
 «Manage»
 «Unmanage»
 «Set Device and Port Names»
 «Set Default Device Icon»
 «Device Documentation»
 «Drawing Size»
 «Background Image»
 «Find...» (Ctrl+F)
 «Auto Topology...»
 «Auto Layout»
 «Properties...» (Alt+Entrée)

Les combinaisons de touches indiquées entre parenthèses vous offrent la 
possibilité de démarrer les éléments de sélection sans utiliser la souris.
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Figure 10 :Barre de menus – Édition

4.2.3 View

L'option de menu «View» dans la barre de menus contient les champs sui-
vants de sélection :
 «Select VLAN»
 «Refresh VLANs»
 «Protocol Statistics»
 «Filter Events for Object»
 «Back»
 «Forward»
 «Up»
 «Home View»
 «Set Home View Settings»
 «Geographical Location View»
 «Zoom»
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Figure 11 :Barre de menus – Affichage

4.2.4 Configuration

L'option de menu «Configuration» dans la barre de menus contient les 
champs suivants de sélection :

 «Moniteur»
Cette boîte de dialogue vous offre un aperçu des options pour les compo-
sants surveillés (voir page “Monitor” on page 321).

 «PSM Manager»
Les modules produit spécifiques (PSM) définissent les propriétés d'un 
équipement, que Industrial HiVision peut lire pour la surveillance ou écrire 
pour la configuration.
Le manager PSM vous offre la possibilité de recharger les PSM ou 
d'importer d'autres PSM que ceux disponibles dans l'état de livraison et 
de les supprimer.
Voir “PSM Manager [Manager PSM]” on page 323.
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 «Reporting»
La fonction Rapports vous permet de gérer des statistiques à long terme, 
hors de la base de données du logiciel du système d'administration de 
réseau.
Voir “Rapports” on page 230.

 «Planificateur de tâches»
La planification vous offre la possibilité de programmer Industrial HiVision 
de sorte qu'il accomplisse automatiquement des tâches répétitives.
Voir “Scheduling” on page 326.

 «Preferences» (Ctrl+E)
Cette sélection vous permet d'entrer les paramètres de configuration pour 
Industrial HiVision (voir page “User Management” on page 347).

 «Changement Mot de passe...»

 «Status Configuration»
Cette boîte de dialogue vous offre la possibilité d'exécuter la configuration 
de l'état des détails de composants des équipements d'une catégorie 
d'équipements ou de l'ensemble des équipements.

 «Scan Ranges»
Cette boîte de dialogue vous offre la possibilité de saisir les plages de 
scan pour la découverte des équipements.

 «User defined Properties»:
Industrial HiVision vous propose, à l'aide de la fonction «User defined 
Properties», d'intégrer dans la gestion d'autres propriétés d'équipements 
compatibles SNMP, extraites de leur MIB.

 MultiConfig™
La fonction de configuration multiple (MultiConfig™) vous offre la possibi-
lité d'effectuer des configurations sur l'équipement et dans Industrial 
HiVision pour : 
– un ou plusieurs équipements
– une ou plusieurs propriétés d'équipement, y compris de l'ensemble 

des équipements
– un ou plusieurs détails d'équipement, y compris de l'ensemble des 

équipements

 «MAC/IP List»
Liste des IP/MAC des équipements détectés.

 «Refresh» (F5)
L'option «Refresh» vous permet de mettre à jour des propriétés ou des 
appareils sélectionnés.
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 «IP Configuration»
Cette boîte de dialogue vous offre la possibilité de configurer les para-
mètres IP d'un équipement reconnu par HiDiscovery sans adresse IP ou 
de modifier des paramètres IP déjà configurés.

 «Trap Destination»
À l'ouverture de la boîte de dialogue, Industrial HiVision interroge les 
paramètres d'alarme de l'équipement et indique si celui-ci envoie des 
alarmes à l'adresse IP affichée.

Les combinaisons de touches indiquées entre parenthèses vous offrent la 
possibilité de démarrer les éléments de sélection sans utiliser la souris.

Figure 12 :Barre de menus – Configuration
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4.2.5 Tools

L'option de menu «Tools» dans la barre de menus contient les champs sui-
vants de sélection :

 «Dashboard»
 «Interface Web»
 «Configuration équipement»
 «CLI»
 «Actions»
 «Navigateur SNMP»
 «Ping»
 «Scan HiDiscovery»
 «Scan réseau»
 «Réseau de démo»
 «Calcul disponibilité»

Les options de menu grisées s'activent en sélectionnant un équipement ou 
une propriété qui prend en charge cette fonction.

Figure 13 :Barre de menus – Outils
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4.2.6 Help

L'option de menu «Help» dans la barre de menus contient les champs sui-
vants de sélection :

 «Online Help», (F1)
 «Readme»
 «Release Notes»
 «Tutorial»
 «Online»
 «Kernel Info»
 «About»

Utilisez la touche F1 pour lancer l'aide en ligne sans utiliser la souris.

 Online Help, (F1)
Cette sélection lance l'aide en ligne du logiciel.

 About
La sélection de ce champ ouvre une fenêtre contenant des informations 
relatives au logiciel.

Figure 14 :Barre de menus – Aide
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4.3 Barre d'outils

La barre d'outils offre un accès rapide à des fonctions fréquemment utilisées 
en cliquant sur la touche de fonction correspondante. Voir “Fenêtre princi-
pale de Industrial HiVision” on page 82.
La barre d'outils contient les champs de sélection suivants :

 «Back»
 «Forward»
 «Up»
 «Home View»
 «Undo»
 «Find»
 «Edit Mode»
 «Properties»
 «WWW»
 «Scan Network»
 «HiDiscovery Scan»
 «Preferences»

Lorsqu'un champ de sélection est grisé, aucune action n'est momentané-
ment possible. Ceci peut être le cas si vous souhaitez utiliser «Up» et que 
vous avez déjà atteint le niveau le plus élevé.
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4.3.1 Edit Mode

Industrial HiVision propose deux modes de fonctionnement. Appuyez sur le 
bouton «Edit Mode» pour basculer entre les deux modes de fonctionnement. 
Vous pouvez protéger par mot de passe le bouton «Edit Mode». Vous pou-
vez utiliser le mot de passe «Edit Mode» ou le mot de passe des administra-
teurs actifs pour protéger le bouton «Edit Mode» par mot de passe.

La durée de déroulement est une autre possibilité de restreindre l'accès au 
«Edit Mode». Vous pouvez définir ici combien de temps le mode d'édition 
peut rester actif (voir page 389 “Avancé”).

 «Edit Mode»
Le «Edit Mode» est le mode administratif. Assurez-vous que vous avez 
spécifié au moins 1 utilisateur avec accès administrateur. Pour spécifier 
un utilisateur en tant qu'administrateur, cochez les cases «Login», «Edit 
Mode», «User Management» et «Web Access» dans la boîte de dialogue 
«User Management». Voir “User Management” on page 347.

La liste suivante contient certains des paramètres que vous pouvez confi-
gurer dans le «Edit Mode» :
– affichage réseau dans l'interface utilisateur graphique
– paramètres de surveillance
– configurer les paramètres de sécurité
– copier un réseau pour réutilisation, Voir “Paste as new Network” on 

page 149.
– gestion des utilisateurs et rôles d'autorisation, Voir “User Manage-

ment” on page 347.
– ports de l'équipement de signalisation, Voir “Signalisation d'équipe-

ments et de ports” on page 310.
– configurer les paramètres de la vue Accueil, Voir “Set Home View Set-

tings” on page 319.
– planification de tâches, Voir “Scheduler” on page 329.
– connexion automatique de l'équipement, Voir “Web Interface” on 

page 451.
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– configurer la fonction «Dashboard», Voir “Dashboard” on page 433.
– fonctions listées dans la section mode exécution

 Mode exécution
Le mode exécution est utilisé uniquement pour surveiller le réseau. 
Lorsque vous spécifiez un rôle qui ne dispose que de l'autorisation de 
«Login», l'utilisateur ne peut utiliser Industrial HiVision qu'en mode exé-
cution. Voir “User Management” on page 347.

La liste suivante contient quelques-unes des fonctions que vous pouvez 
surveiller en mode exécution :
– ouvrir les différents onglets pour visualiser les statuts de réseau
– démarrer le «Dashboard» pour surveiller le réseau, Voir “Dashboard” 

on page 433.
– utiliser le bouton «Find» pour rechercher des équipements, 

Voir “Find...” on page 282.
– utiliser le bouton «Home View» pour revenir aux réglages de base, 

Voir “Home View” on page 318.
– utiliser les boutons de navigation «Forward», «Back» et «Up»
– se déconnecter de Industrial HiVision

Commentaire : Le mode exécution permet d'éviter une écriture involontaire 
dans les paramètres de Industrial HiVision. Le mode exécution sert exclusi-
vement à éviter des conflits lors de l'accès à la base de données. Par 
exemple, le «Edit Mode» ne permet qu'à 1 seul utilisateur à la fois de modifier 
les paramètres de Industrial HiVision. Le mode exécution n'est pas conçu 
pour protéger le système contre un accès non autorisé d'utilisateurs.
Pour éviter autant que possible un accès non autorisé d'utilisateurs, il est 
recommandé de recourir à la « Gestion des utilisateurs » avec autorisations 
des rôles d'accès.

 Exemple de configuration
Cet exemple décrit comment protéger par mot de passe le bouton «Edit 
Mode». Vous pouvez protéger par mot de passe le bouton «Edit Mode» 
avec un mot de passe «Edit Mode» ou avec «User Management». 
Lorsque vous protégez le bouton «Edit Mode» avec «User Manage-
ment», seuls les administrateurs actifs peuvent accéder au «Edit Mode» 
en utilisant leur mot de passe utilisateur 
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Pour protéger par mot de passe le bouton «Edit Mode» avec un mot de 
passe «Edit Mode», vérifiez que la fonction «User Management» est 
désactivée. Pour vérifier que la fonction «User Management» est désac-
tivée, procédez comme suit :
 Ouvrez la boîte de dialogue Preferences > Basics > User Manage-

ment
 Assurez-vous que la liste «Selected Order» est vide.

Pour protéger par mot de passe le bouton «Edit Mode» avec un mot de 
passe «Edit Mode», procédez comme suit :
 Assurez-vous que vous avez accès au «Edit Mode».
 Ouvrez la boîte de dialogue Preferences > Advanced > Program 

Access.
 Saisissez test1 comme mot de passe dans le champ Password for 

Edit Mode > Password.
 Vérifiez votre mot de passe dans le champ Password for Edit Mode > 

Retype Password.
 Cliquez sur le bouton «OK».
Le bouton «Edit Mode» est maintenant protégé par le mot de passe «Edit 
Mode». Pour vérifier le mot de passe, cliquez deux fois sur le bouton «Edit 
Mode». Pour accéder au «Edit Mode», vous devez maintenant entrer le 
mot de passe «Edit Mode».

La gestion des utilisateurs a priorité sur le mot de passe «Edit Mode». 
Lorsque la fonction de gestion des utilisateurs est active, le cadre «Edit 
Mode» est inactif. 

Pour protéger par mot de passe le bouton «Edit Mode» avec la fonction 
«User Management», procédez comme suit :
 Assurez-vous que vous avez accès au «Edit Mode».
 Ouvrez la boîte de dialogue Preferences > Basics > User Manage-

ment.
 Pour ajouter un nouveau rôle au cadre «Access Roles», cliquez sur le 

bouton «New».
 Dans le champ «Role Name», saisissez la valeur Admin.
 Pour attribuer au rôle Admin l'autorisation administrateur, cochez les 

cases «Login», «Edit Mode», «User Management» et «Web Access».
 Pour fermer la boîte de dialogue et ajouter le rôle à la liste «Access 

Roles», cliquez sur le bouton «OK».
 Pour attribuer à un utilisateur local le rôle Admin, cliquez sur le bouton 

Local Users > Edit.
 Dans la boîte de dialogue «Local Users Configuration», cliquez sur le 

bouton «New». La boîte de dialogue «New Entry» s'ouvre.
 Dans le champ «User Name», saisissez la valeur AdminUser.
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 Dans le champ «Password», saisissez la valeur test2.
 Vérifiez le mot de passe dans le champ «Confirm Password».
 Cochez la case Admin.
 Pour fermer la boîte de dialogue et ajouter l'utilisateur à la boîte de dia-

logue «New Entry», cliquez sur le bouton «OK».
 Pour fermer la boîte de dialogue «New Entry», cliquez sur le bouton 

«OK».
 Pour activer la stratégie «local», sélectionnez l'option «local» dans la 

liste «Selectable Policies».
 Cliquez sur le bouton flèche gauche . La stratégie «local» est 

déplacée vers la liste «Selected Order».
 Cliquez sur le bouton «OK».
Le bouton «Edit Mode» est maintenant protégé par le mot de passe 
AdminUser. Pour vérifier le mot de passe, cliquez deux fois sur le bouton 
«Edit Mode». Pour accéder au «Edit Mode», vous devez maintenant 
entrer le mot de passe AdminUser.

Commentaire : Lorsque vous protégez par mot de passe le bouton «Edit 
Mode» avec la fonction «User Management», le mot de passe «Edit 
Mode» est désactivé.
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4.3.2 Preferences

En sélectionnant l'outil «Preferences» dans la barre d'outils, une fenêtre 
s'ouvre avec les éléments de sélection suivants :

 «Basics»
appliquer «Basics»
– vous déterminez le mode de détection des équipements par Industrial 

HiVision,
– vous déterminez le mode de réaction de Industrial HiVision aux évé-

nements,
– vous saisissez les mots de passe d'accès aux équipements et
– gérez vos licences Industrial HiVision.

 «Display»
Le champ de sélection «Display» vous permet de déterminer le mode de 
présentation des événements, des équipements ou du texte. 
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4.4 Ligne d'évènements

La ligne d'événements vous renseigne sur les événements enregistrés dans 
le journal des événements qui n'ont pas encore été validés. Les événements 
survenus sont classés par catégorie en trois champs. En outre, vous obtenez 
des informations plus précises sur les événements, le services consigné et 
le moment de survenance des événements. (voir page 123 “Liste d'évène-
ments”)
Par exemple, en cas d'un événement de type Erreur, la ligne d'événements 
affiche les champs correspondants en couleur. Dans l'affichage détaillé, 
l'équipement concerné clignote en rouge et la ligne d'événements correspon-
dante dans la fenêtre d'événements est marquée en rouge.
L'élément de menu «Preferences» dans la barre d'outils permet à l'utilisateur 
d'adapter les réglages d'affichage par défaut en ce qui concerne la couleur 
et le clignotement. (voir page 93 “Barre d'outils”) 

Commentaire : À propos de la sécurité :
Un pirate peut leurrer le client navigateur, de Industrial HiVision et obtenir 
ainsi un accès non autorisé au serveur noyau/web de Industrial HiVision. Si 
vous supposez qu'une personne non autorisée a tenté d'accéder à Industrial 
HiVision, vérifiez les entrées du journal d'événements de l'ordinateur hôte.
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4.4.1 Nombre d'évènements

La ligne d'événement indique le nombre d'événements non acquittés dans 
les trois champs d'information derrière l'option «Events».
Industrial HiVision peut affecter un événement à l'un des trois types 
d'évaluation :

 Error [Erreur] : (icône rouge)
l'événement survenu est considéré comme une erreur grave.

 Warning [Avertissement] : (icône jaune)
l'événement survenu est une erreur susceptible de conduire à un pro-
blème indirect dans votre réseau.

 Info : (icône bleue)
l'événement survenu est considéré comme un état de fonctionnement 
normal.

Figure 15 :Ligne d'évènements - Évènements

À chaque nouvel événement survenu, Industrial HiVision le compteur ajoute 
une unité. Après validation d'un événement par l'utilisateur, Industrial 
HiVision décompte un unité sur le compteur.
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4.4.2 Type d'évènements

La ligne d'évènements comprend trois champs d'information après l'élément 
«Most Severe Recently».

Le premier évènement affiché est le plus récent et le plus important. Si 
seules des informations sont indiquées, la plus récente information relative à 
l'évènement correspondant s'affiche. S'il s'agit d'avertissements, l'avertisse-
ment le plus récent relatif à l'évènement correspondant s'affiche. S'il s'agit 
d'erreurs, l'erreur la plus récente relative à l'évènement correspondant 
s'affiche.

Figure 16 :Ligne d'évènements – Évènements– Dernier plus important

À chaque nouvel évènement s'affichent,

 dans le champ «Time», la date et l'heure
 dans le champ «Source», le service par lequel l'évènement a été consi-

gné
 dans le champ «Message», une description plus précise du type d'évène-

ment.

Vous trouverez une liste complète de tous les évènements dans “Liste d'évè-
nements” on page 123. Les données figurant dans la ligne d'évènements se 
retrouvent dans les colonnes de la zone des évènements.

Désignation Signification
Heure Date et heure de l'évènement
Source Service, par ex. serviceIndustrial HiVision
Message Catégorie d'évènement, par ex. « New device detected by 

ping » [Nouvel équipement détecté par ping]

Tableau 4 : Informations dans la barre d'évènements
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4.4.3 Valider les évènements

À l'aide du bouton «Acknowledge», vous acquittez l'évènement après en 
avoir pris connaissance. Une autre option consiste à valider via le champ 
«Ack.» dans la liste d'évènements.

Figure 17 :Ligne d'évènements – Évènements – Valider

Après validation, la ligne d'évènements (voir page 101 “Type d'évènements”) 
affiche le prochain évènement consigné dans le journal des événements. 
Vous trouverez une liste complète de tous les évènements dans (voir 
page 101 “Type d'évènements”). Ici, vous pouvez également, dans la 
colonne «Ack.» acquitter les évènements en question.

Le compteur correspondant décompte une unité après validation d'un évè-
nement par l'utilisateur. (voir page 100 “Nombre d'évènements”).

Dans la colonne «Ack.» de “Liste d'évènements” on page 123, un crochet 
vert s'affiche ou l'évènement est masqué en fonction des filtres d'évènement 
sélectionnés après l'acquittement.
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4.4.4 Propriétés d'un évènement

Un clic droit sur une ligne d'évènements puis la sélection de «Properties», 
vous ouvrent une fenêtre contenant des informations sur l'évènement actuel-
lement affiché. 

Figure 18 :Ligne d'évènements – Évènements – Propriétés
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4.5 Cadre Folders [Répertoires]

Dans le cadre Folders [Répertoires] de l'interface Industrial HiVision, vous 
pouvez vous déplacer comme dans les interfaces utilisateurs courantes. 
Voir “Fenêtre principale de Industrial HiVision” on page 82. Vous pouvez 
créer de nouveaux dossiers et parcourir l'arborescence de haut en bas et 
vice-versa à l'aide des touches de fonction «Back», «Forward» ou «Up» de 
la barre d'outils (voir page 93 “Barre d'outils”).

 «Back» : revient à la position antérieure
 «Forward»: avance vers la position suivante
 «Up» : niveau supérieur

Ces fonctions sont également disponibles via la barre de menus sous l'option 
«View» (voir page 87 “View”). 

Si vous avez divisé votre réseau en sous-domaines et configuré ceux-ci dans 
Industrial HiVision, (voir page 63 “Structure de réseau”), Industrial HiVision 
affiche la structure du domaine dans la partie du haut du cadre Folders 
[Répertoires].

Les répertoires et éléments répertoriés dans le cadre Folders [Répertoires] 
munis du signe « + » contiennent des éléments ou répertoires secondaires. 
Pour les afficher, cliquez sur le signe plus. Les éléments/répertoires secon-
daires sont munis d'un signe « - ».

Pour masquer à nouveau des éléments/répertoires secondaires, cliquez sur 
le signe moins.
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À l'état de livraison, Industrial HiVision met trois dossiers à votre disposition :

 «New Devices»
Dans ce dossier, Industrial HiVision affiche tous les nouveaux équipe-
ments reconnus. Il fait partie intégrante du logiciel et est protégé contre 
une suppression accidentelle. Industrial HiVision vous permet de renom-
mer le dossier.

 «Unused Devices»
Les équipements inclus dans ce dossier ne sont pas surveillés par 
Industrial HiVision. Ce dossier fait partie intégrante du logiciel et est pro-
tégé contre une suppression accidentelle. Industrial HiVision vous permet 
de renommer le dossier. Pour diminuer la charge réseau, vous pouvez 
faire glisser les équipements dont la surveillance n'est pas nécessaire 
dans ce dossier. Les équipements dans le dossier «Unused Devices» 
indiquent Industrial HiVision l'état d'équipement « Unmanage ». Pour sur-
veiller à nouveau un équipement, déplacer l'équipement dans le dossier 
souhaité.

 «My Network»
Industrial HiVision a créé ce dossier pour vous permettre de constituer un 
schéma de réseau personnalisé. Vous pouvez le renommer ou le suppri-
mer et en créer de nouveaux pour constituer votre schéma de réseau per-
sonnalisé.
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4.6 Champ de navigation

À l'aide du champ de navigation, vous pouvez vous déplacer aisément dans 
l'affichage de topologie (voir page 107 “Affichage détaillé”).
Cliquez sur le rectangle de navigation et tirez jusqu'à l'emplacement souhaité 
dans le champ de navigation. Votre position dans l'affichage détaillé se modi-
fie proportionnellement. Voir “Fenêtre principale de Industrial HiVision” on 
page 82.
Avec l'option de menu View > Zoom dans la barre de menus ou avec un clic 
droit dans le champ de navigation, vous ajustez l'agrandissement de l'affi-
chage dans le cadre de détails par pas de 10 %.
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4.7 Affichage détaillé

La zone de l'affichage détaillé de l'interface utilisateur Industrial HiVision 
vous offre une représentation claire de votre structure de réseau sous forme 
de schéma de topologie ou de liste. Voir “Fenêtre principale de Industrial 
HiVision” on page 82.

Industrial HiVision vous permet de déplacer des équipements, par glisser-
déposer, des onglets «Map», «List» et «Devices» vers d'autres dossiers de 
projets. Par exemple, après vérification de votre réseau, Industrial HiVision 
affiche un équipement dans le dossier «New Devices». Par glisser-déposer, 
vous pouvez déplacer l'équipement du dossier «New Devices» vers le dos-
sier «My Network». la fonction glisser-déposer vous permet de déplacer un 
ou plusieurs équipements simultanément-

Pour afficher uniquement les informations que vous considérez comme 
importantes dans un onglet de la vue détaillée, vous pouvez masquer les 
colonnes. Si vous masquez les colonnes, Industrial HiVision enregistre les 
noms des colonnes masquées en tant que paramètres utilisateur dans la 
base de données. Si vous exportez l'onglet ou imprimez l'onglet, seules les 
colonnes visibles sont exportées ou imprimées.

Commentaire : Les noms des colonnes masquées sont spécifiques à la 
langue. Si vous modifiez la langue de l'interface utilisateur, cela peut com-
promettre les colonnes masquées dans la base de données.

Pour afficher ou masquer des colonnes, procédez comme suit :
 Cliquez avec le bouton droit sur le titre de la colonne. Industrial HiVision 

affiche une liste déroulante contenant les noms des colonnes.
 Sélectionnez les noms des colonnes que vous souhaitez afficher dans 

l'onglet.
 Pour fermer le menu, déplacez le pointeur hors de la liste déroulante.

La liste déroulante dispose d'une option «Show all». Si vous sélectionnez 
cette option, l'onglet affiche chaque colonne.
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Lorsque vous êtes en mode «Module / Port», Industrial HiVision masque les 
colonnes «C0» à «C4» dans les préréglages de l'onglet «PoE». Industrial 
HiVision affiche chaque colonne dans les autres onglets. Pour afficher à nou-
veau les colonnes, ouvrez la liste déroulante et sélectionnez les colonnes 
que vous souhaitez afficher. En outre, la liste déroulante dans l'onglet 
«PoE»dispose d'une option «Show default». Cette option masque les 
colonnes «C0» à «C4».

Vous pouvez choisir entre les réglages utilisateur et les réglages «Show all» 
ou «Show default» : 
 Pour afficher toutes les colonnes, cliquez une fois sur l'option «Show all». 

Ne fermez pas la liste déroulante après avoir cliqué sur l'option «Show 
all».

 Cliquez sur l'option «Show all» une deuxième fois.

Le premier clic affiche les réglages «Show all». Le deuxième clic affiche 
les réglages enregistrés pour l'utilisateur.

Commentaire : Hormis dans les boîtes de dialogue de MultiConfig™, vous 
pouvez utiliser la fonction « Masquer les colonnes » dans toutes les boîtes 
de dialogue. Si vous configurez des équipements avec MultiConfig™, vous 
devez visualiser toutes les colonnes.

4.7.1 Map

Pour accéder à l'affichage topologie de l'affichage détaillé, cliquez sur 
l'onglet «Map» de l'affichage détaillé.
Les équipements et connexions intégrés dans la structure de réseau sont 
affichés conformément aux options d'affichage sélectionnées que vous avez 
sélectionnées dans l'affichage topologie. Sélectionnez les équipements et 
maintenez la touche de souris enfoncée pour les faire glisser.
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Figure 19 :Affichage détaillé de «Map»

Double-cliquez sur un équipement/composant pour atteindre un niveau infé-
rieur de l'affichage détaillé (voir la figure 47).
Le niveau inférieur est le niveau de détail des composants. Vous le recon-
naissez à l'icône en forme de diagramme.

Figure 20 :Icône diagramme pour un détail de composant

4.7.2 List

Pour accéder à l'affichage topologie de l'affichage détaillé, cliquez sur 
l'onglet «List» de l'affichage détaillé.
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Les équipements et connexions intégrés dans la structure de réseau sont 
affichés conformément aux options d'affichage que vous avez sélectionnées 
dans une liste.

Double-cliquez sur un équipement/composant pour atteindre un niveau infé-
rieur de l'affichage détaillé.

Figure 21 :Affichage détaillé de «List»
110
User Manual Industrial HiVision

Release 8.1 12/19



Interface du logiciel 4.7 Affichage détaillé
4.7.3 Devices

Pour accéder à l'affichage topologie de l'affichage détaillé, cliquez sur 
l'onglet «Devices» de l'affichage détaillé.
Industrial HiVision affiche les équipements du dossier sélectionné dans le 
cadre Folders [Dossiers] ainsi que ses sous-dossiers sous forme de liste. La 
liste répertorie pour chaque équipement :

Le choix d'une catégorie d'équipement vous permet de filtrer les équipe-
ments d'une catégorie et de les sélectionner simultanément. Avec la fonction 
MultiConfig™, vous pouvez configurer simultanément les équipements ainsi 
sélectionnés.

Nom Signification
Type Icône de l'équipement
Status Icône d'état de l'équipement
Name Nom que vous avez donné à l'équipement dans Industrial HiVision, 

sinon adresse IP de l'équipement
IP Address Adresse IP d'administration
MAC Address Adresse MAC d'administration
Product Nom de la famille de produits
Chassis Désignation produit
Serial Nr.. Numéro de série de l'équipement
System Name Nom du système des équipements MIB
Location Désignation du site que vous avez inscrit dans l'équipement
Contact Nom du contact que vous avez inscrit dans l'équipement
Firmware Version Version du firmware sur l'équipement
Chassis Name Nom de châssis d'un équipement ayant plusieurs agents d'administra-

tion
Configuration Signa-
ture

Les équipements compatibles avec cette fonction attribuent une signa-
ture à une configuration sauvegardée.

PSM up to date Cette colonne indique si les données lues par l'équipement corres-
pondent au module PSM (spécifique au produit) actuel dans Industrial 
HiVision. Si les données lues par l'équipement viennent d'une version 
antérieure de Industrial HiVision, les données sont relues par l'équipe-
ment Industrial HiVision lors du cycle de balayage suivant.

Revision«Ether-
Net/IP»

Si la propriété est présente dans l'équipement, la colonne contient le 
numéro de version de l'application Ethernet/IP.

Tableau 5 : Signification des colonnes dans l'affichage détaillé de l'onglet «Devices».
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Figure 22 :Affichage détaillé de «Devices»

 Support étendu d'Ethernet/IP
Sur les onglets «Devices» et «List», Industrial HiVision affiche des infor-
mations supplémentaires sur les équipements de votre réseau qui com-
muniquent via le protocole Ethernet/IP. Industrial HiVision affiche les 
équipements Ethernet/IP suivants :
 Commutateur
 PC
 Appareil Ping

L'onglet «List» contient un dossier «EtherNet/IP» pour les équipements 
Ethernet/IP. Si vous ouvrez ce dossier, Industrial HiVision affiche les 
informations suivantes :
 «Vendor ID»
 «Status»
 «State»
 «Serial Number»
 «Revision»
 «Product Name»
 «Product Code»
 «Device Type»

Si les colonnes de la liste suivante sont vides ou contiennent des valeurs 
par défaut, l'onglet «Devices» affecte les propriétés Ethernet/IP comme 
suit :
 Colonne «MAC Address»

Contient l'adresse MAC de l'équipement.
 Colonne «Chassis»

Contient le nom du produit de l'équipement Ethernet/IP.
 Colonne «Serial Nr.»

Contient le numéro de série de l'équipement Ethernet/IP.
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4.7.4 Ports

Pour accéder à l'affichage topologie de l'affichage détaillé, cliquez sur 
l'onglet «Ports» de l'affichage détaillé.
Industrial HiVision affiche les ports du dossier/de l'équipement sélectionné 
dans le cadre des dossiers ainsi que des sous-dossiers sous forme de liste, 
conformément aux options d'affichage que vous avez sélectionnées.

Nom Signification
Type Icône du port
Status Icône de l'état du port
Device Adresse IP de l'équipement auquel correspond le port
Port Numéro de port
Port Name Nom du port tel qu'il est sauvegardé dans l'équipement
Media Type Type de médium de transfert raccordé, par exemple cuivre
Autoneg État de la fonction d'autonégociation. Si cette fonction apparait grisée, 

ce port ne dispose pas de fonction d'autonégociation.
Link État de connexion de l'équipement raccordé à ce port
Port Enabled Réglage de port activé ou désactivé.
Speed/Duplex Vitesse et transmission duplex de la ligne raccordée au port
User Adresses MAC de l'équipement raccordé au port. La cellule montre le 

nombre des adresses MCA et multidiffusion raccordées au port.
Load Charge de réseau du flux de données entrant
SFP Power RX dBm Affiche la puissance de réception (puissance RX) de l'émetteur-récep-

teur SFP en dBm.
SFP Power TX dBm Affiche la puissance d'émission (puissance TX) de l'émetteur-récep-

teur SFP en dBm.
PVID Port VLAN ID du port. Un tiret indique l'absence de la fonction Port 

VLAN dans l'équipement.
Ingress État de la fonction de filtre d'entrée. Une icône grisée indique l'absence 

de la fonction de filtre d'entrée dans l'équipement.
VLANs Appartenance du port au VLAN.

Un chiffre indique l'ID VLAN, dont VLAN est le membre du port.
« U » signifie membre du VLAN, envoyer les paquets de données sans 
balise (Tag).
« T » signifie membre du VLAN, envoyer les paquets de données avec 
balise (Tag).

VLAN Consistency 
Check

PVID contenu dans VLAN

Tableau 6 : Signification des colonnes dans l'affichage détaillé des ports
User Manual Industrial HiVision
Release 8.1 12/19 113



Interface du logiciel 4.7 Affichage détaillé
Figure 23 :Affichage détaillé de «Ports»
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4.7.5 Connections

Pour accéder à l'affichage topologie de l'affichage détaillé, cliquez sur 
l'onglet «Connections» de l'affichage détaillé.
Industrial HiVision affiche les connexions du dossier sélectionné dans le 
cadre Folders [Dossiers] ainsi que ses sous-dossiers sous forme de liste. La 
liste affiche les informations suivantes pour chaque lien :

Nom Signification
Status Icône d'état de connexion suivant les réglages de surveillance
Name Nom de la connexion, nom sais soi-même pour la connexion ou 

adresse IP/numéro de port des équipements raccordés
Connection Etat de la connexion (active, inactive)
Device A Nom/adresse IP de l'équipement A avec lequel la connexion est éta-

blie
Port A Numéro du port de l'équipement A avec lequel la connexion est établie
Device B Nom/Adresse IP de l'équipement B avec lequel la connexion est éta-

blie
Port B Numéro du port de l'équipement B avec lequel la connexion est établie
Load A-B Charge de réseau du volume de données de l'équipement A vers 

l'équipement B
Load B-A Charge de réseau du volume de données de l'équipement B vers 

l'équipement A
Speed/Duplex Vitesse et transmission duplex de la connexion
Media Type Type de médium de transfert de la connexion, par exemple cuivre
Link Changed Date du dernier changement d'état de la connexion
Config Check Discordance au niveau des paramètres des ports avec lesquels la 

connexion est établie.
Voir tableau 8

SFP Power RX dBm A Affiche la puissance RX de l'émetteur-récepteur SFP en dBm pour le 
port A.

SFP Power RX dBm B Affiche la puissance RX de l'émetteur-récepteur SFP en dBm pour le 
port B.

SFP Power TX dBm A Affiche la puissance TX de l'émetteur-récepteur SFP en dBm pour le 
port A.

SFP Power TX dBm B Affiche la puissance TX de l'émetteur-récepteur SFP en dBm pour le 
port B.

PVID Port A ID VLAN du port A. Un tiret indique l'absence de la fonction Port VLAN 
dans l'équipement A.

PVID Port B ID VLAN du port B. Un tiret indique l'absence de la fonction Port VLAN 
dans l'équipement B.

Tableau 7 : Signification des colonnes dans l'affichage détaillé de l'onglet «Connec-
tions».
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VLANs A
VLANs B

Appartenance de la connexion au VLAN.
Un chiffre indique l'ID VLAN, dont le VLAN est le membre de la 
connexion.
« U » signifie membre du VLAN, envoyer les paquets de données 
sans balise (Tag).
Un chiffre isolé signifie qu'il s'agit d'un membre du VLAN? envoyer les 
paquets de données avec balise (Tag).

VLAN Check Si le port A et le port B ont la même liste VLAN, le résultat du contrôle 
est «OK».
Un tiret indique l'absence des informations de liste VLAN à un port

MTBF Mean Time Between Failure [temps moyen entre pannes] des compo-
sants intégrés dans la connexion.
(voir page 457 “Calculate Availability”).

MTTR (Mean Time to Repair [durée moyenne d'une réparation]) des compo-
sants intégrés dans la connexion.
(voir page 457 “Calculate Availability”).

Value [Valeur] Description
OK Les deux ports raccordés à la connexion ont des para-

mètres duplex concordants.
Duplex Les deux ports raccordés à la connexion ont des para-

mètres duplex différents.
Champ vide Information manquante

Tableau 8 : Vérification de la config. – signification de l'affichage

Nom Signification

Tableau 7 : Signification des colonnes dans l'affichage détaillé de l'onglet «Connec-
tions».
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Figure 24 :Affichage détaillé de «Connections»

4.7.6 Properties

Pour accéder à l'affichage des connexions de l'affichage détaillé, cliquez sur 
l'onglet «Properties» de l'affichage détaillé.
Industrial HiVision affiche sous forme de liste une propriété sélectionnée des 
catégories d'équipements pour le répertoire ou l'équipement sélectionné 
dans le cadre Folders [Répertoires] ainsi que pour les sous-répertoires. 

 Sélectionnez une catégorie d'équipement (par ex. Windows PC).
 Sélectionnez une propriété que vous souhaitez visualiser pour les équi-

pements de la catégorie d'équipement.

La liste répertorie pour chaque classe d'équipement :

 le statut dérivé de la valeur déterminée dans la colonne de droite
 le nom/Adresse IP de l'équipement
 la catégorie d'équipement
 le nom de la propriété interrogée
 la valeur de la propriété
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L'affichage des «Properties» vous offre un rapide aperçu - par exemple, si 
vous souhaitez visualiser : 

 la version du logiciel des équipements d'une catégorie d'équipements
 l'emplacement des équipements d'une catégorie d'équipements
 les états des relais,
 les propriétés de port du PC Windows
 etc.

Figure 25 :Affichage détaillé de «Properties»

4.7.7 Security Status

L'onglet «Security Status» vous offre une vue d'ensemble des propriétés de 
sécurité des équipements dans la sélection des dossiers.
Voir “Etat Sécurité” on page 208.
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Figure 26 :Affichage détaillé de «Security Status»

4.7.8 PoE

Dans la vue détaillée, l'onglet «PoE» affiche une vue d'ensemble des para-
mètres PoE des équipements compatibles Power-over-Ethernet-(PoE) inté-
grés dans votre réseau.

Commentaire : La définition des colonnes dans la vue «Device / Module» et 
«Module / Port» se fonde sur les fonctions PoE à disposition d'un équipe-
ment déterminé.

Si vous sélectionnez un projet dans un cadre de dossiers, l'onglet «PoE» 
affiche les paramètres de chaque équipement compatible PoE intégré dans 
le projet. Par ailleurs, vous pouvez filtrer votre sélection de sorte à intégrer 
exclusivement des équipements à fonction PoE dans un réseau déterminé. 
Pour afficher les paramètres PoE d'équipements individuels, procédez 
comme suit :
 Dans le cadre de dossiers, cherchez un équipement à fonction PoE.
 Ouvrez la vue des équipements pour afficher les propriétés disponibles.
 Cliquez sur la propriété «PoE».

Les paramètres PoE des équipements individuels s'affichent également 
sous l'onglet «List».
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Si l'équipement prend en charge les différents niveaux, utilisez MultiConfig™ 
pour fixer les paramètres PoE au niveau global, des modules et des ports.
 Pour afficher les paramètres PoE au niveau global ou au niveau des 

modules, procédez comme suit :
 Sélectionnez les équipements dont vous souhaitez adapter les para-

mètres.
 Cliquez avec le bouton droit sur un équipement sélectionné.
 Dans la liste déroulante de, sélectionnez la propriété MultiConfig™.
 Ouvrez la boîte de dialogue Basic Settings > PoE > Global.

 Pour afficher les paramètres PoE au niveau des ports, procédez comme 
suit :
 Sélectionnez les équipements dont vous souhaitez adapter les para-

mètres.
 Ouvrez l'onglet «PoE».
 Sélectionnez les ports dont vous souhaitez adapter les paramètres.
 Cliquez avec le bouton droit sur le port de votre choix.
 Sélectionnez l’option MultiConfig™.
 Ouvrez la boîte de dialogue Basic Settings > PoE > Global.

Le bouton «Reload» vous permet de mettre à jour les paramètres dans les 
lignes sélectionnées. Si vous cliquez sur le bouton «Reload», Industrial 
HiVision déclenche une tâche de scrutation pour récupérer les paramètres 
sélectionnés. En fonction de la charge du réseau, l'opération d'actualisation 
et les tâches de scrutation inhérentes peuvent durer un temps non négli-
geable.

À l'aide de la liste déroulante «View:», vous pouvez afficher les propriétés 
«Device / Module» ou «Module / Port».

La vue «Device / Module» détaille les paramètres de modules dans les 
colonnes suivantes :

Nom Signification
Name Indique l'adresse IP de l'équipement.
Operation Indique si la fonction PoE de l'équipement est activée ou désactivée.
Budget Indique le total de puissance disponible pour les prévisions globales de 

puissance.
Remaining Indique la puissance restante.

 «Rem Pwr»= «Budget» - «Reserved»
Reserved Indique la puissance globale réservée.
Delivered Indique la puissance effectivement fournie au module.
Global Threshold[%] Indique la valeur seuil de consommation de courant de l'ensemble de 

l'équipement en pourcentage

Tableau 9 : Signification des colonnes dans la vue «Device / Module»
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Figure 27 :Affichage détaillé - Onglet «PoE», vue «Device / Module»

La vue «Module / Port» détaille les paramètres de ports dans les colonnes 
suivantes :

Device Limit Affiche un avertissement si la consommation de l'équipement dépasse 
le seuil paramétré.

Module Indique le nombre de modules de l'équipement.
Nominal Pwr Indique la puissance disponible sur les modules pour la répartition entre 

les ports.
Max Pwr Indique la puissance disponible maximale pour chaque module.
Del Pwr Indique la puissance effectivement fournie au Powered Device raccordé 

à ce port.
Res Pwr Indique la puissance réservée au module en fonction des catégories 

trouvées des Powered Devices raccordés.
Pwr Source Indique le Power Sourcing Equipment de l'équipement.
Threshold[%] Indique la valeur seuil de consommation de courant du module en pour-

centage
Module Limit Affiche un symbole d'avertissement si la consommation du module 

dépasse le seuil paramétré.
Trap Notif Indique si la fonction « Envoyer alarme SNMP » est activée ou désacti-

vée. Si la fonction est activée et que la valeur seuil de consommation de 
courant est dépassée, l'équipement envoie une alarme.

Nom Signification
Name Indique l'adresse IP de l'équipement.
Nominal Pwr Indique la puissance disponible sur les modules pour la répartition entre 

les ports.
Rem Pwr Indique la puissance restante.

 «Rem Pwr»= «Budget» - «Reserved»
Res Pwr Indique la puissance réservée au module en fonction des catégories 

trouvées des Powered Devices raccordés.
Del Pwr Indique la puissance effectivement fournie au Powered Device raccordé 

à ce port.
Module Indique le nombre de modules de l'équipement.
Port Indique le numéro de port de l'équipement

Tableau 10 : Signification des colonnes dans la vue «Module / Port»

Nom Signification

Tableau 9 : Signification des colonnes dans la vue «Device / Module»
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Vous pouvez désactiver des paramètres de port spécifiques au niveau 
«Device / Module» ou au niveau «Module / Port». 
 Pour activer la surveillance, cliquez sur «Configure Monitoring». 
 Activez ou désactivez les paramètres nécessaires. 
 Utilisez les boutons «Activate all» et «Deactivate all» pour enregistrer la 

modification sur tous les équipements, modules ou ports compatibles 
«PoE».

Après désactivation des paramètres, l'application n'affiche plus d'avertisse-
ment concernant ces paramètres.

Figure 28 :Affichage détaillé - Onglet «PoE», vue «Module / Port»

Operation Indique si la fonction PoE de l'équipement est activée ou désactivée.
Fast Start Indique si la fonction PoE Fast-Startup du port est activée ou désactivée.
Prio Indique la priorité du port.
Status Indique l'état de détection de Powered-Device-(PD) du port.
Det. Cl. Indique la classe de puissance du Powered Device raccordé à ce port.
C0 Det. Affiche un symbole d'avertissement sur les ports n'indiquant pas leur 

classe de puissance.
 «C0»...«C4» Indique l'état actuel des classes 0 à 4 sur le port.
Cons Indique la consommation de courant actuelle du port en watts.
Pwr Limit Indique la puissance maximale en watts mise à disposition par le port.
Port Limit Affiche un avertissement si la consommation du port dépasse le seuil 

paramétré.
Max Cons Indique la puissance maximale en watts que l'équipement a consommée 

depuis le dernier démarrage de l'équipement.
Enab ASDn Indique si la fonction Auto-Shutdown du port est activée ou désactivée.
Start Indique l'heure à laquelle l'équipement a désactivé le courant pour le 

port après activation de la fonction Auto-Shutdown.
End Indique l'heure à laquelle l'équipement a activé le courant pour le port 

après activation de la fonction Auto-Shutdown.

Nom Signification

Tableau 10 : Signification des colonnes dans la vue «Module / Port»
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4.8 Liste d'évènements

Industrial HiVision consigne tous les événements ayant trait au logiciel en soi 
et aux équipements à surveiller . (voir page 372 “Event”). Deux scénarios 
principaux de sélection et d'affichage des événements sont disponibles dans 
la liste des événements : 
 Filtre basé sur les objets
 Type d'événements/filtre chronologique pour tous les objets.

Dans le premier scénario, sélectionnez le nombre des objets nécessaires 
dans la zone. Utilisez le bouton «Filter Events for Object» situé en haut à 
droite au-dessus de la liste des événements. Si vous sélectionnez au moins 
un objet dans la zone, le bouton s'active. Ensuite, utilisez le champ de sélec-
tion en haut à droite au-dessus de la liste des événements pour filtrer les évé-
nements à afficher par Industrial HiVision. Vous pouvez choisir entre les 
options de filtrage suivantes :
 «All Events»,
 «Last 24 Hours Events»,
 «Last 12 Hours Events»,
 «Unacknowledged Events»,
 «Warnings & Errors»,
 «Unacknowledged Warnings & Errors»,
 «Link Events»,
 «User Defined...»

«User Defined...» Pour des événements définis par l'utilisateur, Industrial 
HiVision ouvre une fenêtre dans laquelle vous pouvez spécifier les évé-
nements à afficher par Industrial HiVision dans la liste.
Pour obtenir de l'aide pendant la saisie, passez le pointeur de souris sur 
le champ de saisie.

Pour que Industrial HiVision affiche les événements de l'objet sélectionné 
dans la liste des événements, cliquez une fois sur le bouton «Filter Events 
for Object».
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Figure 29 :Boîte de dialogue «User Defined...»

Commentaire : Utilisez le format horaire 24 heures pour saisir l'heure.

Voici des exemples d'événements :
  «Application Info»,
  «Status Better»/«Status Worse»,
  «Event Acknowledge»,
  «SNMP Trap»,
  «Device Discovered»,
  etc.

Industrial HiVision vous permet d'écrire les événements dans un fichier jour-
nal d'événements. En outre, vous pouvez afficher les événements dans 
l'interface du logiciel.
Pour chaque événement, Industrial HiVision consigne les informations 
suivantes :

 numéro d'identification
 si l'évènement a été validé par l'utilisateur
 type d'évènement (info, avertissement, erreur)
 catégorie d'évènement
 heure à laquelle l'évènement est survenu
 utilisateur lorsque l'entrée a été enregistrée, par ex. celui qui a validé 

l'évènement
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 source à l'origine de la saisie, par ex. un équipement ayant passé à un 
meilleur statut

 les composants ayant provoqué l'entrée, par ex. port dont l'état de 
connexion a récupéré l’état « ok »,

 le message signalant l'événement ayant provoqué cette entrée.

La liste des évènements vous permet de valider des évènements séparés ou 
l'ensemble des évènements. Voir la figure 8 on page 83.

Cliquez avec le bouton droit de la souris sur une ligne de la liste des événe-
ments et sélectionnez
 «Acknowledge» pour valider cet événement
 «Acknowledge All» pour valider tous les événements de l'onglet

Si Industrial HiVision peut associer l'événement à un équipement ou une pro-
priété, double-cliquez sur une ligne dans la liste des événements pour sélec-
tionner la source de l'événement dans le cadre des dossiers.

Commentaire : L'événement «User Intervention» associé ou un événement 
incluant la notification « Mise à jour de l'équipement (F5) terminée » est 
désormais un événement «Application Info»avec la même notification. Si 
vous avez configuré une alarme d'événement pour cet événement «User 
Intervention», modifiez l'alarme d'événement pour correspondre à la nou-
velle «Application Info».
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4.8.1 Event History

La boîte de dialogue «Event History» affiche les mêmes événements que 
dans la Event List, mais dans un diagramme de Gantt. Le diagramme de 
Gantt présente les zones suivantes :
 une arborescence à gauche,

L'arborescence à gauche affiche les utilisateurs, équipements, 
connexions et les sous-composants correspondants qui saisissent les 
événements dans le diagramme. 

 un diagramme à droite.
Le diagramme à droite affiche une ligne spécifique à chaque sous-com-
posant. La ligne se compose de trois événements concernant ce sous-
composant.

La boîte de dialogue «Event History» affiche les événements suivants :
 Période d'état

La période d'état est une barre de couleur qui affiche la période pendant 
laquelle une propriété d'équipement, un équipement ou une connexion 
est dans un état prédéterminé.
La barre affiche l'état d'un événement avec ces couleurs :
– Rouge

Une barre rouge indique des événements à l'état « Erreur ».
– Jaune

Une barre jaune indique des événements à l'état « Avertissement ».
– Vert

Une barre verte indique la durée de fonctionnement sans anomalie de 
l'équipement.

– Argent
Seuls les utilisateurs, équipements et connexions disposent de la 
barre argentée. Cette barre affiche une récapitulation des sous-com-
posants appartenant au même équipement ou à la même connexion.

 Événements d'application 

La boîte de dialogue «Event History» affiche les événements d'applica-
tion dans la ligne d'application. Les événements d'application sont des 
informations concernant l'utilisation de Industrial HiVision, notamment 
l'heure de connexion d'un utilisateur. 
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 Événements d'alarme 

La boîte de dialogue «Event History» affiche les événements d'alarme 
dans la ligne de composant. Les événements d'alarme sont des informa-
tions envoyées par un équipement à Industrial HiVision, notamment en 
cas d'équipement inatteignable ou de modification d'un protocole.

 Événements d'utilisateur 

La boîte de dialogue «Event History» affiche les événements de la caté-
gorie «User Intervention» dans une ligne relative à un utilisateur.

La boîte de dialogue «Event History» affiche le nombre d'événements qui se 
sont produits au même moment ou presque sur une icône. Pour afficher le 
texte concernant les événements, passez le pointeur de souris sur le sym-
bole. Lorsque le nombre d'événements affichés sur une icône est supérieur 
à 1, sélectionnez l'option «Details» en cliquant avec le bouton droit sur 
l'icône. La liste affiche également l'heure de survenance de l'événement.

Pour afficher les événements dans la boîte de dialogue «Event History», pro-
cédez comme suit :
 Dans la liste déroulante des filtres d'événements, sélectionnez un filtre 

pour les événements à afficher.
 Cliquez sur le bouton «Event History».

Pour afficher les événements dans la boîte de dialogue «Event History» liés 
uniquement à un composant spécifié, procédez comme suit :
 Sélectionnez le composant dans l'onglet «Map».
 Cliquez sur le bouton «Filter Events for Object».
 Cliquez sur le bouton «Event History».

Si une icône d'événement affiche un certain nombre d'événements survenus 
au même moment ou à peu près au même moment, vous pouvez utiliser le 
curseur «Zoom Time Scale» pour étirer la ligne de temps. Si vous étirez la 
ligne de temps, la boîte de dialogue «Event History» affiche la liste des évé-
nements. Le curseur «Zoom Row Height» augmente et diminue la hauteur 
de la ligne.

Commentaire : Lorsque vous supprimez un composant de l'onglet «Map», 
les événements que le composant a créés restent dans la liste des événe-
ments. Cependant, Industrial HiVision supprime les événements de la boîte 
de dialogue «Event History».
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La liste ci-dessous contient une description de la case à cocher et des bou-
tons de la boîte de dialogue «Event History» :
 «Fit all Events»

Le bouton réduit la largeur des lignes pour afficher les heures de début et 
de fin des événements.

 «Export»
Le bouton vous permet d'exporter la boîte de dialogue «Export» sous 
forme de fichier PDF.

 «Export all Pages»
La case à cocher vous permet de limiter exclusivement l'opération 
d'exportation aux composants actuellement affichés à l'écran.

Figure 30 :Boîte de dialogue «Event History»

 Exemple
Vous constatez que l'onglet «Map» affiche des liens vers le bas. Pour 
connaître l'heure à laquelle l'état des liens a changé, vous pouvez afficher 
les équipements et les connexions dans la boîte de dialogue «Event His-
tory». Pour filtrer «Event History» des événements liés aux équipements 
et aux connexions, procédez comme suit :
 Dans la section «Event History», sélectionnez la fonction «User 

Defined...» dans la liste déroulante. Industrial HiVision ouvre la boîte 
de dialogue «User Defined...».

 Saisissez les informations sur l'équipement dans la boîte de dialogue 
«User Defined...».
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Commentaire : Pour obtenir de l'aide pendant la saisie, passez le 
pointeur de souris sur le champ de saisie.

– Dans la ligne «ID», sélectionnez «in» dans la liste déroulante et 
saisissez un astérisque (*) dans le champ de texte.

– Dans la ligne «Ack.», sélectionnez «in» dans la liste déroulante et 
saisissez un astérisque (*) dans le champ de texte.

– Dans la ligne «Type», sélectionnez «=» et «Warning» dans les 
listes déroulantes.

– Dans la ligne «Category», sélectionnez «=» et «Status Worse» 
dans les listes déroulantes.

– Dans la ligne «Time», sélectionnez «Before» dans la liste dérou-
lante et entrez l'heure actuelle.

– Dans la ligne «User», sélectionnez «=» et « * » dans les listes 
déroulantes.

– Dans la ligne «Source», sélectionnez «=» et l'adresse IP de l'équi-
pement dans la liste déroulante.

– Dans la ligne «Component», sélectionnez «=» et « * » dans les 
listes déroulantes.

– Dans la ligne «Message», sélectionnez «=» et « * » dans les listes 
déroulantes.

 Pour appliquer les filtres au protocole «Event History», cliquez sur le 
bouton «OK». Industrial HiVision affiche exclusivement les entrées de 
protocole se rapportant aux valeurs de filtrage.

 Pour ouvrir la boîte de dialogue «Event History», cliquez sur le bouton 
«Event History».

 La boîte de dialogue «Event History» affiche l'heure à laquelle l'état de 
l'équipement s'est détérioré.

Puisque vous connaissez désormais le moment de l'interruption des 
connexions de l'équipement, vous pouvez en déterminer la cause.
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4.9 Navigation via le clavier

4.9.1 Navigation dans un tableau

À l'intérieur du tableau, vous pouvez utiliser les touches directionnelles pour 
vous déplacer dans les champs de tableau, vers le haut ou le bas, à gauche 
ou à droite. 
À l'aide de la touche tabulation, vous vous déplacez dans le prochain champ 
de tableau.
Avec Ctrl+Tab, vous accédez à la zone suivante hors du tableau.

4.9.2 Changement de cadre

Avec Tab vous accédez au cadre suivant de l'interface de logiciel.
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5 Création du plan réseau

Au début de la surveillance d'un réseau, le réseau s'affiche dans l'interface 
d'administration de réseau. Industrial HiVision vous permet de reproduire 
votre réseau dans des variantes d'affichage et selon des critères différents, 
ceci de manière simultanée.

Vous pouvez notamment créer un plan réseau sur la base des critères 
suivants :
 qui reproduit l'environnement physique réel,
 qui affiche les nœuds de connexion les plus importants, 
 qui est axé sur la topologie de votre réseau, etc.

Vous pouvez afficher un équipement via des copies ou des liens dans plu-
sieurs schémas de réseau.

Les éléments suivants composent l'affichage de réseau :

 Reconnaissance des équipements
 Disposition des équipements
 Affichage des équipements
 Connexions des équipements

En règle générale, les réseaux sont soumis à des changements permanents. 
Les actions concernées sont les suivantes :

 Suppression d'équipements 
 de nouveaux équipements sont intégrés et par conséquent,
 des nouvelles connexions sont établies.
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5.1 Reconnaissance des 
équipements

Lors de la première étape pour établir un plan réseau, Industrial HiVision 
vous permet de détecter les équipements suivants installés sur le réseau 
(voir page 341 “Basics”) :

 Gamme Hirschmann BAT
 Gamme Hirschmann OCTOPUS
 Gamme Hirschmann GECKO avec fonctionnalité d'administration
 Commutateurs rail Hirschmann avec fonctionnalité d'administration
 Gamme Hirschmann MICE
 Gamme Hirschmann Power MICE
 Gamme Hirschmann MACH
 Gamme Hirschmann GREYHOUND
 Hirschmann GES-24TP Plus
 Gamme Hirschmann EAGLE
 Gamme Hirschmann Rail Router
 Gamme Hirschmann de commutateurs de redondance
 Gamme Hirschmann LioN-P
 Gamme Hirschmann LioN-R
 Gamme Hirschmann LION
 Gamme Hirschmann Ethernet intégré
 Gamme Hirschmann OWL 
 Gamme Hirschmann Dragon PTN
 Hirschmann Dragon MACH 4000 et 4500
 Gamme Hirschmann Bobcat
 Magnum 5RX
 Magnum 6K
 Magnum 10KT
 Magnum DX line
 Magnum 10ETS
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 Magnum 10RX
 Magnum 12KX
 Gammes Schneider Electric TCSESM, TCSESM-E, TCSESB
 Gamme Schneider Electric TCSEFEC
 Gamme Schneider Electric Nxx
 Gamme Selectron Systems ESM
 Gamme Selectron Systems ERT
 Gamme ABB AFF-, AFS-, AFR
 Modem INSYS MoRoS, ISDN, HSPA, UMTS, GPRS, LAN, MI
 Meinberg LANTIME GPS, M300, M600
 Advantech SNMP-1000
 Imprimante EPSON FX-2190, ACULASER C100N
 Appareils avec SNMP
 PC Windows
 Équipements avec ICMP (Ping)

Commentaire : Industrial HiVision reconnaît des équipements à gestion 
SNMP d'autres fabricants sur la base de la MIB II standard. En conséquence, 
Industrial HiVision représente les interfaces existantes de l'ifTable, ainsi 
que les interfaces VLAN ou de routage comme ses propres ports.

 Sous Configuration > Preferences > Basics > Discover Devices, 
sélectionnez la méthode préférée pour la reconnaissance des équipe-
ments.
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Industrial HiVision propose 4 méthodes de reconnaissance d'équipements :

 Découverte au moyen de traps SNMP
Après la mise en marche, les équipements envoient un message d'acti-
vation à la station d'administration de réseau saisie dans l'équipement. 
Ce message analyse Industrial HiVision et affiche les appareils dans le 
dossier cible saisi. (voir page 341 “Basics”)
Cette méthode est préconisée pour une application pendant une surveil-
lance en cours d'exécution dans des réseaux où la largeur de bande est 
cruciale.

 Découverte des équipements à l'aide du protocole HiDiscovery
Le protocole HiDiscovery communique au moyen d'une adresse MAC 
avec des équipements du sous-réseau sur lesquels le protocole HiDisco-
very, est actif.
Cette méthode vous offre la possibilité de détecter des équipements dans 
votre réseau, auxquels vous n'avez encore attribué aucune adresse IP 
valide.
Industrial HiVision affiche les nouveaux appareils détectés dans le dos-
sier cible saisi(voir page 341 “Basics”).
Cette méthode est préconisée lorsque vous souhaitez mettre en marche 
un réseau récemment installé et affecter une adresse IP aux nouveaux 
équipements.

 Reconnaître des équipements via une plage d'adresses IP définies
Avec le balayage du réseau, Industrial HiVision envoie des requêtes Ping 
et SNMP cycliques aux équipements dotés d'une adresse IP située dans 
les plages d'adresses IP définies. Industrial HiVision positionne les équi-
pements ainsi reconnus dans le dossier cible de cette plage d'adresses 
IP. Lors de la définition des plages d'adresses IP, vous pouvez affecter 
un dossier cible à chaque plage d'adresses IP (voir page 341 “Basics”).
Cette méthode est préconisée pour la surveillance d'un réseau en cours 
d'exécution. Vous pouvez adapter la fréquence de requête à la largeur de 
bande de votre réseau. 
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 Détecter des équipements nouvellement créés
Industrial HiVision vous permet d'installer manuellement un équipement 
et d'attribuer une adresse IP à l'entrée de cet équipement. Après la créa-
tion de l'équipement, Industrial HiVision envoie une requête à son 
adresse IP afin de le détecter (voir page 145 “–Création de nouveaux 
équipements”). 

 Reconnaître des équipements dans une liste d'adresses IP
Industrial HiVision vous offre la possibilité de balayer des adresses IP via 
un fichier texte ou Microsoft Excel (.csv). La boîte de dialogue «Create 
Devices from List» vous permet de rechercher le fichier et de le charger 
dans Industrial HiVision. Si un équipement n'est pas accessible dans la 
liste, Industrial HiVision indique l'équipement comme étant un équipe-
ment générique sur la carte de topologie. (voir page 268 “Devices from 
List”)

5.1.1 Icônes d'équipement

Une fois que Industrial HiVision a analysé votre réseau, l’onglet «Map» 
affiche les résultats. L’onglet affiche les différents symboles pour les équipe-
ments reconnus dans le cadre de l’analyse de réseau. Si un module produit 
spécifique (PSM) est affecté aux équipements, l’onglet indique le PSM. 
Sinon, Industrial HiVision affiche brièvement un symbole correspondant à 
l’état de l’équipement.

La liste suivante contient une description des symboles de Industrial 
HiVision :
 Cube jaune – 

L'équipement réagit exclusivement aux requêtes Ping.
 Cube bleu – 

L’équipement réagit aux requêtes HiDiscovery, n’est toutefois pas un 
équipement Hirschmann.

 Icône Hirschmann 
L'équipement réagit aux requêtes HiDiscovery. Industrial HiVision a 
déterminé à l’aide de l’adresse MAC que l’équipement est un équipement 
Hirschmann, mais ne dispose pas d’un PSM.
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 Icône « Nœud inconnu » – 
Un utilisateur a saisi l’équipement manuellement dans Industrial HiVision. 
L’équipement est toutefois inaccessible.

 Commutateur PSM – 
L’équipement réagit aux requêtes SNMP, Industrial HiVision ne connaît 
toutefois pas l’identifiant d’objet.

 PC Windows – 
L'équipement est un ordinateur fonctionnant avec un système d’exploita-
tion Windows.

 PC Linux – 
L'équipement est un ordinateur fonctionnant avec un système d’exploita-
tion Linux.

5.1.2 HiProvision

HiProvision vous permet de surveiller les équipements, tunnels et services 
fonctionnant dans les tunnels de Dragon PTN. L'icône HiProvision affichée 
dans Industrial HiVision représente les équipements, tunnels et services 
Dragon PTN.

Vous pouvez télécharger les manuels HiProvision à partir de la page Web de 
documentation de Hirschmann : www.doc.hirschmann.com

Pour ajouter l'icône HiProvision dans Industrial HiVision, procédez comme 
suit :

Effectuez les étapes suivantes dans HiProvision :
 Accédez à l'onglet Dashboard> Tools> Add-ons> SNMP-Northbound> 

Configuration .
 Dans le cadre Agent , cochez la case Enabled.
 Dans le champ Agent> IP Address & Port, saisissez l'adresse IP du 

PC où HiProvision est exécuté.
 Vous utilisez le champ Port pour définir le port SNMP utilisé pour com-

muniquer avec Industrial HiVision. Le port par défaut est 161. C'est aussi 
le réglage par défaut pour Industrial HiVision.
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 Dans le cadre Agent, cochez la case SNMP v3.
 Configurez les paramètres admin ou user. Configurez les paramètres 

admin pour la gestion des équipements. Les paramètres user vous per-
mettent uniquement de surveiller l'équipement.
– Dans la liste déroulante Authentication Protocol, sélectionnez le 

type d'authentification requis.
Industrial HiVision utilise Md5 ou sha.

– Dans la liste déroulante Encryption Protocol, sélectionnez le type 
de cryptage requis. 
Industrial HiVision utilise None, Des ou Aes128.

Effectuez l'étape suivante dans Industrial HiVision :
 Ouvrez l'onglet «Map».
 Pour ajouter un nouvel équipement à la topologie, cliquez avec le bouton 

droit de la souris sur un emplacement vide dans l'onglet «Map». 
 Dans la liste déroulante, sélectionnez New > Device.
 Dans les champs IP Address > Device > IP Address, saisissez 

l'adresse IP du PC où HiProvision est exécuté.
 Vous utilisez le champ SNMP Port No pour définir le port SNMP utilisé 

pour communiquer avec HiProvision. Le port par défaut est 161. C'est 
aussi le réglage par défaut pour HiProvision.

 Dans le champ Properties > Name, saisissez HiProvision.
 Cliquez sur le bouton «OK».

Industrial HiVision affiche l'icône HiProvision dans l'onglet «Map». 

Les étapes de travail suivantes expliquent comment surveiller «Tunnel List» 
in Industrial HiVision. Vous surveillez «Service List» de la même manière. 

 Faites 2 tunnels dans HiProvision et nommez-les Tunnel 1 et Tunnel 2.
 Assurez-vous que «Edit Mode» est activé.
 Double-cliquez sur l'icône HiProvision dans l'onglet «Map».
 Double-cliquez sur l'entrée «Tunnel List» dans l'onglet «List».
 Dans la boîte de dialogue «Properties», cliquez sur le bouton «Status 

Config».
 Saisissez les valeurs telles qu'elles sont affichées dans (voir la figure 32).
 Pour ajouter des lignes supplémentaires, utilisez le bouton «New».
User Manual Industrial HiVision
Release 8.1 12/19 139



Création du plan réseau 5.1 Reconnaissance des équipe-
ments
Figure 32 :Configuration de l'état des tunnels HiProvision

L'entrée «Tunnel List» dans l'onglet «List» affiche une coche verte tant que 
l'entrée ne contient que Tunnel 1 et Tunnel 2. Si Tunnel 1 ou Tunnel 2 
tombe en panne pour une raison quelconque, alors Industrial HiVision affiche 
l'entrée avec une erreur. Si l'entrée contient une autre valeur, alors Industrial 
HiVision affiche l'entrée sous forme d'avertissement.
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5.2 Assignation d'icônes 
d'équipement

Pour identifier facilement les équipements dans l'affichage détaillé, Industrial 
HiVision vous offre la possibilité d'assigner différentes icônes standard aux 
types d'équipements.

Figure 33 :Icônes d'équipement

À l'état de livraison,Industrial HiVision reconnaît quelques types d'équipe-
ments (par ex. les équipements Hirschmann et leur assigne les icônes 
d'équipements correspondantes.
Vous pouvez affecter d’autres types d’équipement dans la boîte de dialogue 
«Preferences» icônes. Pour différencier les types d'équipements lors de la 
reconnaissance d'équipements, Industrial HiVision vous propose les carac-
téristiques d'affectation suivantes (voir page 385 “Device Icon”) :

 Identifieur d'objet système (SysOID)
Le SysOID désigne une variable MIB. Étant donné que le SysOID d'une 
MIB de fabricant contient le fabricant, vous pouvez utiliser différentes 
icônes pour différencier les équipements au niveau du fabricant. À l'état 
de livraison, Industrial HiVision contient les SysOID de Hirschmann, Sch-
neider, Siemens, Rockwell et Cisco.

 EtherNet/IP
Tout comme l'identifiant d'objet, les équipements EtherNet/IP contiennent 
des informations sur le fabricant et le produit. Vous pouvez ainsi deman-
der à Industrial HiVision d'affecter des icônes au niveau des équipe-
ments.
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 Modbus/TCP
Tout comme l'identifiant d'objet, les équipements Modbus/TCP 
contiennent des informations sur le fabricant et le produit. Vous pouvez 
ainsi demander à Industrial HiVision d'affecter des icônes au niveau des 
équipements.

 MAC Address [Adresse MAC]
L'adresse MAC contient également les données du fabricant. En fonction 
de la profondeur du code du fabricant, vous pouvez affecter l'icône depuis 
le niveau fabricants jusqu'au niveau équipements.
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5.3 Disposition des équipements

5.3.1 Création du plan réseau

Pour un nouveau plan réseau, créez un nouveau répertoire dans le cadre 
Folders [Répertoires]

 Cliquez avec le bouton droit de la souris sur le globe et sélectionnez dans 
le menu déroulant New > Folder.

 Cliquez avec le bouton droit de la souris sur le nouveau répertoire et 
sélectionnez dans le menu déroulant «Properties...». Donnez au nouveau 
répertoire le nom que vous voulez attribuer à ce plan réseau.
Il existe d'autres possibilités de renommer un répertoire, soit en sélection-
nant deux fois le répertoire soit en appuyant sur la touche F2 après avoir 
sélectionné le répertoire. Terminez la saisie du nom en appuyant sur la 
touche Enter.

 Cliquez avec le bouton droit de la souris sur le nouveau répertoire et 
sélectionnez «Scan Ranges». La boîte de dialogue «Scan Ranges» vous 
permet de définir des plages d'adresses IP. Industrial HiVision affiche 
dans ce répertoire les équipements nouvellement reconnus avec les 
adresses IP comprises dans cette plage d'adresses IP.
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Figure 34 :Exemple d'une structure de plan réseau

5.3.2 Déplacement d'équipements dans le plan 
réseau

Déplacez les équipements nouvellement détectés dans le répertoire du plan 
réseau. 

 Sélectionnez les équipements.

 Cliquez sur un équipement en surbrillance et faites-le glisser vers le 
répertoire du plan réseau dans le cadre Folders [Répertoires]. 
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5.3.3 –Création de nouveaux équipements

Si vous voulez entrer le schéma de réseau avant que les équipements soient 
installés dans le réseau, placez les nouveaux équipements dans l'affichage 
détaillé.

 Cliquez avec le bouton droit de la souris dans le cadre de l’affichage 
détaillé et sélectionnez New > Device dans le menu déroulant.

 Dans l'onglet «IP Address», entrez l'adresse IP du nouvel équipement.
Lorsque vous avez sélectionné le champ Device > Scan, Industrial 
HiVision analyse automatiquement le réseau sur l’équipement, si vous 
fermez la boîte de dialogue avec «OK».
Si vous avez sélectionné Device > Generate, Industrial HiVision ajoute à 
cette boîte de dialogue l’option de création de modules et de ports pour 
l’appareil.

Si le nouvel équipement est déconnecté de la station d'administration de 
réseau par un routeur NAT par exemple, Industrial HiVision peut commu-
niquer avec le nouvel équipement via la redirection de port du routeur 
NAT.
Saisissez ensuite l'onglet «IP Address» l'adresse IP du routeur NAT et le 
numéro de port SNMP du port par lequel Industrial HiVision doit commu-
niquer avec le nouvel équipement. Saisissez la combinaison du port et de 
l'adresse IP du nouvel équipement dans le tableau NAT du routeur NAT.
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Figure 35 :Saisie de l'adresse IP d'un nouvel équipement

 Dans l'onglet «Properties», saisissez
 le nom que vous souhaitez et, 
 le cas échéant, le transfert ou la détermination de statut 

(voir page 288 “Propriétés d'un dossier/équipement”).

 Sélectionnez l'équipement et appuyez sur la touche « F5 » de votre cla-
vier ou cliquez avec le bouton droit de la souris sur l'équipement puis 
sélectionnez «Refresh». Ainsi, Industrial HiVision détecte l'équipement 
dans le réseau et en appelle les données.
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5.3.4 Disposition des équipements dans 
l'affichage détaillé

Vous aide à disposer les équipements dans l'affichage détaillé Industrial 
HiVision.

 Cliquez avec le bouton droit de la souris dans le cadre de détails et sélec-
tionnez «Auto Layout». Industrial HiVision repositionne les objets dans 
l'affichage détaillé en fonction de leurs connexions.

 Cliquez sur le bouton droit de la souris dans le cadre de détails et sélec-
tionnez Drawing > Line Up all Objects pour disposer les équipements 
ligne par ligne.

 Sélectionnez plusieurs objets dans le cadre de détails, cliquez avec le 
bouton droit de la souris dans le cadre de détails et sélectionnez 
Drawing > Align Tops/Align Bottoms/Align Left/Align Right afin de 
disposer les objets sélectionnés ligne par ligne ou colonne par colonne.
Dans ce cas, Industrial HiVision sélectionne l'objet le plus à l'extérieur 
pour déterminer la position de la ligne/colonne. 

 Sélectionnez plusieurs objets dans le cadre de détails, cliquez avec le 
bouton droit de la souris dans le cadre de détails et sélectionnez 
Drawing > Center Horizontally/Center Vertically afin de disposer 
les objets sélectionnés ligne par ligne ou colonne par colonne.
Dans ce cas, Industrial HiVision sélectionne l'objet le plus à l'extérieur 
pour déterminer la position de la ligne/colonne. 

Commentaire : Si en faisant glisser des groupes d'objets, des objets isolés 
se retrouvent hors du champ visible et que ceux-ci sont encore contenus 
dans le cadre Folders [Dossiers], ramenez tous les objets dans le champ 
visible en appuyant sur le bouton droit de la souris dans la fenêtre de détails 
et en sélectionnant «Auto Layout» ou Drawing > Line Up all Objects.
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5.3.5 Identification des équipements et ports

Industrial HiVision affiche dans le cadre Répertoires ou dans l'affichage 
détaillé les noms d'équipements et de ports que Industrial HiVision a extrait 
du dialogue «Properties» propre de l'équipement/du port. Si aucun nom n'y 
figure, Industrial HiVision affiche une adresse IP d'administration dans le cas 
d'un équipement et le numéro de module/port dans le cas d'un port.

 Cliquez avec le bouton droit de la souris sur un équipement/port et sélec-
tionnez «Properties» pour saisir le nom.

Les options de configuration (voir page 408 “Device/Port Names”) offrent la 
possibilité de transférer automatiquement 

 les noms d'équipements et de ports à partir de l'équipement et 
 dans le cas du nom de l'équipement, à partir du serveur DNS (Domain 

Name Server) ou d'un fichier privé d'hôtes.

5.3.6 Copie des équipements

Pour afficher par exemple différents scénarios de surveillance, Industrial 
HiVision permet de copier des équipements. À cet effet, vous pouvez saisie 
les différentes configurations d’état pour les équipements copiés dans la 
boîte de dialogue «Properties». Industrial HiVision dispose d’un enregistre-
ment de données pour chaque équipement. Chaque copie a son propre 
enregistrement de données. Le contenu de l'enregistrement de données est 
extrait de l'original pendant la copie. 

Exemple de deux scénarios de surveillance :
Dans le premier scénario, vous souhaitez uniquement afficher les événe-
ments qui vous semblent critiques. Une perte de connexion au niveau du 
port 3 de l'équipement A serait critique.
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Dans l'autre scénario, vous souhaitez afficher les évènements déterminants 
pour la maintenance. La perte d'une alimentation redondante au niveau de 
l'équipement A est considérée cruciale pour la maintenance.
 À cet effet, créez deux nouveaux répertoires dans le cadre Folders 

[Répertoires] en nommant l'un « Critical » [Critique] et l'autre 
« Maintenance ». 

 Cliquez avec le bouton droit de la souris sur l'équipement A et sélection-
nez «Copy». 

 Copiez l'équipement A dans le répertoire « Maintenance » ainsi que dans 
le répertoire « Critical » [Critique].

 En double-cliquant sur le répertoire « Critical » [Critique], vous accédez 
au niveau des composants. 
En double-cliquant sur port 3, vous accédez au niveau des détails. 

 Dans la boîte de dialogue (voir page 297 “Propriétés d'un détail de com-
posant”), procédez aux réglages appropriés pour le détail du «Link».

 Procédez de la même manière dans le répertoire « Maintenance ».

5.3.7 Paste as new Network

Lorsque vous utilisez la fonction «Copy»/«Paste», Industrial HiVision ajoute 
une copie de l'équipement d'origine au dossier sélectionné. L'original et la 
copie font référence au même équipement.

Si vous utilisez les fonctions «Copy» et «Paste as new Network», Industrial 
HiVision copie l'équipement et ajoute un nouvel équipement dans le dossier 
sélectionné. L'équipement copié est un équipement distinct.

Commentaire : La fonction «Paste as new Network» n'est pas disponible 
pour les dossiers suivants :
 «New Devices»
 «Rogue Devices»
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La fonction «Paste as new Network» est utile pour des réseaux identiques 
dont les équipements et connexions sont identiques, mais avec des 
adresses IP différentes.

Outre les connexions, la fonction «Paste as new Network» copie également 
les paramètres de l'équipement. La fonction «Paste as new Network» offre 
la possibilité de déterminer les paramètres à copier sur les équipements du 
nouveau réseau. Vous pouvez vérifier les paramètres copiés par le biais des 
boîtes de dialogue suivantes :
 «Copy Device Credentials»

La fonction copie les paramètres de la boîte de dialogue Preferences > 
Device Credentials.

 «Copy Event Forwarding»
La fonction copie les paramètres de la boîte de dialogue Preferences > 
Event Forwarding.

 «Copy Event Actions: Alarms»
La fonction copie les paramètres du tableau Preferences > Event 
Actions > Alarms.

 «Copy Tasks and Schedules»
La fonction copie les paramètres des boîtes de dialogue 
Configuration > Scheduler.

Cette fonction requiert les conditions suivantes :
 Industrial HiVision est situé dans «Edit Mode».
 Industrial HiVision a détecté les équipements que vous souhaitez copier.
 Les équipements que vous souhaitez copier pour le nouveau réseau se 

trouvent dans le même dossier.
 Vous configurez les connexions, la scrutation et l'état sur les équipements 

d'origine.
 Vous utilisez le réseau d'origine exclusivement pour d'autres réseaux 

avec les mêmes équipements et connexions.

 Exemple de configuration :
Un réseau de trains illustre cet exemple. Cette comparaison avec les 
réseaux de trains met leurs similitudes en évidence. La copie d'un réseau 
de trains suppose un changement des adresses IP et l'utilisation du 
réseau pour un autre train.
Cet exemple requiert les conditions suivantes :
 Vous avez détecté et configuré le Train A dans Industrial HiVision.
 Les équipements que vous souhaitez copier se trouvent dans le même 

dossier.
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 Vous avez créé le dossier Réseaux de trains.
 Le dossier Train A est un sous-dossier du dossier Réseaux de 

trains.

Dans l'exemple suivant, vous copiez le dossier Train A et souhaitez uti-
liser le dossier comme réseau pour le Train B. Pour utiliser les fonctions 
«Copy» et «Paste as new Network», procédez comme suit :

 Créez le sous-dossier Train B dans le dossier Réseaux de trains.
 Ouvrez l'onglet «Map» du dossier Réseaux de trains.
 Cliquez avec le bouton droit de la souris sur la zone vide de la boîte 

de dialogue.
 Dans le menu déroulant, sélectionnez l'option New > Folder.
 Renommez le nouveau dossier Train B.

 Copiez les équipements contenus dans le dossier Train A que vous 
souhaitez utiliser dans le réseau Train B.
 Ouvrez l'onglet «Map» du dossier Train A.
 Sélectionnez les équipements que vous souhaitez copier.
 Cliquez avec le bouton droit de la souris sur un équipement sélec-

tionné.
 Sélectionnez «Copy» dans la liste déroulante.

 Ajoutez les équipements du dossier Train A dans le dossier Train B.
 Ouvrez l'onglet «Map» du dossier Train B.
 Cliquez avec le bouton droit de la souris sur la zone vide de la boîte 

de dialogue.
 Sélectionnez dans le menu déroulant l'option «Paste as new 

Network».

 Attribuez les nouvelles adresses IP aux équipements du Train B.
 Double-cliquez sur la cellule «Source IP Address» dans la pre-

mière ligne de la boîte de dialogue «Copy Devices».
 Dans le champ Edit > IP Address of the Copy, entrez la 1re 

adresse IP du réseau Train B.
 Cliquez sur le bouton «OK».

La boîte de dialogue «Copy Devices» affiche désormais la 1re 
adresse IP du réseau Train B dans la colonne «IP Address of the 
Copy».

 Pour calculer automatiquement l'adresse IP des autres équipe-
ments, cliquez sur le bouton «Calc with Offset».
Industrial HiVision calcule le décalage comme suit :
IP Address of the Copy = Source IP Address + adresse IP 
du 1er équipement réglé manuellement
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 Pour sélectionner les paramètres que vous souhaitez copier sur les 
nouveaux équipements, cochez les cases dans la zone inférieure 
de la boîte de dialogue.

 Pour déterminer le balayage automatique du réseau par Industrial 
HiVision à la fermeture de la boîte de dialogue, «Copy Devices» 
cochez la case «Scan Devices after Copy».

 Cliquez sur le bouton «OK».
Industrial HiVision affiche les équipements pour Train B avec les 
adresses IP que vous avez entrées dans la boîte de dialogue 
«Copy Devices».

Commentaire : Lors de la création de nouvelles adresses IP, veillez au 
caractère univoque de celles-ci. Industrial HiVision affiche les adresses 
IP en double sur fond rouge.

Les définitions des symboles sont répertoriées ci-après dans la colonne 
«Type» :

 : adresse IP déterminée manuellement.

  : l'adresse IP est calculée automatiquement.

5.3.8 Équipements avec plusieurs adresses IP

Industrial HiVision affiche des équipements dotés de plusieurs adresses IP, 
par ex. un routeur, comme un seul équipement. Dans la boîte de dialogue 
«Properties» de l'équipement, vous pouvez visualiser les adresses IP attri-
buées à l'équipement dans l'onglet «MAC/IP Addresses». 
Afin d'assurer une affectation unique, Industrial HiVision identifie un équipe-
ment avec une seule adresse IP. Si vous voulez identifier un équipement 
avec une adresse IP différente, supprimez l'équipement dans l'interface, puis 
recréez-le avec l'adresse IP souhaitée. Après l'actualisation de l'équipement, 
Industrial HiVision identifie l'équipement au moyen de cette adresse IP.
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5.3.9 Création d'un lien

Pour afficher un équipement dans plusieurs schémas de réseau, Industrial 
HiVision permet de créer des liens à partir des équipements. Les liens sont 
particulièrement utiles si vous divisez votre réseau en plusieurs dossiers. 
Dans ce cas, vous pouvez afficher un équipement reliant deux schémas de 
réseau dans chacun d'entre eux. Contrairement à une copie, le lien utilise 
l'enregistrement des données de l'original. Toute modification de l'original est 
prise en charge par le lien.

Outre les liens pour les équipements, vous pouvez également créer des liens 
pour les composants.

 Copiez l'objet pour lequel vous souhaitez créer un lien.

 Cliquez avec le bouton droit de la souris sur l'endroit où vous souhaitez 
placer le lien et sélectionnez «Paste As Link».
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5.4 Connexions des équipements

5.4.1 Affichage automatique de la topologie

La méthode la plus simple d'afficher les connexions entre les équipements, 
est d'utiliser la fonction «Auto Topology...» de Industrial HiVision.

 Sélectionnez Edit > Auto Topology....

 Dans la boîte de dialogue de reconnaissance automatique de topologie 
(voir page 283 “Auto Topology...”), sélectionnez le mode d'exécution pri-
vilégié de la fonction «Auto Topology...» par Industrial HiVision et cliquez 
sur «OK».

Industrial HiVision interroge ensuite les équipements pour détecter leurs 
connexions. Industrial HiVision affiche les connexions identifiées dans l'inter-
face et commence à surveiller le statut de la connexion et de la charge du 
réseau. 

Industrial HiVision affiche les liaisons radio par des lignes en pointillés dans 
le cas d'un réseau local sans fil (WLAN). Étant donné que les stations 
d'accès peuvent être mobiles, l'itinérance (roaming) d'un point d'accès à un 
autre est un processus absolument normal. C'est pourquoi Industrial 
HiVision n'inclut pas l'état de la connexion dans la configuration de l'état des 
liaisons radio. 
Industrial HiVision reconnaît l’interruption de la liaison avec le point d’accès 
quitté après écoulement de la durée de polling pour la détermination de l'état 
du point d’accès.
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5.4.2 Connexion manuelle des équipements

Après la disposition des équipements la mieux adaptée à vos besoins, ajou-
tez les connexions entre les équipements.

 Cliquez au centre d'une icône d'équipement. Cliquez une nouvelle fois, 
puis déplacez le curseur en maintenant le bouton de la souris enfoncé sur 
l'icône de l'équipement avec lequel vous souhaitez établir la connexion.

5.4.3 Modelage d'une ligne de connexion

Industrial HiVision permet de modeler les lignes de connexion. À titre 
d'exemple, vous pouvez ainsi donner la forme réelle d'un anneau à un 
anneau HIPER.

 Sélectionnez la connexion pour plier la ligne ou lui conférer une forme 
courbe. Selon la forme de la connexion et la sélection, plusieurs possibi-
lités s'offrent à vous (voir les infobulles) :

 Ajout d'un point d'ancrage par simple clic sur le point de glissement. 
 Basculement entre « Add anchor point » [Ajout point d'ancrage] et 

« Change shape of curve » [Modification tracé de courbe] en resélec-
tionnant la connexion. 

 Suppression du point d'ancrage en double-cliquant. 
 Modification du tracé de courbe à l'aide du point de glissement. 
 Redressement d'un point de connexion par un simple clic sur le point 

de glissement. 
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Figure 36 :Modeler une connexion 
– gauche : modifier le tracé de courbe
– droite : ajout d'un point d'ancrage

5.4.4 Détermination de l'épaisseur du trait

Selon l'image d'arrière-plan choisie, les lignes peuvent se confondre avec 
celui-ci. Industrial HiVision vous offre la possibilité de modifier l'épaisseur du 
trait. Ainsi, les lignes ressortent mieux sur l'image d'arrière-plan.
L'épaisseur de trait pour l'ensemble du logiciel se configure dans le menu 
Preferences > Display > Device (voir page 382 “Appearance”).
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5.4.5 Autres connexions

À l'instar des connexions d'équipements, Industrial HiVision vous offre la 
possibilité de connecter entre eux des répertoires et des composants, excep-
tion faite des icônes et textes. L'image ci-dessous (voir la figure 37) vous 
montre un exemple de liaison avec un répertoire.

Figure 37 :Liaison avec un répertoire

5.4.6 Reconnaissance d'une connexion avec un 
autre dossier

Industrial HiVision marque d'un drapeau les connexions à un équipement ou 
un dossier hors du dossier actuel. À côté du drapeau, vous trouverez des 
informations sur la destination de la connexion. Si la connexion a plusieurs 
destinations, Industrial HiVision les regroupe et les affiche dans l'infobulle.
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En double-cliquant sur le drapeau,
 vous accédez directement au port indiqué dans la destination si un seul 

équipement est connecté ou,
 vous ouvrez un menu déroulant si le drapeau renvoie vers plusieurs des-

tinations. Le menu déroulant indique la destination de la connexion. 
Sélectionnez la connexion contenant les ports que vous souhaitez 
atteindre.

Figure 38 :Drapeaux d'identification de connexion

5.4.7 Détermination des propriétés de connexion

Définissez les propriétés de connexion.

 Cliquez avec le bouton droit de la souris sur le globe et sélectionnez dans 
le menu déroulant «Properties...» (voir page 305 “Propriétés d'une 
connexion”).

 Dans l'onglet «Connection», saisissez les ports auxquels la ligne est 
connectée. 
Cliquez dans l'arborescence jusqu'à ce que vous puissiez sélectionner le 
port de l'équipement avec lequel vous voulez connecter la ligne.

 Toujours dans l'onglet «Connection», sélectionnez les propriétés à sur-
veiller sous «Monitor». Par défaut, Industrial HiVision surveille automati-
quement la perte de connexion, la charge du réseau et la redondance du 
port.
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Figure 39 :État de surveillance d'une connexion
N - pas de surveillance de connexion
A - Surveillance de connexion active

5.4.8 Types de connexion

Pour faciliter la reconnaissance, Industrial HiVision affiche les connexions 
différemment selon leur nature :

Affichage Signification
Connexion normale

Connexion en veille

Connexion interrompue

Liaison radio

Liaison radio en veille

Liaison radio interrompue

Tableau 11 : Types de connexion
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5.4.9 Affichage du moyen de connexion

Industrial HiVision vous permet de distinguer le moyen de connexion grâce 
à l'icône des extrémités de la connexion (voir page 306 “Connection”).

Affichage Signification
Cuivre
Fibre de verre
Wireless (sans fil), ligne en dents de scie
Unmanaged (non géré)
Unknown (inconnu)

Tableau 12 : Affichage du moyen de connexion
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5.5 Les modifications de réseau 
au fil du temps

Il est rare que votre réseau soit statique. En règle générale et épisodique-
ment, de nouveaux équipements viennent s'ajouter, d'autres sont retirés et 
réutilisés à un autre emplacement.

5.5.1 Ajout d'équipements avec HiDiscovery

Le bouton HiDiscovery situé dans la barre d'outils permet d'ajouter aisément 
un nouvel équipement.

 Cliquez sur le bouton HiDiscovery dans la barre d'outils.
Industrial HiVision lance une nouvelle interrogation du réseau.
Les nouveaux équipements Industrial HiVision détectés ne disposant pas 
encore d’une adresse IP sont représentés par Hirschmann dans le dos-
sier «New Devices».
Les nouveaux équipements Industrial HiVision détectés disposant déjà 
d’une adresse IP sont représentés par Hirschmann dans le dossier cible 
pour la plage d’adresses(voir page 341 “Basics”) .

Comme décrit dans les pages précédentes, vous pouvez déplacer les nou-
veaux équipements dans votre dossier de schéma de réseau et établir les 
connexions.
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 Affectation de l'adresse IP
Après avoir ajouté un équipement à l'aide de HiDiscovery, Industrial 
HiVision vous permet d'affecter aisément une adresse IP à cet équipe-
ment (voir page 429 “IP Configuration”).

 Cliquez avec le bouton droit de la souris sur l'équipement A et sélec-
tionnez «IP Configuration». La boîte de dialogue «IP Configuration» 
permet de saisir les paramètres suivants
d'un nom d'équipement
– l’adresse IP
– le masque réseau
– de l'adresse IP de la passerelle

5.5.2 Ajouter des équipements par scan réseau

Un moyen d'ajouter un nouvel équipement avec une adresse IP préconfigu-
rée consiste à utiliser le bouton «Scan Network» de la barre d'outils.

 Cliquez sur le bouton «Scan Network» dans la barre d'outils.
Industrial HiVision démarre une requête réseau selon les réglages sous 
“Basics” on page 341. Industrial HiVision affiche les équipements nouvel-
lement détectés dans le dossier pour la plage d'adresses “Basics” on 
page 341.

Comme décrit dans les pages précédentes, vous pouvez déplacer les nou-
veaux équipements dans votre dossier de schéma de réseau et établir les 
connexions.
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5.5.3 Ajout manuel d'équipements

La création manuelle est un autre mode d'ajout d'équipement (voir page 145 
“–Création de nouveaux équipements”).

Comme décrit dans les pages précédentes, vous pouvez déplacer les nou-
veaux équipements dans votre dossier de schéma de réseau et établir les 
connexions.

5.5.4 Mise en service d’équipements Hirschmann

Industrial HiVision vous simplifie la mise en service d'équipements 
Hirschmann. Hors l'installation, vous pouvez mettre en route les équipe-
ments Hirschmann à partir de votre station d'administration réseau :

 Déterminez les équipements Hirschmann- avec HiDiscovery   (voir 
page 134 “Reconnaissance des équipements”).

 Configurez les paramètres IP (voir page 429 “IP Configuration”).

 Entrez l'adresse de destination d'alarme (voir page 431 “Trap Destina-
tion”).

 Dans le cas d'un nouvel équipement, modifiez le mot de passe SNMP à 
l'aide de l'interface Web.

 Saisissez le nouveau mot de passe SNMP dans Industrial HiVision (voir 
page 394 “Avancé”).
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5.5.5 Interruption de la surveillance des 
équipements

Afin de réduire votre charge de réseau, Industrial HiVision propose deux pos-
sibilités pour interrompre la surveillance des équipements et des dossiers :
 Faites glisser l'équipement dans le dossier «Unused Devices».
 Cliquez avec le bouton droit de la souris sur l’icône de l’équipement et 

sélectionnez «Unmanage» dans le menu déroulant.
Industrial HiVision affiche l'équipement en grisé.

5.5.6 Suppression d'équipements

Pour supprimer un équipement, procédez comme suit :

 Cliquez avec le bouton droit de la souris sur l’équipement et sélectionnez 
«Delete» dans le menu déroulant (voir page 104 “Cadre Folders [Réper-
toires]”).
Industrial HiVision vous permet de supprimer l’équipement ou de le dépla-
cer vers le dossier «Unused Devices».

5.5.7 Remplacer les équipements

Pour répondre aux exigences actuelles, vous remplacerez progressivement 
les équipements existants dans votre réseau de données par des équipe-
ments plus récents offrant de nouvelles fonctions.
Dans ce cas, Industrial HiVision met à votre disposition un outil de conver-
sion qui vous permet de sauvegarder la configuration d'un équipement Clas-
sic sous forme de fichier XML dans un chemin de fichier.
Vous trouverez une liste des équipements qui prennent cette fonction en 
charge sur la page de FAQ de Hirschmann.
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https://hirschmann-support.belden.com/kb/articles/how-can-i-migrate-the-
configuration-of-a-powermice-to-msp
 Sélectionnez l'équipement Classic que vous souhaitez remplacer par un 

équipement HiOS.
 Sélectionnez Configuration > MultiConfig™.
 Dans la boîte de dialogue MultiConfig™, sélectionnez : 

Device Settings > Advanced > Configuration Saver
 Vérifiez le chemin et le nom du fichier, puis cliquez sur «Write».

Industrial HiVision sauvegarde la configuration dans un fichier au format 
XML.

Lors de la prochaine étape, vous migrez la configuration sauvegardée pour 
l'équipement Classic sur l'équipement HiOS, que vous avez au préalable ins-
tallé et créé dans le plan réseau.
 Sélectionnez l'équipement HiOS auquel vous souhaitez appliquer la 

configuration de l'équipement Classic.
 Sélectionnez Configuration > MultiConfig™.
 Dans la boîte de dialogue MultiConfig™, sélectionnez : 

Device Settings > Advanced > Configuration Migrator
 À l'aide de la boîte de dialogue de sélection de fichier, sélectionnez le 

fichier XML enregistré préalablement. 
 Vérifiez le chemin et le nom du fichier journal dans lequel Industrial 

HiVision consignera le résultat de la migration, puis cliquez sur «Write».
Industrial HiVision transfère la configuration migrée de l'équipement Clas-
sic sur l'équipement HiOS.
Si la colonne «Status» de la boîte de dialogue indique que l'équipement 
HiOS a rejeté les données de configuration, vous trouverez les causes 
possibles dans le fichier journal.
Vous trouverez le chemin du fichier journal sous Configuration > 
Preferences > Advanced > Load/Save > Configuration Saver.
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5.6 Documentation du réseau

Industrial HiVision propose un certain nombre de fonctions qui vous assistent 
lors de la documentation de votre réseau.

5.6.1 Sauvegarder des projets Industrial HiVision

Industrial HiVision vous permet de sauvegarder vos données réseau 
actuelles et la configuration de Industrial HiVision dans un fichier de projet 
(voir “Save” on page 270 et “Save as...” on page 270)

5.6.2 Sauvegarde des données de rapports

Industrial HiVision enregistre les données de la fonction de rapport (voir 
page 324 “Rapports”) dans une base de données séparée, hors du projet. 
Cette base de données se trouve dans le sous-répertoire report_db du 
répertoire d'installation.
Étant donné que plusieurs projets peuvent se trouver dans ce sous-réper-
toire de bases de données de rapports de projets, Industrial HiVision crée un 
sous-répertoire pour chaque projet :
<INSTALL_DIR>/report_db/<UUID>/pm.h2.db
Ces UUID sont disponibles dans le menu d'aide de Kernel Info.
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5.6.3 Exportation du contenu de l'affichage 
détaillé

Industrial HiVision vous offre la possibilité d'exporter le contenu de l'affichage 
détaillé (voir page 272 “Export...”).

 Sélectionnez File > Export... et sélectionnez le type de fichier dans la 
fenêtre «Save».

5.6.4 Impression du contenu de l'affichage 
détaillé

Industrial HiVision vous permet d'imprimer le contenu de l'affichage détaillé.

 Sélectionnez File > Print.
Industrial HiVision crée un fichier PDF temporaire du contenu de la liste 
et ouvre le fichier PDF dans un logiciel d'affichage PDF installé dans votre 
station d'administration, tel Acrobat Reader.

5.6.5 Exportation de la liste des évènements

Industrial HiVision vous permet d'exporter la liste complète des évènements 
(voir page 273 “Export Events...”).

 Sélectionnez File > Export Events... et sélectionnez le type de fichier 
dans la fenêtre «Save».
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5.6.6 Impression de la liste des évènements

Industrial HiVision vous permet d'imprimer la liste complète des évènements.

 Sélectionnez File > Print Events.
Industrial HiVision crée un fichier PDF temporaire du contenu de la liste 
et ouvre le fichier PDF dans un logiciel d'affichage PDF installé dans votre 
station d'administration, tel Acrobat Reader.

5.6.7 Création d'une documentation relative à 
l'équipement

Industrial HiVision vous permet de créer une documentation relative à l'équi-
pement. Dans la documentation de l'équipement, Industrial HiVision génère 
un fichier PDF pour chaque équipement sélectionné. Le fichier PDF contient 
des données relatives à l'équipement ainsi que ses paramètres.

 Sélectionnez les équipements que vous souhaitez documenter dans la 
fenêtre de détails.

 Dans la barre de menus, sélectionnez Edit > Device Documentation > 
Document Selected Devices ou cliquez avec le bouton droit de la souris 
sur un équipement en surbrillance et sélectionnez «Document Selected 
Devices».

 Dans la fenêtre «Choose a directory for placing device documentation 
files», sélectionnez le dossier dans lequel Industrial HiVision doit enregis-
trer vos fichiers PDF et cliquez sur «Select».

Industrial HiVision enregistre un fichier PDF pour chaque équipement sélec-
tionné portant le nom : « nventory_<IP address>.pdf » dans ce dossier.
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5.6.8 Impression ou exportation du statut de 
configuration

Industrial HiVision vous permet d'imprimer ou d'exporter la configuration du 
statut (voir page 417 “Status Configuration”). 

 Sélectionnez Configuration > Status Configuration.

 Cliquez sur «Print».
Industrial HiVision crée un fichier PDF temporaire du contenu de la liste 
et ouvre le fichier PDF dans un logiciel d'affichage PDF installé dans votre 
station d'administration, tel Acrobat Reader.

 Cliquez sur «Export».
Industrial HiVision vous permet d'exporter la liste aux formats suivants :
 Fichier PDF
 Fichier HTML
 Fichier CSV (voir page 470 “Exportation CSV”)

5.6.9 Agent

Der Ordner «Agent» befindet sich im erweiterten Gerätebaum im Ord-
nerrahmen. Der Ordner «Agent» enthält die folgenden Informationen über 
das von Industrial HiVision entdeckte PSM-Gerät:
 «GVRP» - zeigt den Status des GVRP-Protokolls an.
 «VLANs» - zeigt die konfigurierten VLANs an.
 «LLDP Chassis ID» - zeigt die Chassis-ID an.
 «LLDP System Name» - zeigt den Gerätenamen an.
 «Number of Users» - zeigt die Anzahl der angeschlossenen Geräte am 

Port an.
 «Base MAC Address» - zeigt die MAC-Adresse des Geräts an.
 «Firmware Version» - zeigt die laufende Firmware-Version an.
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 «Other Firmware Info» enthält die folgenden Informationen über das 
PSM-Gerät:
 «Backup Firmware»- zeigt die gespeicherte Backup-Firmware an.
 «Stored Firmware» - zeigt die aktuell gespeicherte Firmware an.
 «Boot Code Firmware» - zeigt die gespeicherte Bootcode-Firmware 

an.
 «Interface» enthält die folgenden Informationen über das PSM-Gerät:

 «Netmask» - zeigt die konfigurierte Netzmaske an.
 «Default Gateway» - zeigt das konfigurierte Standard-Gateway an.
 «MAC Address» - zeigt die MAC-Adresse des Geräts an.
 «IP Address» - zeigt die IP-Adresse des Gerätes an.

 «IP Address Conflict» - zeigt den Status an, wenn ein IP-Adresskonflikt 
auftritt.
170
User Manual Industrial HiVision

Release 8.1 12/19



Configuration du réseau
6 Configuration du réseau

Lorsque vous affichez votre réseau avec les équipements et les connexions 
dans Industrial HiVision, vous pouvez configurer les équipements.
La fonction de configuration multiple (MultiConfig™) vous offre la possibilité 
d'effectuer des configurations sur l'équipement et dans Industrial HiVision 
pour :
 un ou plusieurs équipements
 une ou plusieurs propriétés d'équipement, y compris de l'ensemble des 

équipements
 un ou plusieurs détails d'équipement, y compris de l'ensemble des équi-

pements

Pour accéder à la boîte de dialogue MultiConfig™, sélectionnez au moins un 
équipement ou une propriété dans l'affichage détaillé et dans la barre de 
menus Configuration > MultiConfig™.

Commentaire : Tenez compte des effets sur vos ressources de système 
(voir page “Impact sur les ressources du système” on page 236).
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6.1 Utilisation de la boîte de 
dialogue

La boîte de dialogue MultiConfig™ contient 3 cadres :
 Arborescence de type interface Web
 Cadre d'objets
 Cadre des fonctions

Figure 40 :Vision d'ensemble de la boîte de dialogue MultiConfig™ 
1 – Arborescence 
2 – Cadre d’objet 
3 – Cadre de fonction 
4 – Éléments de commande
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6.1.1 Description de l'arborescence

Dans l’arborescence à base Web de type interface, sélectionnez la fonction 
que vous souhaitez configurer. Vous trouvez ici
– les fonctions à configurer sur les équipements
– et les propriétés que vous configurez pour la surveillance dans Industrial 

HiVision

6.1.2 Description du cadre d'objets

Le cadre d'objets contient un tableau d'objets que vous avez sélectionnés 
pour configurer l'affichage détaillé.
La première ligne du tableau contient le récapitulatif des statuts des objets 
du tableau.

Signification des symboles d’état situés après les objets :

Icône Signification
Industrial HiVision a lu les valeurs des paramètres et affiche les concordances 
dans le cadre de fonctions.
Action initiée, néanmoins pas encore commencée.

Industrial HiVision lit/transfère les valeurs de paramètres.

Passez le pointeur de souris sur le symbole pour obtenir des informations sur 
les particularités. 
À titre d'exemple, la présence d'entrées masquées dans un tableau est une 
particularité. Ces entrées masquées se perdent lors de l'écriture.
Industrial HiVision peut accéder à l'équipement. Une ou plusieurs valeurs 
manquent lors du transfert.
Passez le pointeur de souris sur le symbole pour obtenir plus d'informations.
Les objets ne fournissent aucune valeur.
La connexion à l'équipement est interrompue.
Passez le pointeur de souris sur le symbole pour connaître la cause de 
l'absence de lecture/d'écriture des valeurs.

Tableau 13 : Signification des symboles de statut
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6.1.3 Description du cadre de fonction

Dans le cadre de fonctions, Industrial HiVision regroupe une sélection de 
paramètres et actions. Industrial HiVision sélectionne les paramètres confi-
gurables et les actions exécutables qui représentent une intersection des 
objets et de la fonction sélectionnés.

Étant donné que les possibilités d'affichage des paramètres sont très nom-
breuses, vous trouverez des exemples d'application ci-après (voir page 177 
“Exemples pour l’utilisation de MultiConfig™”).

À l'aide des champs de sélection situés sur le bord gauche du cadre de fonc-
tions, sélectionnez les paramètres que vous souhaitez configurer.

Les icônes situés, le cas échéant, à côté des champs de sélection ont la 
signification suivante (voir le tableau 14).

Pour simplifier la saisie des paramètres répétés, Industrial HiVision permet 
de créer des préréglages (réglages par défaut) (voir page 178 “Application 
de la fonction Interlocuteur avec préréglage”).

Icône Signification
Les objets analysés fournissent différentes valeurs pour ce paramètre.

L'objet sélectionné ne fournit aucune valeur pour ce paramètre.

Certains objets ne fournissent aucune valeur pour ce paramètre.

Tableau 14 : Signification des symboles situés à côté des champs de sélection 
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Figure 41 :Préréglage pour la fonction MultiConfig™.

Étant donné que la fonction MultiConfig™ offre un grand nombre de 
méthodes de saisie sur les différents types d'équipement, Industrial HiVision 
permet de saisir tout type de valeur dans les champs de saisie.
Si Industrial HiVision découvre une incohérence lors de la saisie, Industrial 
HiVision l’indique par une police rouge.

Afin de pouvoir charger ou enregistrer des fichiers, vous devez saisir un che-
min d'accès indiquant l'emplacement de sauvegarde dans la boîte de dia-
logue correspondante. Industrial HiVision comprend les chemins absolus et 
relatifs. Lors de la saisie d’un chemin d'accès relatif, celui-ci commence par 
<Install-Dir>/service.
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6.1.4 Description des éléments de commande

 «Write»
Avec «Write», Industrial HiVision transfère les données des paramètres 
sélectionnés aux emplacements suivants :
– à chaque objet dans le tableau du cadre d’objet,
– à tous les objets portant le statut d'erreur, contenus dans le tableau du 

cadre d'objets,
– à chaque objet portant l'état d'erreur, contenu dans le tableau du cadre 

d'objets.
Le choix des objets sur lesquels vous souhaitez écrire se trouve dans le 
cadre d'objets en bas, sous «Write Mode».
Si vous écrivez les paramètres de configuration des équipements de cette 
manière, ceux-ci sont enregistrés dans la mémoire temporaire des équi-
pements. Pour l'enregistrement des données de configuration des équi-
pements, exécutez la dernière étape de configuration, à savoir la 
mémorisation de la nouvelle configuration des équipements.

 «Reload»
Avec la fonction «Reload», Industrial HiVision lit les données des para-
mètres sélectionnés des objets contenus dans le tableau du cadre 
d'objets.
Afin de pouvoir afficher les valeurs des paramètres d'un objet, cliquez sur 
l'objet dans le cadre d'objets.

 «Cancel»
A l'aide de «Cancel» Industrial HiVision ferme la boîte de dialogue. Les 
modifications effectuées après la dernière commande «Write» sont per-
dues.
Les actions déjà lancées  sont achevées par Industrial HiVision.

 «Help»
Avec la fonction «Help», Industrial HiVision ouvre l'aide en ligne à la page 
correspondante.
Si un exemple est disponible pour la boîte de dialogue ouverte (voir 
page 177 “Exemples pour l’utilisation de MultiConfig™”), Industrial 
HiVision ouvre l'aide en ligne à la page de l'exemple.
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6.2 Exemples pour l’utilisation 
de MultiConfig™

En fonction de l'option de menu que vous avez sélectionnée, vous trouverez 
différents affichages dans le cadre de fonctions. Les exemples suivants 
illustrent les différents affichages.

6.2.1 Même interlocuteur sur plusieurs 
équipements

Vous souhaitez saisir le même interlocuteur pour plusieurs équipements, par 
ex. Michel.

 Sélectionnez dans l'affichage détaillé la vue «Map» ou une autre vue 
représentant les équipements.

 Sélectionnez les équipements auxquels vous souhaitez affecter le même 
interlocuteur.

 Pour ouvrir la boîte de dialogue MultiConfig™, cliquez avec le bouton 
droit sur un équipement en surbrillance et sélectionnez MultiConfig™.

 Dans la boîte de dialogue MultiConfig™, sélectionnez dans l'arbores-
cence Device Settings > Basic Settings > System.
Vous trouverez le tableau avec les équipements concernés dans le cadre 
d'objets, et les paramètres à configurer dans le cadre de fonctions.

 Affichage des valeurs actuelles de paramétrage
 Pour afficher les valeurs des paramètres d'un équipement, cliquez sur 

une ligne du tableau dans le cadre d'objets.
 Pour afficher les valeurs de paramètres communes à chaque équipe-

ment, cliquez sur la première ligne «All Objects» du tableau dans le 
cadre d'objets.
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 Écriture de l'interlocuteur sur les équipements
 Cochez la case «Contact».
 Dans le champ de texte «Contact», saisissez le nom de l'interlocuteur, 

par ex. Michel.
 Pour transférer les modifications aux équipements et les y enregistrer 

temporairement, cliquez sur le bouton «Write».
 Pour sauvegarder les modifications effectuées sur les équipements 

dans la mémoire permanente, sélectionnez Device Settings > Basic 
Settings > Load/Save dans l’arborescence.

 Sélectionnez dans le menu déroulant «Action» l'option «Save to 
Device».

 Cliquez sur le bouton «Write».

 Application de la fonction Interlocuteur avec préréglage
Industrial HiVision vous permet de créer un nom comme préréglage afin 
de ne pas devoir ressaisir le nom lors de configurations ultérieures 
d’autres appareils.
 Cochez la case «Contact».
 Dans le champ de texte «Contact», saisissez le nom de l'interlocuteur, 

par ex. Michel.
 Cochez la case «Edit Presets». Industrial HiVision ouvre le tableau de 

préréglage. 
 Pour créer les paramètres sélectionnés comme préréglages, cliquez 

sur le bouton «New» à côté du tableau de préréglage.
 Pour donner au nouveau tableau un nom univoque, double-cliquez sur 

la cellule du nom de cette entrée et saisissez le nom, par ex. 
« Interlocuteur Michel ».

 Pour enregistrer la modification, cliquez sur le bouton «Write».
À l'avenir, vous pourrez choisir le préréglage « Interlocuteur Michel » et 
vous éviter ainsi la sélection puis la saisie du nom.
 Pour modifier une entrée de tableau existante, sélectionnez la ligne 

souhaitée, modifiez les paramètres et cliquez sur «Set».
 Pour sélectionner un objet dans le cadre d'objets, désélectionnez 

«Edit Presets» dans le cadre de fonctions.
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6.2.2 Mise à jour du logiciel sur les équipements 
similaires

Vous souhaitez effectuer une mise à jour du logiciel sur plusieurs équipe-
ments similaires.

 Sélectionnez dans l'affichage détaillé la vue de «Devices».
 Sélectionnez la catégorie d'équipement.
 Sélectionnez les équipements pour lesquels vous souhaitez effectuer une 

mise à jour du logiciel.
 Pour ouvrir la boîte de dialogue MultiConfig™, cliquez avec le bouton 

droit sur un équipement en surbrillance et sélectionnez MultiConfig™.
 Dans la boîte de dialogue MultiConfig™, sélectionnez dans l'arbores-

cence Device Settings > Basic Settings > Software.
Vous trouverez le tableau avec les équipements concernés dans le cadre 
d'objets, et les options à mettre à jour dans le cadre de fonctions.

 Pour ouvrir la fenêtre de sélection de fichier, cliquez dans le cadre de 
fonction «File» > .... Sélectionnez le fichier de mise à jour logicielle ou 
placez-le dans la ligne par glisser-déposer. Cliquez ensuite sur le bouton 
Open.

 Cochez les cases «Update» et «File».
 Pour transférer la mise à jour sur les équipements, cliquez sur le bouton 

«Write».
Dans la colonne «Status» du cadre d'objets, le symbole  vous indique 
la réussite du transfert.

 Pour activer le nouveau logiciel sur les équipements, effectuez un démar-
rage à froid des équipements avec (voir page 180 “Redémarrage de plu-
sieurs équipements”) :
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6.2.3 Redémarrage de plusieurs équipements

Industrial HiVision vous permet, grâce à la fonction MultiConfig™, de réini-
tialiser plusieurs équipements.
Industrial HiVision fait la distinction entre un redémarrage consécutif et un 
redémarrage simultané.

 «Restart (consecutively)»
Industrial HiVision envoie une commande de redémarrage à un équipe-
ment et attend jusqu'à ce que l'équipement ait exécuté l'opération. 
Industrial HiVision envoie ensuite la commande de redémarrage au pro-
chain équipement. 
Choisissez cette méthode si les équipements à redémarrer sont connec-
tés dans une même ligne avec la station d'administration de réseau.

 «Restart (simultaneously)»
Industrial HiVision envoie la commande de redémarrage presque simul-
tanément aux équipements à redémarrer. Choisissez cette méthode si la 
station d'administration de réseau accède directement aux équipements.

Commentaire : Lors du redémarrage, l’équipement interrompt le trans-
fert. Ceci peut entraîner la perte de la commande de redémarrage pour 
certains équipements.

 Dans la boîte de dialogue MultiConfig™, sélectionnez dans l'arbores-
cence Device Settings > Basic Settings > Restart (consecutively) 
ou Device Settings > Basic Settings > Restart (simultaneously).
Vous trouverez ensuite les options de redémarrage des équipements 
dans le cadre d'objets.

 Après la mise à jour du logiciel, cochez la case, par ex. dans la ligne 
«Cold Start».

 Cliquez sur le bouton «Write».
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6.2.4 Chargement/enregistrement de la 
configuration de plusieurs équipements

En fonction des équipements que vous avez sélectionnés, Industrial HiVision 
vous offre plusieurs options pour transférer des configurations :

Action Charger/enre-
gistrer

Charger/Enre-
gistrer via PC

Enregistrement sur l'équipement
Copier la configuration actuelle de la mémoire volatile de 
l'équipement dans la mémoire non volatile de l'équipement.

X

Enregistrement sur serveur TFTP (binaire)
Copier la configuration actuelle de la mémoire volatile de 
l'équipement en format binaire dans l'URL indiquée.

X

Enregistrement sur serveur TFTP (script)
Copier la configuration actuelle de la mémoire volatile de 
l'équipement dans l'URL indiquée en tant que script pouvant 
être lu et édité.

X

Chargement à partir de l'équipement
Copier la configuration de la mémoire non volatile de l'équipe-
ment dans la mémoire volatile de l'équipement.

X

Chargement à partir du serveur TFTP
Lire la configuration depuis l'URL indiquée dans la mémoire 
volatile de l'équipement.

X

Chargement à partir de serveur TFTP et enregistrement sur 
l'équipement
Lire la configuration depuis l'URL indiquée dans la mémoire 
volatile et dans la mémoire non volatile de l'équipement.

X

Suppression : configuration actuelle
Écraser la configuration dans la mémoire volatile de l'équipe-
ment avec la configuration de la mémoire non volatile de l'équi-
pement.

X

Suppression : configuration actuelle et depuis l'équipement
Supprimer la configuration de la mémoire volatile et la configu-
ration de la mémoire non volatile de l'équipement puis rempla-
cer par la configuration correspondant à l'état de livraison. 
Après le redémarrage suivant, l'adresse IP se trouvera égale-
ment dans l'état de livraison.

X

Enregistrement sur le PC (script)
Enregistrer la configuration de la mémoire volatile de l'équipe-
ment dans un fichier sur le PC en tant que script pouvant être 
lu et édité.

X

Enregistrement sur le PC (binaire)
Enregistrer la configuration de la mémoire volatile de l'équipe-
ment dans un fichier sur le PC au format binaire.

X

Tableau 15 : Options de transfert des configurations
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 Sélectionnez dans l'affichage détaillé l’onglet «Map» ou un onglet qui 
affiche les équipements.

 Sélectionnez les équipements pour lesquels vous souhaitez enregistrer 
une configuration ou sur lesquels vous souhaitez charger la configuration.

 Pour ouvrir la boîte de dialogue MultiConfig™, cliquez avec le bouton 
droit sur un équipement en surbrillance et sélectionnez MultiConfig™.

 Sélectionnez Device Settings > Basic Settings > Load/Save dans 
l’arborescence. Vous pouvez également sélectionner Device Settings > 
Basic Settings > Load/Save via PC. 
Vous trouverez ensuite le tableau avec les équipements concernés dans 
le cadre d'objets, et les possibilités de transfert de la configuration dans 
le cadre des fonctions.

 «Load/Save»
– Pour cet exemple, sélectionnez l’option «Load/Save via PC».
– Sélectionnez dans le menu déroulant «Action» le mode de transfert 

souhaité.
– Assurez-vous que la case soit cochée.

 Cochez la case «File» et saisissez le nom de fichier avec le chemin com-
plet, par ex. D:\Data\Network 
Management\Configurations/$CURRENT-
DATE/$IP_ADDRESS.$EXTENSION, ou l’URL 
tftp://10.0.1.159/configs/2009_10_28/$IP_ADDRESS.cfg.
Industrial HiVision permet de saisir un nom de fichier et une URL dans les 
options (voir page “Load/Save” on page 411). 
Lorsque Industrial HiVision écrit, il crée les sous-dossiers manquants.

 Pour transférer le fichier, cliquez sur le bouton «Write».
Dans la colonne «Status» du cadre d'objets, le symbole  vous indique 
la réussite du transfert.

Chargement à partir de PC (script)
Charger la configuration dans la mémoire volatile à partir d'un 
fichier sur le PC en tant que script pouvant être lu et édité.

X

Chargement à partir du PC (binaire)
Charger la configuration à partir d'un fichier sur le PC au format 
binaire dans la mémoire volatile de l'équipement.

X

Action Charger/enre-
gistrer

Charger/Enre-
gistrer via PC

Tableau 15 : Options de transfert des configurations
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6.2.5 Configuration d'une destination d'alarme sur 
plusieurs équipements

Vous souhaitez configurer la même destination d'alarme sur plusieurs équi-
pements.

 Sélectionnez dans l'affichage détaillé la vue «Map» ou une autre vue 
représentant les équipements.

 Sélectionnez les équipements sur lesquels vous souhaitez configurer la 
même destination d'alarme.

 Pour ouvrir la boîte de dialogue MultiConfig™, cliquez avec le bouton 
droit sur un équipement en surbrillance et sélectionnez MultiConfig™.

 Dans la boîte de dialogue MultiConfig™, sélectionnez dans l'arbores-
cence Device Settings > Diagnostics > Status Config > Trap Des-
tinations.
Vous trouverez le tableau avec les équipements concernés dans le cadre 
d'objets, et le tableau des destinations d'alarme dans le cadre de fonc-
tions.

 Pour créer une nouvelle entrée dans le tableau,
Cliquez sur «New».

 Saisissez l'adresse IP de la destination d'alarme, sélectionnez le statut 
actif puis 
Cliquez sur «OK».
La ligne avec la nouvelle destination d'alarme s'affiche dans le tableau.

 Pour transférer la modification aux équipements et l'enregistrer temporai-
rement,
Cliquez sur «Write».

 Pour enregistrer les modifications effectuées sur les équipements dans la 
mémoire permanente, sélectionnez Device Settings > Basic 
Settings > Load/Save dans l’arborescence puis l’action «Save to 
Device». Cliquez sur le bouton «Write».
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6.2.6 Création de règles de pare-feu sur plusieurs 
équipements

La boîte de dialogue MultiConfig™ permet de déterminer les règles de pare-
feu. La boîte de dialogue MultiConfig™ permet également d’enregistrer les 
préréglages pour les règles de pare-feu puis de charger les règles de pare-
feu sur d’autres équipements EagleOne.

 Tableau avec les règles de pare-feu MultiConfig™
La boîte de dialogue MultiConfig™ représente une table d’indexation 
avec des lignes contenant les règles de pare-feu enregistrées sur l’équi-
pement EagleOne sélectionné.
Lorsque vous sélectionnez plusieurs équipements, la table d’indexation 
peut afficher une quantité partielle des règles enregistrées sur les équipe-
ments EagleOne sélectionnés. La table d’indexation identifie la quantité 
partielle avec un signe d’inégalité. Le signe d’inégalité indique que la 
règle est différente sur les équipements sélectionnés. Cette différence 
des règle peut concerner les informations contenues dans la règle ou 
l’ordre de la règles sur les différents équipements. Lorsque vous enregis-
trez le préréglage dont les règles sont identifiées par un signe d’inégalité, 
MultiConfig™ enregistre la cellule inégale comme cellule vide. Vous pou-
vez supprimer des lignes contenant les cellules vides ou saisir les infor-
mations nécessaires.
Les boîtes de dialogue de pare-feu disposent d’une flèche orientée vers 
le haut et d’une flèche orientée vers le bas. Les touches flèche permettent 
de modifier l’ordre des règles dans la table d’indexation.

Commentaire : Il n’est pas possible de modifier les informations dans les 
lignes identifiées par un signe d’inégalité. Vous pouvez toutefois suppri-
mer les lignes de la table d’indexation.

 Exemple
Le serveur de mise à jour d'antivirus exige l'autorisation d'un autre port 
dans les pare-feu de votre entreprise. Pour ce faire, vous devez ajouter 
aux pare-feu concernés une nouvelle 1ère règle qui débloque ce port.
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 Enregistrer une nouvelle règle en préréglage
 Sélectionnez dans l'affichage détaillé l’onglet «Map» ou un onglet qui 

affiche des équipements.
 Avec un clic du bouton droit de la souris sur l’équipement EagleOne-

sélectionnez la fonction MultiConfig™ dans le menu déroulant.
 Dans l'arborescence de la boîte de dialogue de MultiConfig™, sélec-

tionnez le filtre de paquets correspondant.
 Dans le cadre fonctionnel de la boîte de dialogue MultiConfig™, 

cochez la case «Edit Presets».
 Pour enregistrer un préréglage pour les règles de la table d’indexation, 

cliquez dans le cadre «Edit Presets» sur le bouton «New».

Commentaire : Si vous souhaitez enregistrer l’ensemble du contenu 
de la table d’indexation comme préréglage, désélectionnez les règles 
de la table d’indexation. SI vous souhaitez enregistrer 1 ou plusieurs 
règles comme préréglage, sélectionnez la/les règle(s) correspon-
dante(s) dans la table d’indexation.

 Après un double-clic sur la cellule de nom dans le tableau «Edit Pre-
sets», saisissez un nom univoque pour le préréglage.

 Après la saisie du nom, par ex. « Jeu de règles existant », cliquez sur 
le bouton «Set». Vous pouvez également utiliser la touche Entrée sur 
votre clavier.

 Une fois les règles enregistrées comme préréglage, supprimez les 
règles dans la table d’indexation.

 Créez 1 nouvelle règle dans la table d’indexation ou plusieurs règles 
pour la validation des ports, le cas échéant.

 Pour enregistrer la nouvelle règle ou plusieurs règles comme préré-
glage dans la base de données Industrial HiVision, cliquez dans le 
cadre «Edit Presets» sur le bouton «New».
– Après un double-clic sur la cellule de nom dans le tableau «Edit 

Presets», saisissez un nom univoque pour le préréglage.
– Après la saisie du nom, par ex. « Mise à jour antivirus », cliquez sur 

le bouton «Set». Vous pouvez également utiliser la touche Entrée 
sur votre clavier.

 Pour rétablir les règles d’origine, sélectionnez le jeu de règles préréglé 
« Jeu de règles existant » dans le tableau «Edit Presets».

 Pour enregistrer les données sur l’équipement, cliquez sur le bouton 
«Write».
Dans le cadre d’objet, le symbole  dans la colonne «Status» 
indique que MultiConfig™ a enregistré les règles que l’équipement.
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Après ces actions, l'équipement à pare-feu se trouve à nouveau dans son 
état d'origine et MultiConfig™ a sauvegardé la présélection « Mise à jour 
antivirus » dans Industrial HiVision.
 Fermez ensuite la boîte de dialogue MultiConfig™.

 Ajouter une nouvelle règle dans les équipements à pare-feu 
concernés
 Sélectionnez dans l'affichage détaillé l’onglet «Map» ou un onglet qui 

affiche des équipements.
 Sélectionnez les équipements à pare-feu pour lesquels vous souhai-

tez ajouter une nouvelle règle
 Cliquez avec le bouton droit de la souris sur la connexion et sélection-

nez « MultiConfig™ ».
 Pour ajouter la nouvelle règle d'autorisation du port en tant que pre-

mière règle, cochez la première règle.
Si la case «Edit Presets» n’est pas cochée, sélectionnez le préréglage 
« Mise à jour antivirus » dans le menu déroulant.

Industrial HiVision ajoute les règles avec la présélection « Mise à jour 
antivirus » au-dessus de la règle sélectionnée.

Commentaire : Si les règles sont identiques pour les équipements dans 
cette boîte de dialogue, Industrial HiVision permet d’ajouter les nouvelles 
règles au-dessus de la dernière règle.

 Pour enregistrer les données sur l’équipement, cliquez sur le bouton 
«Write».
Dans le cadre d’objet, le symbole  dans la colonne «Status» 
indique que MultiConfig™ a enregistré les règles que l’équipement.

 Fermez ensuite la boîte de dialogue MultiConfig™.
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 Informations générales pour le tableau Edit Presets
 «Edit Presets» activé

lorsque ce mode est activé, vous pouvez afficher et modifier les 
règles. 
– Pour afficher une présélection dans le cadre du bas, sélectionnez 

le préréglage correspondant.
– Pour sauvegarder les règles du cadre du bas dans les présélec-

tions, cliquez sur le bouton «New».
– Pour enregistrer un préréglage, sélectionnez le préréglage respec-

tif dans le menu déroulant «Edit Presets». Modifiez les règles dans 
le cadre du bas. Terminez l'action avec «Set»].

 «Edit Presets» désactivé :
lorsque ce mode est désactivé, vous pouvez ajouter des règles.
– Pour rajouter des règles issues d'une présélection dans les règles 

du cadre du bas, cochez la ligne au dessus de laquelle vous sou-
haitez insérer les règles dans le cadre et sélectionnez la présélec-
tion correspondante.

– Pour ajouter des règles issues d’un préréglage à la fin des règles 
dans le cadre du bas, décochez les lignes dans le cadre du bas et 
sélectionnez le préréglage correspondant.

6.2.7 Industrial HiVision-Eigenschaft 
konfigurieren

Die Verfügbarkeit Ihrer Vermittlungskomponenten hat höchste Priorität. 
Deshalb wollen Sie durch Industrial HiVision besonders informiert sein, wenn 
die Redundanz der Versorgungsspannung entfällt. 
In der Standard-Statuskonfiguration des Netzteil-Status von Industrial 
HiVision
– ordnet Industrial HiVision dem Wert „Nicht installiert“ den Status „OK“ zu.
– ordnet Industrial HiVision dem Wert „Nicht verfügbar“ den Status „Kein 

Status“ zu.
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In beiden Fällen möchten Sie aber den Status „Warnung“ erhalten.

 Öffnen Sie in der Detaildarstellung die Registerkarte «Properties».
 Wählen Sie in der Dropdown-Liste «Property:» die Eigenschaft «Status» 

(«Power Supply»).
 Markieren Sie in der Tabelle die Netzteile, für die Sie die Konfiguration 

ändernwollen.
 Zum Öffnen des MultiConfig™-Dialoges klicken Sie mit der rechten 

Maustaste auf eine markierte Zeile, undwählen Sie MultiConfig™.
 Im MultiConfig™-Dialog wählen Sie im Menübaum «Status Config».

Daraufhin finden Sie im Objekt-Rahmen die Tabelle mit den betroffenen 
Geräten und im Funktions-Rahmen die Möglichkeiten zur Einstellung der 
Statuskonfiguration.

 Markieren Sie folgenden Kontrollkästchen:
– «Value» = «Not Installed»
– «Value» = «Unavailable»

 Wählen Sie in der Dropdown-Liste der beiden Zeilen den Status «War-
ning» aus.

 Um die Änderungen zu speichern, klicken Sie die Schaltfläche «Write».

6.2.8 Sauvegarder les valeurs de référence par 
équipement

En plus de l'édition de valeurs identiques sur plusieurs équipements, la fonc-
tion MultiConfig™ vous permet en outre d'éditer des valeurs individuelles sur 
plusieurs équipements. Vous trouverez un exemple sous “Réglages décisifs 
en matière de sécurité des équipements dans le réseau” on page 213.
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6.2.9 Synchronisation de mot de passe

Industrial HiVision permet de synchroniser les mots de passe SNMP v1/v2 
avec les mots de passe SNMP v3. Cette fonction permet de modifier les mots 
de passe SNMP v1/v2 simultanément dans plusieurs boîtes de dialogue. 
Cette fonction est utile dans des situations dans lesquelles le réseau est éga-
lement surveillé par une autre système d’administration de réseau utilisant 
exclusivement SNMP v1/v2 pour l’accès aux équipements.

La fonction modifie les mots de passe SNMP v1/v2 dans les boîtes de dia-
logue suivantes :
 MultiConfig™ > Device Security > SNMP V1/V2 > Stations
 MultiConfig™ > Program Settings > Device Credentials Pour les 

paramètres «V1».

Pour synchroniser les mots de passe, procédez comme suit :
 Assurez-vous que Industrial HiVision utiliser SNMP v3 pour l’accès aux 

équipements sélectionnés.
 Dans le cade d’équipement MultiConfig™, sélectionnez l’équipement 

supérieur.
 Ouvrez la boîte de dialogue MultiConfig™ > Program Settings > 

Device Credentials.
 Le champ «SNMP Version» indique la version SNMP utilisée pour 

l’accès à l’équipement.
 Contrôlez chaque équipement cité dans le cadre d’équipement 

MultiConfig™.
 Sélectionnez les équipements pour lesquels vous souhaitez synchroniser 

les mots de passe.
 Cliquez avec le bouton droit sur un équipement sélectionné.
 Sélectionnez «MultiConfig™» dans la liste déroulante.
 Ouvrez la boîte de dialogue MultiConfig™ > Device Security > SNMP 

V3 > Password/SNMP Access.
 Saisissez les mots de passe SNMP v3 dans les champs «Read-only 

password (user)» et «Read-write password (admin)». Vous pouvez réuti-
liser les mots de passe actuels ou saisir un nouveau mot de passe dans 
les champs.

 Cochez la case «Synchronize password to v1/v2 community».
 Cliquez sur le bouton «Write».

Commentaire : L’utilisation du protocole SNMP v1/v2 présente un risque 
pour la sécurité.
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6.2.10 Fonction de recherche MultiConfig™

La fonction de recherche MultiConfig™ analyse l’arborescence et les boîtes 
de dialogue à la recherche d’une concordance avec le terme saisi dans le 
champ de recherche. Cette fonction permet de trouver rapidement une fonc-
tion. Après la saisie du premier caractère dans le champ de recherche, 
Industrial HiVision commence à rechercher la suite de caractères dans les 
nœuds d’arborescence et les boîtes de dialogue. Industrial HiVision affiche 
ensuite exclusivement les nœuds d’arborescence et les boîtes de dialogue 
où ladite suite de caractères est trouvée.

Les résultats de la fonction de recherche peuvent contenir une boîte de dia-
logue vide ou une boîte de dialogue ne contenant pas le terme recherché. 
Ceci peut arriver lorsque Industrial HiVision trouve la fonction dans une boîte 
de dialogue, mais que tous les équipements sélectionnés ne disposent pas 
de cette fonction. Lorsqu’un des équipements au sein d’un groupe d’équipe-
ments ne dispose pas de la fonction qui contient le terme recherché, la fonc-
tion recherchée est masquée par Industrial HiVision.

6.2.11 MultiConfig™User Management

La fonction MultiConfig™ «User Management» permet d’indiquer simultané-
ment les informations de connexion d’utilisateur sur plusieurs équipements 
d’un réseau. La fonction «User Management» est exclusivement disponible 
pour les équipements HiOS.

Lorsque vous modifiez des informations de connexion d’utilisateur dans la 
boîte de dialogue «User Management», Industrial HiVision demande la sai-
sie d’un «Password». Cette requête est effectuée pour des raisons de sécu-
rité. Industrial HiVision n’enregistre pas les mots de passe d’équipement et 
n’interroge pas les mots de passe enregistrés sur un équipement. Le mot de 
passe saisi lors de la modification peut être un nouveau mot de passe ou, s’il 
est connu, le mot de passe actuel enregistré sur l’appareil pour l’utilisateur 
correspondant.

Pour modifier les informations de connexion d’une personne, sélectionnez 
l’utilisateur correspondant et cliquez sur le bouton «Edit». Les règles citées 
dans le tableau ci-dessous sont applicables :
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Paramètres Signification
Access Détermine l’utilisateur avec lequel vous accédez à l’équi-

pement. Industrial HiVision ne permet respectivement que 
l’accès d’un seul utilisateur.

Commentaire : La liste suivante contient les conditions 
préalables pour l’activation de l’accès pour un utilisateur.
• Cochez la case «Active».
• Déterminez un mot de passe.
• Décochez la case «User locked».

Username Nom du compte utilisateur.

Commentaire : Pour la modification du nom d’utilisateur, 
il est nécessaire de déterminer préalablement un mot de 
passe.

Active Active/désactive le compte utilisateur.

Valeurs possibles :
 cochée

Le compte utilisateur est activé : Industrial HiVision 
utilise les informations de connexion d’utilisateur pour 
la connexion à l’équipement.

 décochée
Le compte utilisateur est désactivé :

Commentaire : La désactivation de l’utilisateur présup-
pose que vous décochez la case «Access».

Tableau 16 : MultiConfig™«User Management»
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Password Détermine le mot de passe avec lequel Industrial HiVision 
se connecte à un équipement.

Valeurs possibles :
 6–64 caractères alphanumériques
 y compris les caractères spéciaux suivants :

!#$%&'()*+,-./:;<=>?@[\\]^_`{}~

Lorsque vous cochez la case «Policy Check», l'équipe-
ment contrôle si le mot de passe est conforme aux direc-
tives définies dans la boîte de dialogue Device Security > 
User Management > Global.

Commentaire : Industrial HiVision interdit l’utilisation de 
2 astérisques consécutifs, par ex « ** ».

Access Role Détermine le rôle d’autorisation régulant l’accès aux diffé-
rentes fonctions de l’équipement.

Valeurs possibles :
 unauthorized

L’utilisateur est verrouillé et l’équipement refuse la 
déconnexion de l’utilisateur. Affectez cette valeur pour 
verrouiller provisoirement le compte utilisateur.

 guest
L’utilisateur est uniquement autorisé à surveiller 
l’équipement.

 auditor
L’utilisateur est autorisé à surveiller l’équipement et à 
enregistrer le fichier log dans la boîte de dialogue 
« Diagnostic > Rapport > Audit Trail ».

 operator
L’utilisateur est autorisé à surveiller et à configurer 
l’équipement – à l’exception des paramètres de sécu-
rité pour l’accès à l’équipement.

 administrator
L’utilisateur est autorisé à surveiller et à configurer 
l’appareil.

Paramètres Signification

Tableau 16 : MultiConfig™«User Management»
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User locked Indique si le compte utilisateur est verrouillé en raison d’un 
trop grand nombre de tentatives de connexion infruc-
tueuses.

Valeurs possibles :
 cochée

L’équipement a été déconnecté automatiquement en 
raison d’un trop grand nombre de tentatives de 
connexion infructueuses.
Seul l'équipement peut cocher cette case.

 décochée
Permet l’accès pour l’utilisateur.

Commentaire : Pour le déverrouillage du compte utilisa-
teur, vous devez vous connecter à Industrial HiVision en 
tant qu’administrateur.

Policy Check Détermine si Industrial HiVision contrôle la conformité du 
mot de passe à la directive définie lors de la configuration 
ou de la modification du mot de passe.

Valeurs possibles :
 cochée

L’équipement contrôle si le mot de passe est 
conforme à la directive définie dans la boîte de dia-
logue User Management > Global.

 décochée
L’équipement accepte le mot de passe sans le vérifier.

SNMP Auth Type Détermine le protocole d’authentification utilisé par l’équi-
pement lors de l’accès de l’utilisateur avec SNMPv3.

Valeurs possibles :
 hmacmd5

L'équipement utilise pour ce compte utilisateur le pro-
tocole HMAC-MD5.

 hmacsha
L'équipement utilise pour ce compte utilisateur le pro-
tocole HMAC-SHA.

SNMP Encryption Type Détermine le protocole de cryptage utilisé par l’équipe-
ment lors de l’accès de l’utilisateur avec SNMPv3.

Valeurs possibles :
 none

Pas de cryptage
 des

Cryptage DES
 aesCfb128

Cryptage AES 128

Paramètres Signification
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User Manual Industrial HiVision
Release 8.1 12/19 193



Configuration du réseau 6.2 Exemples pour l’utilisation de
MultiConfig™
6.2.12 MultiConfig™ Time Sensitive Networking

Hirschmann-Geräte unterstützen die zeitgesteuerte Kommunikation (bzw. 
„Time-aware queuing“) gemäß IEEE 802.1Qbv. Diese TSN-Funktion bietet 
den TSN-fähigen Ports die Möglichkeit, Datenpakete für jede zeitgesteuerte 
Datenverkehrsklasse im Verhältnis zu einem in der Gate Control List defi-
nierten Zyklus zu übertragen. Das VLAN-Tag eines Ethernet-Paketes – oder 
im Fall eines unmarkierten Paketes – enthält die Priorität.

Diese Funktion ermöglicht die Vermeidung von Latenzen und Datenver-
lusten aufgrund von Überlast für reservierte Datenströme. Die präzise Syn-
chronisation von Zyklen und Gate-Status mittels IEEE 1588 (PTP) 
ermöglicht eine überlastfreie Kommunikation mit geringer Latenz. Als 
Voraussetzung gilt, dass jedes Gerät im Netz IEEE 802.1Qbv unterstützt.

Um die Überwachung der TSN-Ports zu unterstützen, stellt Industrial 
HiVision ein TSN-Widget über das Dashboard bereit. Weitere Informationen 
zum TSN-Widget finden Sie in Kapitel “Widget TSN Schedule” on page 450.

Weitere Informationen zu TSN-Netzen finden Sie im E-Book „TSN for Dum-
mies“ unter: 
https://www.belden.com/resources/knowledge/ebooks/time-sensitive-
networking-for-dummies-lp

 TSN-Beispielnetz
Vor der Konfiguration des TSN-Zeitplanes mithilfe von MultiConfig™ ist 
die Konfiguration bestimmter Funktionen auf den Geräten erforderlich. 
Für die Konfiguration der in TSN-Netzen verwendeten Geräte mithilfe 
vonMultiConfig™ gelten die folgenden Voraussetzungen:
 Konfiguration der VLANs und der VLAN-Portzugehörigkeit
 Konfiguration der Forwarding Database für den TSN-Datenstrom

Beispielsweise konfigurieren wir ein paralleles Netz dahingehend, dass 
ein kritischer Datenstrom zwischen den Endgeräten weitergegeben wird.

Figure 42 :TSN-Netz mit TSN-fähigen Geräten

Talker ListenerDevice 1 Device 2

1/1 1/2 1/1 1/3
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Die Zykluszeit ist anwendungsspezifisch. Im vorliegenden Beispiel 
kommt ein Zykluszeit-Wert von 1000000 ns zur Anwendung. Um die zeits-
pezifischen Einstellungen für die TSN-Funktion zu konfigurieren, bestim-
men und berechnen Sie zunächst die folgenden Verzögerungen.
 Die Laufzeitverzögerung hängt von der Kabellänge ab (ca. 5 ns/m). 
 Bridge-Verzögerung = Empfangsverzögerung + Sendeverzögerung

– Empfangsverzögerung = unabhängige Verzögerung + abhängige 
Verzögerung des empfangenden Ports

– Sendeverzögerung = unabhängige Verzögerung + abhängige 
Verzögerung des sendenden Ports

 Gate-Offenhaltezeit = Laufzeitverzögerung + Bridge-Verzögerung
 Die minimale Gate-Offenhaltezeit ist der Zeitraum, der für die Übertra-

gung eines Paketes erforderlich ist, das aus der Dienstdateneinheit 
(SDU) + 36 Byte besteht, mit der maximal zulässigen Verzögerung.
Um die minimale Gate-Offenhaltezeit zu berechnen, multiplizieren Sie 
die Byte-Gesamtzahl mit einem Faktor, der von der TX-Übertragungs-
rate abhängig ist (80 ns für 100 MBit/s und 8 ns für 1 GBit/s).

 Bei der Zeitplanung für die Gates, die für die Weitergabe von 1 Paket 
vorgesehen sind, muss der interne Overhead berücksichtigt werden. 
Erwägen Sie die Verwendung der folgenden Overhead-Werte: 
1.400 ns für 100 MBit/s und 180 ns für 1 GBit/s.

Commentaire : Die Zeiten für die Empfangs- und die Sendeverzögerung 
für Hirschmann-Geräte finden Sie in der Gerätedokumentation.
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 TSN-Beispielberechnung
Im vorliegenden Beispiel kommen RSPE-Geräte mit der Software-Ver-
sion 07.3.00 zur Anwendung.
Sie berechnen die Verzögerungen für das TSN-Netz und die Geräte wie 
folgt:

 Die folgende Liste enthält die Merkmalswerte des Senders:
– Sendet 1 Datenpaket mit einer 300 Byte langen SDU im Zyklus mit 

Zeit t = 0.
12 MAC-Oktette + 4 VLAN-Oktette + 300 SDU-Oktette + 4 FCS-
Oktette = Ethernet-Datenpaket mit einer Länge von 320 Oktetten

 Die folgende Liste enthält die Merkmalswerte von Gerät 1:
– empfängt das Datenpaket über ein Twisted-Pair-Kupferkabel an 

Port 1/1; die Übertragungsrate beträgt 1 GBit/s
– Kabellänge zwischen Sender und Gerät 1: 10 m
– überträgt das Datenpaket über einen LWL an Port 1/2; die Übertra-

gungsrate beträgt 1 GBit/s

 Die folgende Liste enthält die Merkmalswerte von Gerät 2.

Verzögerung Gerät 1
Laufzeitverzögerung 10 m × 5 ns/m 50 ns

Bridge-Verzögerung (RX) Unabhängige Verzögerung port 1/1 1094 ns
Abhängige Verzögerung 8 ns/Oktett 

× 300 Oktette
2400 ns

Bridge-Verzögerung (TX) Unabhängige Verzögerung port 1/2 530 ns
Bridge-Verzögerung 
(gesamt)

4024 ns

Gate-Offenhaltezeit Laufzeitverzögerung 50 ns
Bridge-Verzögerung 
(gesamt)

4024 ns

Gate-Offenhaltezeit (gesamt) ~4100 ns

Minimale Gate-Offenhal-
tezeit

TX-Übertragungsrate 8 ns/Oktett 
× 340 Oktette

2720 ns

Interner Overhead Wert für 1 GBit/s 180 ns
PTP-Genauigkeitsmarge 1 µs 1000 ns
Minimale Gate-Offenhal-
tezeit

~3900 ns

Tableau 17 : Berechnungstabelle – Gerät 1
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– empfängt das Datenpaket über einen LWL an Port 1/1; die Übertra-
gungsrate des Ports beträgt 1 GBit/s

– Kabellänge zwischen Gerät 1 und Gerät 2: 50 m
– überträgt das Datenpaket über ein Twisted-Pair-Kupferkabel an 

Port 1/3; die Übertragungsrate beträgt 100 MBit/s

 Die folgende Liste enthält die Merkmalswerte des Empfängers:
– empfängt das Datenpaket an einem Kupfer-Port; die Übertra-

gungsrate des Ports beträgt 100 MBit/s

Verzögerung Gerät 2
Gate-Offenhaltezeit von 
Gerät 1

4100 ns

Bridge-Verzögerung von 
Gerät 1 (TX)

Abhängige Verzögerung 0 ns

Laufzeitverzögerung 50 m × 5 ns/m 250 ns

Bridge-Verzögerung (RX) Unabhängige Verzögerung port 1/1 954 ns
Abhängige Verzögerung 8 ns/Oktett 

× 300 Oktette
2400 ns

Bridge-Verzögerung (TX) Unabhängige Verzögerung port 1/31

1. Aufgrund der Gerätearchitektur weist Port 1/3 nach der Gate-Öffnung eine zusätzliche 
Verzögerung auf, die von der Datenpaketlänge abhängig ist.

9900 ns
Bridge-Verzögerung (gesamt) 5040 ns + 5200 ns 13254 ns

Gate-Offenhaltezeit Gate-Offenhaltezeit von 
Gerät 1

4100 ns

Bridge-Verzögerung von 
Gerät 1 (TX)

0 ns

Laufzeitverzögerung 250 ns
Bridge-Gesamtverzögerung 
von Gerät 2

13254 ns

Gate-Offenhaltezeit (gesamt) ~ 17.650 n
s

Minimale Gate-Offenhaltezeit TX-Übertragungsrate 80 ns/Oktett × 
340 Oktette

27200 ns

Interner Overhead Wert für 100 MBit/s 1400 ns
PTP-Genauigkeitsmarge 1 µs 1.000 ns
Minimale Gate-Offenhaltezeit ~29.600 n

s

Tableau 18 : Berechnungstabelle – Gerät 2
User Manual Industrial HiVision
Release 8.1 12/19 197



Configuration du réseau 6.2 Exemples pour l’utilisation de
MultiConfig™
– Kabellänge zwischen Gerät 2 und dem Empfänger: 10 m

 Beispielkonfiguration
Der folgende Arbeitsschritt beschreibt die Konfiguration von Gerät 1. Die 
Konfiguration von Gerät 2 hat auf dieselbe Weise zu erfolgen.

Bei der globalen Aktivierung der TSN-Funktion weisen die TSN-fähigen 
Ports eine gemeinsame Forwarding Database (FDB) auf, die bis zu 
256 Einträge enthält.

Die Gate Control List (GCL) legt fest, wann das Übertragungs-Gate für 
den TSN-Datenstrom geöffnet werden soll. Die Gate Control List enthält 
bis zu 256 Einträge.

Commentaire : Dieses Beispiel geht davon aus, dass für die Geräte wei-
terhin TSN-Standardeinstellungen und Zeitsynchronisierungseinstellun-
gen konfiguriert sind.

Um die Zykluszeit zu konfigurieren, gehen Sie wie folgt vor:
 Öffnen Sie die Registerkarte «Devices».
 Führen Sie einen Doppelklick auf das TSN-Gerät aus, das Sie als 

Gerät 1 verwenden möchten.

Empfänger-Verzögerung
Gate-Offenhaltezeit von 
Gerät 2

17650 ns

Bridge-Verzögerung von 
Gerät 2 (TX)

Abhängige Verzögerung 80 ns/Oktett 
× 300 Oktette

2400 ns

Laufzeitverzögerung 10 m × 5 ns/m 50 ns

Empfangszeit Gate-Offenhaltezeit von 
Gerät 2

17650 ns

Bridge-Verzögerung von 
Gerät 2 (TX)

24000 ns

Laufzeitverzögerung 50 ns
PTP-Genauigkeitsmarge 1 µs 1000 ns
Empfänger-Empfangszeit 
(gesamt)

~42700 ns

Tableau 19 : Empfänger-Berechnungstabelle
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 Öffnen Sie die Registerkarte «List».
 Führen Sie einen Rechtsklick auf Port 1 aus.
 Wählen Sie in der Dropdown-Liste die Option «MultiConfig™».
 Öffnen Sie den Dialog TSN > Configuration.
 Geben Sie in das Feld  eine Zykluszeit von 1000000 ein.
 Um die Änderungen auf dem Gerät zu speichern, klicken Sie die 

Schaltfläche «Write».
 Legen Sie die Parameter für Gerät 2 fest.

Figure 43 :Geben Sie die Zykluszeit ein.

Die Arbeitsschritte zeigen die für Gerät 1 berechneten Werte an, die von 
tableau 17 on page 196 übernommen wurden. Um die Parameter für 
Gerät 2 zu konfigurieren, verwenden Sie die in tableau 17 on page 196 
berechneten Werte. Sie weisen die kritischen Daten dem Datenstrom mit 
Priorität 5 zu. 

 Öffnen Sie den Dialog TSN > Gate Control List > Configured.
 Markieren Sie die Zeile 1, und klicken Sie die Schaltfläche «Edit».
 Geben Sie in das Feld «Interval» den Wert 4100 ns ein. Dies ist die 

Gate-Offenhaltezeit (gesamt) von Gerät 1.
 Markieren Sie die Kontrollkästchen für jedes Gate mit Ausnahme von 

«Gate» 5.
 Klicken Sie die Schaltfläche «OK».
 Um der Tabelle eine neue Zeile für die TSN-Daten mit Priorität 5 hin-

zuzufügen, klicken Sie die Schaltfläche «New».
 Geben Sie in das Feld «Interval» den Wert 3900 ns ein. Dies ist die 

minimale Gate-Offenhaltezeit von Gerät 1.
 Markieren Sie ausschließlich das Kontrollkästchen für «Gate» 5.
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 Klicken Sie die Schaltfläche «OK».
  Um die verbleibende Zeit den Prioritäten 0, 1, 2, 3, 4, 6, und 7 

zuzuweisen, klicken Sie die Schaltfläche «New». Verbleibende Zeit = 
Zykluszeit - (Bridge-Verzögerung (gesamt) + minimale Gate-Offenhal-
tezeit).

 Geben Sie in das Feld «Interval» den Wert 992000 ns ein.
 Markieren Sie die Kontrollkästchen für jedes Gate mit Ausnahme von 

«Gate» 5.
 Klicken Sie die Schaltfläche «OK».
 Um die Änderungen auf dem Gerät zu speichern, klicken Sie die 

Schaltfläche «Write».
 Um den Dialog «Configured» zu schließen, klicken Sie die Schalt-

fläche «Close».
 Legen Sie die Parameter für Gerät 2 fest.

Figure 44 :Gerät 1 TSN > Gate Control List > Configured

Aktivieren Sie nach der Festlegung der TSN-Gate-Zeiten die PTP- und 
TSN-Funktionen. Um die Funktionen zu aktivieren, führen Sie folgende 
Schritte aus:
 Führen Sie im Ordner-Rahmen einen Rechtsklick auf das Gerät aus, 

das Sie als Gerät 1 konfiguriert haben. Informationen zur Identifikation 
Voir “Fenêtre principale de Industrial HiVision” on page 82..

 Wählen Sie in der Dropdown-Liste die Option «MultiConfig™».
 Öffnen Sie den Dialog «TSN».
 Wählen Sie in der Dropdown-Liste «Operation» die Option «On» aus.
 Um die Änderungen auf dem Gerät zu speichern, klicken Sie die 

Schaltfläche «Write».
 Legen Sie die Parameter für Gerät 2 fest.
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Figure 45 :Funktion aktivieren

Wenden Sie nach der Aktivierung der Funktionen die Konfigurationsän-
derungen an. Um die Änderungen zu übernehmen, gehen Sie wie folgt 
vor:
 Öffnen Sie die Registerkarte «Devices».
 Führen Sie einen Doppelklick auf das TSN-Gerät aus, das Sie als 

Gerät 1 konfiguriert haben.
 Öffnen Sie die Registerkarte «List».
 Führen Sie einen Rechtsklick auf Port 1 aus.
 Wählen Sie in der Dropdown-Liste die Option «MultiConfig™».
 Öffnen Sie den Dialog TSN > Configuration.
 Wählen Sie in der Dropdown-Liste «Gate Control Active» die Option 

«Enabled» aus.
 Um die Änderungen auf dem Gerät zu speichern, klicken Sie die 

Schaltfläche «Write».
 Klicken Sie die Schaltfläche «Close».
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Figure 46 :Port aktivieren und Konfigurationsänderungen übernehmen 

Commentaire : Sie verwenden den TSN > Gate Control List > Cur-
rent-Dialog, um ausschließlich die Einstellungen des Gerätes anzuzei-
gen. Um die aktuellen Einstellungen anzuzeigen, klicken Sie die 
Schaltfläche «Refresh».

 Reception delay

Port 
speed

RX 
port

Medium Independent 
delay [ns]

Dependent 
delay [ns]

Max. Reception delay [ns]
68 octets data 

packet
1522 octets data 

packet
(incl. 4 octets VLAN tag)1

1. These octets are included in the Independent delay, together with PREAMBLE, MAC 
addresses and FCS.

48 octets 
SDU2

2. The VLAN tag is not part of the SDU.

1502 octets SDU

100 Mbit/s 1/1
1/2

Twisted pair 3920 … 3940 80 × SDU 7780 123780
Optical 3830 … 3840 80 × SDU 7680 123680

1/3 Twisted pair 11480 … 11690 160 × SDU 27050 251370
Optical 11380 … 11600 160 × SDU 26960 251280

1 Gbit/s 1/1
1/2

Twisted pair 1064 … 1094 8 × SDU 1478 13078
Optical 924 … 954 8 × SDU 1338 12938

1/3 Twisted pair 3388 … 3538 16 × SDU 4306 27506
Optical 3238 … 3388 16 × SDU 4156 27356
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 Transmission delay

Port 
speed

TX 
port

Medium Independent 
delay [ns]

Dependent 
delay [ns]

Max. Transmission delay [ns]
68 octets data 

packet
1522 octets data 

packet
(incl. 4 octets VLAN tag)1

1. These octets are included in the Independent delay, together with PREAMBLE, MAC 
addresses and FCS.

48 octets 
SDU2

2. The VLAN tag is not part of the SDU.

1502 octets 
SDU

100 Mbit/s 1/1
1/2

Twisted pair 1660 … 1690 0 1690 1690
Optical 1720 … 1750 0 1750 1750

1/3 Twisted pair 9670 … 9900 8 × SDU 13740 129740
Optical 9730 … 9960 8 × SDU 13800 129800

1 Gbit/s 1/1
1/2

Twisted pair 530 … 550 0 550 550
Optical 510 … 530 0 530 530

1/3 Twisted pair 2904 … 3124 8 × SDU 3508 3892
Optical 2884 … 3104 8 × SDU 3488 3872
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7 Configurer la surveillance du 
réseau

Les paramètres de base de Industrial HiVision permettent de commencer la 
surveillance de votre réseau immédiatement après la configuration du 
schéma de réseau.
La liste suivante énumère les éléments essentiels de la modification des 
paramètres pour la surveillance de réseau :

 Réglages déterminants pour la sécurité
 Configuration de l'état
 Détermination de l'état
 Adresse de destination d'alarme
 Redirection d'état
 Actions liées aux évènements
 Historique

Vous trouverez un aperçu des composants surveillés sous “Monitor” on 
page 321.

Vous trouverez les réglages pour la surveillance des propriétés d'un réper-
toire/équipement, d'un composant ou d'une liaison dans les chapitres 
suivants :

 “Propriétés d'un dossier/équipement” on page 288
 “Propriétés d'une connexion” on page 305
 “Propriétés d'un détail de composant” on page 297
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7.1 Améliorer la sécurité dans le 
réseau

Un réseau informatique offre de nombreuses cibles d'attaque pour les intrus 
indésirables.
La connaissance d'éventuelles failles de sécurité et leur résolution systéma-
tique améliore la sécurité de votre réseau.
Industrial HiVision vous offre la possibilité de réaliser aisément des réglages 
décisifs en matière de sécurité. 
Les exécutions suivantes vous montrent pas à pas comment Industrial 
HiVision vous soutient dans cette démarche d'amélioration de la sécurité de 
votre réseau.

7.1.1 Attribuer des mots de passe aux 
équipements dans le réseau

Les équipements de mise en réseau configurables, par ex. les concentra-
teurs, les routeurs, les pare-feu et les points d'accès WLAN sont des cibles 
d'attaque potentielles pour endommager votre réseau.
 Compliquez l'accès à l'administration des équipements de mise en 

réseau en attribuant des mots de passe efficaces à ces équipements.
Avec la fonction de configuration multiple, Industrial HiVision vous offre la 
possibilité d'attribuer en une étape de travail le même mot de passe à plu-
sieurs équipements. Notez toutefois que l'attribution de mots de passe indi-
viduels augmente le niveau de sécurité.
 Modifiez périodiquement les mots de passe des équipements. Sélection-

nez des mots de passe valides.
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7.1.2 Changement de mot de passe lors de la 
première connexion

Pour éviter tout accès non désiré, vous devez absolument changer le mot de 
passe par défaut lors de la connexion initiale.

A partir des versions suivantes du logiciel, il est nécessaire de changer le mot 
de passe par défaut lors de la connexion initiale :
 HiOS

07.1.00
08.1.00

 Classic
09.0.17
09.1.00 

 RSB
05.4.00

 HiSecOS
Eagle 20/30/40  03.3.00
EagleONe          05.4.00

 GarrettCom
DX
    DX940      4.2.0
    DX940e    1.0.3
    MN4         4.2.0

10RX
     XRX        5.0.0

Industrial HiVision vous donne la possibilité de changer le mot de passe par 
défaut lors de la connexion initiale. Lorsque vous utilisez la boîte de dialogue 
MultiConfig™ > Password Change, vous pouvez modifier simultanément le 
mot de passe par défaut de plusieurs équipements.

 Exemple de configuration
Dans cet exemple, vous utilisez MultiConfig™ pour modifier le mot de 
passe par défaut d'un équipement lorsque celui-ci doit être modifié lors de 
la connexion initiale.
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La liste suivante contient les conditions préalables pour modifier le mot de 
passe par défaut à l'aide de MultiConfig™ :
 l'équipement est installé sur votre réseau
 l'équipement possède une adresse IP
 vous avez détecté l'équipement à l'aide du bouton «HiDiscovery 

Scan» ou ajoutez manuellement l'équipement avec New > Device.

Pour détecter des équipements à l'aide du bouton «HiDiscovery Scan», 
voir “HiDiscovery Scan” on page 454.

Pour ajouter des équipements manuellement, voir “–Création de nou-
veaux équipements” on page 145.

Une fois que Industrial HiVision a détecté l'équipement, Industrial 
HiVision affiche l'équipement sous la forme d'un ping ou d'un équipement 
HiDiscovery.

Les étapes suivantes vous guident dans la procédure de changement du 
mot de passe :
 Ouvrez l'onglet «Map».
 Sélectionnez les équipements nouvellement ajoutés.
 Cliquez avec le bouton droit sur un équipement sélectionné.
 Dans la liste déroulante, sélectionnez l'option MultiConfig™.
 Dans l'arborescence du menu, sélectionnez Device Settings > 

Device Security > Management Access > Password Change. La boîte 
de dialogue «Password Change» s'ouvre.

 Saisissez le mot de passe que vous souhaitez utiliser pour un accès 
futur dans le champ «New Password».
Le réglage par défaut de ce champ est vide.

 Confirmez votre nouveau mot de passe dans le champ «Repeat».
 Pour télécharger la configuration sur l'équipement, cliquez sur le bou-

ton «Write».

Lorsque vous cochez la case «Advanced», le cadre «Advanced» s'agran-
dit et vous pouvez modifier d'autres valeurs. Les réglages dans le cadre 
«Advanced» prennent effet lorsque vous cliquez sur le bouton «Write».
  Le champ «User» contient le nom d'utilisateur par défaut de l'équipe-

ment. Industrial HiVision utilise la valeur pour se connecter à l'équipe-
ment.
Le réglage par défaut pour ce champ est admin.

 Le champ «Old Password» contient le mot de passe par défaut de 
l’équipement. Industrial HiVision utilise la valeur pour se connecter à 
l'équipement.
Le réglage par défaut pour ce champ est private.
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Commentaire : Sur les équipements Hirschmann et GarrettCom, il 
n'est pas nécessaire de modifier les valeurs par défaut «User» et «Old 
Password».

 Pour vérifier la chaîne de caractères dans le champ «Old Password», 
utilisez le champ «Repeat».
Le réglage par défaut pour ce champ est private.

 Lorsque vous cochez la case «Enable SNMP», l'équipement active 
SNMP. SNMP est inactif sur un nouvel équipement. 
Cette case est cochée par défaut.

 Lorsque vous cochez la case «Add Password to SNMP guess list», 
Industrial HiVision ajoute les valeurs dans les champs «User» et «New 
Password» à Preferences > Advanced > Device Credentials > 
SNMP Guess List. 
Cette case est cochée par défaut.

 Lorsque vous cochez la case «Refresh Device», Industrial HiVision 
recharge l'équipement.
Cette case est cochée par défaut.

 Lorsque vous cochez la case «Hide Passwords», Industrial HiVision 
masque ou affiche les mots de passe en texte clair. Cette case à 
cocher masque ou affiche uniquement les mots de passe dans la boîte 
de dialogue «Password Change».
Cette case est cochée par défaut.
User Manual Industrial HiVision
Release 8.1 12/19 207



Configurer la surveillance du réseau 7.1 Améliorer la sécurité dans le
réseau
7.1.3 Affichage de l'état et configuration de la 
sécurité

 Etat Sécurité
Industrial HiVision présente dans la boîte de dialogue «Security Status» 
une vision d’ensemble des propriétés de sécurité des équipements dans 
les dossiers sélectionnés.
La colonne «Status» indique l'état critique d'une propriété dans cette 
ligne.
Les symboles revêtent les significations suivantes :
  pas d'interrogation de cette propriété
  le résultat de l'interrogation de cette propriété correspond aux 

attentes de sécurité générales
  le résultat de la requête pour cette propriété va à l’encontre des 

directives générales de sécurité. Contrôlez les paramètres selon les 
attentes générales de sécurité.

 « - » signifie que l'équipement est dépourvu de cette fonction.
Pour paramétrer les propriétés que Industrial HiVision doit surveiller, 
faites vos sélections dans le tableau «Configure Monitoring».
Les propriétés sélectionnés sont affichées dans la colonne d’état.
En fonction de l'équipement, vous trouverez les propriétés des colonnes 
suivantes dans le sous-répertoire «Security» des équipements en 
question :
 «Tftp»
 «Profinet IO»
 «IEC61850»
 «Inbound ANY Rule»
 «Outbound ANY Rule»
 «Time Synchronization»
 «Telnet»
 «HiDiscovery»
 «Http»
 «802.1X Port Access Control Enabled»
 «Restricted Management Access»
 «Ethernet/IP»
 «SNMP V1/V2»
 «Unused Active Ports»
 «Default Password»
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Industrial HiVision interroge ces propriétés de manière cyclique (réglage 
par défaut : 24 heures). Pour importer immédiatement les valeurs dans 
Industrial HiVision, cliquez sur le bouton «Refresh».

Pour améliorer la sécurité de votre réseau, la fonction MultiConfig™ vous 
offre la possibilité de modifier plusieurs propriétés avec l'état warning en 
une seule opération.
 Dans le tableau, sélectionnez les lignes de l'équipement auxquelles 

vous souhaitez apporter des modifications et cliquez sur MultiConfig™ 
avec le bouton droit de la souris.
La boîte de dialogue «Security Lockdown» sous «Device Security» 
vous offre la possibilité d'exécuter plusieurs réglages de sécurité en 
même temps.

 Pour contrôler les paramètres correspondants dans la boîte de dia-
logue «Security Status», actualisez l’affichage en cliquant sur le bou-
ton «Refresh». Les propriétés modifiées n’affichent que l'état 
« sécurisé » .

L’onglet «Security Status» affiche exclusivement l'état de fonctionnement 
des fonctions de sécurité d’un équipement. Lorsque vous activez les fonc-
tions de sécurité sur les équipements, rendez le réseau aussi sécurisé 
que possible à l’aide des fonctions disponibles des équipements. 
L’absence ou l’obsolescence des fonctions de sécurité sur les équipe-
ments du réseau permet éventuellement à des personnes non autorisées 
d’accéder au réseau. Assurez-vous que vous appareils en réseau sont à 
jour et que vous avez configuré les fonctions selon vos définitions de 
sécurité.

Certaines variantes de firmware ne prennent pas en charge toutes les 
fonctions de sécurité énumérées dans le tableau. Puisque l’activation 
d’une fonction manquante n’est pas possible, le tableau indique les fonc-
tions manquantes comme non sécurisées.
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 Inbound ANY Rule et Outbound ANY Rule
Si la fonction « filtre de paquets » est activée sur un équipement, 
Industrial HiVision contrôle le contenu des règles et affiche les résultats 
dans la boîte de dialogue «Etat Sécurité».
La séparation des états d’entrée et de sortie est effectuée par le contrôle 
des affectations de rôles sur les interfaces. La directive standard est éga-
lement vérifiée. Si aucune règle n’est applicable, la directive standard 
détermine la manière dont le pare-feu traite les paquets de données. Si 
«Accept» est déterminé pour la directive «Action» standard, l'état est 
Unsecure. Pour déterminer l'état affiché dans les colonnes «Inbound 
ANY Rule» et «Outbound ANY Rule», Industrial HiVision recherche une 
commande « any » dans les champs suivants :
 Eagle 20/30 et Eagle One :

Industrial HiVision recherche une commande « any » dans les règles 
de pare-feu L3 suivantes :
«Source IP (CIDR)» = « any » [tous]
«Destination IP (CIDR)» = « any » [tous]
«Source Port» = « any » [tous]
«Destination Port» = « any » [tous]
«Protocol» = « any » [tous]

Industrial HiVision recherche une commande « any » dans les règles 
de pare-feu L3 suivantes :
«Source IP (CIDR)» = « any » [tous]
«Destination IP (CIDR)» = « any » [tous]
«Protocol» = « any » [tous]

Pour les autres familles d’équipement prises en charge par Industrial 
HiVision, les états standards «Inbound ANY Rule» et «Outbound ANY 
Rule» sont considérés comme SECURE.

 Time Synchronization
Industrial HiVision contrôle l'état de la synchronisation d’heure pour 
chaque équipement de votre réseau. La liste suivante décrit les configu-
rations qui entraînement l’affichage par les équipements d’un avertisse-
ment dans la colonne «Time Synchronization».
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Sur les équipements de type Classic, la colonne «Time Synchronization» 
affiche un avertissement lorsque le SNTP et le NTP sont tous deux non 
sécurisés :
 Pour les configurations suivantes d’équipement, le SNTP est non 

sécurisé :
– Fonctionnement ARRÊT
– Fonctionnement MARCHE + client ARRÊT
– Fonctionnement MARCHE + client MARCHE + autorise Broadcast 

MARCHE
– Fonctionnement MARCHE + client MARCHE + autorise Broadcast 

ARRÊT + non synchronisé
 Pour les configurations suivantes d’équipement, le PTP est non 

sécurisé :
– Fonctionnement ARRÊT
– Fonctionnement MARCHE + non synchronisé

Sur les équipements de type HiOS, la colonne «Time Synchronization» 
affiche un avertissement lorsque le SNTP et le NTP sont tous deux non 
sécurisés :
 Pour les configurations suivantes d’équipement, le SNTP est non 

sécurisé :
– Client ARRÊT
– Fonctionnement MARCHE + client MARCHE + mode Broadcast
– Fonctionnement MARCHE + client MARCHE + mode Unicast + 

non synchronisé
 Pour les configurations suivantes d’équipement, le PTP est non 

sécurisé :
– Fonctionnement ARRÊT
– Fonctionnement MARCHE + non synchronisé

Sur les équipements de type HiSecOS, la colonne «Time Synchroniza-
tion» affiche un avertissement lorsque le SNTP et le NTP sont tous deux 
non sécurisés :
 Pour les configurations suivantes d’équipement, le SNTP est non 

sécurisé :
– Fonctionnement ARRÊT
– Fonctionnement MARCHE + autorise Broadcast MARCHE
– Fonctionnement MARCHE + autorise Broadcast ARRÊT + non 

synchronisé
 Pour les configurations suivantes d’équipement, le NTP est non 

sécurisé :
– Fonctionnement ARRÊT
– Fonctionnement MARCHE + mode serveur
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– Fonctionnement MARCHE + mode Broadcast client
– Fonctionnement MARCHE + mode symétrique actif + non synchro-

nisé
– Fonctionnement MARCHE + mode symétrique passif + non syn-

chronisé
– Fonctionnement MARCHE + mode client + non synchronisé
– Fonctionnement MARCHE + mode client serveur + non synchro-

nisé

Sur les équipements HiSecOS, la colonne «Time Synchronization» 
affiche un avertissement lorsque le NTP est non sécurisé :
 Pour les configurations suivantes d’équipement, le NTP est non 

sécurisé :
– Client ARRÊT
– Client MARCHE + mode Broadcast
– Client MARCHE + mode Unicast + non synchronisé
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7.1.4 Réglages décisifs en matière de sécurité 
des équipements dans le réseau

 Désactiver HiDiscovery
Le protocole HiDiscovery utilise l’Ethernet pour permettre l’attribution d’un 
nom d’équipement et de paramètres IP à un équipement. Pour rendre 
l'attribution la plus simple possible, HiDiscovery renonce aux méca-
nismes qui limitent l'accès aux équipements.

Commentaire : Lorsque la fonction HiDiscovery est activée sur un équi-
pement, l’onglet «Security Status» signale l’équipement et la fonction 
comme non sécurisés.

 Pour limiter l’accès ainsi que les modifications relatives aux para-
mètres IP et au nom d’équipement des équipements de votre réseau, 
désactivez HiDiscovery sur les équipements dès que vous avez ter-
miné la configuration des équipements.
La fonction MultiConfig™ permet de désactiver HiDiscovery sur plu-
sieurs équipements en une seule opération.
– Sélectionnez plusieurs équipements.
–  Cliquez avec le bouton droit de la souris sur un équipement sélec-

tionné et sélectionnez l’option MultiConfig™ dans le menu dérou-
lant.

– Ouvrez la boîte de dialogue sous Device Settings > Basic 
Settings > Network > Global.
Pour désactiver HiDiscovery sur les équipements Classic, sélec-
tionnez l’option «Disable» dans le menu déroulant «HiDiscovery 
Access».
Pour désactiver HiDiscovery sur les équipements HiOS, décochez 
la case «HiDiscovery Enable».

Commentaire : La case à cocher à gauche du nom de fonction indique 
seulement une modification de la fonction.

 Contrôle de la signature de configuration
Les équipements Classic de Hirschmann attribuent une signature de 
configuration individuelle aux configurations des équipements.
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Les équipements HiOS de Hirschmann attribuent une empreinte digitale 
(Fingerprint) individuelle aux configurations des équipements.
La signature de configuration change à chaque fois que vous sauvegar-
dez une configuration sur l'équipement, même si la configuration exis-
tante est restée inchangée.
L'empreinte digitale change lorsque vous sauvegardez une configuration 
sur l'équipement et que la configuration existante a été modifiée.
L'équipement sauvegarde la signature de configuration/l'empreinte digi-
tale générée aléatoirement avec la configuration.
Industrial HiVision vous offre la possibilité de surveiller la signature de 
configuration/l'empreinte digitale. Vous êtes donc au courant si quelqu'un 
modifie la configuration d'un équipement.
 Pour sélectionner les équipements avec une signature de configura-

tion ou une empreinte digitale, ouvrez l'onglet «Properties» dans l'affi-
chage détaillé. Sélectionnez dans le menu déroulant «Property:» 
l’option «Configuration Signature (Device)» .

 Dans le tableau, sélectionnez les équipements pour lesquels vous 
souhaitez surveiller la signature de configuration/l'empreinte digitale.

 Cliquez avec le bouton droit de la souris sur l'équipement et sélection-
nez MultiConfig™.

 Dans l'arborescence de la boîte de dialogue MultiConfig™, cliquez sur 
«Status Config».

 Dans le cadre fonctionnel MultiConfig™, cliquez sur l’option «Set cur-
rent to reference». 

 Dans le cadre «Reference Value», sélectionnez l'état à appliquer à la 
propriété, si une valeur actuelle diffère de la valeur de référence.

 Pour récupérer les signatures de configuration/empreintes digitales 
actuelles en tant que référence dans Industrial HiVision, cliquez sur le 
bouton «Write».

 Sécurité de port
La fonction de sécurité des ports vous offre la possibilité de déterminer 
quel équipement peut envoyer des données à ce port. Vous pouvez ainsi 
bloquer la réception des données provenant d'autres équipements. 
La boîte de dialogue MultiConfig™ de Industrial HiVision vous permet de 
configurer la fonction de sécurité des ports pour les équipements Classic.
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 Charger les certificats des équipements/clés
Lorsque vous voulez communiquer avec un équipement, il se peut dans 
certaines circonstances que vous vouliez savoir si vous communiquez 
effectivement avec le véritable équipement. Les certificats permettent de 
vérifier l'authenticité des équipements.
Les autorités de certification (Certification Authorities, CA) proposent de 
tels certificats, par ex. Verisign, Symantic. Certaines entreprises ont leur 
propre institution avec un serveur interne, qui crée des certificats propres 
à l'entreprise.
Industrial HiVision vous offre la possibilité de charger des certificats sur 
les équipements avec la boîte de dialogue MultiConfig™.
L'utilisation d'un certificat propre pour chaque équipement assure une 
plus grande sécurité que l'utilisation d'un certificat pour plusieurs équipe-
ments.
 Dans l’onglet «Map», cliquez avec le bouton droit de la souris sur 

l’équipement portant le certificat que vous souhaitez charger sur 
l’équipement. Sélectionnez ensuite MultiConfig™.
Dans l'arborescence de la boîte de dialogue MultiConfig™, vous trou-
verez les boîtes de dialogue permettant de charger les certificats/clés 
sous Device Settings > Device Security > Management Access > 
Server.

7.1.5 Configurer les réglages décisifs en matière 
de sécurité dans le réseau

 Security Lockdown
La fonction «Security Lockdown» (limitation d’accès) permet d'appliquer 
les fonctions de sécurité existant déjà sur les équipements Hirschmann 
en un seul clic sur les équipements administrés ou sur des équipements 
sélectionnés.
L'étendue de la limitation se base sur les conditions actuelles présentes 
sur le réseau. Ceci signifie que le fonctionnement de réseau actuel est 
conservé, mais que de nouveaux accès sont limités.
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La fonction «Security Lockdown» contient les fonctions de sécurité sui-
vantes, dans la mesure où elles sont prises en charge par les 
équipements :
 Accès limité de l'administration

Industrial HiVision limite l'accès de l'administration des équipements 
sur la station d'administration réseau. Dans l'état de livraison, l'accès 
est ouvert pour toutes les adresses IP.

 Sécurité des ports
Industrial HiVision active la fonction de sécurité des ports sur les ports 
qui sont liés à une adresse MAC spécifique.
Si, lors de la connexion, l'adresse MAC n'est pas valide, par ex. en rai-
son d'un dépassement du délai, l'équipement exécute une action 
sélectionnable, également réglable. Une telle action pourrait être par 
exemple : envoyer un trap SNMP à la station d'administration réseau.
Dans l'état de livraison, cette fonction est activée.

 Action de sécurité des ports
Dès que l'équipement reconnaît une tentative d'accès non autorisée, 
l'équipement exécute l'action que vous avez préalablement configu-
rée.
Les actions possibles sont :
– Pas d'action
– Désactiver le port
– Envoyer un trap SNMP
– Désactiver le port et envoyer un trap

 Désactiver les ports non utilisés
Industrial HiVision désactive les ports d'un équipement sur lesquels 
aucun liaison n'existe.

 Désactiver les emplacements non utilisés
Industrial HiVision désactive les emplacements d’un équipement 
modulaire pour lesquels l’équipement ne détecte aucun module.

 Désactiver les protocoles non sécurisés
Pour administrer un équipement dans le réseau, les équipements 
offrent des accès via différents protocoles. Industrial HiVision désac-
tive ces protocoles s'ils sont considérés comme non sécurisés. Parmi 
les protocoles considérés comme non sécurisés figurent : HTTP, 
Telnet, SNMPv1, SNMPv2, HiDiscovery. La fonction de SNMPv3 est 
maintenue.
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La fonction MultiConfig™ vous offre la possibilité de configurer simultané-
ment la fonction «Security Lockdown» pour plusieurs équipements en 
une seule opération.
 Pour ouvrir la boîte de dialogue «Security Lockdown», ouvrez l’onglet 

«Devices» dans l’affichage détaillé.
 Sélectionnez les équipements devant être configurés.
 Pour ouvrir la boîte de dialogue MultiConfig™, cliquez avec le bouton 

droit sur un équipement en surbrillance et sélectionnez MultiConfig™.
 Pour ouvrir la boîte de dialogue «Security Lockdown», sélectionnez 

Device Settings > Device Security > Security Lockdown dans la 
boîte de dialogue MultiConfig™.

La fonction «Security Lockdown» présente les limitations suivantes :
 La fonction «Port Security» n’est pas disponible pour les équipements 

EAGLE et BAT.
 La fonction «Port Security Action» n’est pas disponible pour les équi-

pements TCSEFEx et TCSNWx.
 La fonction «Disable Unused Slots» est exclusivement disponible pour 

les équipements modulaires Classic et HiOS.
 La fonction «Disable Unused Slots» est exclusivement disponible pour 

les équipements GarrettCom RX10.
 Les fonctions «Restricted Management Access» et «Disable HiDisco-

very» sont disponibles pour les équipements suivants :
– Les équipements de type Classic commencent avec la version 

09.0.01.
– Les équipements de type HiOS commencent avec la version 

06.0.01.
– Les équipements de type HiSecOS commencent avec la version 

03.0.01.

 Comparer les paires d'adresses MAC/IP
Les pirates utilisent leurs propres équipements pour accéder à votre 
réseau de données. À cet effet, le pirate utilise l'adresse IP d'un équipe-
ment existant, qui est désactivé à ce moment précis, ou une adresse IP 
libre du sous-réseau auquel il souhaite accéder.
L'adresse MAC de l’équipement du pirate peut toutefois être différente de 
celle de l'équipement dont le pirate vient de s'approprier l'adresse IP.
Industrial HiVision vous offre la possibilité de démasquer de tels pirates à 
l'aide de cette fonction.
User Manual Industrial HiVision
Release 8.1 12/19 217



Configurer la surveillance du réseau 7.1 Améliorer la sécurité dans le
réseau
À cet effet, Industrial HiVision collecte les paires d'adresses IP/MAC des 
équipements raccordés. Industrial HiVision présente la liste des paires 
d'adresses IP/MAC collectées sous forme de tableau. Vous pouvez com-
pléter ce tableau manuellement par des entrées définies par l'utilisateur.
Industrial HiVision vous offre la possibilité de comparer de manière auto-
matisée et périodique le contenu de ce tableau avec les paires d'adresses 
IP/MAC actives sur le réseau. Si Industrial HiVision constate une diffé-
rence, Industrial HiVision vous en informe conformément à l'action que 
vous avez définie.
 Effectuez les réglages appropriés pour la surveillance des paires 

d'adresses MAC/IP.
Voir “Sécurité paire adresses MAC/IP” on page 426.

 Identifier les équipements Rogue
Un équipement Rogue est un équipement qui se trouve dans le réseau à 
un endroit où il ne doit pas être. 
Supposons que vous ayez terminé la configuration de votre réseau de 
données dans Industrial HiVision et que Industrial HiVision contienne la 
topologie valable de vos équipements et liaisons d'équipements. C'est à 
ce moment-là qu'il faut geler et retenir cet état dans Industrial HiVision.
Sur la base de cet état gelé et retenu, Industrial HiVision vous offre la pos-
sibilité de détecter quand des individus indésirables s'immiscent dans 
votre réseau de données.
Lorsque cette fonction est activée, Industrial HiVision enregistre une 
image de cette topologie. 
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Mais comment traiter les nouveaux équipements dans votre réseau de 
données qui sont ajoutés à l'installation existante ? Ces nouveaux équi-
pements pourraient représenter un danger potentiel pour votre réseau de 
données. C'est pourquoi, la fonction «Rogue Device Detection» offre un 
traitement particulier pour ces équipements.
 Après l'installation initiale de Industrial HiVision, activez la fonction 

«Rogue Device Detection» sous Configuration > Preferences > 
Basics > Discover Devices > Discovery Mode.
– Industrial HiVision déplace les équipements nouvellement détectés 

dans le répertoire «Rogue Devices». Étant donné que vous placez 
volontairement les équipements créés manuellement dans un 
répertoire particulier, Industrial HiVision laisse les équipements 
créés manuellement dans le répertoire correspondant.

– Lorsque Industrial HiVision déplace un nouvel équipement dans le 
dossier «Rogue Devices», Industrial HiVision génère un événe-
ment «Rogue Device Detection» en complément de l'événement 
« Nouvel équipement détecté ».

 Vous pouvez utiliser «Event Actions» ou «User defined Actions» pour 
définir comment Industrial HiVision doit réagir à un nouvel équipement 
affiché dans le dossier «Rogue Devices».
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7.2 Configuration de l'état

La configuration du statut détermine le statut affecté à une valeur du détail 
de composant. Les statuts possibles sont :
 «No Status»
 «Not Available»
 «OK»
 «Warning»
 «Error»

Exemple :
Vous pouvez assigner le statut «OK», «Warning» ou «Error» à une perte de 
connexion.
Dans le cas d'un terminal que vous déconnectez régulièrement, une perte de 
connexion (= équipement déconnecté) n'est pas une erreur.
Dans le cas d'un serveur qui doit être disponible sans interruption, une perte 
de connexion est une erreur majeure qu'il convient de surveiller.

Industrial HiVision vous offre la possibilité de configurer globalement l'état 
d'un détail de composant pour les équipements d'une catégorie (voir 
page “Status Configuration” on page 417).

Si vous souhaitez modifier la configuration de l'état de différents équipe-
ments, vous pourrez accéder à la configuration de l'état dans la fenêtre des 
propriétés d'un détail de composant. La configuration de l'état vous permet 
de saisir des options de configuration de l'état pour chaque détail de compo-
sant (voir page “Propriétés d'un détail de composant” on page 297).

La condition préalable pour déterminer un statut est la surveillance d'un 
détail de composant. 
Lors de la surveillance d’un détail de composant, Industrial HiVision interroge 
périodiquement la valeur. Ans le cadre de l’interrogation, Industrial HiVision 
attribue un état à cette valeur.

À l'état de livraison, les configurations d’état sont paramétrées de telle 
manière que vous puissiez parfaitement surveiller votre réseau dès la fin de 
l'installation.
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7.3 Détermination de statut

Pour la surveillance de votre réseau, votre station d'administration de réseau 
requiert des informations relatives aux composants du réseau. Pour accéder 
à ces informations,

 la station d'administration de réseau peut interroger les composants de 
manière cyclique ou

 les composants peuvent envoyer des informations (traps) de leur propre 
initiative à la station d'administration réseau.

Commentaire :  Lorsque des interfaces de routeur sont activées en combi-
naison avec un pare-feu à inspection d’état, aucune communication SNMP 
n’est possible entre Industrial HiVision et l’agent d’un équipement Classic.
L’agent Classic répond aux requêtes SNMP avec l’adresse IP de l’interface 
de routeur la plus proche de la station d’administration Industrial HiVision. 
Lorsque vous déterminez une adresse IP différente de l’interface de routeur 
la plus proche de Industrial HiVision, l’adresse IP cible des paquets SNMP 
Industrial HiVision diffère de l’adresse IP source des paquets SNMP issus de 
l’agent de l’équipement.
Si vous utiliser un pare-feu ne disposant pas du jeu de règles approprié pour 
ce type de communication, le pare-feu rejette éventuellement les paquets. 
Ceci provoque une perte de communication entre Industrial HiVision et 
l’agent de l’équipement. Des informations exhaustives sur l’utilisation des 
pare-feu avec Industrial HiVision sont disponibles dans (voir page “Utilisation 
Industrial HiVision avec pare-feu” on page 72).

 Scrutation cyclique (polling)
En fonction de la taille du réseau et de la fréquence de requête, la scru-
tation cyclique peut entraîner une perte considérable de la bande pas-
sante disponible.
Une brève surcharge du réseau peut provoquer la perte d'une réponse ou 
d'une alarme. L'avantage d'une scrutation périodique est la forte probabi-
lité que la station d'administration réseau obtienne une réponse lors de la 
prochaine interrogation.
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 Alarmes
Dès qu'un équipement détecte une modification de statut, il envoie un 
message d'alarme (trap) à la station d'administration de réseau. Étant 
donné que l'équipement envoie une alarme uniquement en raison d'une 
modification de statut, cette méthode a peu d'incidence sur la charge du 
réseau. Néanmoins, en cas de perte de paquet, la station d'administration 
de réseau risquerait de ne pas être informée de la modification de statut.

7.3.1 Adresse de destination d'alarme

Pour envoyer des messages d'alarme, un équipement a besoin d'une 
adresse IP (= adresse de destination d'alarme) de la station d'administration 
de réseau à laquelle il peut envoyer, le cas échéant, un message d'alarme. 
Vous pouvez saisir l'adresse de destination d'alarme directement sur l'équi-
pement via une interface Web, par exemple, ou plus simplement à l'aide 
d'Industrial HiVision (voir page “Trap Destination” on page 431).

 Cliquez avec le bouton droit de la souris sur l’icône de l’équipement et 
sélectionnez «Trap Destination» dans le menu déroulant. La boîte de dia-
logue de configuration d'alarme s'ouvre. 

 Cochez la case «Send Traps». 
 Cliquez sur le bouton «Write».

7.3.2 Actualisation du statut de l'équipement

Industrial HiVision affiche le statut que l'évènement avait au moment de la 
reconnaissance de celui-ci ou le statut émanant des alarmes reçues ou des 
interrogations de statut.

 «Refresh» vous permet de réimporter les propriétés.
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7.4 Redirection d'état

La redirection d'état indique si l'état a été propagé au niveau supérieur sui-
vant.

Figure 47 :Redirection d'état au niveau supérieur
0 - Niveau inférieur = détail de composant
1 - 1er niveau supérieur
2 - 2e niveau supérieur
3 - 3e niveau supérieur
4 - 4e niveau supérieur
5 - 5e niveau supérieur
6 - 6e niveau supérieur
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Un dossier enregistre l’état le plus mauvais affichant le contenu d’un compo-
sant. L'évaluation se base sur la séquence suivante :

 «Error» (état le plus critique)
 «Warning»
 «OK»
 «Not Available»
 «No Status»

 Vous pouvez déterminer la signification des couleurs sous 
Configuration > Preferences > Display > Status Colors.

 Dans la fenêtre de propriétés des composants correspondants, vous pou-
vez spécifier la détermination d'état et la redirection. Le composant peut 
également être un répertoire dans le cadre Folders [Répertoires].
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7.5 Actions d’administration

La surveillance de réseau comprend, outre l’observation passive du réseau, 
également l’intervention active dans les événements du réseau. Cette inter-
vention active est exprimée par la réaction aux événements au sein du 
réseau ou par des actions administratives comme l’activation et la désactiva-
tion de ports selon un schéma horaire.

7.5.1 Actions liées aux évènements

Industrial HiVision vous permet de réagir automatiquement aux évènements 
comme la modification du statut, par exemple.

 Sélectionnez Configuration > Preferences > Basics > Event Actions 
ou cliquez sur «Preferences» dans la barre d'outils et sélectionnez 
Basics > Event Actions.

(voir page “Event Forwarding” on page 352) vous propose les options de 
réactions automatiques suivantes Industrial HiVision :

 «Popup Message Box»
 «Send SMS»
 «Send E-Mail»
 «Run Executable»
 «Play Sound»
 «Push Notification»

Dans le 2ème cadre de cette boîte de dialogue, Industrial HiVision vous per-
met d'affecter une réaction déterminée à un événement.
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Commentaire : Si vous configurez Industrial HiVision pour exécuter un 
fichier exécutable en tant qu'action d'événement et qu'un message d'erreur 
s'affiche, consultez l'erreur du journal du noyau.

7.5.2 Actions liées à des échéances

Industrial HiVision vous permet de fixer une planification horaire au cours de
laquelle Industrial HiVision réagit à un évènement par le biais d'une action.

 Sélectionnez Configuration > Preferences > Basics > Event Actions 
ou cliquez sur «Preferences» dans la barre d'outils et sélectionnez 
Basics > Event Actions.

 Créez une nouvelle entrée dans le cadre «Alarms».
Le cadre «Time» dans la boîte de dialogue «Alarms» permet de fixer une 
période déterminée en indiquant le début et la fin de celle-ci.
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7.5.3 Événement « Je suis en vie »Industrial 
HiVision

Industrial HiVision vous permet de recevoir des signes de vie (messages 
« Je suis en vie ») de Industrial HiVision en cas de télésurveillance.

 Sélectionnez Configuration > Preferences > User defined Actions 
ou cliquez sur «Preferences» dans la barre d'outils et sélectionnez 
Basics > User defined Actions.

 Définissez une action que Industrial HiVision doit exécuter pour donner 
un signe de vie (message « Je suis en vie »), par exemple envoyer un 
SMS.
(voir page “Event Actions” on page 354)

 Définissez une alarme qui amène Industrial HiVision à exécuter une 
action.
(voir page “Event Actions” on page 354)
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7.6 Enregistrements avec 
informations temporelles

Industrial HiVision permet d'enregistrer des valeurs de propriétés contenant 
des informations temporelles dans plusieurs bases de données :
 dans une base de données de projet (historique)
 dans une base de données de rapport séparée (rapport)
Le délai d’accès à la base de données augmente proportionnellement à la 
taille de la base de données.
C’est pourquoi Industrial HiVision limite le nombre des entrées d’historique 
pouvant être enregistrées dans la base de données de projet.

7.6.1 Historique

Afin de surveiller votre réseau pendant une période définie par l'utilisateur, 
Industrial HiVision permet de consigner les états en incluant leur information 
chronologique. 
Les paramètres pour la consignation et l’affichage de l’historique sont dispo-
nibles dans les boîtes de dialogue des paramètres.
– “Propriétés d'une connexion” on page 305 et
– “Propriétés d'un détail de composant” on page 297.
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 Configuration de protocole
La boîte de dialogue «Properties» d'un détail de composant et la boîte de 
dialogue de connexion «Connection» permettent
 d'activer la journalisation de l'historique, 
 de saisir l'intervalle d'enregistrement/de scrutation, 
 de saisir le nombre maximal des entrées enregistrées. Si le nombre 

maximum d’entrées est atteint, Industrial HiVision supprime l’entrée la 
plus ancienne lorsqu’une nouvelle entrée est consignée.
100 entrées (= préréglage) nécessitent env. 5 ko d’espace de disque 
dur.

 Charge du réseau
La fenêtre de l'historique s'ouvre en double-cliquant sur une liaison. Vous 
y trouverez pour chaque direction de données une représentation gra-
phique de la charge du réseau.

Figure 48 :Charge du réseau

Si un port n'a pas encore été affecté à la connexion, ouvrez la boîte de 
dialogue d'attribution des ports en double-cliquant.
Si vous avez activé le polling des valeurs seuils dans la boîte de dialogue 
«Properties» d'une liaison, le graphique représente les lignes de valeurs 
seuils.
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7.6.2 Rapports

La fonction Rapports vous permet de gérer des statistiques à long terme, 
hors de la base de données du logiciel du système d'administration de 
réseau.
Industrial HiVision sauvegarde des valeurs de propriétés avec leurs informa-
tions chronologiques dans une base de données spéciale de rapports. 
Pour évaluer les valeurs enregistrées, la fonction de rapports vous propose 
l'établissement de rapports sous forme de graphiques ou de tableaux.

Commentaire : Selon les paramètres, Industrial HiVision peut enregistrer un 
important volume de données et les sauvegarder sur le disque dur. Veillez à 
ce que votre disque dur dispose d'un espace libre suffisant.

 Exemple d'application pour la surveillance de température
Vous souhaitez observer l'évolution de la température dans un commuta-
teur, ceci pendant plusieurs semaines de travail de 5 jours. Industrial 
HiVision doit générer un rapport hebdomadaire. Vous souhaitez obtenir le 
premier rapport le dimanche 7 octobre 2012 et les autres à un rythme 
hebdomadaire.

Ajout de la propriété température aux rapports :
 Pour accéder au niveau propriétés, double-cliquer dans l’onglet 

«Map» sur l’équipement souhaité.
 Cliquez avec le bouton droit de la souris sur l'icône de la propriété 

«Temperature». Sélectionnez «Add to Reporting...».
Industrial HiVision ouvre la boîte de dialogue pour saisir les para-
mètres des rapports.

 Entrez le 1er octobre 2012, 00 heure, comme date de début d'enregis-
trement.
Appuyez sur la touche Entrée pour fermer le dialogue de date.
Définissez le début de l'enregistrement au plus tard à l'heure à laquelle 
le rapport requiert la première entrée.
Maintenez «Indefinite» comme temps d'arrêt.
Sélectionnez un intervalle de scrutation le plus long possible, néan-
moins suffisant court pour que Industrial HiVision puisse enregistrer 
les fluctuations attendues.
Saisissez 10 minutes comme«Polling Interval».
Cliquez sur le bouton «OK».
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Établissement d'un modèle de rapport :
Un modèle vous permet de définir la présentation du rapport à générer. 
L'exemple suivant illustre votre choix d'un rapport sous forme de 
diagramme à courbes dans un fichier PDF.
 Sélectionnez Configuration > Reporting dans la barre de menus.
 Dans la boîte de dialogue «Reporting», ouvrez l'onglet «Templates».
 Pour créer un nouveau modèle pour votre rapport, cliquez sur le bou-

ton «New».
 Saisissez les paramètres du modèle (voir le tableau 20) :
 Cliquez sur le bouton de commande «OK».

Établissement de la planification du rapport :
La planification permet de définir les moments auxquels Industrial 
HiVision doit générer les rapports et la période qu'ils doivent couvrir.
 Sélectionnez Configuration > Reporting dans la barre de menus.
 Dans la boîte de dialogue «Reporting», ouvrez l'onglet «Scheduling».
 Pour créer une nouvelle planification horaire pour votre rapport, cli-

quez sur le bouton «New».
 Saisissez les paramètres du modèle (voir le tableau 21) :
 Cliquez sur le bouton de commande «OK».

Paramètres Signification
Report
Name Temp. SW1 [commutateur 1]
Title Évolution de la température dans le commutateur 1
Report Type
Type PDF
Layout Chart
Chart Type Line
Data
Monitored Properties Sélectionnez la propriété et cliquez sur la flèche droite.

Tableau 20 : Définition d'un nouveau modèle

Paramètres Signification
Report
Name Temp. SW1 [commutateur 1]
Relative Ce mode de planification horaire génère des rapports successifs.
Duration 5 jours
Offset to execution 6 jours, étant donné que le rapport doit inclure des données de 

lundi à vendredi et que le premier rapport doit être généré le 
dimanche

Tableau 21 : Définition d'une nouvelle planification horaire
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First Execution Dimanche 7 octobre 2012, 00:00:00 HEOr
Schedule every 1 semaine

Paramètres Signification

Tableau 21 : Définition d'une nouvelle planification horaire
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7.7 Propriétés personnalisées

L'utilisation de cette fonction requiert des connaissances avancées de MIB 
SNMP et de l'équipement.

7.7.1 Description des propriétés personnalisées

Industrial HiVision reconnaît déjà dans les préréglages un grand nombre 
d'équipements et leur propriétés.
Industrial HiVision vous propose, à l'aide de la fonction «User defined Pro-
perties», d'intégrer dans la gestion d'autres propriétés d'équipements com-
patibles SNMP, extraites de leur MIB.
Vous pouvez ainsi compléter et surveiller les propriétés des équipements de 
votre choix, compatibles SNMP, dans Industrial HiVision. Vous pouvez éga-
lement ajouter et surveiller de nouvelles propriétés aux équipements déjà 
reconnus par Industrial HiVision.
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7.7.2 Exemple d'application des propriétés 
personnalisées

Dans un réseau sensible, vous souhaitez surveiller la charge des compo-
sants de réseau à l'aide de paquets ICMP. Lorsqu'un équipement reçoit plus 
de 10 requêtes ICMP en 5 minutes, Industrial HiVision doit émettre un aver-
tissement.
 Pour que Industrial HiVision soit informé de cette nouvelle propriété, 

sélectionnez la boîte de dialogueConfiguration > User defined Pro-
perties.

 Pour créer une entrée avec la nouvelle propriété, cliquez sur «New» dans 
la boîte de dialogue «User defined Properties».

 Dans le champ «Name» de la nouvelle propriété, saisissez un nom uni-
voque, par ex. UserDef_ICMP-Message. Industrial HiVision attend à cet 
endroit un nom commençant par UserDef_.

 Dans le champ «Label», saisissez une désignation de cette propriété qui 
sera affichée brièvement par Industrial HiVision sur l’interface utilisateur, 
par ex. ICMP-Watch.

 Sélectionnez dans le menu déroulant «Parent Property» l'option «Agent».
 Saisissez la variable MIB de la nouvelle propriété dans le champ «MIB 

Variable/OID». 
Comme alternative, le gestionnaire MIB vous offre la possibilité d'effec-
tuer une recherche de variables MIB dans la MIB de l'équipement :
– Pour ouvrir la visionneuse MIB, cliquez sur le bouton « ... ».
– Pour voir une vision d’ensemble des MIB chargés par «MIB Viewer», 

cliquez sur le bouton «MIB Manager».
Industrial HiVision permet en outre de charger d’autres MIB dans la 
visionneuse MIB. Cliquez pour cela sur le bouton «Load...». Sélection-
nez ensuite le MIB souhaité dans le système de données.

– Ouvrez le chemin iso:org:dod:internet:mgmt:mib-2:icmp.
– Sélectionnez la variable MIB icmpInMsgs.
– Pour fermer le «MIB Viewer», cliquez sur le bouton «OK».

 Dans le champ «Instance», saisissez l'instance des variables MIB, dans 
le cas présent 0.

 Sélectionnez dans le menu déroulant «Type» l'option «Delta».
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Figure 49 :Création d'une nouvelle propriété personnalisée

 Pour conclure la définition de la propriété, cliquez sur le bouton «OK».
Vous pouvez désormais visualiser la propriété nouvellement définie dans 
la fenêtre «User defined Properties».

 Pour fermer la fenêtre «User defined Properties», cliquez sur le bouton 
«OK».

 Basculez ensuite de l'affichage détaillé à l'affichage liste.
 Sélectionnez dans l'affichage liste l'agent de l'équipement que vous sou-

haitez surveiller.
 Pour ouvrir la fenêtre «New Property», cliquez avec le bouton droit de la 

souris dans l'affichage liste et sélectionnez New > Property.
 Pour refermer la fenêtre, sélectionnez dans la fenêtre «New Property» la 

nouvelle propriété définie ICMP Watch.
 Cliquez sur le bouton de commande «OK».
Vous avez à présent assigné la nouvelle propriété ICMP Watch à l'agent. 
Pour surveiller la nouvelle propriété de l'agent, configurez l'état (voir 
page 220 “Configuration de l'état”) et la détermination de l'état (voir page 221 
“Scrutation cyclique (polling)”).
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7.8 Impact sur les ressources du 
système

Industrial HiVision propose de multiples solutions pour l’administration et la 
surveillance de votre réseau. Néanmoins, cette multiplicité d'options peut 
entraîner un épuisement voire une surcharge de vos ressources système.

Le présent chapitre vous renseigne sur la manière 
 de reconnaître 
 d’agir sur
 de minimiser l’utilisation de vos ressources système.
236
User Manual Industrial HiVision

Release 8.1 12/19



Configurer la surveillance du réseau 7.8 Impact sur les ressources du sys-
tème
7.8.1 Identification de la charge de vos 
ressources système

Les opérations de polling et les affichages d'historique sont les actions prin-
cipales ayant un impact sur les ressources système.
Dans des cas extrêmes, vous pouvez percevoir un ralentissement de votre 
système après avoir modifié un tel paramètre.
Dans d'autres cas, vous aurez besoin d'indicateurs objectifs pour compléter 
votre perception subjective. Ces indicateurs se trouvent dans Help > Kernel 
Info > Polling.

Indicateur Signification
Number of polled pro-
perties [Nombre de 
propriétés scrutées]

Affiche le nombre de propriétés pour lesquelles la scrutation est acti-
vée.
Cet affichage prend en compte pour ce faire les équipements (voir 
page “Manage” on page 279) surveillés par Industrial HiVision avec les 
propriétés correspondantes.

Nombre of properties 
recording history 
[Nombre de propriétés 
enregistrées dans l'his-
torique]

Affiche le nombre de propriétés pour lesquelles l'enregistrement de 
l'historique est activé. 
Cet affichage prend en compte pour ce faire les équipements (voir 
page “Manage” on page 279) surveillés par Industrial HiVision avec les 
propriétés correspondantes.

Polling operations per 
minute [Opérations de 
scrutation par minute]

Industrial HiVision additionne les propriétés pour lesquelles la scruta-
tion est activée et fait le rapprochement entre le total et l'intervalle de 
polling. Étant donné que certains intervalles de scrutation sont supé-
rieurs à 1 minute, il se peut que le nombre d'opérations de scrutation 
au cours de la dernière minute ait pu dépasser la valeur calculée.
Cet affichage prend en compte pour ce faire les équipements (voir 
page “Manage” on page 279) surveillés par Industrial HiVision avec les 
propriétés correspondantes.

Polling operations in 
the last minute [Opéra-
tions de scrutation pen-
dant la dernière 
minute]

Affiche le nombre d'opérations de polling effectuées pendant la der-
nière minute.
Cet affichage prend en compte pour ce faire les équipements (voir 
page “Manage” on page 279) surveillés par Industrial HiVision avec les 
propriétés correspondantes.

Total number of history 
entries set [Total des 
entrées paramétrées 
de l'historique]

Affiche le nombre des entrées enregistrées par Industrial HiVision  
(voir page 229 “Configuration de protocole”).

Total number of actual 
history entries [Total 
des entrées réelles de 
l'historique]

Affiche le nombre des entrées réellement enregistrées par Industrial 
HiVision.

Tableau 22 : Indicateurs de charge des ressources système dans Kernel Info
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7.8.2 Influence sur l'exploitation des ressources 
système

La plus grande influence que vous puissiez exercer sur l'exploitation de vos 
ressources système consiste à ajuster les options d'opérations de polling et 
d'enregistrement dans l'historique. Vous pouvez visualiser les propriétés 
pour lesquelles la scrutation et l'enregistrement sont actuellement activés 
dans la boîte de dialogue «Monitor» (voir page “Monitor” on page 321).

Afin de minimiser l'exploitation de vos ressources système, observez les 
points suivants :
 Chaque propriété que vous activez dans Industrial HiVision pour une 

requête périodique crée une charge dans votre station d'administration 
réseau et augmente le trafic du réseau.
 Vérifiez le nombre réel de propriétés à surveiller.
 Vérifiez la fréquence de requête nécessaire à la surveillance.

 Chaque entrée d'historique encombre la station d'administration de 
réseau et diminue l'espace de stockage.
 Vérifiez le nombre réel de propriétés à enregistrer.
 Vérifiez la taille de mémoire tampon nécessaire.

 La fonction MultiConfig™ vous permet de régler simultanément les comp-
teurs statistiques de plusieurs équipements. Le réglage des compteurs 
statistiques active les opérations de scrutation et d'enregistrement.
 Avant d'utiliser la fonction MultiConfig™, mesurez l'impact de ces 

réglages sur vos ressources système.
 Un nombre important d'événement augmente considérablement la 

mémoire nécessaire, le temps de démarrage du programme, et le temps 
de démarrage de la boîte de dialogue du filtre d'événements.

Afin d'assurer une bonne performance de votre station d'administration de 
réseau, il convient de prendre en compte d'autres facteurs d'influence :
 Extension du réseau
 Nombre de nœuds
 Complexité de la gestion des nœuds
 Charge du réseau
 Capacité de l'ordinateur de votre station d'administration de réseau
 Capacité de mémoire (RAM et disque dur) de votre station d'administra-

tion de réseau
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7.8.3 Minimisation de la scrutation

Industrial HiVision vous permet d'adapter progressivement le comportement 
de polling à vos besoins. Vous pouvez modifier l’intervalle de polling et déter-
miner en outre quelles propriétés Industrial HiVision doit scruter.

 Modification de l'intervalle de scrutation pour les 
propriétés de plusieurs équipements
Le tableau (voir page 467 “Propriétés surveillées dans le préréglage”) 
indique quelles propriétés sont surveillées par Industrial HiVision avec le 
paramètre de polling de base.
Pour réduire le volume de scrutations à l'aide de la surveillance de tem-
pérature des équipements dans l'affichage détaillé, procédez de la 
manière suivante :Surveillance de température
 Dans l’affichage détaillé, sélectionnez l’onglet «Properties».
 Sélectionnez dans le menu déroulant «Device Class:» l'option «All».
 Sélectionnez dans le menu déroulant «Property:» l'option 

«Temperature (Device)».
 Sélectionnez chaque équipement du tableau avec la combinaison de 

touches « CTRL » + « A ».
 Cliquez avec le bouton droit de la souris sur l'équipement A et sélec-

tionnez MultiConfig™.
 Dans l'arborescence de la boîte de dialogue de MultiConfig™, sélec-

tionnez «Property Properties».
 Saisissez 10 minutes dans le champ de texte «Polling Interval».
 Pour enregistrer les modifications, cliquez sur le bouton «Write».
Procédez de la même manière pour désactiver la scrutation.

 Désactivation de la scrutation pour les propriétés de 
connexion
Dans les paramètres de base, Industrial HiVision scrute la charge du 
réseau toutes les 30 secondes.
Pour désactiver la scrutation de la charge du réseau, procédez comme 
suit :
 Dans l’affichage détaillé, sélectionnez l’onglet «Connections».
 Sélectionnez chaque connexion du tableau avec la combinaison de 

touches « CTRL » + « A ».
User Manual Industrial HiVision
Release 8.1 12/19 239



Configurer la surveillance du réseau 7.8 Impact sur les ressources du sys-
tème
 Cliquez avec le bouton droit de la souris sur une connexion et sélec-
tionnez MultiConfig™.

 Dans l'arborescence de la boîte de dialogue de MultiConfig™, sélec-
tionnez «Connection Properties».

 Dans le cadre fonctionnel de la boîte de dialogue MultiConfig™, déco-
chez la case Monitor > Polling > Load.

 Pour enregistrer les modifications, cliquez sur le bouton «Write».

7.8.4 Minimisation de la charge du réseau

Industrial HiVision vous permet de réduire la charge du réseau due à la 
reconnaissance d'équipements.
 Sélectionnez Configuration > Preferences > Advanced > Service 

Parameters.
 Réduisez sous «Device Discovery» la «Scan Rate [devices/min]».
 Réduisez sous «Device Discovery» la valeur pour «Simultaneously Dis-

covered Devices».
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7.9 Systèmes de visualisation de 
processus

7.9.1 Connexion au système de visualisation de 
processus

Comme interface vers des systèmes de visualisation de processus (SCADA, 
Supervisory Control and Data Acquisition), Industrial HiVision contient des 
services OPC sur les systèmes d'exploitation Windows.

Si Hirschmann Industrial HiVision 08.1.00 Service est actif, les services OPC 
peuvent lire des données de Industrial HiVision et les mettre à disposition 
des systèmes de visualisation de processus. Les services OPC peuvent éga-
lement écrire des données dans Industrial HiVision. Pour communiquer, les 
services OPC prennent en charge OPC Data Access V1 à V3 et OPC Unified 
Architecture.
OPC DA se base sur le protocole DCOM (Distributed Component Object 
Model) de Microsoft. DCOM est conçu comme protocole de transmission sur 
plusieurs niveaux, par ex. avec le protocole Internet HTTP. Ainsi, DCOM 
prend en charge la communication directe entre les composants logiciels via 
le réseau local.
Windows 2008 R2, Windows Server 2012 R2 prend en charge DCOM. Vous 
trouverez des informations complémentaires concernant le DCOM sur le site 
de Microsoft.
Activez le protocole DCOM et l'accès à distance sur la station d'administra-
tion réseau pour l'accès à distance d'un client OPC sur le serveur OPC.
OPC UA est un protocole basé sur XML indépendant du système d'exploita-
tion.

Paramètre par défaut pour le nom du Industrial HiVision Service Serveur 
OPC: Serveur OPC UA est défini comme serveur par défaut et le serveur est 
actif (voir page 391 “Accès Services”).
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Commentaire : Lorsque vous activez le service de serveur OPC Industrial 
HiVision, un client OPC utilise le service OPC et Industrial HiVision avec 
droits d’écriture pour accéder aux équipements administrés par Industrial 
HiVision.
Pour désactiver les droits d’écriture, ouvrez la boîte de dialogue 
Configuration > Preferences > Advanced > Mobiles. Décochez la case 
«Global Write» dans le cadre «OPC Server». 
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Figure 50 :Connexion au système de visualisation de processus
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7.9.2 Structure des données de transfert pour 
OPC

Le serveur OPC Industrial HiVision présente les données à transférer dans 
la même arborescence que le cadre Folders [Répertoires] de Industrial 
HiVision. Les éléments individuels et leurs valeurs sont appelés « tags ». 
Pour indiquer la hiérarchie, Industrial HiVision utilise des préfixes qu'il posi-
tionne devant les noms de tags. Les noms de tags correspondent aux noms 
utilisés par Industrial HiVision en anglais. 
Une modification des noms dans Industrial HiVision rend impossible l'accès 
aux tags pour les clients OPC. Il en est de même si les composants sont 
déplacés dans d'autres répertoires.

Commentaire : Si les composants doivent être fréquemment déplacés, vous 
pouvez créer un lien vers les composants dans votre dossier (par ex. Dos-
sier/OPC) et accéder au lien via OPC. Cette méthode vous sera également 
utile si votre système de visualisation de processus impose une limitation de 
la longueur des noms d'étiquette.

Préfixe Type de composant
C_ Connexion
D_ équipement
F_ Dossier
L_ Connexion
P_ Port
V_ Détail de l'équipement

Tableau 23 : Noms d'étiquette pour OPC
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Dans le cas de nom d'équipement, Industrial HiVision affiche les adresses IP 
avec des tirets bas au lieu de points. Le serveur OPC Industrial HiVision rem-
place les points et espaces par des tirets bas.
Dans la structure, chaque nœud/dossier se compose de 5 étiquettes, à 
l'exception des équipements, détails d'équipement et connexions.
Un équipement dispose de l'étiquette supplémentaire « Managed » [Géré].
Un détail d'équipement dispose d'une étiquette supplémentaire « Value » 
[Valeur].
Une connexion dispose des étiquettes supplémentaires « ConnectionState » 
[État de connexion], « Utilization_AB » et « Utilization_BA ». 

Nom d'étiquette Signification Composant
Label Nom du composant tel que l'interface du logiciel l'affiche. tous
État de sécurité État actuel en valeur numérique. 

0=No Status [Sans statut], 
1=Unavailable [Non disponible], 
2=Ok, 
3=Warning [Avertissement], 
4=Error [Erreur]

tous

Status [Statut] État actuel en valeur numérique. 
0=No Status [Sans statut], 
1=Unavailable [Non disponible], 
2=Ok, 
3=Warning [Avertissement], 
4=Error [Erreur]

tous

StatusString 
[Chaîne de statut]

État actuel comme texte (anglais) lisible, par ex. « OK », 
« Error ».

tous

StatusReason 
[Raison du statut]

Liste de toutes les raisons qui contribuent au statut du com-
posant, sous forme de texte lisible (anglais). 

tous

StatusChanged 
[Modification du 
statut]

Affiche si le statut de l'objet n'est pas validé.
 0 = confirmé, 
1 = non confirmé
Vous pouvez mettre la valeur à « 0 » via OPC.

tous

Managed [Géré] Affiche si Industrial HiVision surveille l'équipement. équipement
Value [Valeur] Valeur actuelle du détail de composant. Détail de 

l'équipement
ConnectionState 
[Statut de 
connexion]

Statut de connexion tel qu'il est affiché dans l'interface du 
logiciel, à savoir par représentation de la ligne : 
1=Unavailable [Non disponible], 
2=Active [Actif] (ligne continue), 
3=Standby [Veille] (ligne discontinue), 
4=Inactive [Inactif] (ligne en traits-points )

Liaison

Tableau 24 : Étiquettes disponibles
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Commentaire : Le serveur OPC de Industrial HiVision prend en charge les 
requêtes avec jusqu'à 3 000 tags OPC.

Figure 51 :Exemple d'affichage d'une arborescence OPC

7.9.3 Applications prises en charge pour OPC DA

Hirschmann a testé Industrial HiVision avec les applications suivantes :

Utilization_AB Charge de la ligne depuis le premier point de terminaison 
jusqu'au deuxième point de terminaison (séquence telle que 
représentée dans l'arborescence OPC).

Liaison

Utilization_BA Charge de la ligne depuis le deuxième point de terminaison 
jusqu'au premier point de terminaison (séquence telle que 
représentée dans l'arborescence OPC).

Liaison

Nom d'étiquette Signification Composant

Tableau 24 : Étiquettes disponibles
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7.9.4 Applications prises en charge pour OPC UA

Pour connecter un client SCADA avec le serveur OPC-UA Industrial 
HiVision, le client SCADA requiert l'URL suivante :
opc.tcp://<IP-ADDRESS>:11189/OPCUA/HiVisionUaServer
Le port du serveur OPC-UA se trouve dans la boîte de dialogue 
Preferences > Advanced > Services Access.

Hirschmann a testé Industrial HiVision avec les applications suivantes :

Logiciel Version Fabricant
RS View 32 7.20.00 Rockwell Automation
Genesis 32 8.00.138.00 Iconics, Inc
Simatic WinCC 6.0 Siemens AG
Citect SCADA 6.0 Citect Corporation
Softing OPC Demo Client 4.10 Built 512 Softing AG

Logiciel Version Fabricant
Ignition 7.9.6 Inductive Automation
Prosys 2.3.3-170 Prosys OPC
UaExpert 1.03.0.201 Unified Automation
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7.9.5 Exemple de connexion OPC-UA

Le serveur OPC UA est activé dans le préréglage. Pour vous assurer que le 
serveur OPC-UA est activé, ouvrez la boîte de dialogue Preferences > 
Avancé > Accès Services. La boîte de dialogue «Accès Services» affiche 
en outre le modèle de serveur OPC installé.

Si vous souhaitez modifier le modèle de serveur OPC, procédez comme 
suit :

Les étapes suivantes concernent exclusivement les versions 6.0 et 7.0.
 Lorsque Industrial HiVision est exécuté sur votre ordinateur, arrêter le 

noyau actuel.
 Ouvrez la boîte de dialogue Windows Control Panel> Programs and 

Features.
 Sélectionnez le programme Industrial HiVision et l'option Change.
 Dans la boîte de dialogue de maintenance de Industrial HiVision, sélec-

tionnez l'option Modify et cliquez sur le bouton Next.
 Dans la boîte de dialogue Select Components, cochez la case OPC 

service.
 Assurez-vous que seule une case est cochée puis cliquez sur le bouton 

Next.
 Dans la boîte de dialogue Setup Needs The Next Disk, cliquez sur le 

bouton Browse...
 Sur le support de données d'installation, naviguez vers le dossier conte-

nant le fichier data2.cab et cliquez sur le bouton OK.
 Dans la boîte de dialogue InstallShield Wizard Complete, cochez la 

case souhaitée et cliquez sur le bouton Finish.

Si votre version de Industrial HiVision est 7.1 ou supérieure, Industrial 
HiVision requiert une nouvelle installation.
 Réalisez une sauvegarde de votre base de données avant de lancer la 

nouvelle installation.
 Désinstallez Industrial HiVision.
 Dans la boîte de dialogue Attendant question, cliquez sur le bouton No 

Si vous cliquez sur le bouton No, Industrial HiVision conserve le fichier 
d'installation contenant votre base de données, les PSM et les fichiers de 
licence.

 Réinstallez Industrial HiVision.
 Dans la boîte de dialogue Select Components, cochez la case OPC 

service.
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L'exemple suivant illustre le mode de connexion entre le serveur OPC-UA 
Industrial HiVision et un client OPC-UA d’Inductive Automation 
Ignition. La condition préalable pour cet exemple est que le serveur OPC 
UA et le client soient installés sur le même PC.

 Installez et ouvrez le logiciel client OPC UA.
 Dans le champ Ignition Gateway Control Utility> Port, entrez la 

valeur 8088.
 Redémarrez la passerelle.
 Dans la boîte de dialogue Ignition Gateway Control Utility, cliquez 

sur le bouton Start the Ignition Service
 Dans la boîte de dialogue Message, cliquez sur le bouton OK
 Dans la boîte de dialogue Ignition Gateway Control Utility, sélec-

tionnez l'option Go to webpage.
 Dans la boîte de dialogue Ignition localhost, sélectionnez l'option 

Configure.
 Dans la boîte de dialogue Sign In, entrez les données standards de 

connexion.
User name = admin, Password = password

 Dans la boîte de dialogue Configuration, sélectionnez l'option OPC 
Connections> Servers.

 Dans la boîte de dialogue OPC Server Connections, sélectionnez 
l'option Create new OPC Server Connection....

 Dans la boîte de dialogue Add OPC Server Connection Step 1: Choose 
Type, sélectionnez l'option OPC UA.

 Dans la boîte de dialogue Discover OPC-UA Endpoints, entrez l'URL 
suivante : opc.tcp://127.0.0.1:11189/OPCUA/HiVisionUaServer

 Pendant le processus Discovery, Industrial HiVision enregistre le certifi-
cat Ignition dans le répertoire d'installation sous 
services\PKI\CA\rejected. Si vous souhaitez utiliser une connexion 
sécurisée, coupez le certificat du répertoire rejected et ajoutez-le dans 
le répertoireservices\PKI\CA\cert.

 La boîte de dialogue Discover OPC-UA Endpoints affiche désormais 
diverses options. Pour utiliser une connexion sécurisée, sélectionnez 
l'option SecurityPolicy: Basic128Rsa15, MessageSecurity: 
SignAndEncrypt.

 Dans le cadre New OpcUaConnectionSettings> Main, entrez un nom et 
une description explicites. Vous pouvez adapter les paramètres au terme 
de la configuration.

 Cliquez sur le bouton Create new OPC Server Connection.
 La boîte de dialogue OPC Server Connections s'ouvre et affiche le nou-

veau serveur ainsi que son état.
Vous pouvez désormais configurer le tableau de bord Ignition Designer.
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7.9.6 Serveur OPC UA – certificats personnalisés

L’installation OPC UA Industrial HiVision fonctionne conformément aux spé-
cifications pour l’authentification de serveur à deux étapes avec OPC UA. 
Industrial HiVision met à disposition un serveur OPC UA qui utilise des cer-
tificats CA pour l’identité de serveur. Les clients OPC UA peuvent dans ce 
cas faire confiance à la connexion au serveur. La syntaxe de ces certificats 
correspond à la spécification X509.

Le serveur OPC UA utilise les types de certificat suivants pour 
l’identification :
 un certificat Certification Authority (CA) qui peut être utilisé pour la signa-

ture de certificats dans un environnement d’entreprise, par ex. Hirsch-
mannSampleCA.

 un certificat d’identité d’application identifiant le serveur OPC UA, par ex. 
HiVisionUaServer.

 un certificat HTTPS identifiant le serveur HTTPS OPC UA, par ex. HiVi-
sionUaServer.

Chaque certificat comprend les fichiers suivant :
 une clé privée au format .der
 une clé privée au format .pem

Lorsque le serveur OPC UA démarre, e serveur contrôle si les certificats 
existent dans le sous-répertoire d’installation. Si les certificats manquent, le 
serveur crée les certificats standard.

Commentaire : Les certificats CA se trouvent dans le sous-répertoire d’ins-
tallation services/PKI/CA/private sous le chemin Industrial HiVision. Les 
certificats CA représentent des données très sensibles. Sécurisez le sous-
répertoire contre les accès en lecture et en écriture non autorisés.
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Le fichier de configuration OPC UA server.properties.xml est enregistré 
dans le sous-répertoire lib/opcua/config/. Le fichier de configuration 
contient les paramètres suivants, qui dirigent le comportement du serveur 
relativement au traitement des certificats :
 OpcUaServer.issuer.name est le nom de fichier de base du certificat 

CA. Le nom de fichier de base standard est HirschmannSampleCA. Si 
aucun certificat CA n’existe, le serveur crée le certificat avec le nom de 
fichier indiqué et utilise le nom de fichier standard comme nom de l’émet-
teur du certificat.

 OpcUaServer.private.password est le mot de passe utilisé par le ser-
veur pour le chiffrage ou le déchiffrage des clés privées des certificats. Le 
mot de passe standard est opcua. Lorsque vous modifiez le mot de 
passe, utilisez le nouveau mot de passe pour chaque certificat que vous 
créez. Remplacez les certificats existants basés sur le mot de passe 
obsolète ou recréez-les.

Commentaire : Le mot de passe pour la clé privée représente des données 
hautement confidentielles. Sécurisez le fichier de configuration 
server.properties.xml contre les accès en lecture et en écriture non auto-
risés.

 Certificats standard
Si aucune exigence spécifique n’existe en matière de certificats, le ser-
veur utilise les certificats CA standard et les valeurs du pack d’installation 
pour la création de certificats auto-signés. Le client importe ensuite les 
certificats auto-signés ou les déclare dignes de confiance.

 Certificats d’entreprise CA
Si une organisation émet un certificat d’entreprise CA pour la signature 
des certificats, vous pouvez utiliser le certificat d’entreprise CA avec le 
serveur OPC UA. Pour utiliser les certificats d’entreprise CA avec le ser-
veur OPC UA, procédez comme suit :
 Supprimez les certificats enregistrés dans le sous-répertoire 

services/PKI/CA/private.
 Convertissez vos certificats CA aux formats .pem et .der. Copiez les 

certificats dans le sous-répertoire services/PKI/CA/private.
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 Ouvrez le fichier server.properties.
 Saisissez le nom de base des fichiers de certificat d’entreprise CA 

dans la ligne OpcUaServer.issuer.name.
 Saisissez le mot de passe de la clé privée dans la ligne 

OpcUaServer.private.password.
– Si vous n’utilisez pas de mot de passe, utilisez une suite de carac-

tères vide.

Lorsque le serveur OPC UA démarre pour la première fois, le serveur 
crée un certificat d’identification d’entreprise ainsi qu’un certificat HTTPS 
sur la base du certificat d’entreprise CA.

 Certificat d’identité d’application
Lorsque vous utilisez un certificat créé pour vous par votre organisation 
ou un organisme de confiance, vous pouvez utiliser le certificat comme 
certificat d’identité d’application pour le serveur HTTPS. Pour utiliser le 
certificat d’identité d’application avec le serveur OPC UA, procédez 
comme suit :
 Supprimez les certificats enregistrés dans le sous-répertoire 

services/PKI/CA/private.
 Convertissez vos certificats CA aux formats .pem et .der. Copiez les 

certificats dans le sous-répertoire services/PKI/CA/private.
– Déterminer HiVisionUaServer comme nom de fichier de base pour 

le certificat d’identité d’application.
– Modifiez le certificat HTTPS en HiVisionUaServer_http.

 Ouvrez le fichier server.properties.
 Saisissez le mot de passe de la clé privée dans la ligne 

OpcUaServer.private.password.
– Si vous n’utilisez pas de mot de passe, utilisez une suite de carac-

tères vide.

Lorsque le serveur OPC UA démarre pour la première fois, le serveur 
crée un certificat CA. Le certificat CA créé lors du démarrage n’est pas 
utilisé dans cette situation. Le serveur OPC UA crée en outre les divers 
certificats manquants.
252
User Manual Industrial HiVision

Release 8.1 12/19



Configurer la surveillance du réseau 7.10 Accéder à distance à Industrial
HiVision
7.10 Accéder à distance à 
Industrial HiVision

7.10.1 Accès web à Industrial HiVision

Industrial HiVision vous offre la possibilité d'accéder au serveur web de 
Industrial HiVision à l'aide d'un navigateur via le protocole http ou https. Il est 
recommandé d'utiliser le protocole sécurisé HTTPS et le certificat (voir 
page 259 “Certificat de la connexion HTTPS”). Vous disposez ainsi d'une 
vue d'ensemble de votre réseau depuis le monde entier.
Exemple d'une adresse internet saisie :
https://[IP address of your network management station]:11187
Vous pouvez limiter l'accès au moyen d'un mot de passe. Pour fournir des 
informations relatives à l'accès, Industrial HiVision peut créer un événement 
pour chaque accès réussi (voir page 389 “Avancé”).

Commentaire : Le programme communique avec le service via le port «Web 
Server», 11187, et le port «Project Data Server», 11188, qui se trouve dans 
la boîte de dialogue Preferences > Advanced > Services Access. Les ports 
sont configurables à partir de la version 7.0 de Industrial HiVision. Les ports 
«OPC Server» sont configurables à partir de la version 8.0 de Industrial 
HiVision Preferences > Advanced > Services Access.
Assurez-vous que ce type de communication est possible. Ceci est impor-
tant, notamment lorsque la connexion est réalisée via des pare-feu ou la redi-
rection de port.
Prenez en compte ce fait lors de l'utilisation d'un pare-feu (voir page 32 “Ins-
tallation”).
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Le serveur web de Industrial HiVision fournit les pages suivantes :
 Sélection des différents sites
 Interface utilisateur graphique
 Affichage des événements

Commentaire : Si vous souhaitez tester Industrial HiVision avant de connec-
ter l'application à un réseau réel, utilisez le réseau de démonstration fourni 
par Industrial HiVision (voir page 456 “Demo Network”).

 Sélection des différents sites
Le serveur Web Industrial HiVision fournit tout un choix de sites Internet 
mis à disposition par Industrial HiVision sur cette page.

URL pour ce site Internet :
https://[IP address of your network management station]:11187/idx

 Interface utilisateur graphique
Le serveur Web de Industrial HiVision vous offre la même interface utili-
sateur graphique que celle utilisée dans votre station d'administration 
réseau. À distance, vous pouvez ainsi surveiller et configurer votre réseau 
comme si vous étiez sur site.

URL pour ce site Internet :
https://[IP adresse of your network management station]:11187

 Évènements sur le site Internet
Les assistants électroniques de poche (ADP), les smartphones et 
d'autres équipements portables constituent les outils de travail des admi-
nistrateurs informatiques, dont l'importance ne cesse de croître. La liste 
des événements représente un élément majeur de Industrial HiVision au 
service des administrateurs. La liste des événements vous donne un 
aperçu condensé de l'état du réseau surveillé (voir page “Liste d'évène-
ments” on page 123).
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Le serveur Web Industrial HiVision fournit la liste des événements en for-
mat HTLM. La liste des événements est optimisée pour être visualisée sur 
des équipements portables tels que des téléphones intelligents iPhone, 
BlackBerry, etc.

Vous trouvez ci-après un exemple d'URL applicable au serveur Web 
Industrial HiVision :
https://[IP address of your network management station]:11187/events

Le site Internet des évènements vous permet de valider des évènements. 
Industrial HiVision synchronise les validations entre l'interface utilisateur 
graphique et l'équipement portable.
Pour assurer une bonne visibilité du site Web, Industrial HiVision limite 
l'affichage des évènements aux évènements suivants :
– évènements non validés
– évènements validés de type «Warning» et «Error».
Lorsque vous validez un évènement standard dans la liste,Industrial 
HiVision supprime l'évènement standard de la liste.

Industrial HiVision actualise cette page toutes les 5 minutes.
Vous pouvez sélectionner d'autres fréquences d'actualisation dans la 
boîte de dialogue Configuration > Preferences > Display > Event.
(voir page “Event” on page 372)

Outre les filtres prédéfinis par «Category», Industrial HiVision vous pro-
pose des filtres personnalisés évoquant la «Source» et le «Component» 
à l'origine de l'évènement. 
 Copiez une chaîne provenant de la colonne «Source» ou «Compo-

nent» dans le champ de filtre correspondant. Vous pouvez donner un 
caractère plus général à la chaîne en utilisant le caractère générique 
« * ».

Commentaire : Lorsque vous accédez à la liste d'événements via 
HTTP(S), Industrial HiVision enregistre les paramètres de filtre dans une 
session Web sur le serveur Web de Industrial HiVision.
Industrial HiVision vous offre la possibilité de modifier la validité de cette 
session web dans la boîte de dialogue Configuration > Preferences > 
Advanced > Services.
Utilisez le paramètre Industrial HiVision Web Server > Web Server 
Session Timeout [min].
Si un mot de passe est configuré pour l'accès à Internet, ce mot de passe 
reste valide après l'expiration de la session web.
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Figure 52 :Évènements sur le site Internet de Industrial HiVision

7.10.2 Accéder à l'App à Industrial HiVision

HiMobile est une utilisation mobile (App) pour équipements mobiles comme 
les smartphones et tablettes PC. 
HiMobile vous permet de recevoir des informations sur l'état de votre réseau 
à tout endroit du monde où vous disposez d'une liaison Internet et par ex. 
d'une connexion avec le réseau de Industrial HiVision via un réseau privé vir-
tuel (RPV).
Pour ce faire, HiMobile se connecte en tant que client au service de Industrial 
HiVision pour échanger des informations.

Fonctions de HiMobile :
 Affichage du cadre Répertoires de Industrial HiVision avec les informa-

tions d'état, de liaison et éventuellement des sous-domaines
 Affichage de la liste d'événements de Industrial HiVision avec fonction de 

filtre 
 Message en cas de survenance d'un événement
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 Scan du code QR de l'équipement pour l'identification de l'équipement 
dans le cadre Répertoires et pour d'autres informations sur l'équipement 
ainsi que l'accès au site Web spécifique de l'équipement. 
Transmission des coordonnées de l'emplacement à Industrial HiVision.

 Tableau de bord du réseau pour surveiller les équipements et leurs 
connexions.

Vous trouverez l'App HiMobile à télécharger gratuitement sur le site HiVision.

 Préparer l'accès au serveur WebIndustrial HiVision
La boîte de dialogue servant à saisir les paramètres de connexion appa-
raît après le premier démarrage de l'appli et dans le menu de l'appli 
« Réglages ».
 Saisissez l'adresse IP ou le nom d'hôte de votre station d'administra-

tion de réseau. Vous trouverez l'adresse IP dans Industrial HiVision 
dans la boîte de dialogue suivante :
Configuration > Preferences > Advanced > Management 
Station > IP Address Management Station
Si votre station d'administration de réseau a plusieurs cartes de 
réseau, prenez l'adresse IP de la carte d'administration de réseau uti-
lisée par HiMobile pour communiquer avec Industrial HiVision.
Si votre station d'administration de réseau est protégée par un pare-
feu à fonction NAT, demandez l'adresse IP correspondante à l'admi-
nistrateur du pare-feu.

 Saisissez le port du serveur Web. Vous trouverez l'adresse IP dans 
Industrial HiVision dans la boîte de dialogue suivante :
Configuration > Preferences > Advanced > Mobiles

 Saisissez le «User Name» et le «Password» pour l'accès Web. Vous 
trouverez ces données dans Industrial HiVision dans la boîte de dia-
logue suivante :
Configuration > Preferences > Basics > User Management
Dans la «User Management», sélectionnez un utilisateur qui dispose 
d'un «Web Access» dans les «Access Roles».
Voir “User Management” on page 347.

 Saisissez le nom de l'équipement. Industrial HiVision affiche le nom de 
votre équipement mobile dans la boîte de dialogue «Mobile Devices» 
sous Configuration > Preferences > Advanced > Mobile Devices.
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 Identifier les équipements avec l'App
Industrial HiVision vous offre la possibilité d'enregistrer un code QR par 
équipement. Imprimez ce code QR et fixez-le sur l'équipement concerné. 
Le scanner de code QR HiMobile vous permet de scanner ce code QR 
sur place pour identifier l'équipement. Scannez le code QR pour afficher 
les informations sur votre équipement mobile. HiMobile appelle alors les 
informations de l'équipement sur le serveur WebIndustrial HiVision et 
affiche les informations sur votre équipement mobile.

 Pour générer les codes QR d'équipements, cochez un ou plusieurs 
équipements d'une classe d'équipements et, pour ouvrir la boîte de 
dialogue MultiConfig™, sélectionnez la 
configuration :Configuration > MultiConfig™.

 Dans la boîte de dialogue MultiConfig™, sélectionnez dans l'arbores-
cence Device Settings > Diagnostics > QR Code Generator.
L'équipement offre les possibilités suivantes de sauvegarde du code 
QR :
– Modifier le chemin et du nom de fichier préréglé pour enregistrer 

les fichiers de code QR.
– Définir la taille du code QR en pixels.
– Enregistrer les entrées comme préréglage.

 Pour sauvegarder les codes QR dans le répertoire indiqué, cliquez sur 
le bouton de commande «Write».

La boîte de dialogue Configuration > Preferences > Advanced > 
Load/Save vous permet de définir globalement le chemin avec le nom de 
fichier et des jetons comme caractères de remplacement.

 Affichage de l'emplacement géographique d'un équipement
Industrial HiVision vous offre la possibilité d'afficher l'emplacement géo-
graphique d'un équipement sur une carte, par ex. Google Maps, sur votre 
station d'administration réseau.
Vous avez le choix entre 2 possibilités pour l'indication de 
l'emplacement :
 Dans l'interface utilisateur de Industrial HiVision

 Ouvrez l'onglet «Properties» dans l'affichage détaillé.
 Sélectionnez dans le menu déroulant «Property:» l'option «Loca-

tion Coordinates (Device)».
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 Pour ouvrir la boîte de dialogue «Location Coordinates», exécutez 
un double-clic sur l'équipement dont vous tenez à saisir les coor-
données.

 Enregistrez les coordonnées de l'emplacement sous «Value» dans 
le cadre «Current Value», par ex. 48.743286,9.320326.

 Dans HiMobile
 Pour accéder à l'affichage des propriétés d'un équipement, sélec-

tionnez un équipement. 
 Pour saisir les coordonnées géographiques, effleurez le stylet 

d'édition de la propriété « Coordonnées de l'emplacement ». 
Doté de la fonction « Get My Location », votre équipement portable 
utilise les méthodes disponibles, par ex. GPS, pour déterminer vos 
coordonnées de localisation. Si vous vous trouvez à un autre 
endroit avec votre équipement mobile, vous pouvez saisir manuel-
lement la longitude et la latitude. 
HiMobile transmet ces données à la station d'administration 
réseau.

7.10.3 Certificat de la connexion HTTPS

Pour protéger le mieux possible la connexion entre votre équipement mobile 
ou un navigateur et Industrial HiVision, il faut un nouveau certificat. Il vous 
faut pour cela un référentiel de serveur Web. Le gestionnaire de clés de ser-
veur Web est un fichier contenant les clés de la connexion https.
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L'exemple suivant est valable également pour les systèmes d'exploitation 
Linux vous remplacez « \ » par « / ».
 Dans l'interprète de lignes de commande du système d'exploitation, allez 

dans le répertoire d'installation de Industrial HiVision.
 Créez un référentiel de serveur Web Industrial HiVision dans l'interprète 

de lignes de commande du système d'exploitation Microsoft MS-DOS 
avec la commande suivante :
lib\java_x86\bin\keytool -genkey -alias hirschmann -keyalg 
RSA -keystore keystore -keysize 2048 -keypass password -
storepass password
Après avoir indiqué vos prénom et nom, indiquez le nom spécifique du 
domaine dans lequel votre station d'administration de réseau est inté-
grée.
Vous pouvez répondre à votre guise aux questions concernant votre unité 
organisationnelle, votre ville ou votre commune et votre pays.
Répondez à la demande de code de pays en indiquant les deux lettres de 
votre code de pays.
Vous trouvez le fichier « keystore » dans le répertoire vous ayant permis 
d'exécuter la commande.

 Pour demander un certificat auprès d'une agence de certification, il vous 
faut un fichier « certificate signing request » (*.csr).
Vous créez ce fichier dans l'interprète de lignes de commande du sys-
tème d'exploitation avec la commande suivante :
lib\java_x86\bin\keytool -certreq -alias hirschmann -
keystore keystore -file ihivision.csr -storepass password
Vous trouvez le fichier *.csr dans le répertoire vous ayant permis d'exé-
cuter la commande.

 Demandez avec ce fichier *.csr un certificat à une agence de certification 
comme par ex. Verisign.de.
L'agence de certification vous délivre le certificat signé sous forme d'un 
fichier ou d'une suite de caractères ASCII.
Si vous recevez un fichier, renommez-le enihivision.crt.
Si vous recevez une suite de caractères ASCII. copiez-la complètement 
dans un fichier texte portant le nomihivision.crt.

 Importez le certificat dans le référentiel de serveur Web de l'interprète de 
lignes de commande du système d'exploitation avec la commande 
suivante :
lib\java_x86\bin\keytool -import -trustcacerts -alias hirschmann -file 
ihivision.crt -keystore keystore -storepass password
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 Sauvegardez le fichier « référentiel » dans le répertoire d'installation 
deIndustrial HiVision avant de remplacer le fichier existant par le nouveau 
fichier créé.

 Remplacez le fichier « référentiel » dans le répertoire d'installation 
deIndustrial HiVision par le nouveau fichier « référentiel ».

Commentaire : Les fichiers contiennent des codes confidentiels compa-
rables à un mot de passe. Protégez ces fichiers de tout accès non autorisé.

Au lieu de cela, vous pouvez aussi établir vous-même votre certificat, voir 
openssl.org. Importez le certificat d'origine nécessaire à cet effet dans l'équi-
pement mobile ou le navigateur avec lequel vous voulez vous connecter à 
Industrial HiVision.
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8 Références

Alors que les chapitres précédents étaient axés sur les tâches, le chapitre 
Références décrit les différentes boîtes de dialogue et options de menu 
d'après les fonctions. Les détails de fonctions d'un moindre intérêt pour exé-
cuter des tâches de base vous y sont décrits.
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8.1 File

Le menu «File» contient les fonctions ayant trait aux opérations de fichier.
Industrial HiVision exécute les opérations de fichier sur un ordinateur. Votre 
interface communique avec le service Hirschmann Industrial HiVision 
08.1.00 Service de cet ordinateur. Si vous avez installé le service et l'inter-
face utilisateur sur plusieurs ordinateurs, la boîte de dialogue de sélection de 
fichiers s'affiche pour la sélection de fichiers (voir la figure 55). 

En double-cliquant dans une ligne du tableau, vous accédez à un niveau 
inférieur dans l'arborescence des fichiers. En cliquant sur «Up», vous accé-
dez à un niveau supérieur dans l'arborescence des fichiers.

Le chemin d'accès de la fenêtre où vous vous trouvez s'affiche en haut du 
tableau.

Figure 55 :Boîte de dialogue de sélection de fichiers pour différents ordinateurs
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8.1.1 New Project

Ce champ de sélection vous permet de créer un nouveau projet dans lequel 
vous pouvez enregistrer vos données réseau.

Commentaire : En sélectionnant «New Project», vous supprimez le projet 
actuel. Pour enregistrer les données du projet actuel, exportez ce projet sous 
un autre nom (voir page 270 “Save”), avant de sélectionner un nouveau pro-
jet.

8.1.2 New

Vous utilisez cette sélection pour accomplir les fonctions suivantes :

 ajouter un nouveau dossier
 ajouter un nouvel équipement au dossier sélectionné
 ajouter un nouvel équipement issu d'une liste au dossier sélectionné
 ajouter un nouveau sous-domaine au dossier sélectionné
 établir une nouvelle connexion
 ajouter des compteurs avec des propriétés au niveau du port, par ex. pour 

des paquets de données non diffusés par envoi individuel « In non Uni-
cast Packets ».

 ajouter une ligne de texte 
 ajouter une icône Vous pouvez modifier l’icône dans la fenêtre «Proper-

ties...» de l’icône.
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 Devices from List
Industrial HiVision vous offre la possibilité d’analyser des adresses IP via 
un fichier texte ou Microsoft Excel (.csv). La boîte de dialogue «Create 
Devices from List» vous permet de rechercher le fichier et de le charger 
dans Industrial HiVision. Si un équipement n'est pas accessible dans la 
liste, Industrial HiVision indique l'équipement comme étant un équipe-
ment générique sur la carte de topologie.

La boîte de dialogue «Create Devices from List» vous offre la possibilité 
d'ajouter les adresses IP contenues dans le fichier au tableau 
Preferences > Basics > Discover Devices > Network Scan. Si vous 
cochez la case de contrôle «Add IP addresses to 'Preferences - Basics - 
Discover Devices - Network Scan'», Industrial HiVision reporte les 
adresses IP extraites du fichier textuel dans le tableau.

Si vous cochez les cases de contrôle «Add IP addresses to 'Preferences 
- Basics - Discover Devices - Network Scan'» et «Combine consecutive 
IP addresses into ranges», Industrial HiVision reporte les adresses IP 
dans le tableau de la manière suivante :
 Si les adresses IP couvrent la zone des adresses contenues dans le 

tableau à l'intérieur du fichier, Industrial HiVision fusionne les 
adresses IP avec la zone d'adresses existante.

 Si la zone d'adresses IP chevauche une autre zone ou avoisine une 
zone d'adresses existante plus grande, Industrial HiVision utilise le 
masque du réseau de la zone existante.

 Si la fonction ne peut employer aucun masque du réseau provenant 
de la zone existante, la fonction assigne automatiquement la valeur du 
masque du réseau par défaut 255.255.255.0.

 La fonction réunit certaines adresses IP voisines dans les zones 
d'adresses IP, ayant été saisies dans le même fichier.

Pour établir le fichier d'adresses IP, utilisez les formats suivants :
 192.168.1.10
 # C'est une adresse individuelle.
 192.168.1.11
 # C'est également une adresse unique.
 192.168.1.12,192.168.1.15,
 # C'est une zone d'adresses.
 192.168.1.16,192.168.1.20
 # C'est aussi une zone d'adresses.
 # C'est une ligne de commentaires.
 # 192.168.1.1 C'est également une ligne de commentaires.
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Commentaire : Utilisez une virgule au lieu d'un espace pour séparer des 
zones d'adresses IP. La virgule en fin de ligne est optionnelle. Employez 
le dièse (#) pour ajouter un texte.

8.1.3 Login

Cette sélection vous permet de connecter l'interface utilisateur avec le ser-
vice sur votre ordinateur personnel (localhost) ou avec le service d'un ordi-
nateur distant.

8.1.4 Open...

Par cette sélection, vous ouvrez un projet préenregistré, afin de l'afficher ou 
d'y effectuer des modifications.

 Sélectionnez le chemin d'accès correspondant et le fichier souhaité dans 
l'arborescence de dossiers.

Commentaire : Choisissez un chemin accessible tant par le service de 
Industrial HiVision que par vous-même.
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8.1.5 Save

Cette sélection vous permet d'enregistrer vos données réseau actuelles et la 
configuration de Industrial HiVision dans un fichier de projet avec l'extension 
.ihp.

 Sélectionnez File > Save pour écraser le fichier de projet ouvert avec le 
projet actuel et la configuration actuelle deIndustrial HiVision#.

8.1.6 Save as...

Cette sélection vous permet d'enregistrer vos données réseau actuelles et la 
configuration de Industrial HiVision dans le fichier de projet ouvert. 

 Sélectionnez File > Save as....

 Sélectionnez le chemin d'accès correspondant dans l'arborescence de 
dossiers et attribuez un nom de projet.

Commentaire : Choisissez un chemin accessible tant par le service de 
Industrial HiVision que par vous-même.

 Cliquez sur «Save» pour enregistrer le projet actuel et la configuration 
actuelle de Industrial HiVision dans un nouveau fichier.

8.1.7 Save Backup

Industrial HiVision vous offre la possibilité de sauvegarder les informations 
dont vous avez besoin pour restaurer une installation Industrial HiVision.
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À cet effet, Industrial HiVision sauvegarde les informations suivantes dans 
un fichier ZIP :
 Liste PSM et modules PSM
 Configuration (fichiers des propriétés de service)
 Base de données projets 
 Base de données rapports
 Fichiers de licence 
 Fichiers journaux
 Rapports utilisateurs
 Scripts utilisateurs, tâches et résultats des tâches
 Fichier info.txt avec informations de version
Après l'appel de «Save Backup», Industrial HiVision ouvre une boîte de dia-
logue de sélection de fichier. Vous pouvez indiquer ici l'emplacement de 
stockage du fichier de sauvegarde.

Commentaire : Pour charger le fichier de sauvegarde, vous avez besoin de 
la même version de Industrial HiVision que celle utilisée pour enregistrer le 
fichier de sauvegarde. Les informations de version se trouvent dans le fichier 
info.txt du fichier ZIP de sauvegarde.

8.1.8 Chargement Backup

Industrial HiVision vous offre la possibilité de restaurer une installation 
Industrial HiVision endommagée.
À cet effet, un fichier ZIP de sauvegarde Industrial HiVision contient les infor-
mations suivantes :
 Liste PSM et modules PSM
 Configuration (fichiers des propriétés de service)
 Base de données projets 
 Base de données rapports
 Fichiers de licence 
 Fichiers journaux
 Rapports utilisateurs
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 Scripts utilisateurs, tâches et résultats des tâches
 Fichier info.txt avec informations de version
Après l'appel de «Load Backup», Industrial HiVision ouvre une boîte de dia-
logue de sélection de fichier. Vous pouvez indiquer ici l'emplacement de 
stockage du fichier de sauvegarde.

Commentaire : Pour charger le fichier de sauvegarde, vous avez besoin de 
la même version de Industrial HiVision que celle utilisée pour enregistrer le 
fichier de sauvegarde. Les informations sur la version se trouvent dans le 
fichier info.txt du fichier ZIP de sauvegarde.

8.1.9 Export...

Cette sélection vous permet d'exporter le contenu de l'affichage détaillé.
Industrial HiVision exporte les graphiques (présentation de la topologie) sous 
la forme d'un :

 Fichier PDF
 Fichier jpg
 Fichier png
 Fichier bmp
Industrial HiVision exporte les tableaux en tant que :

 Fichier PDF
 Fichier HTML
 Fichier CSV (voir page 470 “Exportation CSV”)

 Sélectionnez File > Export... et ensuite le type de fichier dans la 
fenêtre «Save».
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8.1.10 Export Events...

Cette sélection vous permet d'exporter la liste d'évènements complète 
comme :

 Fichier PDF
 Fichier HTML
 Fichier CSV (voir page 470 “Exportation CSV”)

 Sélectionnez File > Export Events... et ensuite le type de fichier dans 
la fenêtre «Save».

8.1.11 Print

Cette sélection vous permet d'imprimer le contenu d'un affichage détaillé.

 Sélectionnez File > Print.
Industrial HiVision crée un fichier PDF temporaire du contenu de la liste 
et ouvre le fichier PDF dans un logiciel d'affichage PDF installé dans votre 
station d'administration, tel Acrobat Reader.

8.1.12 Print Events

Cette sélection vous permet d'imprimer la liste des évènements complète.

 Sélectionnez File > Print Events.
Industrial HiVision crée un fichier PDF temporaire du contenu de la liste 
et ouvre le fichier PDF dans un logiciel d'affichage PDF installé dans votre 
station d'administration, tel Acrobat Reader.
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8.1.13 Exit and Stop Service

Cette sélection est disponible en cas de fonctionnement avec les systèmes 
d'exploitation Windows.
Cette sélection vous permet de fermer le logiciel ainsi que le service en cas 
de service local. En mettant fin au service, vous interrompez aussi la surveil-
lance de votre réseau.

8.1.14 Exit

Cette sélection vous permet de fermer le logiciel. Le service reste actif en 
arrière-plan et continue de surveiller votre réseau.
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8.2 Edit

Dans le menu «Edit», vous trouverez les fonctions ayant trait aux opérations 
d'édition et aux propriétés d'équipements.

8.2.1 Undo

Cette sélection vous permet d'annuler votre dernière modification dans le 
logiciel.

8.2.2 Redo

Cette sélection vous permet de restaurer la dernière modification que vous 
avez annulée précédemment.

8.2.3 Edit Mode

Vous utilisez cette sélection pour activer/désactiver le «Edit Mode».
Vous devez disposer des droits d'accès appropriés pour cette fonction, voir 
“Edit Mode” on page 94.
Pour éviter les conflits d'écriture, Industrial HiVision empêche l'activation 
simultanée du «Edit Mode» sur plusieurs interfaces utilisateur.
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8.2.4 Passage à la version gratuite

Cette sélection vous permet de passer de la version sous licence à la version 
gratuite durant la période d'essai de 30 jours gratuits.
Industrial HiVision propose 3 versions :
 Version sous licence

Dès que vous avez entré une clé de licence, Industrial HiVision fonctionne 
en version sous licence. Exploité dans sa version sous licence, Industrial 
HiVision met à votre disposition toute l'étendue de ses fonctions.

 Version d'essai de 30# jours gratuits (sous licence)
Après une réinstallation ou une mise à jour, Industrial HiVision démarre 
avec la pleine disponibilité des fonctions pendant les 30 jours de la 
période d'évaluation gratuite.
Pendant les 7 derniers jours de la période d'essai, une fenêtre dédiée aux 
messages vous signale que la période d'essai prend fin et que vous pou-
vez enregistrer le fichier de projet avant l'expiration de cette période. Si 
Industrial HiVision est arrêté durant cette période, Industrial HiVision 
affiche alors cette fenêtre dédiée aux messages au prochain démarrage.

 Version gratuite
Dans sa version gratuite, Industrial HiVision vous permet de détecter des 
équipements de Hirschmann et d'effectuer les mises à jour des équipe-
ments ainsi identifiés.

8.2.5 Cut

Par cette sélection, vous reprenez les données sélectionnées (les éléments 
d'écran, les composants, les équipements avec les réglages associés) dans 
la mémoire intermédiaire.
Les données sont supprimées et elles peuvent être réinsérées à un autre 
endroit à l'aide de l'option de menu «Paste» si besoin est.
Vous pouvez aussi copier les noms des objets dans d'autres applications 
telles qu'un éditeur de texte.
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8.2.6 Copy

Cette sélection vous permet de placer les données que vous avez sélection-
nées (élément d'écran, composants, équipements y compris les options) 
dans une mémoire intermédiaire.
Les données sont conservées et elles peuvent être insérées en plus à un 
autre endroit à l'aide de l'option de menu «Paste» si nécessaire.
Vous pouvez aussi copier les noms des objets dans d'autres applications 
telles qu'un éditeur de texte.

8.2.7 Paste

Ce champ de sélection vous permet d'insérer les données (les éléments 
d'écran, les composants, les équipements avec les réglages associés) dans 
votre mémoire intermédiaire à l'emplacement occupé momentanément par 
le curseur.

8.2.8 Paste As Link

Ce champ de sélection vous permet d'insérer les données (les éléments 
d'écran, les composants, les équipements avec les réglages associés) dans 
votre mémoire intermédiaire sous la forme d'un raccourci à l'endroit où se 
trouve momentanément le curseur. Seul s'ajoute un renvoi vers les données. 
Les données en elles-mêmes se situent à leur emplacement d'origine (voir 
page 153 “Création d'un lien”).
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8.2.9 Delete

Ce champ de sélection vous permet de supprimer les données sélectionnées 
(les éléments d'écran, les composants, les équipements avec les réglages 
associés).
Industrial HiVision vous donne la possibilité de supprimer l'équipement ou de 
le déplacer dans le dossier «Unused Devices» [Équipements non utilisés].

8.2.10 Rename

Par cette sélection, vous renommez un dossier sélectionné ou un équipe-
ment sélectionné.

8.2.11 Select All

Cette fonction vous permet de sélectionner tous les éléments contenus dans 
le dossier actif.

8.2.12 Acknowledge Status Change

Par ce choix, vous validez le changement d'état des composants sélection-
nés des sous-composants associés.
278
User Manual Industrial HiVision

Release 8.1 12/19



Références 8.2 Edit
8.2.13 Manage

Cette sélection vous permet d'activer la surveillance des équipements sélec-
tionnés (voir page 279 “Unmanage”).

8.2.14 Unmanage

Cette fonction permet de désactiver la surveillance des appareils sélection-
nés. Industrial HiVision continue d'enregistrer l'équipement, sa configuration 
et ses valeurs actuelles dans la base de données. La surveillance de ces 
équipements est en état de veille jusqu'à ce que vous réactiviez «Manage» 
[Administrer] (voir page 279 “Manage”). Industrial HiVision active la licence 
de cet équipement et offre la possibilité de l'utiliser pour un autre équipe-
ment.
Un équipement au statut «Unmanage» est affiché en grisé et d'une icône 
Stop par Industrial HiVision.

8.2.15 Set Device and Port Names

Cette sélection vous permet d'établir que la fenêtre des détails affiche les 
éléments suivants :
– mais le nom des équipements et le nom des ports des équipements 

sélectionnés.
– non pas l'adresse IP et les numéros de port des équipements sélection-

nés,
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8.2.16 Set Default Device Icon

Par ce choix, vous reprenez l’icône de l'affichage issu de la catégorie d'équi-
pements. S'il n'existe aucune icône par défaut applicable à la catégorie 
d'équipements, Industrial HiVision reprend l’icône de l'équipement indiqué 
dans les paramètres (voir page 385 “Device Icon”).

8.2.17 Device Documentation

Cette sélection permet à Industrial HiVision de générer un fichier PDF appli-
cable à :
 «Document Selected Devices»
 «Document All Devices»
Le fichier PDF contient des données relatives à l'équipement ainsi que ses 
paramètres.

 Faites votre choix. Indiquez le dossier, dans lequel Industrial HiVision doit 
archiver les fichiers PDF.

8.2.18 Drawing Size

Cette sélection vous permet d'adapter la taille de la zone graphique de l'affi-
chage détaillé à vos exigences. Industrial HiVision fournit 3 options à cette 
fin :

 «Enlarge»
 «Reduce»
 «Shrink to Fit»
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8.2.19 Background Image

Cette fonction permet de charger, supprimer ou modifier l'image d'arrière-
plan de votre affichage détaillé. Les options suivantes sont disponibles :
 «Paste As Background»

En sélectionnant «Paste As Background», vous ajoutez l'image enregis-
trée dans la mémoire intermédiaire à votre affichage détaillé pour servir 
d'image d'arrière-plan. Si le presse-papier est vide, l'option de menu est 
grisée et ne peut être sélectionnée.

 «Select Background Image...»
En sélectionnant «Select Background Image...», vous insérez l'image 
provenant d'un fichier comme image d'arrière-plan dans votre affichage 
détaillé. Sélectionnez le chemin d'accès correspondant et le fichier sou-
haité dans l'arborescence de dossiers.

Commentaire : Les images d'arrière-plan haute résolution encombrent 
les ressources de votre station d'administration de réseau et réduisent la 
performance du système.

 «Remove Background Image»
En sélectionnant «Remove Background Image», vous supprimez l'image 
d'arrière-plan visualisée dans votre affichage détaillé.
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Figure 56 :Édition : Image d'arrière-plan

8.2.20 Find...

La boîte de dialogue «Find» vous permet d'effectuer une recherche par com-
posants, par adresses MAC ou par adresses IP dans l'affichage.

 Sélectionnez l'onglet «Devices by IP Address» si vous recherchez une 
adresse IP ou «Components by Name» si vous recherchez un élément 
d'équipement.

 Saisissez

 l'adresse IP/l'adresse MAC ou une partie de celles-ci ou encore
 le nom de composant ou une partie de celui-ci sans utiliser de carac-

tère générique.
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 À gauche dans l'arborescence, sélectionnez un équipement ou un dos-
sier, dans lequel Industrial HiVision doit effectuer la recherche.

 Cliquez sur le bouton de commande «Find» pour lancer la recherche.

Industrial HiVision affiche le résultat dans une liste de la boîte de dialogue de 
recherche. Si vous double-cliquez sur une ligne de la liste, Industrial HiVision 
sélectionne le composant recherché dans le cadre Folders [Dossiers].

Figure 57 :Édition : Recherche

8.2.21 Auto Topology...

La fonction «Auto Topology...» vous permet de créer automatiquement les 
connexions entre les équipements. Pour détecter la topologie, Industrial 
HiVision utilise la base de transfert des données « Forwarding Data Base » 
(FDB) et les fonctions du protocole SNMP des équipements.
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IEEE 802.1AB décrit le protocole LLDP (Link Layer Discovery Protocol). 
Grâce au LLDP, l'utilisateur bénéficie d'une reconnaissance automatique de 
la topologie de son réseau local.
Industrial HiVision décèle des mécanismes redondants tels que le protocole 
RSTP, le couplage redondant au réseau ou l'anneau HIPER. Industrial 
HiVision présente chaque connexion redondante comme une connexion 
séparée.
Industrial HiVision peut détecter la topologie des équipements terminaux 
couvrant plusieurs sous-réseaux, si le routeur séparant les sous-réseaux 
prend en charge le tableau ipNetToPhysicalTable du protocole SNMP.

 Sélectionnez Edit > Auto Topology....

 Définissez dans la boîte de dialogue de la détection automatique de la 
topologie, comment Industrial HiVision exécute la fonction «Auto Topo-
logy...».

Sélection Action
Entire Network (Recommended) Reconnaissance de la topologie du réseau entier, y compris 

des commutateurs, routeurs, WLAN et terminaux, et lecture 
de grandes quantités de données provenant des équipe-
ments. 
La reconnaissance de la topologie dans les grands réseaux 
peut durer longtemps.
Dans ce cas, « Entire Network » [Réseau entier] signifie le 
réseau Layer 2, connecté à la carte d'interface réseau de la 
station d'administration de réseau, et tous les VLAN pou-
vant être atteints.

Infrastructure Reconnaissance exclusive de la topologie des équipe-
ments d'infrastructure basés sur LLDP. Exécution très 
rapide, néanmoins parfois incomplète.

Tableau 25 : «Scope»
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Sélection Action
Unmanaged Nodes Industrial HiVision déduit des informations sur la topologie 

d'équipements sans fonction d'administration et d'équipe-
ments sans licence Industrial HiVision à l'aide des informa-
tions d'équipements voisins connus. Industrial HiVision 
représente les équipements inconnus sous la forme d'un 
nuage. Un nuage peut représenter un ou plusieurs équipe-
ments inconnus.

Tableau 26 : «Unmanaged Nodes»

Sélection Action
Create New Topology Create a completely new topology [Création d'une nouvelle 

topologie complète]
Suppression des connexions existantes ainsi que de tous 
les nuages. Ensuite, création de la nouvelle topologie.

Complement Topology Enhance existing topology [Amélioration de la technologie 
existante]
Création de nouvelles connexions et de nouveaux nuages. 
Conserve les connexions existantes.

Update Topology Ajout de connexions manquantes et suppression de diffé-
rentes connexions de la topologie actuelle. Maintien des 
nuages existants s'ils sont en adéquation avec la topologie 
actuelle.

Tableau 27 : «Strategy»

Sélection Action
Automatic Industrial HiVision éclaircit la topologie et réaffecte les 

objets.
Manual Industrial HiVision laisse les objets dans leurs posi-

tions actuelles.

Tableau 28 : «Layout»
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 Cliquez sur le bouton «OK».

Ensuite, Industrial HiVision interroge le réseau quant aux connexions d'après 
les paramètres et affiche les connexions décelées sur l'interface.

Commentaire : Reconnaissance de la topologie
 Les composants de réseau non conformes aux spécifications du proto-

cole LLDP ou non gérables via le protocole SNMP risquent entraîner une 
détection automatique incorrecte de la topologie.

 Une requête DHCP active pendant le processus de reconnaissance peut 
fausser le résultat de la reconnaissance.

 Le routage VLAN peut fausser le résultat de la reconnaissance.
Les modules routeur MACH 3000 M opèrent avec un routage VLAN.

 Pour reconnaître des sous-réseaux derrière des routeurs NAT 1:1, sélec-
tionnez «Infrastructure» sous «Scope» (voir le tableau 25).

 Pour la découverte correcte de la topologie avec les routeurs VRRP, 
Industrial HiVision suppose qu'au moins un des routeurs VRRP se trouve 
dans le même répertoire que celui où vous démarrez la fonction de topo-
logie automatique, ou dans un sous-répertoire. 

 Détection d'équipements d'un réseau local derrière un équipement client 
sans fil :
Les BAT-Geräte de Hirschmann disposent de la fonction de « support du 
pont client ».
Afin que Industrial HiVision puisse détecter des équipements dans un 
réseau local derrière un équipement client sans fil, activez la fonction de 
« support du pont client » dans l'équipement client sans fil et dans le 
réseau étendu (WAN) associé au point d'accès.

Sélection Action
Current Folder Exécute les actions sélectionnées exclusivement dans 

le dossier sélectionné.
Recursive Industrial HiVision exécute la détection automatique 

de la topologie dans le dossier actuel et dans les sous-
dossiers et il affiche le résultat tant dans le dossier 
actuel que dans les sous-dossiers.

Tableau 29 : «Range»
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 Des terminaux à connexion redondante peuvent fausser le résultat de la 
reconnaissance.

 Le reconnaissance de la topologie reconnaît la topologie au moment de 
l'exécution.
Industrial HiVision visualise d'autres modifications dans le réseau (par ex. 
itinérance ou « roaming »), lorsque vous actualisez l'affichage de la topo-
logie.

 Auto Topology pour les équipements non détectés
La fonction «Auto Topology...» de Industrial HiVision a été conçue pour 
des topologies plates Layer 2. Des topologies de routage ont donné lieu 
à des modifications. La topologie détectée peut être incorrecte ou incom-
plète dans de rares cas. Les étapes suivantes vous aident à réaliser une 
topologie complète à partir de votre réseau.

Cette étape établit la topologie sur la base des informations fournies par 
les équipements exclusivement au moyen du protocole LLDP via le pro-
tocole SNMP.
Dragon PTN est un exemple d'équipement qui entre dans cette catégorie.

Procédez comme suit dans le dossier racine du projet :
 Fixez les valeurs suivantes dans la boîte de dialogue «Auto 

Topology» :
– «Scope»: Infrastructure
– «Unmanaged Nodes» : au besoin
– «Strategy»: Create New Topology
– «Layout» : au besoin
– «Range»: Recursive

Après que Industrial HiVision a balayé les équipements dans le dossier 
sélectionné, l'onglet indique «Map» la topologie du réseau. La topologie 
peut être encore incomplète.

Rebalayez votre réseau et procédez comme suit :
 Sélectionnez le dossier souhaité dans le cadre Répertoires.
 Cliquez avec le bouton droit de la souris sur un emplacement vide de 

l'onglet «Map».
 Sélectionnez l'option «Auto Topology...» dans la liste déroulante.
 Fixez les valeurs suivantes dans la boîte de dialogue «Auto 

Topology» :
– «Scope»: Entire Network (Recommended)
– «Unmanaged Nodes» : au besoin
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– «Strategy»: Complement Topology
– «Layout» : au besoin
– «Range»: Current Folder

8.2.22 Auto Layout

La fonction «Auto Layout» vous permet de confier l'affectation des équipe-
ments à le Industrial HiVision. 

 Sélectionnez Edit > Auto Layout.

 Afin que Industrial HiVision repositionne les objets dans l'affichage 
détaillé, cliquez sur le bouton de commande «OK». 

8.2.23 Propriétés d'un dossier/équipement

La boîte de dialogue «Properties...» contient les onglets «Properties», 
«Subcomponents», «Status Reason», «Scan Range», «Protocols», «IP 
Address» et «MAC/IP Addresses».
Les onglets «Protocols» et «MAC/IP Addresses» décrivent les propriétés 
des équipements.

 Propriétés d'un dossier/équipement
L'onglet «Properties» visualise les propriétés générales de l'affichage des 
composants.
D'un seul clic, vous ouvrez une boîte de dialogue servant à sélectionner 
une image, que Industrial HiVision utilise pour l'affichage. Industrial 
HiVision adapte automatiquement la taille de l'image.
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L'affichage de l'état est primordial pour surveiller votre réseau. Sélection-
nez ici si Industrial HiVision détermine le statut de cette connexion et si 
Industrial HiVision transfert le statut déterminé au niveau immédiatement 
supérieur. Industrial HiVision détermine l'état dans le réglage de base et 
il le transmet au niveau immédiatement supérieur. 

Figure 58 :Propriétés d'un dossier/équipement

 Sous-composants d'un équipement/dossier
L'onglet «Subcomponents» affiche un tableau de tous les éléments des 
composants, à partir desquels vous pouvez ouvrir la boîte de dialogue 
«Configuration Signature»:«Properties». 
Outre les noms des éléments, le tableau contient aussi les valeurs des 
différentes propriétés de ces éléments.
User Manual Industrial HiVision
Release 8.1 12/19 289



Références 8.2 Edit
Figure 59 :Sous-composants d'un dossier/équipement

 Status Reason
Si vous déplacez le pointeur de souris sur un élément dans la zone des 
dossiers ou dans l'affichage «Map», Industrial HiVision affiche une liste 
d'états renfermant les avertissements et les erreurs actuellement déce-
lés. En outre, vous pouvez visualiser la liste d'états via l'onglet View > 
Properties > Status Reason.

L'onglet «Status Reason» est disponible pour les éléments suivants :
 Dossier
 Devices
 Conteneur – Sous-dossier d'un dossier d'équipements
 Connexions

À titre d'exemple pour illustrer cette fonction, l'état d'un équipement 
affiche les erreurs constamment dépistées dans votre réseau. Vous 
aimeriez entretenir l'historique de la liste d'états en vue d'une utilisation 
ultérieure.
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Pour enregistrer la liste d'états sous la forme d'un fichier PDF, procédez 
comme suit :
 Sélectionnez l'équipement, dont vous souhaiteriez enregistrer la liste 

d'états.
 Cliquez sur la barre d'outils View > Properties. Industrial HiVision 

ouvre la boîte de dialogue «Properties».
Pour ouvrir la boîte de dialogue «Properties», cliquez autrement sur 
l'équipement sélectionné. Sélectionnez la fonction «Properties» dans 
la liste déroulante.

 Ouvrez l'onglet «Status Reason».
 Pour sauvegarder la liste d'états sur votre ordinateur, cliquez sur le 

bouton de commande «Export». La boîte de dialogue Enregistrer 
s'ouvre.

 Naviguez jusqu'au répertoire, dans lequel vous aimeriez enregistrer le 
fichier.

 Saisissez un nom approprié au fichier dans la zone de texte 
Enregistrer > Nom de fichier.

 Servez-vous de la liste déroulante Enregistrer > Fichiers du 
type pour sélectionner l'option «Adobe Portable Document Format».

 Cliquez sur le bouton de commande Enregistrer.
 Pour fermer la boîte de dialogue «Properties», cliquez sur le bouton 

de commande «OK».

Vous pouvez enregistrer la liste d'états dans les formats suivants :
 Fichier PDF
 Fichier HTML
 Fichier CSV

Commentaire : Le bouton de commande «Print» ouvre la liste d'états 
dans votre programme PDF standard.
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Figure 60 : «Status Reason» d'un dossier ou d'un équipement
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 Plage d'analyse d'un dossier
L'onglet «Scan Range» vous permet de définir des zones d'adresses IP. 
Industrial HiVision affiche dans ce répertoire les équipements nouvelle-
ment reconnus avec les adresses IP comprises dans cette plage 
d'adresses IP (voir page 419 “Scan Ranges”).

Figure 61 :Plages d'analyse d'un dossier
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 Protocole d'un équipement
L'onglet «Protocols» visualise le tableau des protocoles pris en charge et 
des propriétés associées.
Selon les équipements, Industrial HiVision prend en charge les proto-
coles suivants :
 Ping
 SNMP V1
 SNMP V3
 HiDiscovery
 EtherNet/IP
 Modbus/TCP

Industrial HiVision est compatible seulement avec Modbus/Com-
mande Read Device Identification (43 / 14) [Lecture identifi-
cation d'équipement].

Industrial HiVision utilise le protocole maximal possible (ordre : SNMP 
V3, SNMP V1, Modbus/TCP, Ping) pour surveiller un équipement.

Utilisez «Reload» pour demander à Industrial HiVision de déclencher une 
nouvelle requête de protocole d'équipement.

Figure 62 :Protocole d'un équipement
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 Adresse IP d'un équipement
L'onglet «IP Address» vous offre la possibilité de modifier l'adresse IP et 
le numéro de port SNMP des équipements actuels de Industrial HiVision 
dans cette boîte de dialogue.
Vous avez besoin de cette fonction pour que Industrial HiVision vous per-
mette d'accéder de nouveau à un équipement connu, dont l'adresse IP a 
été modifiée directement sur l'équipement.
Si vous souhaitez modifier l'adresse IP sur un équipement, sélectionnez-
le et utilisez la boîte de dialogue Configuration > IP Configuration 
(voir page 429 “IP Configuration”).

Figure 63 :Adresse IP pour un équipement actuel
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 Adresses MAC/IP d'un équipement
L'onglet «MAC/IP Addresses» visualise la liste des adresses IP dispo-
nibles sur l'équipement et des adresses MAC associées. La liste 
comprend :

Paramètres Signification
MAC Address
IP Address
Netmask
Host Name Nom d'hôte provenant du fichier /config/hosts.txt dans le répertoire d'ins-

tallation, si
 le fichier existe,
 l'entrée est présente et
 la détermination d'un nom d'équipement est activée dans les para-

mètres de base.
Dans le cas contraire, le champ reste vide.

DNS Name Nom du « Domain Name Service » [Service de noms de domaine]
Port No Numéro de port du protocole.
Port Port d'équipement
Management Industrial HiVision communique via l'adresse IP de cette ligne avec 

l'administration de l'équipement.
User Generated L'équipement situé dans cette ligne a été généré par l'utilisateur. 

Industrial HiVision n'a pas encore reconnu l'équipement.
Router Entry L'adresse IP située dans cette ligne provient de la table de routage de 

l'équipement.
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Figure 64 :Adresse MAC/IP et nom d'un équipement

8.2.24 Propriétés d'un détail de composant

Dans la boîte de dialogue « Properties of a component detail » [Propriétés 
d'un détail de composant] permet d'accéder au niveau le plus bas de la déter-
mination de statut. Outre les propriétés situées à des niveaux supérieurs, 
cette boîte de dialogue contient une valeur attribuée de manière ciblée. Si 
vous souhaitez observer cette valeur, vous pouvez l'interroger à des inter-
valles de votre choix et la consigner. 
Plage de valeurs pour l'intervalle de scrutation :≥ 5 secondes

Pour configurer la propriété d'un détail de composant, procédez comme suit :
 Sélectionnez un équipement ou un port dans le cadre Répertoires.
 Ouvrez l'onglet «List».
 Pour ouvrir la boîte de dialogue de la propriété que vous souhaitez modi-

fier, effectuez un double-clic sur cette propriété.
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 Définissez la valeur.
 Cliquez sur le bouton «Write».

Figure 65 :Propriétés de données
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Vous pouvez éditer le nom de la propriété si vous avez préalablement auto-
risé la fonction Renommer dans les paramètres (voir page 389 “Avancé”).

 Pour exécuter la consignation, sélectionnez History > Record.
Pour visualiser l'historique dans une autre fenêtre, cliquez sur le bouton 
de commande «Show». En sélectionnant l'onglet figurant dans cette 
fenêtre, vous pouvez choisir entre un affichage tabulaire et un affichage 
graphique.
L'affichage graphique est disponible si la propriété est de type compteur. 

 L'option «Buffer Size» vous permet d'indiquer combien de lignes le proto-
cole met dans la mémoire tampon.
Si vous souhaitez afficher cette valeur dans l'infobulle d'un composant 
d'ordre supérieur, sélectionnez le composant «Show Value in Tooltip of» 
dans la liste déroulante (voir la figure 65).

Spécifiez l'impact de la modification de cette valeur sur l'affichage de statut 
dans la boîte de dialogue «Status Config».

Outre l'observation de votre réseau, Industrial HiVision vous permet de confi-
gurer les propriétés suivantes au niveau du détail de composant, dans la 
mesure où l'équipement prend en charge cette option :

 «Name» du port
Assigner n'importe quel nom lisible au port.

 «Admin» de l'état du port
Activer/désactiver le port.

 «Autoneg»
Activer/désactiver la fonction d'autonégociation.

 «Name» de l'équipement
Assigner n'importe quel nom lisible à l'équipement.

 «Contact»
Désigner un interlocuteur pour cet équipement.

 «Location»
Indiquer l'emplacement de l'équipement.

 «Signaling»
Identifier un équipement spécifique parmi de nombreux équipements au 
même emplacement.
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Figure 66 :Configurer les propriétés d'un détail
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 Valeurs définies
La boîte de dialogue «Status Config» affiche les valeurs possibles du 
détail de composant.
Utilisez la liste déroulante pour assigner les états souhaités aux valeurs.
Les opérateurs vous offrent d'autres options pour la définition de la confi-
guration de l'état.

Figure 67 :Exemple d'affichage de statut des valeurs par défaut
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 Valeurs de liste
La boîte de dialogue «Status Config» affiche une liste contenant les 
valeurs actuelles du détail de composant.
Utilisez la liste déroulante pour assigner les états souhaités aux valeurs. 
Contrairement aux « Defined values » [Valeurs définies], les valeurs sont 
variables et vous pouvez utiliser « Current values » [Valeurs actuelles] 
pour charger les valeurs actuellement disponibles, utiliser le bouton 
«New» pour entrer vos propres valeurs dans la liste et utiliser le bouton 
«Delete» pour supprimer des valeurs de la liste.

Vous souhaitez un message d'erreur lorsque des stations non autorisées 
tentent de se connecter. Saisissez les stations autorisées dans la liste et 
assignez « Error » [Erreur] à « Other value » [Autre valeur] (voir la 
figure 68).

Figure 68 :Affichage de statut des valeurs de liste
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 Valeurs numériques
La boîte de dialogue «Status Config» vous permet de saisir des valeurs 
limites numériques.
Utilisez la liste déroulante pour sélectionner les états que Industrial 
HiVision assigne à l'équipement si le seuil inférieur ou le seuil supérieur 
de ces valeurs sont dépassés. 

Figure 69 :Affichage de statut pour des valeurs numériques
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 Chaîne de caractères alphanumériques
La boîte de dialogue «Status Config» vous permet d'assigner une valeur 
alphanumérique au détail d'équipement.
Utilisez la liste déroulante pour sélectionner les états que Industrial 
HiVision assigne à l'équipement pour d'autres chaînes de caractères.
Exemple : au niveau d'un port, saisissez l'adresse MAC de l'équipement 
connecté. Si l'adresse MAC de l'équipement connecté est correcte, attri-
buez l'état «OK». Si l'adresse MAC de l'équipement connecté est diffé-
rente, attribuez l'état «Error». Dès que l'adresse MAC change, vous 
recevrez un message d'erreur.

Figure 70 :Affichage de statut pour des valeurs alphanumériques

 Generate test events
Le bouton «Generate test events» vous offre la possibilité de générer des 
événements liés aux changements d'état des propriétés. Vous pouvez 
ensuite affecter une action à l'événement.

Après avoir cliqué sur le bouton «Generate test events», Industrial 
HiVision ouvrez la boîte de dialogue «Import event» pour que vous puis-
siez revoir les événements générés. Industrial HiVision écrit également 
les événements de test dans l'onglet «Test Events». Vous pouvez impor-
ter un événement généré répertorié dans l'onglet «Test Events», puis 
affecter une action à l'événement.

Industrial HiVision n'entre pas les événements de test dans la liste des 
événements.
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Dans cet exemple, vous générez des événements de test, puis affectez 
une action à un événement. Pour générer des événements de test, pro-
cédez comme suit :
 Double-cliquez sur un équipement pour lequel vous souhaitez générer 

un événement de test.
 Dans l'onglet «List», cliquez avec le bouton droit sur la propriété pour 

laquelle vous souhaitez générer un événement de test.
 Dans la liste déroulante, sélectionnez l'option «Properties...».
 Dans le cadre «Status», cochez la case «Determine».
 Cliquez sur le bouton «Status Config».
 Dans le cadre «Status Config», configurez la propriété pour générer 

l'événement nécessaire.
 Cliquez sur le bouton «Generate test events».
 Dans la boîte de dialogue «Import event», vérifiez que le tableau 

affiche l'événement auquel vous souhaitez affecter une action.
 Cliquez sur le bouton «Close».

Pour affecter une action à un événement, procédez comme suit :
 Ouvrez la boîte de dialogue «Preferences».
 Sélectionnez «Event Actions» dans l'arborescence du menu.
 Assurez-vous qu'une action est disponible dans le tableau «Actions».
 Dans le cadre «Alarms», cliquez sur le bouton «New».
 Dans le cadre «Filter», cliquez sur le bouton «Import...».
 Dans la boîte de dialogue «Import event», sélectionnez l'onglet «Test 

Events».
 Sélectionnez l'événement auquel vous souhaitez affecter une action.
 Cliquez sur le bouton «OK».

Industrial HiVision récupère les informations de l'événement et les sai-
sit dans le cadre «Filter».

 Cochez la case «Actions» dans le tableau pour l'action que vous sou-
haitez que Industrial HiVision effectue.

 Cliquez sur le bouton «OK».

8.2.25 Propriétés d'une connexion

La boîte de dialogue dédiée aux propriétés d'une connexion comprend 
2 onglets : «Connection»et «Properties».
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Vous accédez à une troisième propriété, l'historique de la connexion, en 
double-cliquant sur la connexion.

Pour consulter la boîte de dialogue des propriétés, effectuez un clic droit sur 
une connexion et sélectionnez «Properties...» dans la liste déroulante.

 Connection
Sélectionnez les ports raccordés sur l'onglet «Connection». Pour assurer 
un meilleur aperçu, la boîte de dialogue vous permet de sélectionner les 
ports à visualiser dans l'affichage de la sélection.
Si l'affichage de la vitesse est activé et la vitesse augmente, Industrial 
HiVision accroît l'épaisseur de trait par pas de 2 points à 10, 100, 1 000, 
10 000 MBit/s. Si l'affichage de la vitesse est activé, Industrial HiVision 
affiche les paramètres actuels de connexion dans l'infobulle. 
Si l'affichage de vitesse est activé, Industrial HiVision affiche les para-
mètres actuels de vitesse, y compris lorsque l'affichage de vitesse est 
désactivé dans la boîte de dialogue des propriétés de connexion (voir 
page 379 “Device”).
Dans le cas de l'affichage automatique du support de connexion via 
l’icône de fin de connexion, Industrial HiVision sélectionne le symbole cor-
respondant. Industrial HiVision vous offre la possibilité de définir vous-
même l’icône de fin de connexion applicable à une connexion. Cette 
option contribue à une meilleure vision d'ensemble lorsque les conditions 
empêchent la détermination du support.
Si l'observation de la connexion est importante pour vous, vous pouvez 
interroger aux intervalles de votre choix les paramètres standard 
suivants :
 le statut de connexion
 la charge (charge entrante)

Si un équipement terminal ne fournit aucune valeur de charge entrante 
à une connexion, Industrial HiVision affiche la charge sortante à l'autre 
extrémité de la connexion comme une charge entrante à cette extré-
mité.

 la redondance de port
 les propriétés de port WLAN

Industrial HiVision utilise «Load History» «Load History» pour enregistrer 
en continu la valeur de la charge entrante interrogée.
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 Properties
L'onglet «Properties» de la connexion vous permet de donner n'importe 
quel nom à la connexion et de définir la façon de traiter l'état.
L'affichage de l'état est primordial pour surveiller votre réseau. Sélection-
nez ici si Industrial HiVision détermine le statut de cette connexion et si 
Industrial HiVision transfert le statut déterminé au niveau immédiatement 
supérieur. Industrial HiVision détermine l'état dans le préréglage et le 
transmet au niveau immédiatement supérieur, dès que vous avez affecté 
les ports raccordés à la connexion (voir ci-dessous).
L'option «Availability» vous fait accéder aux champs permettant de saisir 
les valeurs «MTBF» et «MTTR» utilisées par le Industrial HiVision pour 
calculer la disponibilité.

8.2.26 Ajouter un détail de composant à un port

Industrial HiVision fournit à la surveillance de nombreux détails de compo-
sant pour les composants individuels. Pour assurer une meilleure vision 
d'ensemble,Industrial HiVision affiche une sélection de ces composants.

Pour ajouter un autre détail de composant à un port, procédez comme suit :
 Sélectionnez un port dans le cadre Répertoires.
 Ouvrez l'onglet «List».
 Effectuez un clic droit sur la surface vide dans la boîte de dialogue «List».
 Sélectionnez New > Property.

Industrial HiVision vous propose alors une liste d'autres détails de compo-
sant. Un détail de composant est disponible en deux types : «Delta» et 
«Absolute».

 «Delta» :La surveillance se base sur la différence entre les valeurs de 
deux requêtes consécutives. Le symbole de la propriété Delta se recon-
naît au triangle situé dans le coin supérieur droit.

 «Absolute» : La surveillance se base sur la valeur absolue de chaque 
requête.
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Figure 71 :Symboles des propriétés Delta et Absolute [Absolu]

 Après avoir double-cliqué sur une ligne, sélectionnez le détail de compo-
sant correspondant et attribuez-lui un symbole dans l'affichage détaillé.

 Effectuez un clic droit sur l’icône. Sélectionnez ensuite «Properties» pour 
ouvrir la boîte de dialogue « Propriétés d'un détail de composant », 
Voir “Propriétés d'un détail de composant” on page 297..

8.2.27 Ajout aux rapports

La fonction Rapports vous permet de gérer des statistiques à long terme, 
hors de la base de données du logiciel du système d'administration de 
réseau.

Vous pouvez ajouter les aspects suivants à la fonction présentant des 
rapports :
 Détails d'équipement scrutables
 Connexions entre 2 équipements aux extrémités desquelles Industrial 

HiVision a détecté un statut de connexion.

 Pour ajouter un détail d'équipement ou une connexion à la fonction de 
création de rapports, cliquez avec le bouton droit de la souris sur le détail 
de l'équipement ou de la connexion et sélectionnez «Add to Reporting...».

 Pour ajouter respectivement plus de 1 détail d'équipement à la fonction 
dressant des rapports, procédez comme suit :
 Ouvrez l'onglet «Properties».
 Sélectionnez les éléments que vous souhaitez ajouter.
 Effectuez un clic droit sur une propriété.
 Sélectionnez l’option «Add to Reporting...».
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Commentaire : Si un détail d'équipement a été ajouté au préalable à la fonc-
tion de création de rapports, Industrial HiVision visualise un message indi-
quant combien d'éléments n'ont pas été ajoutés dans la boîte de dialogue 
«Add Properties to Reporting». La boîte de dialogue «Reporting» affiche les 
éléments surveillés (voir page 324 “Rapports”).

La boîte de dialogue vous permet d'activer ou de désactiver les rapports pour 
cette propriété ou connexion au moyen de «Record». Si vous désactivez les 
rapports, l'entrée est conservée dans la fonction de rapport (voir page 324 
“Rapports”). Pour les rapports, vous avez le choix d'enregistrer la valeur ou 
le statut.

Les fonctions «Start» et «Stop» vous permettent de déterminer le début et la 
fin de l'enregistrement. Selon le préréglage, l'enregistrement commence dès 
que vous cliquez sur «OK» et dure tant que le service Industrial HiVision 
fonctionne.

Si vous avez préalablement activé la scrutation pour la propriété ou la 
connexion ou si vous avez modifié l'intervalle de scrutation, ces paramètres 
sont conservés. Sinon, Industrial HiVision active la scrutation et fixe l'inter-
valle de scrutation à la valeur minimale de 30 secondes.

Paramètre pour les intervalles de scrutation :
 Valeur minimale : 30 seconds
 Valeurs possibles : multiples de 30 secondes
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Figure 72 :Ajout de propriété aux rapports :

8.2.28 Signalisation d'équipements et de ports

La fonction de signalisation vous permet d'identifier un équipement ou un 
port à l'aide des diodes électroluminescentes LED de l'équipement. Lors de 
l'établissement de nouvelles connexions, cette fonction vous offre la possibi-
lité de vérifier que l'équipement correspondant et le port approprié sont bien 
utilisés. 
Vous pouvez aussi activer cette fonction via HiMobile.

Commentaire : La fonction de signalisation HiMobile est disponible sur les 
équipements présentant les versions de logiciel suivantes : 
 La signalisation est prise en charge sur des équipements Classic pourvus 

d'une version logicielle à partir de 09.0.03.
 La signalisation est prise en charge sur des équipements HiOS pourvus 

d'une version logicielle à partir de 06.0.01.
 La signalisation est prise en charge sur des équipements HiOS pourvus 

d'une version logicielle à partir de 06.0.01.
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 La signalisation est prise en charge sur des équipements HiSecOS pour-
vus d'une version logicielle à partir de 03.0.01.

 La signalisation de la connexion est prise en charge sur des équipements 
HiOS reliés directement et dotés d'une version logicielle à partir de 
06.0.01.

 Signalisation des équipements et des ports
Pour activer la fonction de signalisation sur un équipement, procédez 
comme suit :
 Assurez-vous qu'Industrial HiVision se trouve dans le «Edit Mode».
 Exécutez un double-clic sur l'équipement, pour lequel vous tenez à 

activer la fonction de signalisation.
 Ouvrez l'onglet «List».
 Effectuez un clic droit sur l'entrée «Signaling».
 Sélectionnez «Properties» dans la liste déroulante.
 Allez à l'intérieur du cadre «Value» dans la liste déroulante «Current 

Value» pour sélectionner l'option «On».
 Cliquez sur le bouton «Write».

Le tableau figurant sur l'onglet «List» indique la fonction «Signaling» en 
état de «On» et les LED clignotent sur l'équipement durant 10 secondes. 
Au bout de 10 secondes, l'entrée change passant dans l'état d'« Arrêt ».

Les étapes à suivre pour activer la fonction «Signaling» sur un port 
s'apparentent à celles déjà décrites ci-dessus. La seule différence réside 
dans le fait que vous sélectionnez le port, pour lequel vous aimeriez acti-
ver la fonction «Signaling».
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Figure 73 :Boîte de dialogue des propriétés de signalisation

 Prise en charge de la fonction de signalisation
La liste suivante répertorie les équipements et les versions de logiciel 
supportant la fonction de « Signalisation » de Industrial HiVision :

le type d'équipe-
ment

À partir de la ver-
sion

Signalisation 
d'équipements

Signalisation de 
port/connexion

Classic 09.0.01 X
HiOS 04.0.00 X X
HiSecOS 03.0.00 X

Tableau 30 : Logiciel supportant la fonction de signalisation
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8.3 View

Le menu «View» renferme des fonctions servant à naviguer à travers l'histo-
rique du contenu du cadre de l'affichage détaillé.

8.3.1 Select VLAN

Cette fonction vous offre la possibilité de reconnaître l'appartenance au 
réseau local des équipements et connexions reconnus puisqu'ils sont repré-
sentés en couleur.
 Sélectionnez View > Select VLAN.

Industrial HiVision ouvre une boîte de dialogue pour choisir un VLAN.
 Servez-vous de la liste déroulante pour sélectionner l'ID VLAN du réseau 

local, dont vous souhaitez visualiser l'appartenance au réseau local.
Industrial HiVision représente les équipements et leurs connexions qui 
appartiennent à d'autres réseaux locaux en gris clair. Les équipements du 
réseau local sélectionné restent en couleur ou en gris foncé.

Industrial HiVision affiche le réseau local sélectionné sur le bord supérieur du 
cadre « Folders » [Dossiers].
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8.3.2 Refresh VLANs

Cette fonction vous permet d'actualiser les informations sur le réseau local 
(VLAN) dans l'équipement Hirschmann.
 Pour actualiser les informations sur le réseau local, sélectionnez un nœud 

dans le cadre d'objets.
 Sélectionnez View > Refresh VLANs dans la barre de menus.

Industrial HiVision a actualisé les informations dans les sous-composants 
du nœud sélectionné.

8.3.3 Protocol Statistics

Les statistiques protocoles vous offrent un aperçu du comportement du 
temps de réponse des équipements avec Industrial HiVision en regard du 
protocole de communication. Cet aperçu vous aide à déterminer si le com-
portement du temps de réponse est la cause dans le cas de figure où 
Industrial HiVision ne pourrait établir de communication avec un équipe-
ment.Protocol Statistics [Statistiques protocoles]

Vous pouvez indiquer le nombre d'échantillons, sur la base desquels 
Industrial HiVision calcule la moyenne mobile du temps de réaction des pro-
tocoles ICMP et SNMP.
 Ouvrez la boîte de dialogue Configuration > Preferences > Services.
 Vous pouvez définir le nombre d'échantillons ICMP via le paramètre 

«ICMP Statistics - Moving Average Number of Samples».
 Vous pouvez définir le nombre d'échantillons SNMP via le paramètre 

«SNMP Statistics - Moving Average Number of Samples».
La boîte de dialogue affiche la moyenne mobile comme étant égale à 0, 
jusqu'à ce que Industrial HiVision calcule la première valeur moyenne.
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Industrial HiVision vous propose une partie des statistiques de journalisation 
en tant qu'informations détaillées par équipement. «Avg Resp [ms]» et «Std 
Dev» sont fournies dans les propriétés de journalisation de l'équipement.
La fonction d'établissement de rapports vous permet d'analyser avec plus de 
précision le comportement d'équipements isolés. À cet effet, ajoutez les 
détails de journalisation dans un rapport.

Avec «Export», vous pouvez enregistrer le tableau complet comme :

 Fichier PDF
 Fichier HTML
 Fichier CSV (voir page 470 “Exportation CSV”)

Paramètres Signification
Device Adresse IP de l'équipement, auquel s'appliquent les entrées de cette 

ligne
Protocol Protocole pertinent, via lequel Industrial HiVision communique avec 

l'équipement
Requests Nombre de demandes de Industrial HiVision depuis la dernière réinitia-

lisation
Responses Nombre de réponses de l'équipement depuis la dernière réinitialisation
Timeouts Nombre de cas, dans lesquels l'équipement a pris plus de temps à 

répondre que celui défini dans les réglages
Errors Nombre de paquets divergeant de la normale
Msg Loss [%] Perte de pqt [%] = perte de paquets [%] = 1 -

(réponses/demandes) x 100
Avg Resp [ms] Moyenne des temps de réponse
MAvg Resp [ms] Moyenne mobile des temps de réponse 
Min Resp [ms] Temps d'attente minimal d'une réponse
Max Resp [ms] Temps d'attente maximal d'une réponse
Std Dev Écart type des temps de réponse = mesure de la variation
Try 1 Nombre de réponses reçues après la 1ère tentative de demande 

(« essai 1 »).
Suivant vos réglages dans la configuration du protocole SNMP sur 
Industrial HiVision, Industrial HiVision dresse des colonnes portant la 
mention «Try» 2, «Try» 3 etc.
La colonne «Try» 2 contient uniquement le nombre de réponses recueil-
lies après la 2ème tentative de demande.

Tableau 31 : Statistiques des protocoles
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Avec «Print», vous pouvez imprimer le tableau complet. Industrial HiVision 
crée un fichier PDF temporaire du contenu de la liste et ouvre le fichier PDF 
dans un logiciel d'affichage PDF installé dans votre station d'administration, 
tel Acrobat Reader.

Avec «Reload», vous demandez à Industrial HiVision d'actualiser les valeurs 
dans le tableaux.

Avec «Reset», vous demandez à Industrial HiVision de remettre les valeur 
des tableaux à « 0 ».

8.3.4 Filter Events for Object [Filtrer les 
évènements pour cet objet]

L'option «Filter Events for Object» vous permet de filtrer la liste des événe-
ments sur la base de l'objet d'interface utilisateur graphique (IUG) sélec-
tionné. Vous avez la possibilité de filtrer les événements d'après les types 
d'objet suivants :
• Devices
• Connexions
• Ports
• Propriétés de l'équipement
Pour filtrer les événements d'un objet, procédez comme suit :
 Sélectionnez le nombre des objets requis sur l'onglet ou dans l'affichage 

en arborescence. Si vous sélectionnez au moins 1 objet, le bouton de 
commande «Filter Events for Object» est activé.

 Cliquez sur le bouton «Filter Events for Object».

Figure 74 : Liste générée avec la fonction « Filtrer les événements d'un objet » 
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La liste des événements affiche les événements filtrés en fonction de l'objet. 
La zone «Filter» figurant sur la barre d'information de la liste des événements 
visualise des informations à propos des objets servant au filtrage. Quelques 
scénarios éventuels sont décrits ci-après : 
Si vous filtrez des événements sur la base d'une connexion entre 
2 équipements, la zone «Filter» affiche ces informations :
• Adresses IP et identificateurs des équipements raccordés, au cas où ces 

derniers seraient renommés, dans la colonne «Source»
• Numéro et identificateur de port dans la colonne «Component»
• Chemin d'accès au composant, si le port fait partie d'une interface de 

réseau local sans fil (WLAN) ou d'un module, dans la colonne «Compo-
nent».

Si vous filtrez des événements sur la base de dossiers, la zone «Filter» 
affiche ces informations :
• Adresses IP et identificateurs des équipements, au cas où ces derniers 

changeraient de nom, dans la colonne du dossier «Source».

Commentaire : Si vous rebaptisez la propriété d'un équipement, Industrial 
HiVision recherche uniquement le nouvel identificateur. La règle ne 
s'applique pas aux ports.

8.3.5 Back [Précédent]

Avec «Back», vous accédez à la prochaine vue du cadre d'affichage détaillé.
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8.3.6 Forward [Suivant]

Avec «Forward», vous accédez à la prochaine vue du cadre d'affichage 
détaillé.

8.3.7 Up [Haut]

Avec «Up», vous accédez au niveau immédiatement supérieur du cadre 
d'affichage détaillé.

8.3.8 Home View

Le bouton de commande «Home View» vous offre la possibilité de réinitiali-
ser la taille de la fenêtre et les paramètres de l'affichage détaillé sur les 
réglages que vous avez définis à l'aide du bouton de commande «Set Home 
View Settings».

Les paramètres suivants constituent des préréglages permanents :
 Réseau local VLAN «All»
 Filtre d'événements «Last 24 Hours Events»
 Affichage d'onglets «Map»

Pour appliquer la fonction à titre d'illustration, procédez comme suit :
 Cliquez sur le bouton «Home View».
 Notez les réglages des paramètres et la taille de la fenêtre.
 Établissez que le réseau local VLAN surveille exclusivement le réseau 

local VLAN 1.
 Fixez le plein écran comme étant la taille de la fenêtre.
 Sélectionnez un autre dossier dans l'arborescence du menu.
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 Sélectionnez un équipement sur l'onglet «List».
 Filtrez les événements sur l'option «Unacknowledged Warnings & 

Errors».

Industrial HiVision affiche alors les événements sélectionnés dans le mode 
plein écran. Industrial HiVision visualise également les équipements partici-
pant au réseau local VLAN 1 avec la couleur d'état applicable à chaque équi-
pement. Pour réinitialiser l'affichage sur la configuration enregistrée 
précédemment, cliquez sur le bouton de commande «Home View».

8.3.9 Set Home View Settings

La fonction «Set Home View Settings» vous offre la possibilité de définir la 
taille de la fenêtre et les contenus de l'affichage détaillé que Industrial 
HiVision visualise, lorsque vous cliquez sur le bouton de commande «Home 
View».

Pour appliquer la fonction à titre d'illustration, procédez comme suit :
 Assurez-vous que le «Edit Mode» est activé.
 Définissez l'affichage en fonction de vos besoins.

 Industrial HiVision vous offre la possibilité d'enregistrer les réglages 
suivants :
– Définissez un autre dossier dans l'arborescence du menu.
– Établissez une autre taille d'écran de visualisation.
– Définissez l'affichage maximisé ou normal au choix.

 Cliquez sur la fonction View > Set Home View Settings.

En outre, vous pouvez fixer les réglages dans la liste Configuration > 
Preferences > Display > Appearance > Home View Settings > Home Fol-
der (voir page 382 “Appearance”).
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8.3.10 Position géographique

Industrial HiVision vous offre la possibilité d'afficher l'emplacement d'un équi-
pement sur une carte.
 Dans la vue détaillée, cliquez sur un équipement avec le bouton droit de 

la souris et sélectionnez «Geographical Location View». 
Si les conditions suivantes sont remplies, Industrial HiVision vous montre 
l'emplacement de l'équipement sur une carte.
 Les coordonnées sont entrées dans la propriété «Location Coordinates» 

de l'équipement.
Voir “Propriétés d'un détail de composant” on page 297.

 Sous Configuration > Preferences > Advanced > External Applica-
tions, l'URL de l'application d'affichage sur carte est entrée sous «Geo-
graphical Location View».
Voir “Paramètres Service” on page 406.

8.3.11 Zoom

Avec «Zoom», vous ajustez le zoom avant de l'affichage du cadre de détails 
par pas de 10 %.
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8.4 Configuration

8.4.1 Monitor

La boîte de dialogue «Monitor» répertorie les fonctions de surveillance pour 
les composants actuellement surveillés.

 Propriété
 la valeur de la propriété
 Prise en charge de la valeur d'un message d'alarme (trap) concernant 

cette propriété.
 Requête cyclique de la valeur de cette propriété
 Intervalle de requête
 Enregistrement de l'historique de cette propriété
 Taille de la mémoire circulaire pour l'enregistrement de l'historique 

(nombre d'entrées)
 Déduction du statut de la propriété de la valeur de la propriété
 Redirection d'état vers le prochain niveau supérieur.

Un double-clic sur une ligne du tableau vous permet d'éditer la configuration 
du statut de la propriété.

Commentaire : Avant de cliquer sur le bouton «Disable Polling», enregistrez 
votre projet (Voir “Save” on page 270.). Le bouton désactive la scrutation 
pour les propriétés actuelles et supprime la liste. Le bouton désactive en 
outre la fonction standard de scrutation dans la boîte de dialogue Voir “Save” 
on page 270..
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Figure 75 :Configuration > Monitor
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8.4.2 PSM Manager [Manager PSM]

Les modules produit spécifiques (PSM) définissent les propriétés d'un équi-
pement, que Industrial HiVision peut lire pour la surveillance ou écrire pour 
la configuration.
Le manager PSM vous offre la possibilité de recharger les PSM ou d'importer 
d'autres PSM que ceux disponibles dans l'état de livraison et de les suppri-
mer.
 Industrial HiVision assigne la catégorie Commutateur  ou « Switch » aux 

équipements, pour lesquels Industrial HiVision ne possède aucun module 
PSM.

 Lors de l'importation, Industrial HiVision compare la version du module 
PSM à importer avec un module PSM éventuellement déjà disponible. Si 
le module PSM à importer existe déjà, Industrial HiVision ouvre alors une 
boîte de dialogue. La boîte de dialogue vous permet de conserver des 
modules produit spécifique PSM disponibles ou de les écraser.

Commentaire : Industrial HiVision reprend les modifications apportées 
après le redémarrage du service.
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Figure 76 :Configuration > PSM Manager

8.4.3 Rapports

La fonction Rapports vous permet de gérer des statistiques à long terme, 
hors de la base de données du logiciel du système d'administration de 
réseau.
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 Surveillance
Ce tableau répertorie les propriétés que vous avez sélectionnées pour la 
surveillance (voir page 308 “Ajout aux rapports”).
 Pour modifier une entrée dans ce tableau, sélectionnez-la et cliquez 

sur le bouton de commande «Edit».
 Pour supprimer une ou plusieurs entrées dans ce tableau, sélection-

nez-les et cliquez sur le bouton de commande «Delete».
Si des entrées sont disponibles dans des modèles, Industrial HiVision 
refuse de supprimer ces entrées.
Supprimez ces entrées dans le tableau des modèles afin de pouvoir 
supprimer les entrées dans le tableau de surveillance.

 Pour vérifier si les entrées sont encore valides, vu qu'elles pourraient 
avoir changé durant le traitement de cette boîte de dialogue, cliquez 
sur le bouton de commande «Refresh».

Une entrée est valide si Industrial HiVision accède au composant et qu'il 
peut l'interroger.

Commentaire : Industrial HiVision peut enregistrer des valeurs, tant que 
Hirschmann Industrial HiVision 08.1.00 Service est actif. Si vous arrêtez 
Hirschmann Industrial HiVision 08.1.00 Service, il en va de même de 
l'enregistrement qui est interrompu jusqu'au prochain redémarrage du 
Hirschmann Industrial HiVision 08.1.00 Service.

Paramètres Signification
Record Activer cette entrée.

Si vous fermez cette boîte de dialogue et que vous cliquez sur 
« OK » ou « Appliquer » dans la boîte de dialogue 
« Surveillance », Industrial HiVision lance l'enregistrement d'après 
les réglages figurant ci-dessous.

Recording > Start > Now Si vous fermez cette boîte de dialogue et que vous cliquez sur 
« OK » ou « Appliquer » dans la boîte de dialogue 
« Surveillance », Industrial HiVision lance l'enregistrement.

Recording > Start > Time Si vous fermez cette boîte de dialogue et que vous cliquez sur 
« OK » ou « Appliquer » dans la boîte de dialogue 
« Surveillance », Industrial HiVision lance l'enregistrement à cet 
instant précis.

Recording > Stop > Inde-
finite

Après le démarrage de l'enregistrement, Industrial HiVision pour-
suit durablement l'enregistrement jusqu'à la suppression ou la 
modification de cette entrée.

Polling Interval Intervalle de temps, auquel Industrial HiVision consulte la valeur 
sur l'équipement de manière cyclique.

Tableau 32 : Modification d'une entrée dans le tableau de surveillance
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 Templates
Cette boîte de dialogue vous permet de définir le format des rapports.
 Pour définir un nouveau modèle, cliquez sur le bouton de commande 

«New».
 Pour modifier un modèle, cliquez sur le bouton de commande «Edit».
 Pour supprimer un ou plusieurs modèles, cliquez sur le bouton de 

commande «Delete».
 Pour vérifier l'aspect d'un modèle, cliquez sur le bouton de commande 

«Display Report».

 Pour éviter les discontinuités dans un graphique de lignes, combinez 
exclusivement des propriétés ayant les mêmes intervalles de scruta-
tion.

 Pour mieux représenter des diagrammes, Industrial HiVision comble 
les lacunes entre les données en répétant les dernières données. 
Dans les rapports sous forme de tableau et dans les fichiers Excel, les 
valeurs de remplissage sont grisées et facilement reconnaissables.

 Scheduling
Cette boîte de dialogue permet à Industrial HiVision de produire des rap-
ports à des périodes définies.
 Pour définir une nouvelle période, cliquez sur le bouton de commande 

«New».
 Pour modifier une période, cliquez sur le bouton de commande «Edit».
 Pour supprimer une ou plusieurs périodes, cliquez sur le bouton de 

commande «Delete».

Paramètres Signification
Report > Name Nom d'identification du modèle.
Report > Title Titre écrit par Industrial HiVision en en-tête du rapport.
Report Type > Type Format d'édition du rapport.

Options : «PDF», «Excel»
Report Type > Layout Présentation du rapport.

Possible : «Chart», «Table»
Report Type > Chart Type Sélection pour présenter le diagramme.

Possible : «Line» (pour représenter des valeurs numériques), 
«Bar»

Data Sélection des propriétés que vous avez ajoutées au préalable aux 
rapports (voir page 308 “Ajout aux rapports”)

Tableau 33 : Définition d'un nouveau modèle
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Industrial HiVision fait la distinction entre 3 types de périodes :

– Temps absolu de démarrage et de fin («Absolute»)
– Temps absolu de démarrage et temps relatif de fin («Relative Stop»)
– Temps relatif de démarrage et de fin («Relative»)

 Temps absolu de démarrage et de fin («Absolute»)
Industrial HiVision génère un rapport fondé sur les données acquises 
entre l'instant du début et l'instant de la fin.

 Temps absolu de démarrage et temps relatif de fin («Relative Stop»)
Industrial HiVision Generated Reports [Rapports générés]
La période de rapport commence au même instant de démarrage 
dans chaque cas.
La période de rapport se termine plus tard dans chaque cas et couvre 
ainsi des périodes plus longues.

Paramètres Signification
Name Industrial HiVision offre tout un choix de modèles existants.
From À la première ouverture de cette boîte de dialogue, Industrial 

HiVision affiche l'instant, auquel Industrial HiVision a commencé à 
enregistrer les données du modèle sélectionné. Si le rapport à 
générer doit commencer par des données à compter d'un instant 
ultérieur, saisissez alors ici cet instant précis.
Possible : instant situé après le début de l'enregistrement et avant 
l'établissement du rapport.

Until Instant final de la période de rapport
Possible : instant situé après l'instant du début.

Tableau 34 : Planification avec instants absolus de démarrage et d'arrêt
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 Temps relatif de démarrage et de fin («Relative»)
Industrial HiVision Generated Reports [Rapports générés] 
Les rapports commencent à la fin du rapport précédent. 
Les rapports comprennent des données couvrant des périodes suc-
cessives d'égale longueur. 

Paramètres Signification
Begin of report period À la première ouverture de cette boîte de dialogue, Industrial 

HiVision affiche l'instant, auquel Industrial HiVision a commencé à 
enregistrer les données du modèle sélectionné. Si le rapport à 
générer doit commencer par des données à compter d'un instant 
ultérieur, saisissez alors ici cet instant précis.
Possible : instant situé après le début de l'enregistrement et avant 
l'établissement du rapport.

Offset to execution Décrit l'arrêt relatif des données comprises dans le rapport. L'arrêt 
relatif des données comprises dans le rapport, se base sur le 
moment de l'établissement du rapport.
La marge d'exécution est la période comprise entre l'arrêt relatif 
des données comprises dans le rapport et le moment de l'établis-
sement du rapport.
Possible : période située entre le début de l'enregistrement et l'éta-
blissement du premier rapport.

First Execution Instant, auquel Industrial HiVision doit générer le premier rapport.
Schedule every Période entre l'établissement d'un rapport et la création du pro-

chain rapport suivant.

Tableau 35 : Planification avec instant absolu de démarrage et d'instant relatif d'arrêt

Paramètres Signification
Duration Avec la durée, vous déterminez le démarrage relatif des données 

prises en charge dans le rapport.
Possible : période plus petite que l'intervalle de répétition moins 
les intervalles jusqu'aux exécutions proches.

Offset to execution Décrit l'arrêt relatif des données comprises dans le rapport. L'arrêt 
relatif des données comprises dans le rapport, se base sur le 
moment de l'établissement du rapport.
La marge d'exécution est la période comprise entre l'arrêt relatif 
des données comprises dans le rapport et le moment de l'établis-
sement du rapport.
Possible : période située entre le début de l'enregistrement et l'éta-
blissement du premier rapport.

First Execution Instant, auquel Industrial HiVision doit générer le premier rapport.
Schedule every Période entre l'établissement d'un rapport et la création du pro-

chain rapport suivant.

Tableau 36 : Planification avec instant absolu de démarrage et instant relatif d'arrêt
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 Generated Reports [Rapports générés]
Cette boîte de dialogue répertorie les rapports générés. Industrial 
HiVision stocke les rapports générés dans le répertoire d'installation dans 
le répertoire \var\report_files.
 Pour afficher un rapport, sélectionnez le rapport et cliquez sur le bou-

ton de commande «View».
 Pour enregistrer un rapport, sélectionnez-le rapport et cliquez sur le 

bouton de commande «Save».
 Pour supprimer un ou plusieurs rapports, sélectionnez-les et cliquez 

sur le bouton de commande «Delete».
 Pour actualiser la liste, cliquez sur le bouton de commande «Refresh». 

Après l'actualisation, Industrial HiVision ajoute les rapports générés 
depuis la dernière actualisation.

Industrial HiVision affiche sous le tableau le chemin d'accès à l'emplace-
ment où Industrial HiVision enregistre les rapports. Dans le cas de 
connexions à distance, l'indication du chemin d'accès fait référence au 
système de fichiers, sur lequel le Hirschmann Industrial HiVision 08.1.00 
Service est accompli.

Les données enregistrées via la fonction de rapport sont des captures ins-
tantanées. Elles matérialisent la valeur d'une propriété enregistrée par 
Industrial HiVision à un moment précis. Toute conclusion émanant de ces 
données ne peut s'appliquer à des valeurs situées entre ces moments.

8.4.4 Scheduler

La boîte de dialogue «Scheduler» vous offre la possibilité de faire exécuter 
automatiquement des tâches répétitives par Industrial HiVision.
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 Task
Ce tableau répertorie les tâches prédéfinies que Industrial HiVision exé-
cute selon les planifications sauvegardées.
 Pour définir une nouvelle tâche, cliquez sur le bouton de commande 

«New».
 Pour modifier une tâche, cliquez sur le bouton de commande «Edit».
 Pour supprimer une ou plusieurs tâches, cliquez sur le bouton de com-

mande «Delete».

Paramètres Signification
Task Name Nom d'identification quelconque de la tâche.
Device Sélection de l'équipement sur lequel Industrial HiVision doit exécu-

ter la tâche.
Task Type Industrial HiVision prévoit les rôles d'accès suivants :

 «Standard»
 «Advanced»
 «Save Device Configuration»
 «Save Project»
En fonction de la sélection, la partie qui fait suite à cette boîte de 
dialogue se modifie.

Standard Standard appartient au type de tâche « Action SNMP ».
Industrial HiVision propose les actions suivantes en tant qu'action 
SNMP :
– Validation/dévalidation du port
– Validation/dévalidation de la tension poE d'un port
Après sélection d'une action, le tableau vous propose de sélection-
ner le port de l'équipement et les paramètres correspondants 
(marche/arrêt).

Advanced Advanced appartient au type de tâche « Action de script ».
Comme action de script, Industrial HiVision propose les actions 
suivantes :
– Cisco: show running config [visualiser configuration en cours]
– Cisco: show running config all [visualiser toutes les configura-

tions en cours]
– HiOS: show running config [visualiser configuration en cours]
– HiOS: show running config all [visualiser toutes les configura-

tions en cours]
Pour exécuter l'action, sous programme, vous avez la possibilité 
d'utiliser le client telnet intégré ou de sélectionner un programme 
propre avec transmission de paramètres.

Tableau 37 : Définition de nouvelles tâches
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 Scripts
La boîte de dialogue «Scripts» vous permet d'élargir le choix des actions 
scripts à l'appui de scripts personnalisés.
 Pour définir un nouveau script, cliquez sur le bouton de commande 

«New».
 Pour modifier ou importer un script, cliquez sur le bouton de com-

mande «Edit».
 Pour supprimer un ou plusieurs scripts, cliquez sur le bouton de com-

mande «Delete».
 Pour dupliquer un script, cliquez sur le bouton de commande «Dupli-

cate».

Save Device Configuration L'option vous permet de procéder à la planification de l'enregistre-
ment des configurations d'équipements. Vous pouvez sélectionner 
plusieurs équipements, puis définir le chemin d'accès ainsi que les 
règles applicables à la sauvegarde des fichiers.

Save Project Utilisez cette option pour planifier une tâche d'enregistrement de la 
base de données du projet à l'emplacement de votre choix.
La base de données contient les informations suivantes relatives 
aux équipements :
– L'emplacement des équipements s'affiche dans l'onglet 

«Map».
– Les connexions de données entre les équipements indiquées 

dans l'onglet «Map»
– Les données de connexion de l'équipement
– La configuration de l'état de l'équipement Industrial HiVision

Paramètres Signification
Script Name Nom d'identification quelconque de ce script.
Content Importer script ou saisir script en tant que texte.

Tableau 38 : Définition de nouveaux scripts

Paramètres Signification

Tableau 37 : Définition de nouvelles tâches
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Commentaire : Industrial HiVision utilise des sessions à distance Telnet 
ou SSH pour exécuter des scripts sur un équipement. Après une 
connexion réussie, la session attend un signal de sortie spécifique de 
l'équipement. Des équipements sans fil n'émettent aucun signal de sortie. 
Il en découle un dépassement de temps (timeout). Pour contourner ce 
comportement, vous pouvez programmer Industrial HiVision de sorte que 
Industrial HiVision ouvre un outil de la ligne de commande (par ex. Putty) 
pour exécuter ensuite votre script.

 Schedules
La boîte de dialogue «Schedules» [Planifications] vous permet de définir 
des planifications pour l'exécution d'une tâche.
 Pour définir une nouvelle tâche, cliquez sur le bouton de commande 

«New».
 Pour modifier une tâche, cliquez sur le bouton de commande «Edit».
 Pour supprimer une ou plusieurs tâches, cliquez sur le bouton de com-

mande «Delete».

Commentaire : Vous pouvez planifier uniquement 1 tâche pour 
1 équipement.

 Results
Le tableau «Results» répertorie le résultat des tâches exécutées.
 Pour afficher un résultat sélectionné, cliquez sur le bouton de com-

mande «View».
 Pour supprimer un résultat, cliquez sur le bouton de commande 

«Delete».
 Pour actualiser la liste des résultats, cliquez sur le bouton de com-

mande «Refresh».

Paramètres Signification
Task Name Tâches des tâches définies dans la boîte de dialogue «Tasks».
Execution Mode d'exécution : une fois ou plusieurs fois avec saisie de la date 

de départ et de l'intervalle de répétition en cas d'exécution multiple.
Repetition Saisie des conditions de répétitions en cas de modèles multiples 

:Nombre de répétition, échéance finale.

Tableau 39 : Définition de nouvelles planifications
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 Exemple de planification d'un événement s'appliquant à 
un équipement individuel
Cet exemple illustre la planification d'un événement enregistrant une 
configuration d'équipement. Si Industrial HiVision décèle une erreur 
durant le processus d'enregistrement de la configuration, l'anomalie 
détectée est rapportée dans un protocole. 

Industrial HiVision enregistre le fichier log sous le chemin d'accès 
suivant : \log\services\HiVisionKernelDb.0.stderr.log.

Commentaire : Si la tâche «Save Device Configuration» échoue lors de 
la récupération de la configuration de l'équipement, procédez comme 
suit :
 Assurez-vous que Industrial HiVision peut accéder à l'équipement 

sélectionné.
 Vérifiez que les protocoles SNMP et HTTP ou HTTPS sont bien acti-

vés sur l'équipement.
 Assurez-vous que Industrial HiVision dispose des droits d'administra-

teur applicables aux protocoles SNMP, HTTP et HTTPS sur l'équipe-
ment sélectionné.

 Vérifiez que l'équipement sélectionné prend bien en charge la fonction 
« Enregistrer sur le PC » ou « Exporter la configuration ».

Pour effectuer la planification d'un événement en vue d'enregistrer le 
fichier de configuration applicable à un équipement individuel dans 
Industrial HiVision, procédez comme suit :
 Ouvrez Industrial HiVision.
 Assurez-vous que «Edit Mode» est activé.
 Pour ouvrir la boîte de dialogue «Scheduler», cliquez sur 

Configuration > Scheduler.

Les étapes de travail suivantes se rapportent à l'onglet «Tasks» :
 Pour ouvrir la boîte de dialogue «New Entry», cliquez sur le bouton 

«New».
 Entrez un nom qui décrit l'événement, par exemple, «Save Device 

Configuration».
 Sélectionnez un équipement dans la liste «Device».
 Dans le champ «Task Type», sélectionnez l'option «Save Device 

Configuration» dans la liste déroulante.
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 Lorsque l'équipement sélectionné prend en charge la fonction, les 
champs du cadre «Save Config» sont actifs. Dans le cadre «Save 
Config», saisissez les informations appropriées dans les champs 
suivants :
– Dans le «Destination folder», entrez ou naviguez jusqu'au réper-

toire, dans lequel vous souhaitez enregistrer la configuration.
– Industrial HiVision entre DeviceConfig_<IP Address> dans le 

champ «File name».
– Le champ «On multiple task execution» vous permet de sélection-

ner la façon dont Industrial HiVision gère plusieurs fichiers. Pour 
conserver un historique des modifications de configuration, sélec-
tionnez «Add timestamp to target file name». 

 Industrial HiVision conserve un enregistrement des tâches échouées 
détectées. Pour enregistrer chaque tâche réussie, décochez la case 
«Suppress report creation for successfully completed task».

 Cliquez sur le bouton «OK».

Les étapes de travail suivantes se rapportent à l'onglet «Schedules» :
 Pour ouvrir la boîte de dialogue «New Entry», cliquez sur le bouton 

«New».
 Ouvrez la liste déroulante «Name» dans le champ «Task».
 Sélectionnez la tâche établie au cours des étapes de travail précé-

dentes.
 Pour que Industrial HiVision enregistre la configuration de l'équipe-

ment plusieurs fois, sélectionnez «Multiple execution» dans le champ 
«Execution».

 Vous pouvez laisser la date et l'heure actuelles dans le champ «Start 
Date» (réglage par défaut). 

 Modifiez le réglage «Interval» à 1 et les unités à «Days».
 Pour que Industrial HiVision enregistre la configuration de l'équipe-

ment tous les jours jusqu'à ce que vous modifiiez ce réglage, sélec-
tionnez l'option «Repeat indefinitely» (réglage par défaut) dans le 
champ «Repetition».

 Cliquez sur le bouton «OK».
334
User Manual Industrial HiVision

Release 8.1 12/19



Références
 Exemple de planification d'un événement s'appliquant à 
plusieurs équipements
Vous pouvez également planifier 1 événement pour enregistrer la confi-
guration de plusieurs équipements. Si Industrial HiVision décèle une 
erreur durant le processus d'enregistrement de la configuration, l'anoma-
lie détectée est rapportée dans un protocole.

Le fichier de protocole se trouve sous le chemin d'accès suivant : 
\log\services\HiVisionKernelDb.0.stderr.log.

Commentaire : Si la tâche «Save Device Configuration» échoue durant 
la consultation de la configuration d'équipement, procédez alors comme 
suit :
 Assurez-vous que Industrial HiVision peut accéder à l'équipement 

sélectionné.
 Vérifiez que les protocoles SNMP et HTTP ou HTTPS sont bien acti-

vés sur l'équipement.
 Assurez-vous que Industrial HiVision dispose des droits d'administra-

teur applicables aux protocoles SNMP, HTTP et HTTPS sur l'équipe-
ment sélectionné.

 Vérifiez que l'équipement sélectionné prend bien en charge la fonction 
« Enregistrer sur le PC » ou « Exporter la configuration ».

Pour effectuer la planification d'un événement en vue d'enregistrer le 
fichier de configuration applicable à 1 équipement individuel dans 
Industrial HiVision, procédez comme suit :

 Open... [Ouvrir] Industrial HiVision

 Assurez-vous que le «Edit Mode» est activé.
 Sélectionnez sur l'onglet «Map» les équipements dont vous aimeriez 

enregistrer la configuration. Vous pouvez également choisir les équi-
pements des onglets «List», «Devices» et «Security».

 Effectuez un clic droit sur un équipement.
 Sélectionnez l'option «Schedule Saving Device Configuration» dans la 

liste déroulante. La boîte de dialogue «Schedule Saving Device Confi-
guration» s'ouvre. Dans le champ «Device», Industrial HiVision fait 
ressortir les équipements que vous avez sélectionnés sur l'onglet 
«Map».
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 Saisissez les informations correspondantes dans le champ «Save 
Config» en remplissant les champs suivants :
– Introduisez le lieu dans le «Destination folder», sous lequel vous 

aimeriez enregistrer la configuration ou naviguez jusqu'à l'empla-
cement de stockage souhaité.

– Industrial HiVision entre DeviceConfig_<IP Address> dans le 
champ «File name».

– Le champ «On multiple task execution» vous offre la possibilité de 
sélectionner comment Industrial HiVision utilise plusieurs fichiers. 
Pour entretenir l'historique des modifications de configuration, 
sélectionnez «Add timestamp to target file name». 

 Les journaux Industrial HiVision détectent les tâches échouées. Pour 
enregistrer chaque tâche réussie, décochez la case «Suppress report 
creation for successfully completed task».

 De plus, le champ «Reporting» inclut la fonction «Schedule Execu-
tion». La fonction vous permet de procéder à la planification d'un évé-
nement en vue d'enregistrer le fichier de configuration. Si la fonction 
est activée, Industrial HiVision enregistre la configuration des équipe-
ments dans un fichier unique.

 Afin que Industrial HiVision enregistre plusieurs fois la configuration de 
l'équipement, allez dans le champ «Execution» pour sélectionner 
l'option «Multiple execution».

 Vous pouvez laisser inchangées les indications actuelles, relatives à 
la date et à l'heure dans le champ «Start Date» (préréglage). 

 Modifiez le réglage «Interval» en 1 et les unités en «Days».
 Assurez-vous que la fonction «1 minute delay between start of tasks» 

est activée. La fonction permet à Industrial HiVision d'ajouter une tem-
porisation entre les différents processus d'enregistrement se rappor-
tant à la configuration des équipements.

 Afin que Industrial HiVision enregistre quotidiennement la configura-
tion de l'équipement, sélectionnez «Repetition» l'option «Repeat inde-
finitely» dans le champ (préréglage).

 Cliquez sur le bouton «OK».
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 Exemple de planification d'un événement pour Save Project
La fonction «Save Project» vous permet de programmer une sauvegarde 
de votre base de données de projet.

Commentaire : Les fichiers de sauvegarde créés avec la tâche «Save 
Project» sont spécifiques à la version.

Pour planifier un événement dans Industrial HiVision, créer une sauve-
garde de votre base de données de projet, procédez comme suit :
 Assurez-vous que le «Edit Mode» est activé.
 Pour ouvrir la boîte de dialogue «Scheduler», cliquez sur 

Configuration > Scheduler.

Les étapes de travail suivantes se réfèrent à l'onglet «Tasks» :
 Pour ouvrir la boîte de dialogue «New Entry», cliquez sur le bouton de 

commande «New».
 Saisissez un nom décrivant l'événement, par ex. «Save Project».
 Dans le champ «Task Type», sélectionnez l'option «Save Project» à 

partir de la liste déroulante.
 Dans le champ «Save Project File», entrez l'information suivante : 

– Dans le champ «Destination folder», entrez le chemin vers le fichier 
choisi pour l'enregistrement.

– Dans le champ «File name», entrez un nom qui décrit le fichier.
– Les étapes suivantes mènent à plusieurs fichiers au même endroit. 

Ouvrez la liste déroulante «On multiple task execution» et sélec-
tionnez «Overwrite target file» ou «Add timestamp to target file 
name».

 Industrial HiVision saisit les entrées de journal des tâches échouées 
détectées. Pour consigner une tâche réussie, décochez la case «Sup-
press report creation for successfully completed task».

 Cliquez sur le bouton «OK».

Les étapes de travail suivantes se réfèrent à l'onglet «Schedules» :
 Pour ouvrir la boîte de dialogue «New Entry», cliquez sur le bouton de 

commande «New».
 Dans le champ «Task», ouvrez la liste déroulante «Name».
 Sélectionnez la tâche créée au cours des étapes précédentes.
 Pour que Industrial HiVision enregistre plusieurs fois la base de don-

nées du projet, dans le champ «Execution», sélectionnez l'option 
«Multiple execution».

 Vous pouvez laisser inchangées les indications actuelles, relatives à 
la date et à l'heure dans le champ «Start Date» (préréglage).
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 Modifiez le réglage «Interval» en 1 et les unités en «Weeks». La valeur 
minimale de la tâche «Save Project» est 1 heure.

 Pour que Industrial HiVision enregistre chaque semaine les données 
de projet jusqu'à ce que vous modifiez le paramètre, sélectionnez, 
dans le champ «Repetition», l'option «Repeat indefinitely» (préré-
glage).

 Cliquez sur le bouton «OK».

8.4.5 Preferences

La fenêtre «Preferences» vous donne la possibilité de procéder aux réglages 
de base du logiciel. Ces paramètres ont trait aux fonctions de surveillance, 
fonctions d'administration, options d'affichage, droits d'accès et autres. 
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Figure 77 :Configuration > Preferences

 Pour reprendre des modifications dans les boîtes de dialogue et pour fer-
mer la fenêtre, cliquez sur le bouton de commande «OK».

 Pour reprendre des modifications dans les boîtes de dialogue, avant de 
passer à une autre boîte de dialogue, cliquez sur le bouton de commande 
«Apply».

 Pour fermer la fenêtre, cliquez sur le bouton de commande «Cancel». Les 
changements non enregistrés via le bouton de commande «Apply» sont 
alors perdus.

 Importation et exportation des réglages de l'utilisateur
Industrial HiVision vous permet d'importer et d'exporter les réglages de 
l'utilisateur applicables à des paramètres. Industrial HiVision exporte le 
fichier avec les réglages de l'utilisateur et une extension .prefs. Vous pou-
vez utiliser le fichier pour une sauvegarde ou pour importer les réglages 
de l'utilisateur dans une nouvelle station d'administration. L'application 
redémarre après l'importation des réglages de l'utilisateur.

Pour des raisons de sécurité, Industrial HiVision exclut les paramètres 
suivants du fichier d'exportation :
 Mots de passe
 Réglages de l'utilisateur accessibles par un mot de passe
 Réglages de la gestion des utilisateurs
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 Licences
 Informations sur la connexion d'équipements
 Informations sur la connexion d'équipements portables

Commentaire : Industrial HiVision affiche un message d'information et 
vous permet d'appliquer les réglages avant d'exporter le fichier avec les 
réglages de l'utilisateur.
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Preferences > Basics

8.4.6 Basics
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Preferences > Basics > Discovering devices

 Discovering devices
Cette boîte de dialogue vous permet de définir de quelle manière 
Industrial HiVision détecte les équipements dans votre structure de 
réseau. Industrial HiVision affiche les équipements nouvellement recon-
nus dans le répertoire cible indiqué. Si vous n'avez pas indiqué de réper-
toire cible dans le tableau d'analyse du réseau (voir ci-dessous), 
Industrial HiVision affiche les équipements détectés dans le répertoire 
«New Devices».
La fonction « Search » [Recherche] de la barre d'outils vous permet de 
lancer une recherche parmi les équipements déjà reconnus.

Industrial HiVision vous offre les possibilités suivantes pour le «Discovery 
Mode» :

 «Standard»
Industrial HiVision utilise la possibilité que vous avez sélectionnée 
pour la découverte des équipements.

 «Monitoring Mode»
Industrial HiVision analyse uniquement «Cold Start Trap» et les 
réponses ARP pour la découverte des équipements.

 «Rogue Device Detection»
Industrial HiVision utilise la possibilité que vous avez sélectionnée 
pour la découverte des équipements et déplace les équipements nou-
vellement reconnus dans le répertoire «Rogue Devices».

Industrial HiVision vous offre les possibilités suivantes pour la découverte 
des équipements :

 Découverte au moyen de traps SNMP
 Découverte des équipements à l'aide du protocole HiDiscovery
 Détecter des équipements via une zone d'adresses IP définie 

(«Network Scan»)
 Découverte de nouveaux équipements créés
 Détecter les équipements au moyen d'une liste

Reconnaissance au moyen d'alarmes
Après la mise en marche, les équipements envoient un message d'acti-
vation à la station d'administration de réseau saisie dans l'équipement.
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Industrial HiVision lit ensuite les propriétés des équipements.
– Industrial HiVision traite l'équipement comme un nouvel équipement 

et mémorise de nouveau toutes les propriétés et la structure de l'équi-
pement (module ou bloc d'alimentation nouveau/enlevé).

– Read properties again [Relancer l'analyse des propriétés] : Industrial 
HiVision relance l'analyse des propriétés déjà connues.

Exemple : vous déconnectez un équipement doté de 2 alimentations 
électriques pendant la durée des travaux de maintenance. Comment réa-
git Industrial HiVision après la reconnexion de l'équipement lorsqu'une ali-
mentation électrique est défaillante ?
– Avec l'option «Reload Device», Industrial HiVision affiche l'équipe-

ment doté d'un bloc d'alimentation en vert.
– Avec l'option «Reload Properties», Industrial HiVision affiche l'équipe-

ment avec deux blocs d'alimentation dont l'un en rouge.
Industrial HiVision affiche les équipements nouvellement reconnus dans 
le dossier correspondant.
Cette méthode de reconnaissance d'équipements est préconisée pour 
une application pendant une surveillance en cours d'exécution dans des 
réseaux où la largeur de bande est cruciale.

Découverte des équipements à l'aide du protocole HiDiscovery.
Le protocole HiDiscovery communique au moyen d'une adresse MAC 
avec des équipements du sous-réseau sur lesquels le protocole 
Hirschmann, est actif. Les catégories d'équipements Hirschmann sui-
vantes prennent en charge le protocole HiDiscovery. 
– MACH
– GREYHOUND
– PowerMICE
– MICE
– RS
– RSB
– RSR
– RSP
– GECKO
– OCTOPUS
– EES
– EAGLE
– BAT (without BAT-C)
– RR-EPL
Cette méthode vous vous offre la possibilité de détecter des équipements 
dans votre réseau, auxquels vous n'avez encore attribué aucune adresse 
IP valide.
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Industrial HiVision affiche les équipements nouvellement reconnus dans 
le dossier correspondant.
Cette méthode est préconisée lorsque vous souhaitez mettre en marche 
un réseau récemment installé et affecter une adresse IP aux nouveaux 
équipements. Choisissez cette méthode pour une période limitée afin de 
préserver votre réseau d'une charge inutile.

 Saisissez la valeur souhaitée applicable à l'intervalle de polling dans 
le champ «Polling Interval» et sélectionnez l'unité de mesure de cette 
valeur dans la liste déroulante : secondes, minutes, heures ou jours.
Préréglage : 5 minutes.
Tenez compte des effets sur vos ressources de système (voir 
page 236 “Impact sur les ressources du système”).

Reconnaissance des équipements via une plage d'adresses IP définies.
La fonction «Network Scan» permet à Industrial HiVision d'adresser des 
requêtes ping aux équipements présentant une adresse IP issue des 
zones d'adresses IP définies et d'afficher les nouveaux équipements 
répondant dans le dossier cible enregistré. 
Un firewall bloque les requêtes Ping.
Afin que Industrial HiVision soit en mesure de détecter des équipements 
derrière un pare-feu transparent, cochez la case de contrôle «evaluate 
ARP». Un firewall transparent transmet une « ARP Response » [Réponse 
ARP]. Si la réponse Ping fait défaut, Industrial HiVision évalue la réponse 
ARP.
La méthode «Network Scan» se prête à la surveillance d'un réseau cou-
rant. Vous pouvez adapter la fréquence de requête à la largeur de bande 
de votre réseau. 
 Saisissez la valeur souhaitée applicable à l'intervalle de consultation 

dans le champ «Polling Interval» et sélectionnez l'unité de mesure de 
cette valeur dans la liste déroulante : secondes, minutes, heures ou 
jours. 
Préréglage : 15 minutes.
Tenez compte des effets sur vos ressources de système (voir 
page 236 “Impact sur les ressources du système”).

 Cliquez sur le bouton «New» pour saisir une plage d'adresses IP. La 
saisie de la plage d’adresses IP comprend :
– la première adresse IP de la plage de requête
– la dernière adresse IP de la plage de requête
– le masque de réseau correspondant
– l'activation/la désactivation de cette plage pour la requête
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– un nom de votre choix à attribuer à la plage
– le dossier cible dans lequel Industrial HiVision doit afficher un nou-

veau dossier reconnu.
Vous pouvez saisir des adresses IP se chevauchant, Industrial 
HiVision gardera une copie d'un équipement dans chaque dossier 
correspondant.

Le tableau affiche les adresses IP déjà créées.
 Pour éditer une plage d’adresses IP, sélectionnez une ligne dans le 

tableau et cliquez sur le bouton «Edit».
 Pour supprimer un équipement enregistré, sélectionnez la ligne dans 

le tableau et cliquez sur le bouton «Delete».
 Pour dupliquer une plage d’adresses IP, afin de modifier la copie par 

la suite, sélectionnez une ligne dans le tableau et cliquez sur le bouton 
«Duplicate».

Découverte de nouveaux équipements créés
Vous procédez ici au réglage initial de la boîte de dialogue servant à saisir 
l'adresse IP et s'affichant lorsque vous créez un nouvel équipement (voir 
page 145 “–Création de nouveaux équipements”).

Reconnaître des équipements dans une liste d'adresses IP
Industrial HiVision vous offre la possibilité d’analyser des adresses IP via 
un fichier texte ou Microsoft Excel (.csv). La boîte de dialogue «Create 
Devices from List» vous permet de rechercher le fichier et de le charger 
dans Industrial HiVision. Si un équipement n'est pas accessible dans la 
liste, Industrial HiVision indique l'équipement comme étant un équipe-
ment générique sur la carte de topologie. (voir page 268 “Devices from 
List”)
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Figure 78 :Configuration > Preferences > Basics > Discover Devices
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Preferences > Basics > User Management

 User Management
La gestion des utilisateurs se base sur un modèle de rôles.
Définissez les noms de rôle dans le cadre «Access Roles». Assignez une 
fonction à ces rôles par l'attribution des autorisations d'accès. Par 
exemple, vous attribuerez naturellement à un administrateur tous les 
droits disponibles, tandis qu'un observateur pourra se connecter, mais 
n'aura aucun droit lui permettant d'apporter une quelconque modification.
Industrial HiVision prévoit les rôles d'accès suivants :
 «Login»
 «Edit Mode»
 «User Management»
 «Web Access»

Après avoir établi les rôles d'accès, vous créez les utilisateurs et vous 
attribuez 1 ou plusieurs rôles configurés ci-dessus aux utilisateurs. Cette 
attribution dépend de la méthode que Industrial HiVision doit utiliser pour 
vérifier l'autorisation d'un utilisateur.
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Industrial HiVision utilise 3 «Policies» pour vérifier l'autorisation d'un 
utilisateur :
– «Local Users», nom d'utilisateur local avec attribution du rôle.

Industrial HiVision copie le nom du rôle créé ci-dessus dans l'en-tête 
du tableau des utilisateurs. Vous pouvez ainsi attribuer aisément des 
rôles à un nom d'utilisateur.
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– «LDAP Server», contrôle central des utilisateurs à l'aide du 
Lightweight Directory Access Protocol.
Mettez les informations sur les utilisateurs Industrial HiVision et les 
rôles d'accès associés à la disposition de l'administrateur de votre ser-
veur LDAP.
Indiquez à l'administrateur de votre serveur LDAP les données utilisa-
teur suivantes à entrer dans le serveur LDAP :
– «User Name»
– «Password»
– «Access Roles»

Le champ Preferences > Basics > User Management > LDAP Server 
Configuration inclut la case de contrôle «Use Secure Connection». 
La case à cocher vous permet de choisir entre une connexion sécuri-
sée et une connexion non sécurisée lorsque vous utilisez un serveur 
LDAP pour autoriser un utilisateur Industrial HiVision. 
 Si vous cochez la case, l'utilisateur s'authentifie auprès du serveur 

via une connexion SSL. El intercambio de datos entre Industrial 
HiVision y el servidor LDAP está cifrado.

 Si la case n'est pas cochée, la connexion n'est pas sécurisée et les 
données telles que les mots de passe sont envoyées en texte clair.
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– «RADIUS Server», contrôle central des utilisateurs à l'aide du Remote 
Authentication Dial-In User Service.
Indiquez à l'administrateur de votre serveur RADIUS les données uti-
lisateur suivantes à entrer dans le serveur RADIUS :
– «User Name»
– «Password»
– «Access Roles»
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Vous pouvez définir dans la zone inférieure de la boîte de dialogue «User 
Management» quelles méthodes Industrial HiVision emploie pour vérifier 
les autorisations d'un utilisateur. Tant que le champ «Selected Order» est 
vide, Industrial HiVision est accessible librement.
Industrial HiVision utilise la première entrée dans ce champ pour contrôler 
l'autorisation. Si la vérification du premier procédé n'est pas fructueuse, 
Industrial HiVision contrôle l'autorisation à l'aide du second procédé. Si 
aucun des contrôles d'autorisation effectués par Industrial HiVision ne 
réussit, Industrial HiVision refuse l'accès.

Pour permettre aux utilisateurs de HiMobile d'accéder à l'application 
Industrial HiVision procédez comme suit :
 Sélectionnez Industrial HiVision.
 Assurez-vous que le «Edit Mode» est activé.
 Ouvrez la boîte de dialogue Configuration > Preferences > 

Basics > User Management.
 Pour établir un rôle d'accès à l'intention des utilisateurs de HiMobile, 

cliquez sur le bouton de commande «New».
 Saisissez la valeur HiMobile dans le champ «Role Name».
 Dans le cadre «Permissions», cochez les cases de contrôle «Login» 

et «Web Access». 

Commentaire : Hirschmann vous recommande de désactiver les 
options «Edit Mode» et «User Management» applicables aux utilisa-
teurs de HiMobile.

 Cliquez sur le bouton «OK».
 Ouvrez la boîte de dialogue Configuration > Preferences > 

Advanced > Services Access.
 Assurez-vous que l'option «Web Server» est activée.
 Créez un certificat et importez ce certificat sur votre équipement por-

table (voir page 259 “Certificat de la connexion HTTPS”).
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Preferences > Basics > Event Forwarding

 Event Forwarding
Cette boîte de dialogue permet de fixer des paramètres de transmission 
d'événements sur un service Syslog.
«Forward events to syslog server» vous permet d'activer/désactiver la 
fonction de transmission d'événements de manière globale. Si la fonction 
de transmission des événements est validée, Industrial HiVision envoie 
un message Syslog au serveur Syslog saisi dans cette boîte de dialogue 
dès qu'un événement survient.
Avec «Forward internal events», par exemple, «Industrial HiVision 
Started», Industrial HiVision envoie également des messages Syslog 
pour les événements internes Industrial HiVision.
Avec «Forward events of all devices», Industrial HiVision envoie des mes-
sages Syslog au serveur Syslog pour chaque équipement disponible. 
Lorsque vous cochez la case «Forward events of all devices», le tableau 
«Forward events for devices» est masqué.
Avec «Event Type», vous spécifiez à quel niveau d'évaluation d'un évé-
nement Industrial HiVision envoie un message Syslog.
Dans le tableau «Forward events for devices», vous saisissez l’équipe-
ment dont les événements doivent conduire à un message Syslog.
Dans le tableau «Syslog servers», vous saisissez les données du serveur 
Syslog auquel Industrial HiVision envoie les messages Syslog.
Industrial HiVision établit la communication avec le serveur Syslog via les 
protocoles de transport suivants :
 User Datagram Protocol (UDP)
 Transport Layer Security (TLS)
Lorsque le protocole TLS est utilisé, Industrial HiVision accepte le certifi-
cat du serveur Syslog sans validation supplémentaire.
Dans certains cas, un serveur Syslog peut nécessiter un processus de 
validation en deux étapes qui inclut la validation du certificat client. Si un 
serveur Syslog nécessite un processus de validation en deux étapes, la 
communication avec le serveur Syslog n'est pas possible.
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Figure 79 :Configuration > Preferences > Basics > Event Forwarding
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Preferences > Basics > Event Forwarding

 Event Actions
Dans cette boîte de dialogue, vous définissez des actions à exécuter par 
Industrial HiVision lorsque des événements spécifiques surviennent.

Figure 80 :Configuration > Preferences > Basics > Event Actions

Le cadre «Actions» décrit les actions que Industrial HiVision peut 
exécuter :
 Ouvrir la fenêtre de notification sur l'écran
 Envoyer un SMS
 Émettre un son
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 Envoi d'un e-mail
 Exécuter un programme (voir remarque dans “Installation sous Win-

dows”). La figure ci-dessous (voir la figure 81) montre le programme 
utilisateur « siren.exe » à titre d'exemple.

 Pour spécifier l'action que vous voulez affecter aux événements, cli-
quez sur le bouton «New».
Dans le cas d'actions ne pouvant être exécutées lors de la première 
tentative, par ex. ligne occupée lors de l'envoi d'un SMS, Industrial 
HiVision prévoit la possibilité de réitérer l'action.

La boîte de dialogue «New Entry» contient le bouton «Test Action». Le 
bouton «Test Action» vous permet de tester votre configuration.

L'action «Send SMS» requiert
– que votre station d'administration réseau soit connectée au réseau 

téléphonique par ex. via un modem et
– que le programme SMS soit correctement configuré.
Saisissez le numéro de téléphone du destinataire sous «Recipient».
Si vous entrez le numéro de téléphone de votre modem comme «Sen-
der», Industrial HiVision l'envoie avec le message. Vous pouvez ainsi 
reconnaître sur l'écran de votre téléphone portable que le message a 
été envoyé par Industrial HiVision.
En tant que «Service Provider», vous saisissez le service que vous 
avez configuré dans votre programme SMS (si disponible). 

Sous Preferences > Advanced > External Applications, vérifiez 
que les entrées pour les applications externes requises sont présentes 
et qu'elles répondent à vos besoins.

Le tableau affiche les actions IP déjà créées.
 Pour éditer une action, sélectionnez une ligne dans le tableau et cli-

quez sur le bouton «Edit».
 Pour supprimer une ligne du tableau, sélectionnez la ligne dans le 

tableau et cliquez sur le bouton «Delete».
 Pour dupliquer une action afin de pouvoir ensuite modifier la copie, 

sélectionnez une ligne dans le tableau et cliquez sur le bouton «Dupli-
cate».
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Figure 81 :Configuration > Preferences > Basics > Event Actions > Actions, 
exemple d'application de l'action « Execute programm » [Exécuter le pro-
gramme] pour le programme utilisateur « siren.exe »

Le cadre «Alarms» offre la possibilité d'exécuter une action lorsque cer-
tains événements se produisent ou en l'absence de confirmation de cer-
tains événements.
Sous «Type», vous spécifiez quand Industrial HiVision exécute l'action.
Sous «Alarm», saisissez un nom pour l'événement qui doit déclencher 
une action.
Sous «Filter», vous définissez l'événement qui doit déclencher les actions 
sélectionnées ci-dessous. Industrial HiVision autorise les caractères 
génériques pour définir les filtres. 

Désignation Signification
Type Sélection du type de statut (erreur, avertissement,...)
Category Événement d'une certaine catégorie (état meilleur, nouvel équipement, 

...)
User Identifiant sur la station d'administration de réseau
Source Cause de l'événement
Component Composant de la cause de l'événement
Message Texte décrivant l'événement

Tableau 40 : Critères de filtres
356
User Manual Industrial HiVision

Release 8.1 12/19



Références
Pour vous simplifier la tâche, «Import...» contient les événements déjà 
survenus, provenant de la liste, dans le cadre Événements.

 Sélectionnez une ligne et cliquez sur le bouton «OK».
Industrial HiVision transpose les propriétés de l'événement sélec-
tionné dans le cadre Filtres.

La ligne «Message» vous permet de saisir le texte de notification pour les 
actions. Pour ce faire, vous pouvez utiliser les mots clés de filtre précédés 
du signe $ comme une entrée variable. Saisissez les mots clés en majus-
cules. Par exemple, si vous entrez « $TIME » dans le message, Industrial 
HiVision indique l'heure à laquelle l'événement est survenu dans le mes-
sage. Les mots-clés fournis par Industrial HiVision apparaissent dans 
l'infobulle de la ligne «Message».

La liste suivante contient des mots réservés à l'usage interne de Industrial 
HiVision. Si vous tapez un des mots dans le champ «Message», Industrial 
HiVision ouvre un message d'erreur. Les mots utilisés seuls ou dans le 
cadre d'un mot plus long sont interdits. Les mots réservés ne s'appliquent 
qu'aux interfaces graphiques utilisateur (GUI) en anglais et en allemand.

Liste des mots réservés en anglais :
 Alarm
 alarm
 Alarms
 alarms
 Actions
 actions
 Message
 message
 Critical
 critical

Liste des mots réservés en allemand :
 Alarm
 Alarme
 Alarms
 Nachricht
 Kritisch

Le cadre «Time» vous permet de fixer une planification horaire au cours 
de laquelle Industrial HiVision réagit à un événement par le biais d'une 
action. 
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Dans le cadre «Actions», vous pouvez sélectionner une ou plusieurs des 
actions déjà créées. Industrial HiVision exécute ces actions lorsque l'évé-
nement défini ci-dessus se produit ou en l'absence de confirmation de 
l'événement dans le délai spécifié dans «Type».

Figure 82 :Configuration > Preferences > Basics > Event Actions > Alarms > 
Message
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L'exemple de configuration suivant décrit comment configurer Industrial 
HiVision pour envoyer un e-mail pour un événement. Dans cet exemple, 
vous configurez les boîtes de dialogue Configuration > 
Preferences suivantes :
 La boîte de dialogue Advanced > Paramètres Service
 La boîte de dialogue Basics > Event Actions > Actions > New > 

New Entry 
 La boîte de dialogue Basics > Event Actions > Alarms > New > New 

Entry

Pour que Industrial HiVision puisse envoyer des emails, il se connecte à 
un serveur hôte de messagerie. Obtenez les informations suivantes sur 
le serveur auprès de l'administrateur de votre serveur de messagerie : 
 Nom d'hôte
 Le nom du compte email que Industrial HiVision utilise pour envoyer 

l'email. Assurez-vous que le nom de l'expéditeur de l'e-mail soit facile-
ment identifiable en tant que Industrial HiVision.

 Est-il nécessaire pour Industrial HiVision de se connecter au serveur ? 
Si c'est le cas, les informations suivantes sont nécessaires :
– Quel type de connexion utilise le serveur. Industrial HiVision se 

connecte en utilisant les protocoles suivants :
Normal, communication non sécurisée 
STARTTLS, déclenche une session TLS
SSL, utilise le protocole Secure Socket Layer

– Quel port TCP utilise le serveur.
– Le nom d'utilisateur et le mot de passe utilisés pour l'authentifica-

tion.

Les éléments suivants peuvent empêcher Industrial HiVision d'envoyer 
un email :
 Réglages du pare-feu
 Réglages de protection contre les virus

Pour configurer Industrial HiVision pour se connecter à un serveur de 
messagerie, procédez comme suit :
 Ouvrez la boîte de dialogue Advanced > Paramètres Service.
 Dans le champ Mail Server > SMTP Mail Host, saisissez le nom du 

serveur de messagerie, par exemple smtp2.xxxx.com.
 Dans le champ «Sender Address», saisissez le compte email à partir 

duquel Industrial HiVision envoie l'email, par exemple, Industrial 
HiVision@xxxx.com.

 Cliquez sur le bouton «OK».
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Pour envoyer un e-mail au responsable de la tâche, procédez comme 
suit :
 Ouvrez la boîte de dialogue Basics > Event Actions.
 Pour effectuer une entrée dans le tableau «Actions», cliquez sur le 

bouton Actions > New.
 Dans le champ Edit > Action > Name, saisissez la valeur 

Send_email_to_admin.
 Dans la liste déroulante «Action», sélectionnez l'option «Send E-

Mail».
 Saisissez l'adresse e-mail du responsable de la tâche dans le champ 

«Recipient».
 Cliquez sur le bouton «OK».

Pour configurer un événement pour lequel Industrial HiVision envoie un 
email, procédez comme suit :
 Ouvrez la boîte de dialogue Basics > Event Actions.
 Pour effectuer une entrée dans le tableau «Alarms», cliquez sur le 

bouton Alarms > New.
 Dans la boîte de dialogue «Edit», saisissez le texte que vous souhai-

tez afficher sur la ligne d'objet dans le champ «Name».
 Saisissez l'événement que vous souhaitez envoyer par e-mail dans le 

cadre «Filter».
Lorsque Industrial HiVision a un événement dans «Event History» que 
vous souhaitez envoyer par e-mail, Industrial HiVision peut entrer 
automatiquement des valeurs dans le cadre «Filter» en utilisant le 
bouton «Import...».
– Cliquez sur le bouton «Import...».
– Sélectionnez l'événement dans l'onglet «Application Events».
– Cliquez sur le bouton «OK».

Vous pouvez également générer des événements de test que vous 
pouvez envoyer par e-mail. Voir “Generate test events” on page 304.

 Saisissez le message que vous souhaitez afficher dans le corps de l'e-
mail dans le champ «Message».
Vous pouvez saisir du texte libre ou utiliser des jetons. Lorsque vous 
passez le curseur au-dessus du champ de texte, Industrial HiVision 
affiche une bulle d'aide contenant les jetons que vous pouvez utiliser. 
Les jetons représentent les colonnes affichées dans le journal des 
événements. Par exemple, $TYPE = colonne «Type», $MESSAGE = 
colonne «Message».

 Cochez la case Send_email_to_admin dans le tableau «Actions».
 Cliquez sur le bouton «OK».
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Preferences > Basics > User defined Action

 User defined Action
Les actions personnalisées vous permettent de lancer des actions sur 
d'autres équipements via votre station d'administration réseau.

Exemple d'interface : « Activer le client Telnet »
Vous aimeriez accéder à un équipement connu tel qu'un commutateur 
(switch) via un client Telnet, par ex « Putty ».
 Allez sur la barre de menus Industrial HiVision pour sélectionner 

Configuration > Preferences.
 Dans la boîte de dialogue, sélectionnez «Preferences» Basics > User 

defined Actions.
 Pour définir une nouvelle action configurable par l'utilisateur, cliquez 

sur le bouton de commande «New».
 Saisissez un nom pour identifier l'appel du client Telnet dans le champ 

«Name», par ex. « Gérer un commutateur via Telnet ».

Location 
[Emplace-
ment]

Signification

Desktop Industrial HiVision démarre l'application sur l'ordinateur, sur lequel l'interface 
Industrial HiVision fonctionne. Le service peut s'exécuter sur un autre ordina-
teur.
Vous sélectionnez «Desktop», si l'application qu' Industrial HiVision démarre 
attend une interaction.
Exemple d'application : démarrage d'un client Telnet

Service Industrial HiVision démarre l'application sur l'ordinateur, sur lequel l'interface 
Industrial HiVision fonctionne. 
Cette sélection vous permet de configurer des équipements n'autorisant la 
configuration qu'à partir de l'adresse IP de la station d'administration réseau.
Exemple d'application : scripts de configuration que vous souhaitez activer 
depuis plusieurs interfaces (même d'appliquettes ou « applets ») ou qui exé-
cutent un fichier séquentiel (voir « Exemple d'interface »).

Browser Industrial HiVision démarre l'application avec l'URL.
Exemple : pour ouvrir l'interface utilisateur graphique d'un équipement dans le 
navigateur, saisissez la valeur suivante dans le champ «Parameters» :  
http://10.0.1.13

Tableau 41 : Lieu d'exécution d'une action personnalisée
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 Dans la ligne «Available for», sélectionnez l’icône, au moyen de 
laquelle vous tenez à démarrer l'action. Industrial HiVision place 
l'action d'après la définition figurant dans la liste déroulante. Vous trou-
vez l'action en cliquant avec le bouton droit de la souris sur ce sym-
bole, sous «Actions».
– Dès lors que vous souhaitez appeler ultérieurement cette action au 

niveau des équipements, servez-vous de la liste déroulante «Avai-
lable for» pour sélectionner «Device».

 Sélectionnez dans le menu déroulant «Device Type» l'option «All».
 Vous souhaitez démarrer le client telnet sur l'ordinateur où s'exécute 

l'interface de Industrial HiVision. Le client telnet attend une interaction 
avec l'administrateur du Switch. Par conséquent, sélectionnez 
«Desktop» comme «Location of Execution»(voir le tableau 41).

 Saisissez le chemin d'accès et le nom de l'application dans la zone de 
texte «Application». En outre, il vous est possible de sélectionner 
l'application en cliquant sur le bouton de commande «...».
Pour sélectionner le client Telnet « Putty », saisissez par exemple ce 
qui suit : 
C:/Data/Software/putty.exe.

 La zone de texte «Parameters» vous permet de transmettre des para-
mètres avec des jetons à l'application. Dans cet exemple, saisissez :
– Appel de telnet
– le jeton pour l'adresse IP de l'équipement
$“-telnet $IP_ADDR“

Exemple de service : « activer/désactiver le port »
Des connexions Ethernet sont disponibles dans un espace réservé à des 
visiteurs. La salle est accessible à tout le monde. Vous ne souhaitez donc 
activer un port relié à cette connexion Ethernet que si vous avez vraiment 
de la visite.

 Écrivez à cette fin les commandes SNMP pour activer/désactiver le 
port dans les petits fichiers séquentiels suivants :

Pour les utilisateurs de Windows :
1. Fichier séquentiel : Port-on.bat
set IP_ADDR=%1%
set IF_INDEX=%2%
"<installation folder>\bin\SnmpSet.cmd.exe" -c private %IP_ADDR% 
1.3.6.1.2.1.2.2.1.7.%IF_INDEX% integer 1
2. Fichier séquentiel : Port-off.bat
set IP_ADDR=%1%
set IF_INDEX=%2%
"<installation folder>\bin\SnmpSet.cmd.exe" -c private %IP_ADDR% 
1.3.6.1.2.1.2.2.1.7.%IF_INDEX% integer 2
362
User Manual Industrial HiVision

Release 8.1 12/19



Références
Pour les utilisateurs de Linux :
1. Fichier séquentiel : Port-on.bat
#!/bin/bash
IP_ADDR=$1
IF_INDEX=$2
"<installation folder>/bin/SnmpSet" -c private $IP_ADDR 
1.3.6.1.2.1.2.2.1.7.$IF_INDEX integer 1
2. Fichier séquentiel : Port-off.bat
#!/bin/bash
set IP_ADDR=%1%
set IF_INDEX=%2%
"<installation folder>/bin/SnmpSet" -c private $IP_ADDR 
1.3.6.1.2.1.2.2.1.7.$IF_INDEX integer 2
Marquez le fichier comme Executable, Exec-Bit, avec la commande: 
chmod 700 Port-On.sh

 Enregistrez les fichiers séquentiels dans la station d'administration 
réseau, par ex. sous C:\Data\PortOnOffBatch.

 Allez sur la barre de menus Industrial HiVision pour sélectionner 
Configuration > Preferences.

 Dans la boîte de dialogue, sélectionnez «Preferences» Basics > User 
defined Actions.

 Pour définir une nouvelle action configurable par l'utilisateur, cliquez 
sur le bouton de commande «New».

 Saisissez le nom du premier fichier séquentiel, par ex. « Activer le port 
de visiteur ».
User Manual Industrial HiVision
Release 8.1 12/19 363



Références
 Dans la ligne «Available for», sélectionnez l’icône, au moyen de 
laquelle vous tenez à démarrer l'action. Industrial HiVision place 
l'action d'après la définition figurant dans la liste déroulante. Vous trou-
vez l'action en cliquant avec le bouton droit de la souris sur ce sym-
bole, sous «Actions».
– Dès lors que vous souhaitez appeler ultérieurement cette action au 

niveau des équipements, servez-vous de la liste déroulante «Avai-
lable for» pour sélectionner «Device». 

 Dans cet exemple, le port de la connexion à l'intérieur de la salle des 
visiteurs est relié à un commutateur sur rail du type RS30. Utilisez 
donc la liste déroulante «Device Type» pour choisir l'option «Open-
Rail, Mach 4000, Octopus».

 Vous souhaitez démarrer les fichiers batch sur l'ordinateur où s'exé-
cute Industrial HiVision. Industrial HiVision transmet le numéro d'inter-
face du port en tant que paramètre de commande lors de l'appel du 
fichier batch. Après quoi, les fichiers batch s'exécutent de manière 
autonome. Par conséquent, sélectionnez «Service» comme «Location 
of Execution»(voir le tableau 41).

 Saisissez le chemin d'accès et le nom de l'application dans la zone de 
texte «Application». En outre, il vous est possible de sélectionner 
l'application en cliquant sur le bouton de commande «...».
Dans cet exemple, saisissez ce qui suit : 
C:\Data\PortOnOffBatch\Port-on.bat

 La zone de texte «Parameters» vous permet de transmettre des para-
mètres avec des jetons à l'application. Dans cet exemple, saisissez ce 
qui suit :
– le jeton pour l'adresse IP de l'équipement
– le jeton pour le port
$IP_ADDR $USER

Si vous saisissez la valeur $USER dans la zone de texte «Parameters», 
Industrial HiVision ouvre la zone de texte «User Input Prompt».

 La zone de texte «User Input Prompt» vous permet de saisir des ins-
tructions dans la boîte de dialogue «User Input».
Pour cet exemple, entrez: « Entrer l'index d'interface ».
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Sous «Advanced», vous trouvez d'autres détails de fonction :
 «Token Language»

Industrial HiVision transfert le contenu du jeton à l'application dans la 
langue choisie. Ceci concerne les jetons : « Status (textual) » [Statut 
(textuel)], « Value » [Valeur] et « Name » [Nom].

 Demande de mot de passe lors de l'appel de l'action
Si plus de 30 minutes se sont écoulées entre la saisie du mot de passe 
et la prochaine requête d'action, Industrial HiVision redemande le mot 
de passe.

 Options d'affichage pour le contenu de l'évènement d'application
 Options d'affichage pour le mode d'affichage de l'évènement d'appli-

cation.
«Only In Case Of Failure» : Une défaillance s'est produite si la valeur 
de restitution de l'application a une autre valeur que 0.

Figure 83 :Exemple d' action personnalisée

Exemple pour le navigateur : « Afficher le navigateur Web »
Vous souhaitez accéder aux services de votre Industrial HiVision sur le 
serveur web afin de lire la liste des évènements.
 Allez sur la barre de menus Industrial HiVision pour sélectionner 

Configuration > Preferences.
 Dans la boîte de dialogue « Réglages », sélectionnez Basics > User 

defined Actions.
 Pour définir une nouvelle action configurable par l'utilisateur, cliquez 

sur le bouton de commande «New».
 Pour appeler le client Telnet, saisissez n'importe quel nom, par ex. 

« Événements ».
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 Dans la ligne «Available for», sélectionnez l’icône, au moyen de 
laquelle vous tenez à démarrer l'action. Industrial HiVision place 
l'action d'après la définition figurant dans la liste déroulante. Vous trou-
vez l'action en cliquant avec le bouton droit de la souris sur ce sym-
bole, sous «Actions».
– Dès lors que vous souhaitez appeler ultérieurement cette action au 

niveau des équipements, servez-vous de la liste déroulante «Avai-
lable for» pour sélectionner «Device». 

 Pour le «Device Type», sélectionnez l'option «Windows PC».
 Vous souhaitez visualiser la liste d'évènements dans le navigateur 

web. Par conséquent, sélectionnez «Browser» comme «Location of 
Execution»(voir le tableau 41).

 La ligne «Parameters» vous permet de transférer les paramètres à 
l'application au moyen de jetons. Dans cet exemple, saisissez :
– Appel du navigateur web
– Le jeton pour l'adresse IP de l'ordinateur sur lequel s'exécute le 

service de Industrial HiVision.
– Le port pour le serveur web de Industrial HiVision
– Le site web que vous souhaitez visualiser
http://$IP_ADDR:11187/events
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Preferences > Basics > License

 License
Vous avez besoin d'une clé de licence pour le fonctionnement d'Industrial 
HiVision Le nombre d'équipements que vous pouvez afficher dépend de 
la clé de licence. Vous pouvez ainsi adapter le montant de votre investis-
sement dans Industrial HiVision à la croissance de votre réseau.
Après une nouvelle installation et une mise à jour, une nouvelle clé de 
licence est requise. Industrial HiVision met les équipements, pour les-
quels il n'existe aucune licence dans l'état « Unmanaged » (= non géré). 
Dès que vous avez saisi une clé de licence applicable à ces équipements, 
vous pouvez les remettre dans l'état géré « Managed » .
Industrial HiVision présente les équipements sans licence valide avec un 
sceau.

Figure 84 :Équipement sans clé de licence Industrial HiVision

 Cliquez sur le bouton de commande «New» et introduisez la clé de 
licence dans la fenêtre de saisie. Si vous disposez d'une clé de licence 
électronique, un simple copier/coller remplace la transcription.
Pour terminer la saisie, cliquez sur le bouton de commande «OK».
Vous ajoutez de nouvelles clés de licence et des licences de mise à 
jour de la même manière.

Après la saisie d'une clé de licence, Industrial HiVision affiche cette clé de 
licence dans une ligne du tableau.

Désignation Signification
Key Numéro de clé
Version Numéro de version de logiciel d'Industrial HiVision
Expires Date de fin de validité de la licence
Type Version complète ou version mise à jour
Devices Nombre d'équipements couverts par la licence

Tableau 42 : Entrées du tableau de licence
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Une licence complète vous permet de surveiller un certain nombre d'équi-
pements dans Industrial HiVision Une licence complète est associée à 
une version d'Industrial HiVision au moment de l'acquisition.

Commentaire : Pour établir la clé de matériel, Industrial HiVision s'appuie 
sur quelques composants de matériel de votre station d'administration de 
réseau. Ces composants de matériel incluent entre autres les cartes inter-
face réseau. Afin que vous puissiez remplacer les composants matériels, 
Industrial HiVision compare certaines combinaisons des composants 
matériels pour déterminer la clé du matériel.
Tant qu'une des cartes d'interface réseau au moins, installée au moment 
de demander la clé de licence, est active dans la station d'administration 
réseau, Industrial HiVision détecte la clé appropriée. Dans ce cas, 
Industrial HiVision déduit que les autres composants matériels sont 
encore installés.
Si Industrial HiVision constate que la station d'administration ne dispose 
d'aucune carte d'interface active, le champ «Hardware Key» indique alors 
ce message. « La clé du matériel n'est pas valide. Elle ne contient aucune 
interface réseau. » Pour visualiser la clé du matériel, ajoutez une inter-
face. Vous pouvez aussi activer une interface réseau à cette fin.

Hardware Key Clé de matériel indiquée lors de la requête de clé 
de licence. Si la clé de matériel de cette clé de 
licence coïncide avec la clé de matériel figurant 
dans le tableau de licence, vous pouvez utiliser 
cette clé de licence sur cette station d'administra-
tion réseau.

License Holder Nom de titulaire de licence indiqué lors de la 
requête de clé de licence.

Registration Code Code d'enregistrement que vous avez reçu lors de 
l'achat d'une version complète, d'une mise à niveau 
ou d'un plan de maintenance. Vous avez utilisé ce 
code d'enregistrement pour demander la clé de 
licence. 

Désignation Signification

Tableau 42 : Entrées du tableau de licence
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«Leased licenses»
Si vous disposez d'une structure de réseau hiérarchique et que vous avez 
octroyé des licences à des sous-domaines, la boîte de dialogue 
«Licenses» comporte un tableau affichant les licences allouées dans la 
zone inférieure.
Ce tableau comprend les colonnes suivantes :
– «Subdomain name»
– «IP Address»
– «Leased licenses»
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Preferences > Display

8.4.7 Display
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Preferences > Display > Language

 Language
Cette boîte de dialogue vous offre la possibilité de sélectionner la langue 
de l'interface utilisateur graphique et les formats de la date.
Réglages par défaut :
 Langue : langue du système de votre ordinateur.
 Format de date de l'interface : année-mois-jour
 Format de date du service : année-mois-jour
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Preferences > Display > Event

 Event
Cette boîte de dialogue vous permet d'accéder au préréglage de l'affi-
chage d'évènements.

Évènements de la liste d'évènements (voir la figure 8) :

 «Max. Number of Events»
Servez-vous de la liste déroulante pour sélectionner le nombre maxi-
mal d'événements qu'Industrial HiVision doit afficher dans la liste des 
événements. Si le nombre des événements survenus dépasse le 
nombre indiqué, #Variable:Produktname kurz# rejette les événements 
anciens (d'après le principe du premier entré, premier sorti).
Préréglage : 1000
Plage de valeurs : ≤ 50 000

 «Event Display»
L'option «Show Event List and Summary» vous permet d'afficher/de 
masquer la liste des événements et le résumé des événements dans 
la fenêtre principale.
Préréglage : afficher.
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 «Event Log to File»
L'option «Logging Enabled» vous permet d'établir qu'Industrial 
HiVision consigne chaque événement se produisant dans le fichier du 
journal des événements. Industrial HiVision écrit le fichier journal des 
évènements dans le langage du système d'exploitation.Fichier journal 
des évènements
Vous trouvez le fichier du journal des événements 
HiVisionEvents0.csv dans le répertoire d'installation d'Industrial 
HiVision sous \log\events.
Si le fichier HiVisionEvents0.csv dépasse la taille de 1 Mo, 
Industrial HiVision renomme le fichier HiVisionEvents0.csv en 
HiVisionEvents1.csv. Industrial HiVision consigne les nouveaux 
événements dans le nouveau fichier HiVisionEvents0.csv.
Si la taille du fichier HiVisionEvents0.log dépasse de nouveau 
1 Mo, Industrial HiVision renomme les fichiers :
– HiVisionEvents1.csv fichier en HiVisionEvents2.csv
– HiVisionEvents0.csv fichier en HiVisionEvents1.csv
– etc.
Industrial HiVision peut écrire jusqu'à 1 000 fichiers log. Si d'autres 
événements surviennent, Industrial HiVision écrase le fichier 
HiVisionEvents999.csv d'après le schéma expliqué ci-dessus.

 «Logfile path»
Constituant une alternative au répertoire d'installation, cette ligne vous 
permet de sélectionner n'importe quel chemin d'accès, où Industrial 
HiVision doit écrire le fichier log des événements.

Commentaire : Des retards ou des interruptions lors de l'écriture sur 
un lecteur de réseau risquent de bloquer le service Industrial HiVision.

Commentaire : Des retards ou interruptions du réseau peuvent être à 
l'origine de contenus incomplets du fichier journal des événements. 

Commentaire : Étant donné que le service écrit le fichier log, le 
compte du système local requiert les droits d'écriture de ce répertoire.
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 «Status Change Caused by Status Propagation»
Le fait de modifier l'état d'une propriété d'un composant ou d'un dos-
sier représente un événement, que Industrial HiVision peut afficher 
comme une entrée dans le cadre dédié aux événements.
Sélectionnez les événements que Industrial HiVision doit visualiser via 
la liste déroulante :
– «No Event», si vous souhaitez afficher uniquement les modifica-

tions d'état du niveau le plus bas comme entrée. Industrial HiVision 
masque les modifications d'état redirigées du niveau le plus bas 
vers le haut comme entrée d'événement.

– «Info Event», si Industrial HiVision doit afficher les modifications 
d'état comme une entrée dans la liste des événements. Le type 
« Info » est attribué aux entrées d'événements découlant de la 
transmission d'un changement d'état (voir page 100 “Nombre 
d'évènements”).

– «Similar Event», si Industrial HiVision doit afficher les modifications 
d'état comme une entrée dans la liste des événements.
Les entrées d'événements provoquées par une modification d'état 
transférée reçoivent le type correspondant au changement d'état 
transmis à ce niveau.
Préréglage : aucun événement.

 «Source»
En cas d'évènement concernant un équipement, Industrial HiVision 
ajoute le nom d'événement dans la liste d'évènements ainsi que 
l'emplacement [Location] que vous avez saisi dans la propriété d'équi-
pement «Location».

Évènements sur le site Internet Industrial HiVision
(voir page 254 “Évènements sur le site Internet”)

 «Days in event log»
Industrial HiVision affiche sur la page évènements du site Internet les 
évènements du nombre de jours passés que vous indiquez ici.
Présélection : 7 jours

 «Automatic page refresh every»
Industrial HiVision actualise périodiquement la page évènements du 
site Internet. Indiquez ici la durée de la période en minutes.
Présélection : 5 minutes
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«"I'm alive" Event»
(voir page 227 “Événement « Je suis en vie »Industrial HiVision”)

 «Send "I'm alive" events»
S'il est activé, Industrial HiVision envoie périodiquement l'évènement 
défini en tant qu'action de «"I'm alive" Event».
Préréglage : inactif

 «Send interval»
Préréglage : 1 minute

 «Send warning events since last "I'm alive" event»
S'il est activé, Industrial HiVision envoie en même temps que l'évène-
ment « Je suis en vie » les évènements ayant l'état d'avertissement 
que Industrial HiVision a enregistré depuis l'envoi du dernier évèvene-
ment « Je suis en vie ».
Préréglage : inactif

Figure 85 :Configuration > Preferences > Display > Event
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Preferences > Display > Event Auto-Acknowledge

 Event Auto-Acknowledge
Cette boîte de dialogue offre la possibilité de définir les événements «Sta-
tus Worse» que l'application Industrial HiVision peut automatiquement 
acquitter si un événement «Status Better» lié se produit dans un intervalle 
de temps spécifié.

Événements de la liste «Event Auto-Acknowledge» :

 «Ping Reachability»
Un événement lié à un changement d'état d'accessibilité d'un port.

 «Port Link»
Un événement lié à un changement d'état de liaison d'un port.

 «Port In Load»
Un événement lié à un changement d'état de la charge de trafic 
entrant sur un port. 

 «Port Out Load»
Un événement lié à un changement d'état de la charge de trafic sortant 
sur un port.

 «Ring Coupling Status»
Un événement lié à un changement d'état du couplage en anneau 
redondant.

 «Ring Status»
Un événement lié à un changement d'état de la propriété «Ring Sta-
tus».

 «Rapid Spanning Tree»
Un événement lié à un changement d'état du Spanning Tree Rapid 
Protocol.

 «Spanning Tree Status»
Un événement lié à un changement d'état du Spanning Tree Protocol.

 «Multiple Spanning Tree Status»
Un événement lié à un changement d'état du Multiple Spanning Tree 
Protocol.

 «Interface Link»
Un événement lié à un changement d'état de liaison d'une interface.
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 «Interface In Load»
Un événement lié à un changement d'état de la charge de trafic 
entrant sur une interface.

 «Interface Out Load»
Un événement lié à un changement d'état de la charge de trafic sortant 
sur une interface.

Pour configurer la fonction d'acquittement automatique d'un événement, 
procédez comme suit :

 La fonction d'acquittement automatique est désactivée par défaut. 
Pour activer la fonction d'acquittement automatique, cochez la case 
«Event Auto-Acknowledge Global». 

 Sélectionnez le ou les événements pour lesquels il est nécessaire 
d'activer la fonction. Cochez la case appropriée dans la liste «Event 
Auto-Acknowledge».

 Pour régler l'intervalle de temps, saisissez la valeur requise dans le 
champ «Auto-acknowledge interval» et sélectionnez les unités de 
temps pour cette valeur dans le menu déroulant. Vous pouvez choisir 
entre secondes, minutes, heures ou jours.
Réglage par défaut : 3 minutes.
La plage de valeurs pour «Auto-acknowledge interval» peut être spé-
cifiée entre 1 seconde et 2 jours.

Lorsque vous configurez une alarme pour un événement «Status 
Worse», vous pouvez également choisir de ne pas afficher une alarme 
pour cet événement. Ceci est possible si l'événement a été acquitté au 
préalable. 

Vous pouvez créer une nouvelle alarme pour un événement «Status 
Worse» dans la boîte de dialogue Configuration > Preferences > 
Basics > Event Actions > Alarms > New > New Entry(voir la 
figure 82). Dans le cadre «Type», cochez la case «If event has not 
been acknowledged after» et sélectionnez un intervalle de temps qui 
dépasse l'intervalle de temps spécifié dans le champ «Auto-
acknowledge interval».

 Pour accepter les modifications, cliquez sur le bouton «Apply».

  Si vous voulez réinitialiser les valeurs aux paramètres par défaut, cli-
quez sur le bouton «Reset to Defaults».
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Figure 86 :Configuration > Preferences > Display > Event Auto-Acknowledge
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Preferences > Display > Device

 Device
Cette boîte de dialogue permet de déterminer l'affichage des équipe-
ments dans le réseau, les connexions entre les équipements et le libellé.

 «Symbol»
Cliquez sur le champ d'option blanc correspondant pour sélectionner 
l’icone que Industrial HiVision doit utiliser pour visualiser 
l'équipement :
– «Realistic»_ Représentation de l'équipement sous la forme d'une 

image de produit
– «Abstract» : représentation symbolique de la fonction de l'équipe-

ment
Préréglage : «Realistic»

 «Status Visualisation»
Vous déterminez ici le mode utilisé par Industrial HiVision pour illustrer 
le statut des équipements ou une modification de statut à l'écran.
Industrial HiVision offre les options d'affichage suivantes :
– «Flash after Status Change»
– «Acknowledged OK with Color»
– «Status Symbol in Icon»
– «Filled Background»
– «Frame»
– «Icon and Text Flash as well»
Préréglage : «Filled Background» et «Frame» activés.

 «Font»
Indiquez la taille des caractères (en pt) et la police de l'écriture des 
équipements et des connexions entre les équipements.
Réglage de base : taille des caractères = 13, police = Arial.

 «Device Appearance»
Fixez la taille et la largeur maximale (en pixels) des icônes, dont 
Industrial HiVision se sert pour visualiser les équipements se trouvant 
dans le réseau à l'écran. Réglage de base : taille des icônes = 48, lar-
geur max. = 150.
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 «Connection Appearance»
– Déterminez si Industrial HiVision doit libeller à l'écran les 

connexions établies entre les équipements intégrés dans le réseau 
et de quelle manière.
Servez-vous de la liste déroulante «Draw Label» pour définir 
quand Industrial HiVision doit afficher une connexion avec l'état de 
la connexion.
Options : «Always», «Never», «Under Mouse Pointer»
Préréglage : «Never»
La liste déroulante «Draw Terminal Labels» vous permet d'établir 
si Industrial HiVision affiche les terminaisons de la connexion.
Options : «Always», «Never», «Under Mouse Pointer»
Préréglage : «Always»

– Les réglages sous l'option «Line Thickness» vous offrent un meil-
leur aperçu de la vitesse et de l'état de la connexion dans l'affi-
chage de la topologie.
Si vous activez l'affichage de la «Speed», Industrial HiVision gros-
sit l'épaisseur du trait par pas de 2 points à mesure que la vitesse 
augmente et passe à 10, 100, 1 000 et 10 000 Mbit/s. Si vous acti-
vez l'affichage de la «Speed», Industrial HiVision affiche le réglage 
actuel de la connexion dans l'infobulle. 
Dans le cas d'une désactivation de l'affichage de la «Speed», 
Industrial HiVision affiche le réglage actuel de la vitesse, même si 
vous avez activé l'affichage «Speed» dans la boîte de dialogue 
avec les propriétés de la connexion (voir page 306 “Connection”).
Si vous activez l'affichage «Status», Industrial HiVision augmente 
l'épaisseur du trait par pas de 2 points à mesure que la pondération 
de l'état croît.
Préréglage : «Status»

– Avec «Minimum Line Thickness», vous déterminez la plus petite 
épaisseur de trait appliquée par Industrial HiVision lorsque l'épais-
seur de trait augmente en fonction de la vitesse.
Option : 1, 3, 5
Préréglage : 1

 «Preview»
Le cadre «Preview» visualise comment vos réglages influent sur la 
présentation.
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 Si vous cliquez sur «Reset to Defaults», vous annulez vos modifica-
tions et les paramètres de base s'appliquent.

Figure 87 :Configuration > Preferences > Display > Device

Affichage Signification
OK Acknowledged L'état n'a pas changé et il est correct.
OK Status Changed L'état a changé et il est correct.
Warning Acknowledged L'état n'a pas changé. Il y a un message d'avertissement.
Warning Status Changed L'état a changé. Il y a un message d'avertissement.
Error Acknowledged L'état n'a pas changé. Il y a une erreur.
Error Status Changed L'état a changé. Une erreur est survenue.

Tableau 43 : Aperçu de l'affichage des équipements et lignes de connexion
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Preferences > Display > Appearance

 Appearance
Cette boîte de dialogue vous permet de modifier l'affichage de texte et la 
sélection des onglets :
 «Toolbars»

Emplacement du texte dans la barre d'outils
Préréglage : «Text Alongside Symbol»

 «Font Size»
Préréglage : en fonction de la résolution de l'écran.

 «Security»
Représenter les mots de passe sous la forme d'étoiles (non lisibles) 
lors de l'ouverture de boîtes de dialogue, dans lesquelles vous pouvez 
saisir ou consulter les mots de passe.
Préréglage : «Hide Passwords»

 «Tab Presets»
Selon le contexte, Industrial HiVision met différents onglets à votre 
disposition :
– Sélectionnez «Saved settings» pour visualiser à l'ouverture de 

l'affichage le dernier onglet à y avoir été ouvert.
– Sélectionnez «Default settings», afin que Industrial HiVision choi-

sisse l'onglet présentant l'affichage de la liste au-dessous du 
niveau des équipements.

– Sélectionnez «Don't apply», pour qu'Industrial HiVision conserve 
l'affichage actuel (affichage liste ou topologie) en cas de bascule-
ment vers un autre équipement ou détail de composant.

Préréglage : «Saved settings»
 «Home View Settings»

Définit les préréglages de l'affichage applicable au bouton de com-
mande «Home View».

 Industrial HiVision vous offre la possibilité d'enregistrer les réglages 
suivants :
 Définissez un autre dossier dans l'arborescence du menu.
 Établissez une autre taille d'écran de visualisation.
 Définissez l'affichage maximisé ou normal au choix.

Les paramètres suivants sont définis en tant que préréglage dans 
Industrial HiVision :
  Réseau local VLAN «All»
 «Last 24 Hours Events»
  Présentation de la «Map»
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Figure 88 :Configuration > Preferences > Display > Appearance
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Preferences > Display > Status Colors

 Status Colors
Cette boîte de dialogue vous permet d'attribuer une couleur à chaque sta-
tut. Vous pouvez sélectionner les couleurs de premier plan et d'arrière-
plan.

 Si vous cliquez sur «Reset to Defaults», vous annulez vos modifica-
tions et les paramètres de base s'appliquent.

Figure 89 :Configuration > Preferences > Display > Status Colors

Status [Status] Premier plan Arrière-plan
OK noir vert
Warning noir jaune
Error blanc rouge
Not Available noir gris
No Status noir blanc

Tableau 44 : Paramètres de base des couleurs de statut
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Preferences > Display > Device Icon

 Device Icon
Cette boîte de dialogue vous permet d'assigner des icônes prédéfinies à 
différents types d'équipements.

 Pour définir une nouvelle affectation d’icônes par défaut, cliquez sur le 
bouton «New». Pour éditer une entrée, sélectionnez les lignes dans le 
tableau et cliquez sur le bouton «Edit».

Industrial HiVision vous propose les méthodes de différenciation sui-
vantes des types d'équipements :

 System Object Identifier («SysOID»)

 «EtherNet/IP»
Outre la saisie des paramètres dans la boîte de dialogue, Industrial 
HiVision vous offre la possibilité de charger des paramètres provenant 
d'un fichier EDS(Electronic Data Sheet).

 «Modbus/TCP»

Type SysOID
SysOID ID fabricant
Icon Cliquez sur « ? » pour rechercher dans votre système de fichiers un fichier 

image pour l'icône.

Type EtherNet/IP
Vendor Code Identification du fabricant dans la description d'équipement selon EtherNet/IP.
Product Type Type de produit dans la description d'équipement selon EtherNet/IP. « * » dans 

ce champ signifie « All products » [Tous les produits].
Product Code Identification du produit dans la description d'équipement selon EtherNet/IP. 

« * » dans ce champ signifie « Tous les produits ».
Icon Cliquez sur « ? » pour rechercher dans votre système de fichiers un fichier 

image pour l'icône.

Type Modbus/TCP
Vendor Name Identification du fabricant dans la description d'équipement selon Mod-

bus/TCP.
Product Code Identification du produit dans la description d'équipement selon Modbus/TCP. 

« * » dans ce champ signifie « Tous les produits ».
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 «MAC Address»

Dans le tableau, vous pouvez :
– ajouter de nouvelles entrées
– éditer des entrées existantes
– supprimer des entrées existantes
– dupliquer des entrées existantes
– Insérer de nouvelles entrées EtherNet/IP via le bouton «EDS File». 

Industrial HiVision charge les fichiers EDS sélectionnés et les fichiers 
d'icône correspondants.
Industrial HiVision trouve également des icônes dans les sous-fichiers 
spécifiques aux fabricants.

Les fichiers EDS se trouvent sur le CD de l’équipement. Vous pouvez 
également télécharger les fichiers EDS depuis le site internet du fabri-
cant. Les fichiers EDS contiennent le «Vendor Code», le «Product 
Type», le «Product Code» et le nom de l’icône. Industrial HiVision 
essaie d’ouvrir l’icône avec le nom saisi.

Si Industrial HiVision n’ouvre pas l’icône pour le nouvel équipement, 
procédez comme suit :
 Ouvrez le fichier EDS de l’équipement sur un éditeur de texte, par 

ex. Notepad++.
 Vérifiez que le symbole est sous le chemin d’accès concerné, par 

ex. « icône = « Icon/xxxx.ico"; ».
 Enregistrez et fermez le fichier EDS.
 Cliquez sur le bouton «EDS File».
 Sélectionnez le fichier EDS pour l'équipement.
 Cliquez sur le bouton «OK».

Icon Cliquez sur « ? » pour rechercher dans votre système de fichiers un fichier 
image pour l'icône.

Type MAC Address
MAC Address La partie des adresses MAC des équipements à laquelle vous souhaitez assi-

gner une icône d'équipement en utilisant les adresses MAC. Exemple : les pre-
miers 24 bits de l’adresse MAC des adresses Hirschmann s’appellent 
00:80:63.

Number of Bits Le nombre de bits des adresses MAC que vous souhaitez utiliser pour l'affec-
tation d'icônes. Les premiers 24 bits d'une adresse MAC indique le fabricant de 
l'équipement.

Icon Cliquez sur « ? » pour rechercher dans votre système de fichiers un fichier 
image pour l'icône.
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Lors de la reconnaissance d'équipement et pour des équipements sélec-
tionnés avec Edit > Set Default Device Icon, Industrial HiVision vérifie 
le type d'équipement. Industrial HiVision attribue à l'équipement l'icône 
qu'Industrial HiVision trouve en premier dans le tableau.
Pour modifier l’ordre des entrées dans le tableau, sélectionnez les bou-
tons «Up» et «Down».
Les icônes déjà définies dans Industrial HiVision pour les équipements 
Hirschmann sont masquées dans la partie supérieure du tableau. De 
cette manière, Industrial HiVision assigne l'icône appropriée aux équipe-
ments Hirschmann.

Figure 90 :Tableau d'assignation des icônes d'équipements
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Preferences > Avancé

8.4.8 Avancé
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Preferences > Avancé > Avancé

 Avancé

«Expire Time for Edit Mode»
La durée de déroulement vous permet de définir combien de temps 
Industrial HiVision doit rester en mode édition après avoir effectué une 
saisie. Une fois cette durée écoulée, Industrial HiVision passe en « mode 
Exécution ». 
Réglages possibles : entre 5 et 60 minutes ou «Permanent».

«Web Access»
«Generate an Event for every Successful Web Access» vous offre la pos-
sibilité de générer un évènement pour les tentatives non autorisées 
d'accès au Web ainsi que pour les accès réussis.

«Allow Renaming» offre la possibilité de renommer une propriété des 
détails des composants. Vous pouvez par exemple modifier la propriété 
«In Load» d’une connexion en « Volume de données entrantes ».

Via «Auto Reload», vous définissez que Industrial HiVision effectue les 
tâches suivantes :
– interroger les valeurs actuelles d'une boîte de dialogue de propriétés 

à l'ouverture de celle-ci.
– d'interroger les valeurs actuelle du contenu d'un cadre de détails à 

l'ouverture de celui-ci.
La fonction «if Value Older than» vous permet d'afficher les valeurs auto-
matiques issues d'une interrogation automatique en fonction de leur 
ancienneté.

«Include device passwords in documentation»
«Device Documentation» vous permet de créer une documentation 
d'équipement avec des mot de passe lisibles ou masqués.
Par défaut : mot de passe masqué.

SNMP V1 ******,****** public, private
SNMP V3 admin, MD5: ******, 

DES: ******
admin, MD5: private, 
DES: private

Tableau 45 : Exemple de documentation d'équipements avec des mots de passe 
lisibles et masqués
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Commentaire : Si vous avez oublié votre mot de passe, quittez Industrial 
HiVision. Connectez-vous sous Windows en tant qu'« administrator » ou 
sous Linus en tant que « root » et redémarrez Industrial HiVision. Un 
redémarrage de Industrial HiVision en tant qu'« administrator » ou 
« root » permet une nouvelle saisie sans que le mot de passe ne soit 
requis au préalable.

Figure 91 :Configuration > Preferences > Advanced > Program Access
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Preferences > Avancé > Accès Services

 Accès Services
La boîte de dialogue «Services Access» vous permet d'activer et de 
désactiver diverses méthodes d'accès à la gestion du réseau à partir d'un 
autre ordinateur. Lorsqu’un pare-feu sépare vos services Industrial 
HiVision d'un client, ajoutez une règle au pare-feu pour transférer les don-
nées entre les services et le client. Voir “Utilisation Industrial HiVision 
avec pare-feu” on page 72.
 «Web Server»

Ce service vous permet d'accéder à votre station d'administration de 
réseau au moyen d'un autre ordinateur et via un navigateur Web. 
L'adresse du serveur Web est :
Protocole : //adresse IP de la station d'administration réseau : numéro 
de port, par exemple
http://10.0.1.159:11187
Si vous configurez une connexion sécurisée utilisant HTTPS, 
Industrial HiVision utilise un certificat Hirschmann qui détermine la non 
validité de votre navigateur. Si vous souhaitez utiliser ce service, 
approuvez cette connexion, et ajoutez une exception à votre naviga-
teur. Sauvegardez l’exception.
Si vous souhaitez spécifier une valeur différente que Industrial 
HiVision utilise pour se connecter à «Web Server», décochez la case 
«Use Default Values». Saisissez la valeur souhaitée dans le champ 
«Port». Si vous cochez la case «Use Default Values», la valeur du 
champ «Port» est réinitialisée à la valeur par défaut, 11187.

 «Project Data Server»
Avec «Remote Access», vous autorisez les interfaces Industrial 
HiVision fonctionnant sur d'autres ordinateurs à avoir accès au service 
local Industrial HiVision.
Pour spécifier une valeur différente que Industrial HiVision utilise pour 
se connecter à «Project Data Server», décochez la case «Use Default 
Values». Saisissez la valeur requise dans le champ «Port». Si vous 
cochez la case «Use Default Values», Industrial HiVision réinitialise la 
valeur du champ «Port» à la valeur par défaut, 11188.
Si vous autorisez «Services Access», l'interface locale est reliée, à 
l'instar de l'interface de l'ordinateur externe, via la connexion réseau 
au lieu de l'adresse IP interne 127.0.0.1. En conséquence, l'interface 
interne perd également la connexion au service lorsque la connexion 
réseau est interrompue.
Le champ «Port»affiche le port sur lequel les interfaces Industrial 
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HiVision, fonctionnant sur d'autres ordinateurs, peuvent accéder au 
service local Industrial HiVision.
«Subdomain interface»
Si vous activez la fonction «Subdomain interface», vous laissez une 
autre station d'administration réseau accéder au service local 
Industrial HiVision comme super-domaine.
«Password»
Si vous utilisez cette station d'administration comme sous-domaine, la 
boîte de dialogue vous permet de saisir le mot de passe pour accéder 
à l'interface des sous-domaines. Voir “Liaison de sous-domaines à 
des super-domaines” on page 66.
«Superdomain»
Lorsqu'une connexion sécurisée est établie, Industrial HiVision vous 
permet de sélectionner le processus que le super-domaine utilise pour 
traiter les certificats fournis par le sous-domaine :
 «Accept any subdomain cartificate»

Cette méthode permet au super-domaine d'accepter le certificat 
fourni par le sous-domaine sans vérification. Le certificat ne sera 
pas ajouté au truststore et un événement est créé avec l'empreinte 
digitale du sous-domaine dans le message.
Réglage par défaut : Activé.

 «Accept any subdomain certificate and store as trusted»
Cette méthode permet au super-domaine d'accepter le certificat 
fourni par le sous-domaine sans vérification. Le certificat sera 
ajouté au truststore et sera utilisé pour de futures connexions. Un 
événement est créé qui enregistre le fait que l'empreinte digitale du 
sous-domaine est ajoutée au truststore.

 «Verify subdomain certificate against trusted certificates»
Cette méthode est utilisée pour vérifier que le certificat fourni par le 
sous-domaine a été ajouté au truststore.
Si le certificat n'est pas dans le truststore, la connexion est rejetée. 
Un événement d'erreur est créé avec l'empreinte digitale du sous-
domaine dans le message.

 «OPC Server»
Le «OPC Server» vous permet d'activer le serveur OPC Industrial 
HiVision(voir page 244 “Structure des données de transfert pour 
OPC”).
Avec «Global Write», vous autorisez l'écriture des valeurs d'objets 
dans Industrial HiVision en utilisant une commande d'écriture OPC 
(voir page 241 “Connexion au système de visualisation de proces-
sus”).
Pour sécuriser la communication entre le serveur OPC UA et Industrial 
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HiVision, utilisez un certificat CA (voir page 250 “Serveur OPC UA – 
certificats personnalisés”).
Lorsque vous utilisez HTTP pour vous connecter au serveur OPC UA 
Industrial HiVision, configurez le client OPC UA pour accéder au ser-
veur sur le port affiché dans le champ «OPC UA Server Port (http)». 
Lorsque vous utilisez HTTPS pour vous connecter au serveur OPC 
UA Industrial HiVision, configurez le client OPC UA pour accéder au 
serveur sur le port affiché dans le champ «OPC UA Server Port 
(https)».
Pour spécifier une valeur différente que le client OPC utilise pour se 
connecter à «OPC Server», décochez la case «Use Default Values». 
Saisissez la valeur requise du protocole HTTP que vous souhaitez uti-
liser dans le champ «OPC UA Server Port (http)». Si vous cochez la 
case «Use Default Values», Industrial HiVision réinitialise la valeur 
des champs «OPC UA Server Port (http)» aux valeurs par défaut, 
11189 ou 11190.

Commentaire : Lorsque vous désactivez la fonction «OPC Server», 
redémarrez le noyau Industrial HiVision.

Figure 92 :Configuration > Préférences > Avancé > Accès Services
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Preferences > Avancé > Avancé

 Avancé
Industrial HiVision vous facilite la communication avec les équipements 
SNMP grâce à l’utilisation automatisée de mot de passe.

«Device Credentials»
En établissant la communication avec un équipement SNMP,Industrial 
HiVision tente d'accéder avec des noms d'utilisateur et des mots de 
passe connus.
En cas de saisie d’un mot de passe erroné, Industrial HiVision reçoit une 
alarme d'authentification de l'équipement concerné.
S'il essaie avec un mot de passe correct, Industrial HiVision reçoit une 
réponse suite à une requête SNMP, puis introduit le nom d'utilisateur et 
le mot de passe adéquats dans le tableau supérieur de la boîte de dia-
logue.

«SNMP Guess List»
Lors de la configuration de communication d'un équipement SNMP 
inconnu, Industrial HiVision tente une authentification à partir des don-
nées de connexion de «SNMP Guess List».
Vous créez une nouvelle entrée dans le tableau via le bouton «New».
Industrial HiVision met à disposition les options suivantes pour les 
entrées du tableau :
– Modifier l’entrée via le bouton «Edit»
– Supprimer l’entrée via le bouton «Delete»
– Dupliquer l’entrée via le bouton «Duplicate»

«Hide Passwords»
Industrial HiVision vous permet de remplacer les mots de passe par des 
étoiles. 
En ouvrant cette boîte de dialogue, les options de ce champ dépendent 
des options définies dans la boîte de dialogue Display > Appearance.
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Figure 93 :Configuration > Preferences > Advanced > Device Credentials

Outre l'utilisation automatique de mots de passe,Industrial HiVision vous 
permet de saisir manuellement et individuellement la configuration SNMP 
d'équipements SNMP.
 Pour ouvrir la boîte de dialogue «New Entry» permettant la configura-

tion SNMP, cliquez sur le bouton «New» dans le cadre «Device Cre-
dentials».

 Entrez l'adresse IP de l'équipement dont vous souhaitez configurer 
l'accès SNMP.

 Sélectionnez la version SNMP prise en charge par l'équipement.
 Selon la version SNMP sélectionnée, entrez les informations d'accès 

nécessaires :

Version SNMP Désignation Signification
V1 Read Password Mot de passe qui vous octroie un droit de lecture sur 

l'équipement.
V1 Write Password Mot de passe qui vous octroie un droit d'écriture/ de lec-

ture sur l'équipement.
V3 (easy) Username Nom d'utilisateur qui vous permet d'accéder à l'équipe-

ment.

Tableau 46 : Entrées de configuration SNMP
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Sous «Advanced», vous trouverez d'autres paramètres spécifiques 
SNMP. Les options par défaut répondent à de nombreuses exigences.
 Avec «Timeout [s]», vous déterminez la durée d'attente d'Industrial 

HiVision pour obtenir une réponse à une requête SNMP. Si aucune 
réponse n'est donnée, Industrial HiVision relance la requête SNMP.

 Vous utilisez «Retries» pour déterminer la fréquence des nouvelles 
tentatives de requête SNMP lancées par Industrial HiVision en cas 
d'absence de réponse.
À chaque nouvelle tentative, Industrial HiVision double le temps 
d'attente avant de relancer une requête.

 Avec «Port No», vous sélectionnez le port de protocole de l'équipe-
ment auquel Industrial HiVision adresse une requête SNMP.

 «Hide Passwords» vous permet de remplacer les mots de passe de 
cette entrée de tableau par des étoiles. 

V3 (easy) Password Mot de passe associé au nom d'utilisateur.
V3 (complete) Username Nom d'utilisateur qui vous permet d'accéder à l'équipe-

ment.
V3 (complete) Authentication Méthodes SHA, MD5 pour l’authentification du message
V3 (complete) Password Mot de passe pour authentification
V3 (complete) Encryption DES, AES128, algorithme de cryptage symétrique
V3 (complete) Password Mot de passe pour cryptage

Version SNMP Désignation Signification

Tableau 46 : Entrées de configuration SNMP
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Figure 94 :Configuration > Preferences > Advanced > Device Credentials > 
New
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Preferences > Avancé > Management Station

 Management Station
Cette boîte de dialogue permet de saisir le préréglage des paramètres IP. 
Industrial HiVision saisit ces préréglages lorsque vous ouvrez la boîte de 
dialogue dans laquelle les saisies de paramètres IP sont attendues, par 
ex. la configuration d’équipements qui a reconnu Industrial HiVision grâce 
à HiDiscovery.

«IP Address Prefix»:
Industrial HiVision vous propose ici le préfixe de sa propre adresse IP.

«Default Netmask»:
Industrial HiVision vous propose ici le masque de réseau de sa propre 
adresse IP.

«Default Gateway»:
Industrial HiVision vous propose ici le préfixe de la passerelle également 
utilisé par votre station d'administration de réseau.

«IP Address Management Station»:
Si votre station d'administration réseau dispose de plusieurs adresses IP, 
Industrial HiVision saisit les adresses IP dans une liste déroulante.
 Sélectionnez l'adresse que vous souhaitez utiliser comme adresse de 

destination d'alarme.

«Network Card Management Station»:
Si votre station d'administration réseau dispose de plusieurs cartes 
d’interface réseau, Industrial HiVision prépare ces cartes dans une liste 
déroulante.
 Sélectionnez la carte à laquelle le protocole HiDiscovery doit accéder.

«Management Station Appearance»:
Si la fonction est active et Industrial HiVision un périphérique exécutant le 
noyau, Industrial HiVision l'icône du périphérique.
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Figure 95 :Configuration > Preferences > Advanced > Management Station
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Preferences > Avancé > OPC-SNMP

 OPC-SNMP
Le serveur OPC d'Industrial HiVision vous permet d'utiliser une requête 
client OPC pour déterminer les valeurs SNMP des équipements.
Dans la boîte de dialogue Advanced > OPC-SNMP, saisissez les attributs 
SNMP dont vous souhaitez déterminer les valeurs. Dans le tableau vous 
pouvez 
– ajouter de nouvelles entrées
– éditer des entrées existantes
– supprimer des entrées existantes
– dupliquer des entrées existantes

Dans les boîtes de dialogue «Edit» et «New», vous pouvez saisir directe-
ment les attributs SNMP ou les sélectionner à partir d'une MIB.
Pour sélectionner un attribut SNMP depuis un MIB; cliquez sur le bouton 
«Select MIB Attribute...». Sélectionnez un attribut SNMP depuis la boîte 
de dialogue «MIB Viewer». Pour charger des MIB supplémentaires, cli-
quez sur le bouton «MIB Manager».
Attribuez un nom court et compréhensible à l'entrée, car il sera utilisé ulté-
rieurement lors d'une requête dans un tag OPC.
Si vous utilisez un « Object Identifier (OID) » dans le tag OPC, vous sai-
sissez l'OID complet, y compris une éventuelle instance existante.

L'étiquette OPC pour une requête client OPC est par exemple :
Industrial_HiVision.snmp.get.10:0:1:159,161,ifAdminState

Pour ce faire :
 10:0:1:159 est l’adresse IP de l’équipement avec pour séparateur le 

double point à la place du point
 161 est le port SNMP
 ifAdminState est le nom de l’attribut SNMP comme il est configuré 

dans les réglages
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Figure 96 :Configuration > Preferences > Advanced > OPC-SNMP
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Preferences > Avancé > Paramètres Service

 Paramètres Service
Le programme Industrial HiVision démarre son propre service. Votre sys-
tème d'exploitation PC affiche le service Industrial HiVision. 
Le service Industrial HiVision se compose des services suivants :
 «Device Discovery»

• «Scan Rate [devices/min]»
Ce service effectue l'analyse du réseau (voir page 341 “Basics”). 
Le taux d'analyse limite le nombre de Pings par minute. 
Préréglage : 600

• «Simultaneously Discovered Devices»
Ce réglage vous permet de modifier la charge de réseau pendant 
la reconnaissance d'équipements. Entrez ici le nombre d'équipe-
ments interrogés simultanément par Industrial HiVision pendant la 
reconnaissance d'équipements.
Préréglage : 20

• «SNMP Guessing Packet Rate [pkts/s]»
Ce paramètre vous permet de définir combien de paquets de pré-
visions par seconde Industrial HiVision envoie à un équipement 
SNMP pour connaître les données de connexion.
Préréglage : 100

 «Web Server»
• «Web Server Root Directory»

Le réglage indique le répertoire de base du serveur web Industrial 
HiVision.

• «Web Server Session Timeout [min]»
Ce réglage vous permet de définir la durée maximale sans fonc-
tionnement des réunions serveur web.
Préréglage : 20
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 «Device Availability»
Ces options vous permettent d'adapter Industrial HiVision au compor-
tement de vos équipements en matière de temps de réponse Ping.
– «Ping Timeout [s]»

Lorsque l'équipement ICMP répond pendant ce délai à une requête 
Ping, Industrial HiVision continue de reconnaître la présence de 
l'équipement s'il a répondu à la dernière requête.

– «Max. Ping Response Time [ms]»
Lorsque l'équipement ICMP répond pendant ce délai à une requête 
Ping, Industrial HiVision reconnaît que l’équipement est à nouveau 
disponible s'il a répondu à la dernière requête.

Des valeurs basses améliorent la performance de Industrial HiVision. 
Dans le cas de valeurs trop faibles, il se peut que la réponse Ping 
arrive trop tard et qu'Industrial HiVision ffiche l'équipement comme 
étant « unreachable » [inaccessible]. En cas de grands sous-réseaux 
qui présentent des interruptions temporaires, utilisez des valeurs infé-
rieures.
Des valeurs supérieures peuvent être la cause d'un affichage tem-
porisé de modifications de statut dans Industrial HiVision.
«Simultaneously Discovered Devices» :cette option vous permet de 
modifier la charge de réseau pendant la reconnaissance d'équipe-
ments. Entrez ici le nombre d'équipements interrogés simultanément 
par Industrial HiVision pendant la reconnaissance d'équipements.
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 «Reporting»
– «Reliability Polling Intervals»

L'enregistrement de la valeur interrogée est largement antérieur au 
nombre maximal d'intervalles de scrutation x intervalle de scruta-
tion [s] de l'interrogation de propriété (voir page 297 “Propriétés 
d'un détail de composant”).

– «Replication Lock for Reporting Events [s]»:
Le verrouillage de répétition contribue à réduire l'enregistrement 
d'évènements récurrents dans la liste d'évènements.
Préréglage : 3600
Industrial HiVision enregistre la notification d'évènements de type 
«Warning» ou «Error» si leur dernier enregistrement remonte à 
une période antérieure à la durée du verrouillage de répétition.
Industrial HiVision prend en compte une modification après le redé-
marrage du logiciel.

 «Statistics»
– «ICMP Statistics - Moving Average Number of Samples»

La saisie définit la valeur moyenne glissante calculée sur la base 
d’une partie des temps de réponse.
Préréglage : 5
La valeur moyenne glissante est comprise en tant que type de pro-
priété dans les propriétés de protocole de chaque équipement et 
peut être inclue dans l’outil de rapport.

– «SNMP Statistics - Moving Average Number of Samples»
La saisie définit la valeur moyenne glissante calculée sur la base 
d’une partie des temps de réponse.
Préréglage : 10
La valeur moyenne glissante est comprise en tant que type de pro-
priété dans les propriétés de protocole de chaque équipement et 
peut être inclue dans l’outil de rapport.
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Figure 97 :Configuration > Preferences > Advanced > Service Parameters
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Preferences > Avancé > Paramètres Service

 Paramètres Service
Industrial HiVision utilise des applications auxiliaires externes pour les 
fonctions suivantes :

 «Telnet»
 «SSH»
 «Browser»

Sur les systèmes Linux, Industrial HiVision utilise Mozilla Firefox 
comme navigateur par défaut. Si vous souhaitez utiliser un autre navi-
gateur, indiquez le chemin d'accès à votre navigateur dans la ligne 
«Browser».

 «Ping»
 «PDF Viewer»
 «SMS»
 «HiProvision»

Si vous avez installé le programme HiProvision dans le répertoire 
d'installation Industrial HiVision, vous pouvez cocher la case «Use 
Default HiProvision».
Si vous avez installé le programme HiProvision dans un autre empla-
cement, saisissez l'emplacement dans le champ de texte «HiProvi-
sion».
Pour plus d'informations sur le programme «HiProvision», voir “HiPro-
vision” on page 138

 «Mail Server»
Pour effectuer la configuration de la messagerie

 «Geographical Location View»
Saisie de l'URL permettant d'appeler le programme d'affichage de 
l'emplacement géographique, par exemple, maps.google.
http://maps.google.de/maps?q=$LATITUDE,$LONGITUDE($NAME)&z=19
Voir “Position géographique” on page 320.
406
User Manual Industrial HiVision

Release 8.1 12/19



Références
User Manual Industrial HiVision
Release 8.1 12/19 407



Références
Preferences > Avancé > Device/Port Names

 Device/Port Names
Cette boîte de dialogue vous permet de modifier le nom des équipements 
et des ports dans la boîte de dialogue respective des propriétés et par 
conséquent, dans l'affichage de l'interface utilisateur.
Déterminez tout d'abord si Industrial HiVision doit afficher les équipe-
ments et ports avec leurs noms préenregistrés ou si Industrial HiVision 
détermine les noms des équipements.

Lors de l’ajout de nouveaux équipements à Industrial HiVision, le cadre 
«Device/Port Names» vous permet de sélectionner la méthode avec 
laquelle Industrial HiVision affiche les noms d’équipements.
 La fonction «Basics» : «Use default names or entered names» permet 

à Industrial HiVision d’afficher de nouveaux équipements avec 
l’adresse IP.

 La fonction «Basics» : «Set names from device in Industrial HiVision» 
permet à Industrial HiVision d’afficher les noms des nouveaux équipe-
ments.

Commentaire :  Le bouton «Reset to Defaults» ne réinitialise que la boîte 
de dialogue «Device/Port Names» sur les préréglages.

Pour modifier la manière dont Industrial HiVision affiche les noms d’équi-
pements, procédez comme suit :
 Supprimez l’équipement de Industrial HiVision.
 Ouvrez la boîte de dialogue «Device/Port Names»pour les résultats 

souhaités.
 Scannez à nouveau le réseau de l’équipement.

Détermination des noms d'équipements

Request DNS Lorsqu'il reconnaît un nouvel équipement, Industrial 
HiVision détermine le nom d'équipement à partir de 
« Domain Name Server ».

Request Now Industrial HiVision détermine pour les équipements déjà 
reconnus le nom d'équipement à partir du « Domain 
Name Server ». Cette opération peut prendre un certain 
temps.
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Industrial HiVision écrit les noms d'hôte et les noms DNS dans le tableau 
d'affectation des adresses MAC/IP (voir page 425 “Liste MAC/IP”).

«Set Device Name»
Ce cadre permet de sélectionner le nom d'équipement que Industrial 
HiVision reporte dans le champ de nom de la propriété d'équipement. 
Industrial HiVision affiche ce nom dans le cadre Folders [Répertoires] et 
dans l'affichage détaillé.
Les réglages suivants sont possibles :
– «DNS Name»
– «Host Name»
– «System Name»
– «Location»
– «Contact»

En les sélectionnant et en cliquant sur les touches directionnelles, vous 
déplacez les noms potentiels entre les tableaux «Possible Parameters» 
et «Used Parameters». Industrial HiVision charge le nom qui se trouve au 
plus haut dans le tableau «Used Parameters». Si le paramètre utilisé est 
vide pour un équipement, Industrial HiVision prend le prochain nom de la 
liste. Si Industrial HiVision ne trouve aucune entrée pour un équipement, 
Industrial HiVision charge alors l'adresse IP d'administration de l'équipe-
ment.

«Port Name»
La fonction «Set Port Name» vous permet de charger les noms de port 
saisis dans l'équipement dans le champ de nom des propriétés de port si 
le nom de port de l'équipement y est enregistré. Industrial HiVision affiche 
ces noms dans le cadre Folders [Répertoires] et dans l'affichage détaillé. 
En l'absence de ce paramétrage,Industrial HiVision affiche l'adresse IP 
des équipements et le numéro des ports.

Use Name of Hosts File Industrial HiVision détermine pour les équipements déjà 
reconnus le nom d'équipement à partir du fichier hôte. Le 
fichier hôte est le fichier texte hosts.txt dans le sous-
répertoire config du répertoire d'installation. 
Le fichier hôte comprend pour chaque équipement une 
ligne avec l'adresse IP et le nom, séparé par un caractère 
de tabulation.

Read Now Industrial HiVision détermine pour les équipements déjà 
reconnus le nom d'équipement à partir du fichier hôte.
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Commentaire : Industrial HiVision charge la sélection de noms lorsqu'il 
reconnaît un port ou un équipement. Une modification postérieure est 
effective après le rechargement du nom de l'équipement ou du port. Pour 
ce faire, sélectionnez les équipements concernés et avec le bouton droit 
de la souris «Set Device and Port Names».

Figure 98 :Définition des noms d'équipements et de ports
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Preferences > Avancé > Load/Save

 Load/Save
Cette boîte de dialogue vous permet de saisir les réglages suivants :
– Adresse IP d’un serveur tftp disponible dans le réseau
– Nom de fichier avec indication du chemin d’accès
– URL. 
Industrial HiVision charge automatiquement dans les boîtes de dialogue 
dans lesquelles vous effectuez des opérations de transfert de fichiers, par 
ex. le chargement/l’enregistrement de configurations dans la boîte de dia-
logue MultiConfig™.
Vous évitez ainsi de multiples saisies de l'URL et du nom de fichier 
lorsque vous appelez la boîte de dialogue MultiConfig™.

Chaîne de substitution Signification
$INSTALL Dossier d’installation de Industrial HiVision sur la station d’admi-

nistration réseau.
$TFTP_SERVER Adresse IP du serveur TFTP que vous avez enregistrée dans la 

boîte de dialogue Configuration > Preferences > Advanced > 
Load/Save.

$IP_ADDRESS Adresse IP de l'équipement dont Industrial HiVision lit la confi-
guration ou sur laquelle Industrial HiVision écrit la configuration. 
Industrial HiVision applique les adresses IP provenant du 
tableau du cadre Objets.

$SYSTEM_NAME Nom système de l’équipement dont Industrial HiVision lit la 
configuration ou sur lequel Industrial HiVision écrit la configura-
tion. 

$CURRENT_DATE Date actuelle de la station d'administration de réseau.
$CURRENT_TIME Heure actuelle de la station d'administration de réseau.
$EXTENSION Extension du nom de fichier :

cfg pour fichier binaire
cli pour fichier script
html pour fichier HTML

Tableau 47 : Chaînes de substitution prises en charge 
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Figure 99 :Configuration > Preferences > Advanced > Load/Save
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Preferences > Avancé > 1:1 NAT Devices

 1:1 NAT Devices
Cette boîte de dialogue vous permet d’administrer et de surveiller des 
équipements Industrial HiVision derrière un routeur NAT 1:1.
Afin que Industrial HiVision soit en mesure de reconnaître les équipe-
ments derrière les routeurs 1:1 NAT, saisissez les adresses MAC du port 
(du router 1:1 NAT) avec lequel la station d’administration réseau est 
connectée.
Vous trouverez l'adresse MAC du port dans la boîte de dialogue des pro-
priétés du routeur NAT 1:1 sous l'onglet «MAC/IP Addresses».

Figure 100 :Configuration > Preferences > Advanced > 1:1 NAT Devices
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Preferences > Avancé > Mobile Devices

 Mobile Devices
Dès que vous envoyez pour la première fois une requête HiMobile à 
Industrial HiVision, Industrial HiVision enregistre votre équipement 
mobile.
Dans la colonne «Push Notification», vous activez/désactivez l'envoi de 
notifications push à l'équipement enregistré.
Préréglage : actif.
Pour supprimer un équipement enregistré, sélectionnez la ligne dans le 
tableau et cliquez sur le bouton «Delete».
Industrial HiVision envoie des notifications push aux appareils ayant une 
entrée active dans ce tableau. Pour envoyer des notifications push, 
Industrial HiVision requiert un accès Internet.
Si, après un redémarrage ou une mise à jour de Industrial HiVision, vous 
ne trouvez plus l'entrée de votre équipement mobile sur la liste, quittez 
HiMobile sur votre équipement mobile. Pour enregistrer l'équipement 
mobile dans Industrial HiVision, démarrez HiMobile.
Vous pouvez définir dans les actions d'événements quand Industrial 
HiVision doit envoyer des notifications push.
(voir page 354 “Event Actions”)
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Preferences > Avancé > PoE

 PoE
 «Automate Power Limit»

Les fonctions «Automate Power Limit» et «Power Limit» permettent à 
l’équipement d’envoyer des alarme et à l’application d’envoyer des 
avertissements concernant la consommation de courant au niveau du 
port. 
Pour régler la fonction «Automate Power Limit», configurez le taux de 
majoration qui s’applique sur la valeur «Power Limit» affichée dans la 
vue «Module / Port» de l’onglet «PoE».
Le taux de majoration est un réglage configurable utilisé dans la for-
mule «Power Limit» = «Max Cons» + taux de majoration. Pour calculer 
le taux de majoration, utilisez la formule : taux de majoration = «Max 
Cons» x «Automate Power Limit». La valeur par défaut de «Automate 
Power Limit» est 10. Vous configurez le taux de majoration dans la 
boîte de dialogue Preferences > Advanced > PoE > Automate Power 
Limit.

Pour configurer le taux de majoration pour les ports Power-over-Ethernet 
(PoE), procédez comme suit :
 Cliquez sur le bouton «Preferences».
 Ouvrez la boîte de dialogue Advanced > PoE.
 Définissez le taux de majoration PoE sous «Automate Power Limit».
 Cliquez sur le bouton «OK».

Vous trouverez de plus amples informations sur la définition de la valeur 
«Power Limit» sous “Power Limit” on page 423.
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Références 8.4 Configuration
Figure 101 :Preferences > Avancé > PoE
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Configuration > Status Configuration

8.5 Status Configuration

Cette boîte de dialogue vous permet de configurer l'état d’une propriété des 
composants pour tous les équipements d’une classe d’équipement ou pour 
chaque équipement en même temps.

La boîte de dialogue affiche un tableau des catégories d'équipement avec 
leurs propriétés potentielles.

 Pour afficher les propriétés de chaque classe d’équipements, sélection-
nez la case «Combine Entries». Pour afficher les propriétés selon la 
classe d’équipements, sélectionnez la case «Combine Entries».

 Pour définir les valeur des propriétés, effectuez un double-clic sur une 
ligne du tableau.

Industrial HiVision ouvre la boîte de dialogue «Status Configuration».

 Assignez les valeurs à l'état souhaité et cliquez sur le bouton «OK».

 Pour modifier les propriétés des équipements que vous avez configurés 
individuellement au préalable, sélectionnez la case «Overwrite all Proper-
ties».

Industrial HiVision charge la «Status Configuration» des équipements de 
cette catégorie.

Cette fonction est très utile lorsque vous devez disposer d'une disponibilité 
maximale dans un anneau HIPER. Dans ce cas, le préréglage «Warning» 
est trop faible pour une perte de redondance. Dans la boîte de dialogue de 
«Status Configuration», une seule opération est nécessaire pour convertir le 
statut des équipements d'une catégorie de « No redundancy » [sans redon-
dance] à «Error».
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Références 8.5 Status Configuration
Figure 102 :«Status Configuration» * Double-cliquez dans une ligne
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Configuration > Scan Ranges

8.6 Scan Ranges

Cette boîte de dialogue vous permet de saisir la plage de scan d'un réper-
toire sélectionné.

 À partir d'un répertoire sélectionné dans le cadre Folders [Répertoires] ou 
d'un affichage détaillé actif, sélectionnez Configuration > Scan Ranges 
ou avec le bouton droit de la souris Scan Ranges dans le menu de sélec-
tion.

 Cliquez sur le bouton «New» pour saisir une plage d'adresses IP. La sai-
sie de la plage d'adresses IP comprend :
– la première adresse IP de la plage de requête
– la dernière adresse IP de la plage de requête
– le masque de réseau correspondant
– l'activation/la désactivation de cette plage pour la requête
– un nom de votre choix à attribuer à la plage

Industrial HiVision a déjà chargé le dossier sélectionné ou l'affichage détaillé 
actif comme dossier cible.

Le tableau affiche les adresses IP déjà créées.

 Pour éditer une plage d’adresses IP, sélectionnez une ligne dans le 
tableau et cliquez sur le bouton «Edit».

 Pour supprimer un équipement enregistré, sélectionnez la ligne dans le 
tableau et cliquez sur le bouton «Delete».

 Pour dupliquer une plage d’adresses IP, afin de modifier la copie par la 
suite, sélectionnez une ligne dans le tableau et cliquez sur le bouton 
«Duplicate».
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Références 8.6 Scan Ranges
Figure 103 :Plages d'analyse pour un dossier

Commentaire : Veillez à l’exactitude des masques de réseau dans cette 
boîte de dialogue avec les masques de réseau à l’intérieur de votre réseau, 
afin que la reconnaissance s’effectue correctement.
Si le masque de réseau à l’intérieur de votre réseau est plus grand que le 
masque de réseau d’une plage de scan, Industrial HiVision ignore l’adresse 
IP la plus élevée dans le masque de réseau de la plage de scan lors de l’ana-
lyse réseau, car l’adresse IP est une adresse de diffusion.
Si, dans votre réseau, le masque de réseau est plus petit que le masque de 
réseau d'une plage d'analyse, Industrial HiVision scanne, lors de l'analyse du 
réseau, l'adresse IP la plus élevée dans le masque de réseau de la plage de 
scan. Étant donné que cette adresse IP est une adresse de diffusion, chaque 
équipement répond et Industrial HiVision reconnaît un équipement qui 
n'existe pas.
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Configuration > User defined Properties

8.7 User defined Properties

Cette boîte de dialogue permet de compléter et de surveiller les propriétés 
des équipements compatibles SNMP de votre choix dans Industrial HiVision 
(voir page 233 “Description des propriétés personnalisées”).
 Dans la barre de menus, sélectionnez Configuration > User defined 

Properties pour ouvrir la boîte de dialogue «User defined Properties».
Vous pouvez éditer, supprimer ou dupliquer une propriété personnalisée 
sélectionnée. Lorsque vous sélectionnez une propriété personnalisée, le 
bouton «Delete» est grisé si la propriété est attribuée à une propriété de 
niveau supérieur.

8.7.1 Création d'une nouvelle propriété 
personnalisée

Vous trouverez un exemple d'application dans le chapitre « Configuration de 
la surveillance de réseau » (voir page 234 “Exemple d'application des pro-
priétés personnalisées”).

Nom Signification
Name Pour cette propriété, nom univoque de votre choix commen-

çant par « UserDef_ », par exemple « UserDef_ICMP-
Message ».

Label Nom de votre choix utilisé par Industrial HiVision pour l’affi-
chage dans l’interface utilisateur.

Icon Sélection d'un fichier pixel utilisé comme icône de propriété 
par Industrial HiVision comme icône pour les propriétés dans 
l'interface utilisateur.

Tableau 48 : Boîte de dialogue « New Entry » [Nouvelle entrée] pour une propriété 
personnalisée.
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Parent Property Propriété de niveau supérieur d'une nouvelle propriété par ex. 
la propriété « Vitesse » appartenant à la propriété de niveau 
supérieur « Port ».

MIB Variable/OID Variable MIB/OID (identification d'objet) que vous pouvez 
sélectionner en cliquant sur les trois points du navigateur MIB.

Instance Affectation des variables MIB à un détail d'équipement, par 
exemple « 0 » pour le temps.
Industrial HiVision détermine sinon le type lui-même, par ex. 
« Numéro du module ».

Type Industrial HiVision sélectionne le type automatiquement (par 
ex. adresse MAC ou un nombre entier (Integer)) si Industrial 
HiVision peut déterminer le type.

Mapping Affectation d’une valeur numérique à une signification, par ex. 
« 0 = false » ou « 1 = true ». Industrial HiVision détermine cette 
valeur à partir de la MIB.

Factor Facteur pour convertir une unité, par ex. Celsius en Fahren-
heit.

Offset Décalage pour convertir une unité, par ex. Celsius en Fahren-
heit.

Nom Signification

Tableau 48 : Boîte de dialogue « New Entry » [Nouvelle entrée] pour une propriété 
personnalisée.
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Configuration > MultiConfig™

8.8 MultiConfig™

La fonction de configuration multiple (MultiConfig™) vous offre la possibilité 
d'effectuer des configurations sur l'équipement et dans Industrial HiVision 
pour : 
 un ou plusieurs équipements
 une ou plusieurs propriétés d'équipement, y compris de l'ensemble des 

équipements
 un ou plusieurs détails d'équipement, y compris de l'ensemble des équi-

pements
Vous trouverez des informations complémentaires avec exemples d'applica-
tion au chapitre “Configuration du réseau” on page 171.

8.8.1 Power Limit

Pour configurer la fonction «Power Limit» sur le port «PoE», procédez 
comme suit :
 Sélectionnez les ports PoE dans votre réseau nécessitant la même valeur 

seuil.
 Effectuez un clic droit sur l’un des ports sélectionnées. Une liste dérou-

lante s’ouvre.
 Sélectionnez l’option «MultiConfig™».
 Ouvrez la boîte de dialogue Device Settings > PoE > Automate Power 

Limit.
 Afin de configurer la fonction «Power Limit», supprimez la sélection de la 

case «Automate Power Limit».
 Saisissez la valeur nécessaire dans le champ «Power Limit». Si la puis-

sance est supérieure à la valeur seuil saisie, l’équipement envoie une 
alarme et l’application envoie un avertissement.

 Pour régler automatiquement le «Power Limit», sélectionnez la case 
«Automate Power Limit».

 Cliquez sur le bouton «Write».
 Cliquez sur le bouton «Close».
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Figure 104 :Configuration > MultiConfig™ > Device Settings > PoE > Power 
Limit
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Configuration > Liste MAC/IP

8.9 Liste MAC/IP

8.9.1 Adresses MAC/IP

Cette boîte de dialogue affiche une liste des adresses IP reconnues par 
Industrial HiVision et leurs adresses MAC correspondantes. La liste 
comprend :

Désignation Signification
MAC Address
IP Address
Netmask
Host Name Nom d'hôte provenant du fichier /config/hosts.txt dans le répertoire d'ins-

tallation, si
- le fichier existe
- l'entrée est disponible
- la détermination d'un nom d'équipement est activée dans les réglages 
de base
Dans le cas contraire, le champ reste vide.

DNS Name Nom du « Domain Name Service » [Service de noms de domaine]
Port No Numéro de port du protocole.
Port Port d'équipement
Management Industrial HiVision communique via l'adresse IP de cette ligne avec 

l'administration de l'équipement.
User Generated L'équipement situé dans cette ligne a été généré par l'utilisateur. 

Industrial HiVision n'a pas encore reconnu l'équipement.
Router Entry L'adresse IP située dans cette ligne provient de la table de routage de 

l'équipement.
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Il est possible d’enregistrer toute la liste via «Export» dans les formats 
suivants :

 Fichier PDF
 Fichier HTML
 Fichier CSV (voir page 470 “Exportation CSV”)

Il est possible d’imprimer toute la liste via «Print». Industrial HiVision crée un 
fichier PDF temporaire du contenu de la liste et ouvre le fichier PDF dans un 
logiciel d'affichage PDF installé dans votre station d'administration, tel Acro-
bat Reader.

8.9.2 Sécurité paire adresses MAC/IP

Cette boîte de dialogue vous offre la possibilité de surveiller l'assignation des 
adresses MAC aux adresses IP et de détecter les doublons dans les 
adresses IP. 
Industrial HiVision identifie les types d'entrées suivants dans le tableau :
 «Existent»

Cette entrée provient d'un équipement existant ou détecté sur le réseau. 
Si vous supprimez cet équipement de la topologie, Industrial HiVision 
supprime l'équipement de cette liste.
Industrial HiVision inclut cette entrée dans l'analyse des événements.

 «User Generated»
Un utilisateur a créé ou édité cette entée à cet endroit. Cette entrée est 
conservée dans la liste jusqu'à ce que l'utilisateur la supprime manuelle-
ment de la liste.
Industrial HiVision inclut cette entrée dans l'analyse des événements.

 «Excluded»
Un utilisateur a créé ou édité cette entée à cet endroit. Cette entrée est 
conservée dans la liste jusqu'à ce que l'utilisateur la supprime manuelle-
ment de la liste.
Industrial HiVision exclut cette entrée de l'analyse des événements.
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La sélection dans la liste déroulante «Display» vous permet de filtrer le 
contenu du tableau en fonction du type.
 Pour activer la surveillance, sélectionnez la case «Configure Schedule for 

Checking».
Dès que vous quittez la boîte de dialogue avec le bouton «Scheduler», 
Industrial HiVision ouvre la boîte de dialogue. Définissez ici les critères 
pour la surveillance.
Voir “Scheduler” on page 329.
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8.10 Refresh

«Refresh» vous permet de déclencher la lecture par Industrial HiVision des 
valeurs de propriétés d'un équipement, d'un dossier ou de la propriété elle-
même, tous préalablement sélectionnés. Après la lecture des valeurs, 
Industrial HiVision actualise l'affichage.

 En mode édition et pendant l'actualisation d'un équipement ou d'un dos-
sier d'équipement, Industrial HiVision lit les propriétés existantes exclusi-
vement à l’intérieur et en dessous de l'équipement ou du dossier 
concerné.
Ce procédé permet, par exemple après l'ajout d'un module au matériel, 
de le rendre visible dans Industrial HiVision. 

 En mode édition et pendant l'actualisation d'un équipement ou d'un dos-
sier d'équipement, Industrial HiVision lit les propriétés existantes exclusi-
vement à l’intérieur et en dessous de l'équipement ou du dossier 
concerné.

Lors de l'actualisation d'une propriété, Industrial HiVision lit la valeur de la 
propriété.
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8.11 IP Configuration

Cette boîte de dialogue vous offre la possibilité de configurer les paramètres 
IP d'un équipement reconnu par HiDiscovery sans adresse IP ou de modifier 
des paramètres IP déjà configurés.

Ouvrez la boîte de dialogue pour la configuration IP, effectuez-y un clic droit 
sur l’équipement et sélectionnez «IP Configuration». 

Lorsque vous ouvrez cette boîte de dialogue, Industrial HiVision interroge 
l'équipement via le protocole HiDiscovery. Si la requête réussit, Industrial 
HiVision affiche les paramètres de l'équipement et le bouton «Signal». Si 
l'équipement ne répond pas à la requête de HiDiscovery, Industrial HiVision 
interroge l'équipement via SNMP. Si la requête SNMP réussit, Industrial 
HiVision affiche les paramètres de l'équipement.

 Cliquez sur le bouton «Signal» pour activer le clignotement des LED pour 
identifier l’équipement. Pour désactiver à nouveau le clignotement, cli-
quez sur le bouton «Signal». 
Configuration requise pour cette fonction :
– HiDiscovery est activé pour l’équipement.
– Vous avez sélectionné la carte d’interface réseau pour ce réseau dans 

la boîte de dialogue Configuration > Preferences > Advanced > 
Management Station sous «Default Network Card» (HiDiscovery).

 Vous pouvez saisir un nom pour l’équipement dans le champ «Name».
 Vous pouvez assigner une nouvelle adresse IP à l’équipement via le 

champ « Adresse IP ».
 Vous pouvez assigner un nouveau masque de réseau à l’équipement via 

le champ « Masque de réseau ».
 Vous pouvez assigner une nouvelle passerelle à l’équipement via le 

champ « Passerelle ».
 Lorsque vous cliquez 1 fois sur le bouton «Default Values», Industrial 

HiVision saisit les valeurs par défaut de “Management Station” on 
page 398 dans les champs pour la configuration IP.

Lorsque vous cliquez sur le bouton «OK», Industrial HiVision transmet les 
noms et la configuration IP à l’équipement.

Pour fermer la boîte de dialogue et conserver les entrées d’origine, cliquez 
sur le bouton «Cancel».
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Figure 105 :Configuration IP d'un équipement
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8.12 Trap Destination

Ouvrez la boîte de dialogue des destinations d'alarme en cliquant avec le 
bouton droit de la souris sur «Trap Destination». 

À l'ouverture de la boîte de dialogue, Industrial HiVision interroge les para-
mètres d'alarme de l'équipement et indique si celui-ci envoie des alarmes à 
l'adresse IP affichée.

 Si bous souhaitez que l’équipement envoie des alarme lorsque d’événe-
ments définis surviennent, sélectionnez la case «Send Traps».

 Vous sélectionnez l’adresse IP de votre station d’administration réseau, 
via laquelle vous exécutez Industrial HiVision, dans la liste déroulante «to 
IP Address».

 Si vous souhaitez enregistrer cette configuration d’alarme dans la 
mémoire permanente de l’équipement, sélectionnez la case «Save 
Config on Device».

Figure 106 :Destinations d'alarme d'un équipement
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Commentaire : Si votre pare-feu Windows est activé et qu'aucun service 
d'alarme Windows n'est installé, le pare-feu bloque la réception d'alarmes. 
Néanmoins, si vous souhaitez recevoir des alarmes, ajoutez le fichier /ser-
vices/HiVisionKernelDb.exe dans le répertoire d'installation Industrial 
HiVision en tant que fichier exécutable.
Le service d'alarme Windows est installé si « SNMP Trap Connection:Trap 
Service » figure sous Help > Kernel Info dans Industrial HiVision. 
Vous pouvez configurer le pare-feu de Windows dans l'onglet « Exceptions » 
sous Start > Settings > Control Panel > Windows Firewall Cliquez sur 
« Programme » pour sélectionner le fichier /services/HiVisionKer-
nelDb.exe dans le répertoire d'installation de Industrial HiVision.
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Tools > Dashboard

8.13 Tools

Le menu «Tools» contient différents outils pour accéder aux équipements de 
votre réseau via Ping, l'interface graphique, CLI, le routeur SNMP ou l’ana-
lyse HiDiscovery.

8.13.1 Dashboard

Le «Dashboard» Industrial HiVision est un outil utile pour la recherche 
d'erreur qui permet à l'administrateur d'afficher les statistiques réseau ainsi 
que des informations utiles concernant la puissance du réseau en temps 
réel.

Industrial HiVision permet de créer plusieurs tableaux de bord avec des infor-
mations différentes et d'afficher un aperçu de ses tableaux de bord dans un 
diaporama. La fonction vous permet en plus d'enregistrer et de charger les 
mises en page des tableaux de bord.

La fenêtre principale contient un temporisateur. Le temporisateur vous per-
met d'adapter la durée d'affichage de chaque page du diaporama.

Lorsque vous fermez l'application Industrial HiVision, l'application enregistre 
les dimensions et la position du tableau de bord. L'application enregistre les 
autres options de tableau de bord actives, par ex. le mode plein écran, l'état 
de temporisation et les états « Répétition » ou « Pause ».
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Figure 107 :Tableau de bord Industrial HiVision

Commentaire : Si le tableau de bord n'affiche pas les boutons «New», 
«Delete» et «Save», cliquez sur le bouton «Edit Mode» de la barre d'outils 
Industrial HiVision.

 Configuration et affichage des widgets
Industrial HiVision vous permet d’adapter le tableau de bord  vos besoins. 
La fonction Drag-and-Drop vous permet de déterminer le type et la posi-
tion du widget qui s’affiche sur le tableau de bord. De plus, vous pouvez 
déterminer le nombre de lignes et de colonnes pour chaque tableau de 
bord.

La couleur de fond du widget correspond au pire état affiché dans le wid-
get. Les couleurs de fond présentent le même état que sur l’interface uti-
lisateur graphique (GUI) de Industrial HiVision. L’utilisateur peut 
déterminer les couleurs de fond (voir “Status Colors” on page 384).
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 Taille du widget
Le tableau de bord vous permet d’agrandir ou de réduire le widget.

Pour agrandir le widget, vérifiez que des cellules vides se situent à droite 
ou sous le widget que vous souhaitez agrandir. Si aucune cellule n’est 
disponible, ajoutez le nombre de cellules nécessaire via le bouton «Grid».

Sélectionnez le widget que vous souhaitez agrandir. Agrandissez le wid-
get via le symbole plus (« + ») du bouton «Widget Size». À chaque clic 
sur le bouton plus (« + »), le widget est agrandi de 1 cellule. 

 Bouton « Propriétés »
Certains widgets vous permettent de configurer quel paramètre doit être 
surveillé. Pour définir les paramètres surveillés par le widget, cliquez sur 
le bouton «Properties» et saisissez les valeur dans la boîte de dialogue 
«Parameters». De plus, les widgets vous permettent de déplacer les 
paramètres de différents onglets de l’interface utilisateur graphique ou de 
cadre Répertoires dans le widget.

Les widgets suivants vous permettent de définir les paramètres à 
surveiller :
 «Connection Status»
 «Moving Avg Ping Response Time»
 «Numeric Property»
 «Top 10 Moving Avg Response Time» (pas de Drag-and-Drop)

 Modes d’affichage
Industrial HiVision vous permet d’afficher un diaporama des pages du 
tableau de bord à l’aide des méthodes suivantes. 
 Lorsque vous cliquez sur le bouton « Plein écran , le tableau de 

bord passe en mode plein écran et le diaporama est mis sur 
« Pause ».

 Vous pouvez également ouvrir le diaporama via le bouton 
« Répétition » . Lorsque vous ouvrez le diaporama via le bouton 
« Répétition », le tableau de bord passe en mode plein écran et le dia-
porama débute avec l’affichage des pages de l’utilisateur actuel.
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En « Mode plein écran », le tableau de bord dispose également d’une 
barre d’outils contenant les fonctions de commande suivantes.
 Pour arrêter le diaporama sur la page actuelle, cliquez sur le bouton 

« Pause » . 
 Pour redémarrer le diaporama, cliquez sur le bouton « Répétition » 

.
 Si vous souhaitez ouvrir une page en particulier, vous pouvez sélec-

tionner la page en question dans la liste déroulante.

Commentaire : Pour afficher la barre d’outils, déplacez le curseur de la 
souris dans la zone supérieure de l’écran.

Pour quitter le mode plein écran, cliquez sur le bouton « Restauration » 
 ou sur le bouton « Echap » du clavier.

 Renommer 
La fonction du tableau de bord vous permet de modifier les noms des 
pages disponibles.

Pour modifier le nom des pages disponibles, suivez les étapes suivantes :
 Cliquez sur le bouton «Rename».
 Saisissez le nom dans le champ «Dashboard Name».
 Cliquez sur le bouton «OK».

 Ordre du tableau de bord
En présence de plusieurs tableaux de bord, Industrial HiVision vous per-
met de les afficher dans n'importe quel ordre. En présence de plusieurs 
tableaux de bord ou si le tableau de bord sélectionné n'est pas en haut de 
la liste, le bouton Haut est activé. Le bouton « Haut » déplace le tableau 
de bord d'une position vers le haut.

 Widget Device Summary
Le widget affiche un aperçu sur les équipements qui regroupe l’ensemble 
des projets. L’aperçu affiche les équipements en fonction de l'état de 
l’équipement. Le widget affiche exclusivement les états des équipements 
gérés (« managed ») et sous licence.
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Industrial HiVision contient l’équipement et une copie des équipements 
dans l’aperçu. Si vous insérer 1 copie d’un équipement dans Industrial 
HiVision, le widget « Aperçu des équipements » compte l’équipement 
2 fois. Le widget compte l’équipement 2 fois étant donné que la copie de 
l'état peut différer de l’original. Le widget « Aperçu des équipements » 
exclut les liens du comptage.

Le widget affiche l'état de l’équipement, sans prendre en compte l'état 
confirmé de l’équipement(voir “Valider les évènements” on page 102).

Dans chaque champ se trouve une flèche derrière chaque nom. La flèche 
indique la tendance du champ depuis la dernière actualisation. Exemple : 
le champ «Warning» indiquant « 3 » lors de l’analyse précédente et est 
de « 2 » après l’analyse actuelle. Dans ce cas, le champ comporte une 
flèche vers le bas.

 Widget Connection Summary
Le widget affiche un aperçu des connexions qui regroupe l’ensemble des 
projets. L’aperçu affiche les connexions en fonction de l'état de la 
connexion.

Le widget affiche l'état des connexions, sans prendre en compte l'état 
confirmé (voir “Valider les évènements” on page 102).

La flèche indique la tendance du champ depuis la dernière actualisation. 
Exemple : le champ «Warning» indiquant « 3 » lors de l’analyse précé-
dente et est de « 2 » après l’analyse actuelle. Dans ce cas, le champ 
comporte une flèche vers le bas.
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 Widget Connection Status
Vous pouvez insérez plusieurs widgets «Connection Status» au tableau 
de bord. Le widget «Connection Status» indique l'état de connexion et la 
charge de réseau des connexions sélectionnées sous la forme d’un 
diagramme. Les valeurs de charge et les états de connexion sont affichés 
dans des diagrammes séparés. Le cadre du widget affiche la couleur de 
l'état de connexion actuel. Le widget extrait les états de connexion de la 
banque de données de Industrial HiVision. Si Industrial HiVision déter-
mine une erreur en rapport avec la connexion pour une raison précise, le 
cadre du widget indique la couleur définir pour cette erreur.

Figure 108 :Widget «Connection Status» avec fonction «Top to bottom» active.
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Lors de la création d’un nouveau widget, ce dernier est en état non confi-
guré. Par exemple, le widget n’a pas encore de connexion déterminée à 
un projet. Dans cet état, le widget affiche un diagramme vide. 

Pour configurer le widget, suivez les étapes suivantes : 
 Placez le widget par Drag-and-Drop dans une cellule du tableau de 

bord. 
 Pour ouvrir la boîte de dialogue «Widget Parameters», cliquez sur la 

bouton «Properties» sur le côté droit du tableau de bord.
 Saisissez la durée de l’historique souhaitée dans le champ «History 

Size».
La plage pour «History Size» peut être compris entre 1 min. et 2 h. La 
valeur par défaut est de 30 min.

 Sélectionner l’unité de mesure dans la liste déroulante.
 Attribuez aune connexion au widget. Sélectionnez une connexion 

dans le champ «Connection».
 Cliquez sur le bouton «OK».

Commentaire :  Si vous sélectionnez un élément qui n’est pas une 
connexion, le widget indique «Widget Configuration Error».

Le widget enregistre les données du serveur vers «In Load» et «Out 
Load» et affiche ces données en un digramme d’historique. Le 
diagramme d’historique fait passer lentement l’image sur le widget et 
vous permet de lire l’information. Le widget affiche le diagramme jusqu’à 
ce que vous fermiez le widget ou que vous saisissiez une autre 
connexion.

La boîte de dialogue «Widget Parameters» vous permet également de 
configurer l’aspect visuel du widget. Pour configurer le widget de sorte 
qu’il affiche le diagramme inférieur de «Out Load» directement en des-
sous du diagramme supérieur de «In Load», sélectionnez la case «Top to 
bottom». Pour transformer le l’histogramme de charge solide en un 
diagramme avec barres empilées, sélectionnez la case «Stacked». 
Chaque barre indique l'état d’un jeu de données selon le type de 
diagramme, par ex. en barres solides ou empilées. Le widget enregistre 
la configuration de l'état de chaque jeu de données et l’affiche.
User Manual Industrial HiVision
Release 8.1 12/19 439



Références
Commentaire : Le diagramme en barres solides représente les barres en 
utilisant la couleur correspondant à l'état de la valeur au moment 
concerné. Le diagramme en barres empilées représente les parties de la 
barre qui se situent en-dessous, entre ou au-dessus des valeurs limites, 
en différentes couleurs. Cela permet de représenter les modifications 
dans la configuration de l'état.

Le widget utilise les même valeurs limites que celles configurées dans 
l’interface utilisateur graphique. Voir “Propriétés d'une connexion” on 
page 305.

Figure 109 :Widget «Connection Status» avec fonctions «Top to bottom» et «Sta-
cked» activées.

Le widget essaie de transmettre la charge dans les deux directions à 
l’aide de différentes méthodes. Le widget extrait les valeurs de la banque 
de données dans l’ordre suivant :
 Les valeurs de propriétés de «In Load» des deux ports finaux de la 

connexion. La légende indique la direction du trafic de données.
 Lorsqu’une page ne livre aucune propriété de type «In Load», le wid-

get utilise la propriété «Out Load» de la page opposée. La légende 
indique la direction du trafic de données.
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 Lorsque 1 seul côté de la connexion est un port, le widget utilise les 
propriétés «In Load» et «Out Load» de ce port. La légende indique le 
nom du point final auquel est annexé soit «In Load» ou «Out Load».

 S’il est impossible de déterminer la direction du trafic de données, le 
diagramme et la légende restent vides.

Si vous modifiez une connexion déterminée avec un widget, le widget 
renvoie les modifications en continu. Si vous supprimez une connexion, 
le widget affiche «Widget Configuration Error».

 Widget Kernel Status Info
Le widget «Kernel Status Info» affiche des informations concernant le 
noyau de Industrial HiVision. 

Vous trouverez des informations supplémentaires concernant le noyau 
de Industrial HiVision dans le chapitre suivant (Voir “Kernel Info” on 
page 466.).

Le widget affiche les informations suivantes :
 «Kernel uptime»

La durée de fonctionnement depuis le démarrage de Industrial 
HiVision.

 «Memory Usage»
La part d’espace de sauvegarde utilisées par les services. Industrial 
HiVision détermine la part en pourcentage d’espace de sauvegarde 
comme suit :
percent = actual memory used/reserved memory

 «Polling Operations per Minute»
Le nombre défini d’opérations pouvant être effectuées par le noyau 
par minute.

 «Polling Operations last Minute»
Le nombre d’opérations effectuées par le noyau lors des dernières 
minutes.

 «Polling Operations dropped»
Le nombre d’opérations rejetées par les services lors des dernières 
minutes. Vous pouvez influencer le nombre d’opérations polling reje-
tées en modifiant le nombre d’opérations polling surveillées ou l’inter-
valle polling.
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Commentaire : Plus d’informations concernant la configuration des para-
mètres qui interroge le noyau Voir “Monitor” on page 321..

 Widget Security Summary
Le widget «Security Summary» affiche les paramètres relatifs à la sécu-
rité.

Le champ «Vulnerable Devices» indique le nombre d’équipements vulné-
rables aux attaques. Les équipements vulnérables ont au moins 
1 fonction activée qui devrait être désactivée selon les recommandations, 
par ex. protocoles HTTP ou SNMP-v1/v2. Le widget compte également 
les équipements dont les fonctions de sécurité sont désactivées. Le 
nombre affiché dans le widget correspond au nombre d’équipements 
dans votre projet donc l'état de sécurité est plus mauvais qu’« OK ».

L’onglet «Security Status» dans l’interface utilisateur graphique de 
Industrial HiVision identifie quel équipement a été inclus dans les résul-
tats par le widget ainsi que les risques en matière de sécurité de l’équipe-
ment. Pour réduire le nombre d'équipements dans le comptage et 
améliorer la sécurité du réseau, désactivez/activez les fonctions identi-
fiées dans l’onglet «Security Status». Vous pouvez également utilisez la 
fonction MultiConfig™ «Security Lockdown».

Le champ «Rogue Devices» indique le nom d’équipements dans la topo-
logie d’équipements Rogue Voir “Identifier les équipements Rogue” on 
page 218. Lorsque le nombre d’équipements Rogue est supérieur à 0, le 
widget affiche la couleur déterminée pour les « Avertissements ».
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Commentaire : Le widget affiche un triangle d’avertissement à droite du 
champ «Rogue Devices». Le triangle vous rappelle d’activer la fonction. 
Lorsque vous activez la fonction «Rogue Device Detection», le widget 
masque le triangle. 

Le champ «Config. Signature Changes» indique le nombre d’équipe-
ments avec une modification de configuration. Le champ regroupe 
chaque modification, même lorsque les modifications ont été réinitialisées 
sur les valeurs par défaut.

Pour que le widget affiche les propriétés, définissez une valeur de réfé-
rence et configurez la détermination de l'état comme suit :
 Ouvrez l’onglet «Properties» dans l’interface utilisateur graphique 

(GUI) de Industrial HiVision.
 Ouvrez la liste déroulante «Property:» et sélectionnez «Configuration 

Signature».
 Sélectionnez l’équipement ou les équipements dans le tableau pour 

lequel/lesquels «Configuration Signature» n’est pas activé. 
Les équipements avec un «Configuration Signature» activé pré-
sentent une coche dans le tableau «Status». Pour localiser les équi-
pements qui nécessitent des mesures, vous pouvez filtrer le tableau. 
Pour filtrer le tableau, cliquez sur le titre de colonne «Status» jusqu’à 
ce que le tableau affiche les entrées les plus hautes.

 Ouvrez la boîte de dialogue «Status Config» via Configuration > 
MultiConfig™ > Status Config.

 Cochez la case «Set current to reference».
 Cochez la case «Value is Reference Value». 
 Ouvrez la liste déroulante «Value is Reference Value» et sélectionnez 

« OK ». 
 Cochez la case «Other Value».
 Ouvrez la liste déroulante «Other Value» et sélectionnez «Warning» 

ou «Error».
 Pour enregistrer les modifications, cliquez sur le bouton «Write».

Commentaire : Le widget affiche un triangle d’avertissement à droite du 
champ «Config. Signature Changes». Le triangle vous rappelle de confi-
gurer la fonction. Le triangle est masqué après la configuration des réfé-
rences pour chaque équipement.

L'état du champ «Config. Signature Changes» est soit « OK » pour la 
valeur « 0 » ou correspond au plus mauvais état des propriétés «Configu-
ration Signature» configurées.
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La flèche indique la tendance de chaque champ.

 Widget Numeric Property
Le widget «Numeric Property» vous permet de suivre l'état des para-
mètres avec des valeurs numériques. Le widget vous permet de suivre 
jusqu’à 10 paramètres numériques. 

Effectuez les étapes suivantes dans la boîte de dialogue «Widget 
Parameters» pour la saisie du paramètre que vous souhaitez surveiller :
 Pour ouvrir la boîte de dialogue «Widget Parameters», cliquez sur le 

bouton de commande «Properties».
 Saisissez la durée pendant laquelle vous souhaitez surveiller l’équipe-

ment dans le champ «History Size».
Préréglage : 30

 Saisissez l’unité de mesure «History Size» pour la durée pendant 
laquelle vous souhaitez surveiller l’équipement.
Préréglage : «Minutes»

 Sélectionnez jusqu’à 10 paramètres de la structure du projet.
 Vous pouvez définir un autre nom pour le widget dans le champ 

«Title».
 Cliquez sur le bouton «OK».
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La liste suivante contient quelques paramètres numériques pouvant être 
surveillé par le widget :
 «Ports»:

«In Load»
«Out Load»
«Speed»

 Agent : 
«Number of Users»

 Protocole [Protocol] : 
«Moving Avg Response Time»
«Avg Response Time»
«Min Response Time»
«Max Response Time»
«Std. Deviation»
«Message Loss»

Commentaire : Il est possible que 2 équipements présentent la même 
valeur pour un paramètre, par ex. les équipements 10.0.1.10, 10.0.1.17 
et 10.0.1.200 peuvent avoir une température de 38 °C et 39 °C. Dans ce 
cas, un trace recouvre l’autre trace. Voir les traces bleues, jaunes et 
oranges dans la figure «Numeric Property» ci-dessous.
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 Widget Moving Avg Ping Response Time
Le widget «Moving Avg Ping Response Time» vous permet d’afficher le 
temps de réponse d’une requête ping pour jusqu’à 10 équipements. Vous 
pouvez saisir les équipements à l’aide de la fonction Drag-and-Drop ou 
via la boîte de dialogue «Widget Parameters».
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Pour effectuer la saisie des équipements que vous souhaitez surveiller, 
suivez les étapes suivantes dans la boîte de dialogue «Widget 
Parameters» :
 Pour ouvrir la boîte de dialogue «Widget Parameters», cliquez sur le 

bouton de commande «Properties».
 Saisissez la durée pendant laquelle vous souhaitez surveiller l’équipe-

ment dans le champ «History Size».
Préréglage : 30

 Saisissez l’unité de mesure «History Size» pour la durée pendant 
laquelle vous souhaitez surveiller les équipements.
Préréglage : «Minutes»

 Sélectionnez jusqu’à 10 paramètres de la structure du projet.
 Cliquez sur «OK».

Pour effectuer la saisie des équipements que vous souhaitez surveiller 
via la fonction Drag-and-Drop, suivez les étapes suivantes :
 Ouvrez l’onglet « GUI Map ».
 Sélectionnez l’(les) équipement(s) que vous souhaitez surveiller.
 Placez les équipements sélectionnés dans le widget «Moving Avg 

Ping Response Time».

Commentaire : Pour chaque nouvelle sélection d’équipement que vous 
souhaitez surveiller, le widget remplace les équipements actuels pas les 
équipements nouvellement sélectionnés. 

Plus d’informations relatives aux valeurs moyennes CSMP glissantes 
Voir “Paramètres Service” on page 402..
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 Widget Top 10 Moving Avg Response Time
Le widget affiche temps glissants moyens de réponse pour jusqu’à 
10 équipements. Les équipements présentant un temps de réponse glis-
sant moyen plus important sont représenté en haut du diagramme.

Pour configurer le widget, ouvrez la boîte de dialogue «Widget Parame-
ters» via le bouton «Properties». La boîte de dialogue vous permet de sai-
sir le protocole devant être affiché par le widget. Vous pouvez 
sélectionner les protocoles suivant dans la liste déroulante :
 Préréglage Ping
 SMNP V1
 SMNP V3

Le widget affiche une flèche de tendance à côté de l’adresse IP de 
chaque équipement. La flèche de tendance indique le déplacement 
compte tenu de la position d’un équipement depuis le dernier polling en 
relation avec les autres équipements affichés dans le widget.

Les informations mises à disposition dans le widget vous aident lors de la 
planification concernant la puissance optimale dans votre réseau. Le wid-
get indique par exemple, quel équipement présente un temps de réponse 
moyen long. Un long temps de réponse moyen peut provoquer des pénu-
ries dans votre réseau. Si un équipement avec un long temps de réponse 
moyen se trouve au milieu de votre réseau, cet équipement peut influen-
cer les autres équipements de votre réseau. Le remplacement d’un équi-
pement lent permet une transmission du flot de données sans entrave.

La liste suivante contient certaines causes possibles pour un temps de 
réponse long :
 L’équipement est surchargé en raison des données CPU envoyées. 

La réception et la transmission de données représentent la tâche prin-
cipale d’un équipement de réseau. Le traitement d’exigence adminis-
tratives est une tâche secondaire.

 Le chemin d’accès à l’équipement est lent.
– Connexion lente
– Connexion lente du voisin
– Câble en fibre de verre ou Ethernet lent

Commentaire : Lors de la première configuration du widget il affiche les 
longs temps de réponse le cas échéant. Dans ce cas, attendez un petit 
instant que les valeurs affichées se stabilisent avant de prendre des 
mesures. Si les temps de réponse moyens restent inchangés après 1 
envisagez d’autres mesures.
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 PoE Status
Le widget «PoE Status» vous permet de surveiller les états des équipe-
ments PoE de votre réseau.

Le widget affiche la somme des avertissements trouvés sur l’onglet 
«PoE» pour les paramètres suivants :
 «Class 0 Detected»

Affiche la somme des ports sur lesquels l’équipement a détecté qu’un 
équipement de classe 0 est raccordé.

 «Device»
Affiche la somme des équipements sur lesquels la valeur de «Device 
Limit» a été dépassée.

 «Module»
Affiche la somme des modules sur lesquels la valeur de «Module 
Limit» a été dépassée.

 «Port»
Affiche la somme des ports pour lesquels la valeur de «Port Limit» a 
été dépassée.

La flèche indique la tendance du champ depuis la dernière actualisation. 
Exemple : le champ «Class 0 Detected» indiquant « 3 » lors de l’analyse 
précédente et est de « 2 » après l’analyse actuelle. Dans ce cas, le 
champ comporte une flèche vers le bas.

Lorsque vous désactivez la fonction «PoE Class 0 Detection» des ports 
de l’onglet «PoE», le widget affiche un triangle d’avertissement à côté du 
champ «Class 0 Detected». Les ports pour lesquels vous avez désactivé 
la fonction de détection ne sont pas compris dans le nombre indiqué au 
champ «Class 0 Detected».
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Commentaire : Si le widget affiche un triangle d’avertissement à côté 
d’un champ, plusieurs éléments sont concernés le cas échéant, comme 
indiqué par le nombre.

Figure 110 :Widget «PoE Status»

 Widget TSN Schedule
Le widget affiche la durée du cycle TSN et la commande gate d’un port 
dans un tableau. Le tableau affiche 1 ligne pour chaque classe «Priority». 
Les colonnes à côté de la classe «Priority» indique l'état de chaque Gate. 
Une Gate est une période durant laquelle le port est soit ouvert, soit fermé 
pour la classe de priorité. Une Gate ouverte transmet le trafic de données 
de la classe de priorité. Une Gate fermée bloque le trafic de données de 
la classe de priorité. Une cellule verte signale une Gate ouverte tandis 
qu’une cellule grise indique une gate fermée. La longueur de la colonne 
indique la durée durant laquelle la Gate est soit ouverte, soit fermée, par 
rapport à la durée du cycle.
Pour configurez le widget, cliquez sur le bouton «Properties». Industrial 
HiVision ouvre la boîte de dialogue «Widget Parameters». La boîte de 
dialogue vous permet de saisir le port compatible TSN pour afficher le 
widget.
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Figure 111 :Widget «TSN Schedule»

8.13.2 Web Interface

L'outil «Web Interface» vous permet d’ouvrir l’interface web de l’équipement 
sélectionné dans la fenêtre via l’interface Industrial HiVision dans le naviga-
teur internet.
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8.13.3 Device Configuration

L'outil «Device Configuration» vous permet d’ouvrir l’interface web de l’équi-
pement sélectionné dans la fenêtre via l’interface Industrial HiVision dans le 
navigateur internet. Pour ce faire, Industrial HiVision utilise le nom d'utilisa-
teur et le mot de passe issus des paramètres de configuration SNMP (voir 
page 394 “Avancé”). Ainsi, Industrial HiVision ne requiert aucune identifica-
tion et vous accédez directement à la page d'accueil de votre équipement.

Les gammes d'équipement suivantes sont dotées de cette fonction :
 MACH 4000
 MACH 1000
 MACH 100
 GREYHOUND
 PowerMICE
 MS20/MS30
 MSP
 RS20/RS30/RS40
 RSP/RSPS/RSPL
 RSR20/RSR30
 RED
 EES20/EES25
 OCTOPUS
 EAGLE 20
 Magnum 12KX
 TCSESM
 TCSESM-E
 TCSG
 TCSN
 TCSEFEC
 ESM 801-TG
 ESM 802-TG
 ERT
 AFF650
 AFS650/655
 AFS66x
 AFS670/675
 AFS677
 AFR677
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Commentaire : Industrial HiVision vous permet avec la fonction «Device 
Configuration», indépendamment d’autres applications, par ex. un routeur ou 
un environnement Java installé, d’utiliser l’interface utilisateur graphique de 
produits Hirschmann. Hirschmann a développé Industrial HiVision comme 
application qui vous autorise ç utiliser simplement dans un réseau fermé 
l’interface utilisateur graphique grâce à la fonction «Device Configuration».
Lorsque Industrial HiVision établit une connexion sûre avec HTTP ou SSH, 
Industrial HiVision ne contrôle pas l’identité de l’équipement avec lequel 
Industrial HiVision se connecte. De plus, Industrial HiVision n’indique pas à 
l’utilisateur l’identité de l’équipement. Un pirate sur le réseau pourrait utilisez 
l’absence de contrôle pour obtenir des informations sensibles.
Il est recommandé d’utiliser Industrial HiVision dans un réseau fermé. N’uti-
lisez pas la fonction «Device Configuration» et la boîte de dialogue 
MultiConfig™, qui utilisent HTTPS, dans un réseau ouvert. Effectuez les 
mises à jours de Industrial HiVision dès qu’une version plus récente est dis-
ponible.

8.13.4 CLI

L’outil «CLI» vous permet de créer une connexion vers l’équipement sélec-
tionné via l’interface Industrial HiVision. Pour cela, Industrial HiVision ouvre 
une nouvelle fenêtre.
Industrial HiVision contrôle automatiquement si l’équipement permet une 
réunion SSH ou une réunion Telnet. Industrial HiVision privilégie la création 
de réunions SSH.

Commentaire : Sous Linux, l'outil «CLI» requiert que les clients Telnet et 
SSH soient installés et que la variable d'environnement PATH contienne le 
nom du répertoire dans lequel le programme « xterm » est installé.
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8.13.5 SNMP Browser

L’outil «SNMP Browser» vous permet de lire et d'écrire la MIB d'un équipe-
ment sélectionné. Industrial HiVision utilise la MIB dans une nouvelle fenêtre.

Commentaire : Le «SNMP Browser» est un logiciel additionnel à utilisation 
libre. Le «SNMP Browser» n'entre pas dans le test du système.

8.13.6 Ping

L'outil «Ping» vous permet d'envoyer une requête Ping à des équipements 
sélectionnés dans une fenêtre. Industrial HiVision ouvre une fenêtre Ping 
séparée.

Commentaire : Sous Linux, l'outil «Ping» requiert que la variable d'environ-
nement PATH contienne le nom de répertoire dans lequel le programme 
« xterm » est installé.

8.13.7 HiDiscovery Scan

Le «HiDiscovery Scan» vous permet de reconnaître les équipements du 
réseau qui prennent en charge le protocole HiDiscovery, à condition que le 
protocole HiDiscovery v1 de ces équipements soit activé.
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Commentaire : En ce qui concerne HiDiscovery, Industrial HiVision ne 
prend en charge que le protocole HiDiscovery v1.

 Exemple de configuration
Dans cet exemple, vous analysez votre réseau pour détecter les équipe-
ments dont le protocole HiDiscovery est actif.
 Ouvrez la boîte de dialogue Preferences > Advanced > Management 

Station.
 Sélectionnez l'adaptateur connecté au réseau que vous souhaitez 

analyser dans la liste déroulante Network Card Management 
Station > Default Network Card (HiDiscovery).

 Pour enregistrer les valeurs dans Industrial HiVision et fermer la boîte 
de dialogue, cliquez sur le bouton «OK».

 Pour analyser le réseau, cliquez sur le bouton «HiDiscovery Scan».

8.13.8 Scan Network

La fonction «Scan Network» permet de détecter chaque équipement d'un 
domaine d'adresse du réseau déterminé (voir “Basics” on page 341). Pour 
démarrer une recherche de nouveaux équipements, sélectionnez l'option 
«Scan Network» dans la liste déroulante.

L'outil «Scan Network» dispose d'une fonction de commutation. La fonction 
de commutation démarre et arrête un balayage de réseau. Lors d'un 
balayage de réseau, cliquez sur le bouton «Scan Network» pour mettre en 
pause le balayage en cours.
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8.13.9 Demo Network

Le logiciel « Demo Network » [Démo réseau], également fourni, vous offre la 
possibilité de simuler un réseau sur votre ordinateur afin de vous familiariser 
avec Industrial HiVision hors connexion.

 Pour démarrer la simulation du réseau de démonstration, sélectionnez 
Tools > Demo Network. 

À l'état de livraison, la reconnaissance d'équipement est activée via une 
alarme et Industrial HiVision détecte les équipements de démonstration. 
Industrial HiVision affiche les équipements de démonstration dans le dossier 
«New Devices». Étant donné que le réseau de démonstration fonctionne 
sans raccordement au réseau, il effectue une simulation via l'interface local-
host avec l'adresse IP 127.0.0.1 et distingue les équipements par le biais du 
numéro de port :127.0.0.1:9003, 127.0.0.1:9004, 127.0.0.1:9005. La simula-
tion reproduit les fonctions d'administration des équipements suivantes :

 Découverte de la topologie basée sur LLDP
 Coupures de ligne
 Coupure de ligne dans le MRP
 Bloc d'alimentation manquant
 Charge du réseau sur l'équipement 9010
 Activer ou désactiver le contact de signalisation
 Modifier la température de l'équipement
456
User Manual Industrial HiVision

Release 8.1 12/19



Références 8.13 Tools
Figure 112 :Réseau de démo

8.13.10Calculate Availability

La durée de vie des composants est limitée en raison des propriétés phy-
siques de chacun. MTBF désigne le temps moyen entre deux pannes.
Les réparations de ces composants se traduisent également en durée. 
MTTR (mean time to repair) désigne la durée moyenne d'une réparation.
Industrial HiVision calcule la disponibilité d'un chemin d'accès basée sur les 
valeurs MTBF et MTTR des composants des équipements concernés le long 
de ce chemin d'accès.
Industrial HiVision prend également en compte les chemins d’accès redon-
dants.
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Le type d'un équipement raccordé influence son appartenance au réseau. 
Un commutateur / routeur à connexion redondante influence davantage la 
disponibilité du réseau qu'un équipement terminal à connexion redondante.

Si les valeurs calculées pour la disponibilité ne répondent pas à vos exi-
gences, vous pouvez prendre les mesures suivantes pour augmenter la 
disponibilité :
 établir un chemin d'accès redondant
 réduire la durée de réparation grâce, par exemple, à la disponibilité 

d'équipements de remplacement.

 Conditions requises pour le calcul de disponibilité
 Pour les systèmes d’exploitation Windows :

Pour le calcul de disponibilité, Industrial HiVision utilise la version 
Microsoft .NET Framework Version 2.0 ou supérieure.
Ce programme est inclus dans l'installation standard des systèmes 
d'exploitation Windows mentionnés dans la configuration système 
requise.
Ce logiciel doit être installé sur votre station d’administration réseau 
pour que la disponibilité puisse être calculée correctement.

 Pour les systèmes d’exploitation Linux :
Installez MONO 2.0.
Vérifiez si ces programmes sont installés dans votre station d'adminis-
tration réseau.

 Conseil pour Debian 6.0 et Ubuntu 12.04 (LTS) :
Installez libmono2.0-cil et libmono-winforms20-cil.

Catégorie de disponi-
bilité

Désignation Disponibilité en % Indisponibilité par 
an

1 (AEC-0) stable 99.0 3,7 jours
2 (AEC-1) disponible 99.9 8,8 heures
3 (AEC-2) disp. élevée 99.99 52,2 minutes
4 (AEC-3) insensible aux défail. 99.999 5,3 minutes
5 (AEC-4) tolérance de défail. 99.9999 32 secondes
6 (AEC-5) résistant aux défail. 99.99999 3 secondes

Tableau 49 : Catégorie de disponibilité selon ACE
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Avant le calcul de disponibilité, Industrial HiVision effectue les vérifica-
tions suivantes :
– Les valeurs «MTBF»/«MTTR» de chaque connexion sont-elles supé-

rieures à 0 ?
– Tous les objets (équipements, nuages) disposent-ils des propriétés 

«MTBF» et «MTTR», et leurs valeurs sont-elles supérieures à 0 ?
Si Industrial HiVision détecte des objets présentant des valeurs défail-
lantes, Industrial HiVision les affiche dans une fenêtre. Dès que les 
entrées requises ont été saisies, vous pouvez redémarrer le calcul.
Si vous souhaitez poursuivre le calcul malgré les informations man-
quantes, cliquez sur le bouton «Use Default Values». Dans ce cas, 
Industrial HiVision prend en compte les valeurs par défaut en cas 
d'entrées manquantes lors du calcul.
Lorsque de tels objets manquent, vous pouvez démarrer le calcul de dis-
ponibilité en un clic sur «Use Default Values». Industrial HiVision utilise 
ensuite toutes les valeurs «MTBF»/«MTTR» saisies pour le calcul et dans 
le cas contraire les valeurs par défaut «MTBF»/«MTTR».
«MTBF» = 30 000 h pour les équipements, 100 000 h pour les 
connexions
«MTTR» = 24 h pour les équipements et les connexions
Les valeurs actuelles pour les équipements/connexions diffèrent de ces 
valeurs par défaut.
L'utilisation des valeurs par défaut vous permet de calculer notamment la 
différence de disponibilité entre 2 chemins alternatifs.

 Préparation du calcul de disponibilité
L'exemple suivant décrit le mode de préparation du calcul de disponibilité 
d'une connexion entre 2 équipements.
Les valeurs MTBF des équipements Hirschmann sont indiquées dans le 
chemin d'installation de Industrial HiVision sous :
/data/doc/MTBF-Products.PDF.
 Ouvrez l’onglet «Map» au niveau des équipements.
 Pour saisir les valeurs «MTBF»/«MTTR» d’une connexion, procédez 

comme suit :
– Effectuez un clic droit sur une connexion, et sélectionnez «Proper-

ties...».
– Ouvrez l’onglet «Properties» dans la boîte de dialogue.
– Saisissez les valeurs «MTBF»/«MTTR» dans le cadre «Availabi-

lity».
– Cliquez sur le bouton «OK».
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 Ajoutez les propriétés personnalisées «MTBF», «MTTR» et «Node 
Type» aux propriétés des équipements.
– Double-cliquez sur 1 connexion des 2 équipements pour atteindre 

un niveau inférieur de l’affichage détaillé.
– Pour ajouter les valeurs «MTBF» et «MTTR» personnalisées, 

effectuez un clic droit dans l'espace vide de l'affichage détaillé.
– Sélectionnez New > Property.
– Dans la boîte de dialogue «New Property», cliquez sur «MTBF» et 

«MTTR» tout en gardant la touche « Ctrl » enfoncée.
– Cliquez sur le bouton «OK».
– Pour saisir la valeur «MTBF», ouvrez la boîte de dialogue «Proper-

ties» en double-cliquant sur la propriété «MTBF».
– Saisissez la valeur dans le champ «Current Value» et cliquez sur 

le bouton «Write».
– Cliquez sur le bouton «OK».
– Saisissez la valeur «MTTR» de la même manière.

 Complétez les propriétés de l'autre équipement en conséquence.
Si l’un des équipement est un équipement à connexion redondante, affec-
tez lui de la même manière (voir ci-dessus : «MTBF» et «MTTR») la pro-
priété «Node Type» avec la valeur «End Device».

Industrial HiVision dispose également, en alternative de la configuration 
des équipements, l’option MultiConfig™. Elle présente l’avantage de per-
mettre à 2 équipements d’être configurés simultanément avec les pro-
priétés «MTBF»/«MTTR».
 Ouvrez l’onglet «Map» au niveau des équipements.
 Pour saisir les valeurs «MTBF»/«MTTR» d’une connexion, procédez 

comme suit :
– Effectuez un clic droit sur une connexion, et sélectionnez 

MultiConfig™.
– Dans la boîte de dialogue MultiConfig™, sélectionnez dans 

l'arborescence.
Vous trouverez le tableau avec les connexions concernées dans le 
cadre d'objets, et le tableau des propriétés dans le cadre de fonc-
tions.
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– Saisissez les valeurs «MTBF»/«MTTR» dans le cadre «Availabi-
lity».

– Cliquez sur le bouton «Write».
 Pour insérer les propriétés personnalisées «MTBF» et «MTTR» dans 

les propriétés de l’équipement.
– Pour sélectionner les deux équipements, cliquez sur les équipe-

ments des terminaisons de connexion en maintenant la touche 
« Ctrl » enfoncée.

– Pour ouvrir la boîte de dialogue MultiConfig™, cliquez avec le bou-
ton droit sur un équipement en surbrillance et sélectionnez 
MultiConfig™.

– Dans la boîte de dialogue MultiConfig™, sélectionnez dans 
l'arborescence Program Settings > New Property.
Vous trouverez le tableau avec les équipements concernés dans le 
cadre d'objets, et le tableau des propriétés dans le cadre de fonc-
tions.

– Pour créer une nouvelle entrée de la valeur «MTBF» dans le 
tableau, cliquez sur le bouton «New».

– Sélectionnez une propriété «MTBF», et cliquez sur le bouton 
«OK».

– Pour créer une nouvelle entrée de la valeur «MTTR» dans le 
tableau, cliquez sur le bouton «New».

– Sélectionnez une propriété «MTTR», et cliquez sur le bouton 
«OK».

– Cliquez sur le bouton «Write».
 Pour ouvrir la boîte de dialogue permettant de saisir les valeurs 

«MTBF», ouvrez l’onglet «Properties» dans l’affichage détaillé.
– Sélectionnez la propriété dans la liste déroulante «Property» 

«MTBF (Device)».
– Sélectionnez les équipements concernés.
– Pour ouvrir la boîte de dialogue MultiConfig™, cliquez avec le bou-

ton droit sur un équipement en surbrillance et sélectionnez 
MultiConfig™.

– Pour saisir la valeur «MTBF», ouvrez la boîte de dialogue «Pro-
perty Value» dans l’arborescence de la boîte de dialogue 
MultiConfig™.
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– Saisissez la valeur «MTBF» dans le champ «Value».
– Cliquez sur le bouton «Write».

 Pour ouvrir la boîte de dialogue permettant de saisir les valeurs 
«MTTR», ouvrez l’onglet «Properties» dans l’affichage détaillé.
– Sélectionnez la propriété dans la liste déroulante «Property» 

«MTTR (Device)».
– Sélectionnez les équipements concernés.
– Pour ouvrir la boîte de dialogue MultiConfig™, cliquez avec le bou-

ton droit sur un équipement en surbrillance et sélectionnez 
MultiConfig™.

– Pour saisir la valeur «MTTR», ouvrez la boîte de dialogue «Pro-
perty Value» dans l’arborescence de la boîte de dialogue 
MultiConfig™.

– Saisissez la valeur «MTTR» dans le champ «Value».
– Cliquez sur le bouton «Write».

 Calculate Availability
L'exemple suivant décrit le mode de calcul de la disponibilité d'une 
connexion après la préparation décrite plus haut.
 Ouvrez l’onglet «Map» au niveau des équipements.
 Pour sélectionner la connexion des 2 équipements, cliquez sur les 

2 équipements des terminaisons de connexion en maintenant la 
touche « Ctrl » enfoncée.

 Pour ouvrir la boîte de dialogue du calcul de disponibilité, sélectionnez 
Tools > Calculate Availability dans la barre de menus.
– Si la propriété «MTBF»/«MTTR» manque pour des objets précis, 

Industrial HiVision ouvre la boîte de dialogue «Availability» avec un 
tableau des équipements pour lesquels cette propriété manque. 
Ce tableau comprend également des équipements dont la valeur 
des propriétés est 0. 
Vérifiez si des objets (par ex. des équipements ou des 
connexions), dont vous souhaitez calculer la disponibilité 
manquent.

– Si les propriétés «MTBF» et «MTTR» sont définies pour chaque 
objet dans l’onglet «Map», Industrial HiVision effectue le calcul et 
affiche le résultat dans la boîte de dialogue «Availability».
Dans le « Detail Frame » [Cadre de détails], Industrial HiVision 
affiche le chemin d'accès pris en compte pour le calcul. Pour affi-
cher les détails, sélectionnez la case «Details».
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Industrial HiVision écrit les détails du calcul de disponibilité dans un fichier 
log. Vous trouvez l'empreinte digitale dans le champ de texte 
<Installation path>/log/availability. Le nom du fichier journal se 
compose du nom du fichier projet chargé et  de l'horodatage.

Commentaire : Calcul de disponibilité
Industrial HiVision effectue le calcul de disponibilité en supposant que les 
équipements du réseau transmettent à tous leurs ports. Des terminaux, le 
routage et VLAN connectés de manière redondante peuvent fausser le 
résultat. Comme solution pour les terminaux à connexion redondante, 
établissez la propriété «Node Type» dans l’équipement et placez sa 
valeur sur « Équipement ».

Commentaire : Connexions parallèles
Pour optimiser le calcul, Industrial HiVision regroupe sous un chemin 
d'accès les connexions parallèles entre 2 équipements. Les chemins 
d'accès s'affichent dans la liste des chemins d'accès dans la boîte de dia-
logue et tant que chemin unique dans le fichier de journalisation. 
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8.14 Help

Vous trouverez le «Online Help» ainsi que les informations de version pour 
ce programme dans le menu «Help».

8.14.1 Online Help F1

Pour accéder à «Online Help», appuyez sur la touche « F1 » de votre clavier 
ou en cliquant sur Help > Online Help.
Dans l'«Online Help», vous retrouverez le contenu intégral du manuel avec 
sommaire, index, fonction de recherche et aides à la navigation.
Dans les différentes boîtes de dialogue, vous accédez directement à la page 
du manuel ayant trait à cette boîte de dialogue en cliquant sur « Help » [Aide].

8.14.2 Readme

Avec Help > Readme, vous ouvrez le fichier «Readme». Il contient des infor-
mations sur l'installation de Industrial HiVision. 
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8.14.3 Release Notes

Avec Help > Release Notes, vous ouvrez le fichier «Release Notes». Il 
contient les informations concernant la version installée d'Industrial HiVision. 

8.14.4 Tutorial

Cliquez sur Help > Tutorial pour ouvrir un exercice guidé visant à vous 
familiariser avec Industrial HiVision dans le navigateur. Cet exercice vous 
guide dans votre découverte des nouvelles fonctions essentielles d'Industrial 
HiVision.

8.14.5 Online

Vous trouverez de plus amples informations sous Help > Online. 
Vous pouvez sélectionner :

 Hirschmann
pour ouvrir le site internet Hirschmann.

 Le centre de compétence Hirschmann
pour ouvrir le site internet du centre de compétence Hirschmann.
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 Industrial HiVision
pour ouvrir la page produit Industrial HiVision sur le site internet 
Hirschmann.

 Demande de licence
pour ouvrir un formulaire de commande pour la demande d’une licence 
en ligne pour Industrial HiVision dans le navigateur. 
Éléments requis pour solliciter une clé de licence :
– code d'enregistrement du certificat de produit (fourni à la livraison)
– clé matérielle (voir boîte de dialogue Configuration > Preferences > 

Basics > License).
Industrial HiVision transfère automatiquement la clé matérielle lorsque 
vous appelez la page de demande ici.

8.14.6 Kernel Info

L'option de menu Help > Kernel Info contient les informations nécessaires 
à l'intervention d'un technicien d'assistance

Le noyau est au cœur de l’application Industrial HiVision. Le noyau a pour 
but de collecter des informations depuis les équipements du réseau et l’inter-
face utilisateur. Le noyau enregistre les informations dans une banque de 
données. L’interface utilisateur envoie une demande au noyau, par ex. une 
demande concernant les états d’équipements. Le noyau extrait les informa-
tions de la base de données et répond à la demande.
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Figure 113 :Info Kernel Industrial HiVision

8.14.7 About

 Program Info
Vous trouverez les informations relatives à la version de programme et 
l’éditeur sous Help > About > Program Info.
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 EULA
Vous trouverez les informations relatives au contrat de licence sous 
Help > About > EULA.

 License
Vous trouverez des informations relatives aux licences sous Help > 
About > License.
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Annexe A.1  Foire aux questions
A.1 Foire aux questions

Vous trouverez des réponses aux questions le plus souvent posées sur le 
site Internet de Hirschmann Industrial HiVision :

www.hivision.de
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A.2 Propriétés surveillées

A.2.1 Propriétés surveillées dans le préréglage

Propriétés surveillées par Industrial HiVision au moyen d'alarmes et de pol-
ling dans les réglages de base que vous trouverez détaillées dans le tableau 
suivant.

Industrial HiVision liste les alarmes dans la liste d’événements. 

Commentaire : Tenez compte des effets sur vos ressources de système 
(voir page “Impact sur les ressources du système” on page 236).

Propriété Trap 
SNMP

Polling Intervalle de polling

Status [Statut] AutoConfiguration Adap-
ter

x

Fan Status [Statut ventilateur] x
Power Supply Status [Statut bloc ali-
mentation]

x

Relay Status [Statut relais] x
Port Link [Connexion port] x * 30 secondes
Port In Load [Port charge entrante] * 30 secondes
Port Out Load [Port charge sortante] * 30 secondes
Port Admin [Port Administration] x

Tableau 50 : Propriétés surveillées
* Dans les réglages par défaut, le polling est activé pour les ports dotés 
d'une connexion filaire dans Industrial HiVision.
** Dans les réglages par défaut, le polling est activé pour les ports dotés 
d'une liaison radio dans Industrial HiVision
*** Le protocole le plus élevé pris en charge par l'équipement
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Port Oper Status [Port statut opération-
nel]

x

WLAN-Station [Station WLAN] x ** 30 secondes
WLAN-Access-Points [Points d'accès 
WLAN]

x ** 30 secondes

Signal to Noise Ratio(Rapport 
signal/bruit)

x** 30 secondes

Spanning Tree Status [Statut STP] x * 30 secondes
Rapid Spanning Tree Status [Statut 
RSTP]

x * 30 secondes

Multiple Spanning Tree Status [Statut 
d'arborescence couvrante multiple]

x * 30 secondes

Protocol Ping Reachability [Accessibi-
lité Protocole Ping ]

x 30 secondes

Protocol SNMPv1 Reachability [Acces-
sibilité Protocole SNMPv1]

x*** 2 heures

Protocol SNMPv3 Reachability [Acces-
sibilité Protocole SNMPv3]

x*** 2 heures

Ring Status HIPER [Statut anneau 
HIPER]

x * 30 secondes

Ring Coupling Status HIPER [Statut 
anneau de couplage HIPER]

x * 30 secondes

Dual Homing Status [Statut DHP] x * 30 secondes
Ring Coupling Enabled [Couplage 
anneau HIPER activé]

x

Ring Manager Enabled [Administrateur 
anneau HIPER activé]

x

Dual Homing [Dual Homing activé] x
Router Redundancy Mode [Mode 
redondance routeur]

x

Router Redundancy Status [Statut 
redondance routeur]

x

Température x x 5 minutes
Configuration Status x x 5 minutes
Configuration Signature x 1 heure
Configuration File x x 24 heures
Http x 24 heures
Telnet x 24 heures

Propriété Trap 
SNMP

Polling Intervalle de polling

Tableau 50 : Propriétés surveillées
* Dans les réglages par défaut, le polling est activé pour les ports dotés 
d'une connexion filaire dans Industrial HiVision.
** Dans les réglages par défaut, le polling est activé pour les ports dotés 
d'une liaison radio dans Industrial HiVision
*** Le protocole le plus élevé pris en charge par l'équipement
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SNMP V1/V2 x 24 heures
Tftp x 24 heures
IEC61850 x 24 heures
Profinet IO x 24 heures
EtherNet/IP x 24 heures
Unused Active Ports x 24 heures
802.1X Port Access Control Enabled x 24 heures
Outbound ANY Rule x 24 heures
Inbound ANY Rule x 24 heures

Propriété Trap 
SNMP

Polling Intervalle de polling

Tableau 50 : Propriétés surveillées
* Dans les réglages par défaut, le polling est activé pour les ports dotés 
d'une connexion filaire dans Industrial HiVision.
** Dans les réglages par défaut, le polling est activé pour les ports dotés 
d'une liaison radio dans Industrial HiVision
*** Le protocole le plus élevé pris en charge par l'équipement
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A.3 Exportation CSV

Lorsque vous travaillez avec des données CSV dans différentes langues, les 
jeux de caractères correspondants sont nécessaires. Industrial HiVision uti-
lise le codage suivant pendant l'exportation de données dans un fichier 
CSV : 

A.3.1 Microsoft Excel avant 2010

Pour l'importation dans Microsoft Excel, sélectionnez :
 Sélectionnez l’option de menu dans Excel 

Data:Import External Data:Import Data
 Sélectionnez le fichier, puis cliquez sur « Open » [Ouvrir]. 
 Dans l'étape 1 de l'assistant de conversion de texte, sélectionnez 

« Séparé » pour le type de données original.
 Dans l'étape 1 de l'assistant de conversion de texte, sélectionnez 

« Séparé » pour le type de données original.
 Dans l'étape 2 de l'assistant de conversion de texte, sélectionnez 

« Tabstopp » [Taquet de tabulation] et « Semicolon » [Point-virgule] 
comme séparateurs.

Langue Jeu de caractères
allemand, anglais, français, espa-
gnol, italien, portugais, indonésien

Latin-8859-1

Grec Windows-1253
Coréen Johab
Japonais Shift-JIS
Chinois GB2312
Russe Cyrillique-8859-5

Tableau 51 : Jeux de caractères pour l'exportation CSV
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A.3.2 Microsoft Excel 2010

Pour l'importation dans Microsoft Excel, sélectionnez :
 Sélectionnez l’option de menu dans Excel
 Sélectionnez le fichier et cliquez sur « Importation ». 
 Dans l'étape 1 de l'assistant de conversion de texte, sélectionnez 

« Séparé » pour le type de données original.
 Dans l'étape 2 de l'assistant de conversion de texte, sélectionnez 

« Tabstopp » [Taquet de tabulation] et « Semicolon » [Point-virgule] 
comme séparateurs.

 Dans l’étape 3 de l’assistant de conversion de texte, sélectionnez « Par 
défaut » pour le format de données des colonnes.

 Cliquez sur « Terminer ».
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Annexe A.4  Assistance linguistique
A.4 Assistance linguistique

Langue Interface 
utilisateur

Aide en 
ligne

Manuel 
(fichier 
PDF)

Manuel 
(imprimé)

Tutorial 
[Tutoriel]

Lisez-moi

Français X X X X X X
Anglais X X X X X X
Espagnol X X X
Français X X X
Italien X X X
Russe X
Chinois X X X
Coréen X
Japonais X
Grec X
Portugais X
Indonésien X

Tableau 52 : Assistance linguistique
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Annexe A.5  Ports utilisés
A.5 Ports utilisés

Industrial HiVision nécessite pour la communication entre l'interface utilisa-
teur et le service des ports de protocole déterminés dans votre réseau. Le 
tableau suivant reproduit les ports et leur utilisation.
Lorsqu’un pare-feu sépare les services Industrial HiVision d’un client, insérez 
des règles de pare-feu pour continuer à transmettre les données entre les 
services et le client. Voir “–Création de nouveaux équipements” on 
page 145.

Ports utilisés Utilisation
11185 CORBA Naming Service
11186 Alarmes de l'agent de démonstration au service Industrial HiVision
11187 Serveur HTTP/HTTPS
11188 Communication entre l’interface et le service. Industrial HiVision utilise ce 

port pour la communication entre le service et les sus-domaines.
11191 Communication avec le serveur OPC-DA
11189 Communication avec le serveur OPC-DA-HTTP
11190 Communication avec le serveur OPC-DA-HTTPS

Tableau 53 : Ports utilisés
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Annexe A.6  Maintenance
A.6 Maintenance

Hirschmann œuvre en permanence à l'amélioration et au perfectionnement 
des logiciels. Vérifiez régulièrement si une nouvelle version du logiciel vous 
apporte des avantages supplémentaires. Les informations et les logiciels dis-
ponibles au téléchargement figurent sur les pages produits Hirschmann du 
site Internet.
www.hirschmann.com
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Annexe A.8  Copyright des logiciels intégrés
A.8 Copyright des logiciels inté-
grés

Industrial HiVision inclut un certain nombre de composants open source.
Les auteurs de ces composants les ont publiés sous différentes licences.
Ces licences se trouvent dans le chemin d’installation de Industrial HiVision 
sous data\doc\FOSS-BOM.html
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Assistance
C Assistance

Questions techniques

Pour toutes les questions techniques, veuillez vous adresser à votre parte-
naire agréé Hirschmann le plus proche ou directement à la société Hirsch-
mann.

Vous trouverez les adresses de nos partenaires sur internet, à l’adresse 
http://www.hirschmann.com.

Vous trouverez une liste de numéros de téléphone et d’adresses e-mail pour 
une assistance technique par Hirschmann sous https://hirschmann-sup-
port.belden.com.

Vous trouverez en outre une base de données spécialisée gratuite sur ce site 
Internet, ainsi qu'une zone de téléchargement de logiciels.

Le centre de compétence Hirschmann

Le centre de compétence Hirschmann possède trois longueurs d'avance sur 
la concurrence grâce à sa large palette de services novateurs:

 Le Consulting comprend tous les services de conseil technique allant de 
l'analyse système à la planification réseau en passant par l'étude et la 
conception.

 Différentes formations sont à votre disposition : l'acquisition de connais-
sances de base, les formations produit et les formations utilisateurs avec 
certification.
Vous trouverez nos offres de formations technologiques et produits à 
l'adresse http://www.hicomcenter.com.

 Le support technique englobe différents services allant de la mise en ser-
vice du matériel au service d'astreinte jusqu'aux concepts de mainte-
nance.

Dans tous les cas, le centre de compétence Hirschmann vous offre un ser-
vice à la carte. Vous avez entièrement le choix entre les différents services 
qui sont à votre disposition.

Internet :
http://www.hicomcenter.com
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Critique du lecteur
D Critique du lecteur

Que pensez-vous de ce manuel ? Nous nous attelons à décrire intégrale-
ment le produit concerné et à transmettre les connaissances fondamentales 
pour vous assister lors de l’utilisation de ce produit. Vos commentaires et 
suggestions nous aident à optimiser davantage encore la qualité et le carac-
tère informatif de cette documentation.

Votre appréciation de ce manuel :

Avez-vous trouvé des erreurs dans ce manuel ? 
Si oui, lesquelles et à quelle page ?

très bon bon satisfaisant moyen mauvais
Description précise O O O O O
Lisibilité O O O O O
Compréhensibilité O O O O O
Exemples O O O O O
Structure O O O O O
Exhaustivité O O O O O
Graphiques O O O O O
Dessins O O O O O
Tableaux O O O O O
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Suggestions, propositions d'améliorations, propositions de compléments :

Commentaires d'ordre général :

Expéditeur :

Cher utilisateur,

Société / service : 

Nom / numéro de 
téléphone : 

Rue : 

Code postal / localité : 

E-mail :

Date / signature : 
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Veuillez remplir cette feuille et nous la renvoyer 

 par télécopie au +49 (0)7127 14-1600 ou
 par courrier à l'adresse 

Hirschmann Automation and Control GmbH
Département 01RD-NT
Stuttgarter Str. 45-51
72654 Neckartenzlingen
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